Enterprise Architect
User Guide Series

User Interface
How do I use Enterprise Architect? The
Enterprise Architect User Interface provides
access to the facilities of just the right feature
set and screen environment for the specific
work that you do.

Author: Sparx Systems
Date: 21/12/2018
Version: 1.0
CREATED WITH

Table of Contents
User Interface
The Start Page
How to Remove Links to Recent Projects
The Enterprise Architect Ribbons
File Management
Show Panel
Start Ribbon
Explore Panel
View Panel
Collaborate Panel
Help Panel
Design Ribbon
Package Panel
Diagram Panel
Element Panel
Impact Panel
Tools Panel
Layout Ribbon
Diagram Panel
Undo Panel
Style Panel
Alignment Panel
Tools Panel

10
14
22
25
29
33
40
44
51
57
62
67
71
76
81
88
90
92
96
103
105
108
112

Filter Panel
Helpers Panel
Specialize Ribbon
Tools Panel
Technologies Panel
Add-Ins Panel
Publish Ribbon
Report Panel
Diagram Panel
Tools Panel
Model Exchange Panel
Technologies Panel
Construct Ribbon
Task Management Panel
Testing Panel
Change Management Panel
Status Panel
Simulate Ribbon
Core Panel
Run Panel
Executable Panel
Decision Analysis Panel
Process Analysis Panel
System Behavior Panel
Code Ribbon
Import Panel
Source Code Panel

114
119
123
126
129
136
138
141
143
146
148
152
154
157
163
168
178
180
184
187
189
192
194
196
198
201
204

Schema Panel
Configure Panel
Build and Run Panel
Execute Ribbon
Analyze Panel
Windows Panel
Run Panel
Configure Ribbon
Security Panel
Set User Avatar
Version Control Panel
Model Panel
Reference Data Panel
User Tools Panel
Specification - Specify Ribbon
Element Panel
Display Panel
Document Edit Ribbon
File Panel
Edit Panel
Font Panel
Paragraph Panel
User Button
Toolbars
Navigator Toolbar
Default Tools Toolbar
Workspace Layouts Toolbar

207
210
214
216
218
226
228
232
236
240
242
245
250
254
256
258
266
272
274
279
288
294
308
311
313
320
324

Project Toolbar
Diagram Toolbar
UML (New) Elements Toolbar
Element Toolbar
Current Connector Toolbar
Code Generation Toolbar
Record & Analyze Toolbar
Build Toolbar
Debug Toolbar
Status Bar
Introducing the Enterprise Architect Windows
Dock Windows
Autohide Windows
Code Editors
Other Windows
The System Output Window
The Web Browser
Perspectives
Using Perspectives
Customizing Perspectives
Types of Perspective
Portals
Perspective Portal
Workspace Portal
Window Portal
Status Portal
Extend Portal

327
330
335
338
342
346
350
353
356
359
362
368
374
376
379
380
383
385
392
398
404
415
422
424
428
433
437

Execute Portal
Revisit Portal
Guidebook Portal
Learning Portal
Keyboard Shortcuts
Keyboard-Mouse Shortcuts
Diagram Shortcuts
Customization
Visual Styles
Customize Dialog
Customize Commands
Customize Toolbars
Add Custom Tools
Open External Tools
Pass Parameters to Applications
Customize Keyboard Shortcuts
Customize Submenus
Customize Options
Workspace Layouts
Customizing Ribbon Sets
Working Sets
Local Options
General Options
Window Behavior
Diagram Options
Diagram Theme Options
Diagram Gradients and Backgrounds

439
447
450
452
457
471
474
483
484
491
493
500
504
506
508
510
513
515
517
521
525
535
539
545
550
558
564

Standard Colors
Create Custom Colors
Get/Set Custom Project Colors
Diagram Appearance Options
Set User Default Fonts
Diagram Behavior Options
Sequence Diagram Options
Object Display Options
Connector Display Options
Communication Message Colors
XML Specifications
Model-Specific Options
Cloud Page
Tutorial
Startup
Create a Project
Add a View to your Model
Add New Packages
Create a New Diagram
Create New Elements on a Diagram
Add Connectors
Modify Properties
Save Changes
Move Objects Around
Move Objects Within a Package
Move Objects Between Packages
Move Elements in a Diagram

572
580
583
586
593
596
606
610
619
626
628
635
639
644
646
649
652
654
657
660
664
667
669
670
672
674
676

Move Elements Between Diagrams
Connect a Different Element on a Diagram
Delete a Connector
Delete an Element
Remove Elements From a Diagram
Delete Elements From Your Model

678
682
684
688
689
691

User Guide - User Interface

21 December, 2018

User Interface

The Enterprise Architect application workspace (or user
interface) provides a powerful and flexible analysis,
modeling, design and construction environment. The
workspace is built from familiar components, such as
toolbars, docking windows, dialogs and menus. Together
these elements provide a rich set of tools for working with
models, UML, diagrams, source code, executing
applications (debugging and visualization), rich text
documents, collaborative tools, extension technologies and
much more.
The Enterprise Architect user interface is highly
customizable both in functionality and in appearance. Visual
styles are available based on the popular Microsoft Office
and Visual Studio, from the classic look and feel of the
Windows XP era right up to the latest Office and Visual
Studio incarnations. Dark and light styles are further
enhanced with the ability to automatically display source
code and diagrams in dark or normal styles.
Customization of toolbars, menus, workspace layouts,
Perspectives and shortcuts helps you get the most out of
Enterprise Architect for your particular needs. Taking the
(c) Sparx Systems 2018
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time to become familiar with the customizations available is
well worth while, as it can help you build the precise
modeling and design environment you need to focus on your
work.
If you want to explore the basic process and tools for
creating a model in Enterprise Architect, you can watch the
demonstration on the Sparx Systems website, and/or work
through the simple Tutorial provided in this section. Use the
links under the 'Learn more' heading.

User Interface Tools
Tool
The Enterprise Architect workspace is the interface
through which you create, open and display your models;
the main workspace component is the central Diagram
View, which is where you create model diagrams, view
reports, scroll through lists of model elements, access the
internet and edit and debug source code.
The ribbons provide access both to high-level functions
related to the project life cycle, and to project and system
administration functions; at all levels of the system you
can also access functions and operations using context
menus.
The windows are used to enter and display information on
(c) Sparx Systems 2018
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your project and models; you can rearrange windows to
adapt the screen space to your work habits.
Toolbars are small sets of buttons that provide quick
access to common operations, both on your project as a
whole and on the individual modeling units.
The Diagram Toolbox provides all the components and
connectors that you use to create models using the
medium of diagrams; the Toolbox automatically matches
the kind of diagram you have open, from any technology
that is currently active in your model.
You can use keyboard key combinations to quickly
initiate a wide range of actions throughout the system,
and Diagram Quick Key (single-key) shortcuts to perform
actions on the elements and connectors in an open
diagram.
Enterprise Architect provides various customization tools
that you can use to:
· Tailor the ribbons, menus, toolbars and function keys
you use in your work
· Set the visual style of the application, and
· Customize the workspace layout
You can use several navigation and search tools to search
for, track and locate information in your project, and filter
the information so that you can explore particular views
(c) Sparx Systems 2018
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of your project rather than the entire contents.

(c) Sparx Systems 2018
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The Start Page
The features described here are available from Enterprise
Architect Release 14.1 onwards.
The Start Page is the default landing page that displays
when you first open Enterprise Architect. It provides a range
of useful commands to create and/or access project files,
connect to a server repository, or access a project via the
Cloud. You can also access a set of Portals that provide the
facilities, resources, links, tailored searches and reports for
working in a particular task area, such as publishing or
developing a model.
The facilities and commands on the Start Page are made
available through the 'Open' and 'New' options, the 'Recent'
list and the 'Open a Portal' option.
Notice that when you open Enterprise Architect for the first
time, the Project Browser contains the option '<click to open
project>'. This has the same effect as the 'New > Manage
Projects' option, described in the New table.

Access
Opened by default on startup of Enterprise Architect.
Ribbon

(c) Sparx Systems 2018

Start > View > Workspace > Show Start
Page
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Open
Option

Action

Local project

Click on this option to display the 'Select
Enterprise Architect Project to Open'
dialog to browse for and open an existing
project file (.eap, .eapx or .feap).

Server
Connection

Click on this option to display the 'Data
Link Properties' dialog, from which you
begin to specify a data source to connect
to, on one of a number of supported
repositories.
This feature is available in the Corporate,
Unified and Ultimate editions.

Cloud
Connection

Click on this option to open the 'Cloud
Connection' dialog, which you use to
specify a project held at a remote
location, and to access it through the
internet or web. You work on the project
using the Enterprise Architect installation
on your machine.
An advantage of working in this way is
that you do not need to have the database

(c) Sparx Systems 2018
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drivers installed on your machine, as you
would to work on projects held on a
DBMS server.

New
Option

Description

Create a new
project

Click on this option to create a new local
(.eap or .feap) project file, and to add
model structures to it using the Model
Wizard.

Manage
projects

Click on this option to open the 'Manage
Projects' dialog, which you use to manage
connections to the Enterprise Architect
projects (.eap files, .eapx files, .feap files,
DBMS server connections and Cloud
connections) to which you have access.

Recent
This is a list of up to ten Enterprise Architect projects (.eap
(c) Sparx Systems 2018
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files, .eapx files, .feap files, DBMS server connections and
Cloud connections) that you have opened most recently. The
drop-down arrow in the list heading displays options to:
· Switch the list between recently-accessed models and
currently 'watched' models, and
· Set up a 'Watched Model' configuration to define what
projects to monitor and what actions to capture within the
models (see the Model Watches Help topic)
Option

Action

<Model
names>

Either:
· Click on a project name in the list to
open that project in the current
instance of Enterprise Architect (and
close any project you already have
open), or
· Ctrl+click on a project name in the list
to launch that project in a separate
instance of Enterprise Architect, in
addition to the current project
You can also right-click on a project
name in the list and display a short
context menu with options to:
· Open the selected project in the current
instance of Enterprise Architect (and
close any project you already have
open)
· Launch the selected project in a new

(c) Sparx Systems 2018
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instance of Enterprise Architect
(keeping the current project open in the
current instance)
Add the model to the list of watched
models that you are monitoring for
various kinds of activity
If the project is accessed via a
connection string to a DBMS or Cloud
repository, change the project name
Remove the selected project from the
list (which removes the link to the
project, not the project file itself)

Open a Portal
This option displays a drop-down list of the Portals
available in Enterprise Architect. Click on the appropriate
Portal name to display that Portal on the left or right of the
screen.
Portal Name

Description
The Perspective Portal provides a number
of work Perspectives grouped by general
work area. Each Perspective filters the
modeling windows and dialogs to present
only the modeling Patterns you might use

(c) Sparx Systems 2018
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in the work defined by the Perspective.
When you select a Perspective the Model
Wizard displays, showing the 'Model
Patterns' tab and providing the model
templates that you might use to initially
create a model supporting the type of
work. The Portal also includes a category
for Perspectives that you have created
yourself.
The Workspace Portal provides links to
the system-provided workspaces and
working sets that you might use to lay out
the Enterprise Architect work area, and to
any working sets and workspaces that
you have created yourself.
The Window Portal provides links to the
Enterprise Architect windows you use to
navigate through, develop and manage
your model.
The Status Portal provides links to run
searches that locate recent activities of
various types across the model.
The Extend Portal lists the MDG
Technologies currently active in your
model, and for each one provides links to
(c) Sparx Systems 2018

Page 19 of 694

User Guide - User Interface

21 December, 2018

the facilities for working with those
technologies within Enterprise Architect.
The Execute Portal provides a wide range
of options that help you to perform Visual
Execution Analysis, Simulation, Profiling
and Debugging of your modeled
application.
The Guidebook Portal provides links to
the library of Enterprise Architect User
Guides in PDF format. The Portal
initially displays with ten categories of
document, each of which can be
expanded to a list of the PDF documents
in that category.
The Learning Portal provides links to
either the web version of the Enterprise
Architect User Guide, or the
locally-installed Help if you have
downloaded that. The Portal also
provides links to a number of useful web
pages on the Sparx Systems website, such
as the Tutorials, Webinars and Video
Demonstrations pages.
The Revisit Portal provides links to the
diagrams, source files and system
(c) Sparx Systems 2018
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windows that you currently have open,
and the diagrams and source files that
you have recently opened and then closed
again.

Notes
·

You can hide the Start Page, or show it again, by toggling
the 'Start > View > Workspace > Show Start Page' ribbon
option; this setting persists after shut down and restart of
Enterprise Architect until you explicitly toggle the option
again

(c) Sparx Systems 2018
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How to Remove Links to Recent
Projects
In the 'Manage Projects' dialog and on the Start Page
'Recent' section, the projects that you have opened most
recently are listed in the order of opening date/time up to a
maximum of ten projects, with the most recently opened
project at the top of the list. If the list identifies projects that
you do not want to be so immediately accessible, you can
remove them specifically from the list.
Removing a project from the list only removes the hyperlink
to the project and does not remove the project from the file
system or repository.

Access
Ribbon

> Open Project or
Start > View > Workspace > Show Start
Page > Recent

Keyboard
Shortcuts

Ctrl+O

(c) Sparx Systems 2018
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Remove a project hyperlink from the
'Manage Projects' list
Ste Action
p
1

On the 'Manage Projects' dialog, in the 'Recent
Projects' panel, click on the name of the project to be
removed.

2

Click on the Remove Selection from List button.
The project link is immediately removed from the
list.

Remove a project hyperlink from the Start
Page, Recent list
Step

Action

1

On the Start Page, right-click on the name
of the project to remove and select the
'Remove Selection from List' option.

2

The name of the project disappears from

(c) Sparx Systems 2018
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the list.

Notes
·

·

You can only remove one project link from the list at a
time
To remove a link there must be at least two projects in the
list

(c) Sparx Systems 2018
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The Enterprise Architect Ribbons
When you open Enterprise Architect version 13 or later you
will see a set of ribbons at the top of the screen. This is a
modern, contemporary way of accessing the tool's powerful
features. Ribbons bring many features immediately to the
surface, making them easily accessible to a modeler; both
new users and those who have been using Enterprise
Architect for many years will be delighted to find their
preferred tools right at their fingertips. Each ribbon provides
actions with a particular focus, and the commands on the
ribbons are grouped by function into panels.

Searching for an Item
The ribbons expose a wide range of Enterprise Architect
features, and the system provides two facilities to help you
locate and access the feature you need:
· Click on the 'Find Command' field at the end of the
sequence of tabs and type in some text relating to the
feature you want to locate, then press the Enter key; this
displays a hierarchical menu of options that match your
search text, and when you click on an option the
appropriate dialog opens
Note that this facility is only available in the 'Microsoft
Office 2016' Visual Style theme
· Click on the
button (for File Management options)
to the left of the ribbon tabs and, on the resulting dialog,
(c) Sparx Systems 2018
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type your search text in the 'Search' field at the bottom; a
list of options relating to the search text is immediately
displayed down the left hand side of the dialog and, when
you click on an option, the appropriate dialog opens
Also, when you 'mouse over' any option on any of the
ribbons, a tool-tip displays in the left end of the Status Bar
at the bottom of the screen, summarizing the function of the
option.
You therefore have help in identifying both what option
provides a function, and what function an option provides.

Contextual Ribbons
Some ribbons are contextual and are only needed when you
are performing a particular task. For example, the
'Document-Edit' ribbon is only needed when you are
viewing or editing a document inside Enterprise Architect.
This ribbon will remain visible while a document is open;
when all documents are closed the ribbon will be hidden
from view.

Using the Keyboard with Ribbons
The actions that are presented on the ribbons can also be
accessed using the keyboard. If you tap and release the Alt
key, each panel will be annotated with a letter code.
(c) Sparx Systems 2018
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Pressing this letter on the keyboard will activate the ribbon
and display a further set of annotations for the actions in the
ribbon.

Customizing the Ribbons
If a ribbon presents more options than you require, you can
customize it to hide the panel containing those options, or
hide the whole ribbon. To do this, you select the 'My Ribbon
Sets' tab on the 'Workspace Layout' dialog (Start > View >
Workspace > My Workspaces), create a Ribbon Set to
customize the ribbon display, and define the ribbons and
panels to show or hide in that Ribbon Set. You can
re-activate hidden ribbons and panels by editing this Ribbon
Set.
The 'My Ribbon Sets' tab also provides the option of
defining one of the ribbons as the default to automatically
display when Enterprise Architect is opened in a work
session. Normally the 'Start' ribbon is fully open when the
system is accessed.

(c) Sparx Systems 2018
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Minimizing the Ribbon Bar
On occasion you might need more screen space to view
diagrams and other model representations. To help with this,
you can conveniently minimize the ribbons and completely
hide them from view. The ribbon tabs will still be visible,
so you can click on the required tab and redisplay the
corresponding ribbon until the focus is returned to another
part of the user interface. Many modelers will find that
leaving the ribbons maximized will provide a convenient
visual reminder of the actions that are available while
working on models.
To minimize or restore the ribbons, right-click on the ribbon
bar and select or deselect the 'Minimize the Ribbon' option.
Alternatively, double-click on the currently-displayed
ribbon tab.

(c) Sparx Systems 2018
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File Management
When managing the project as a unit, you can create, open,
close or save projects, provide desktop shortcuts to a
project, or perform print tasks.

Access
Other

Click on

.

File Management Options
Option

Action

New Project

Create a new Enterprise Architect project,
using the Model Wizard to help you
define the base technology, model types
and Patterns to use as a framework.
Shortcut: Ctrl+N

Open Project

Open an existing project, or create a new
project from scratch or from a base
template project.

(c) Sparx Systems 2018
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Shortcut: Ctrl+O
Reload
Project

Reload the current project. (Use this in a
multi-user environment to refresh the
Project Browser).
Shortcut: Ctrl+Shift+F11

Close Project

Close the current project.

Save Project
As

Save the current project with a new name
(as a .eap or .feap file). The current
project can be a base template or a
complete operational project.

Save as
Shortcut

Create a desktop shortcut to the current
project.
(This option is also active in the 'Lite',
read-only edition of Enterprise Architect.)

Print Setup

Configure your printer's settings.

Page Setup

Configure the page settings to print the
current diagram.

Print Preview

Preview how the currently displayed
diagram will print.

Print

Print the currently displayed diagram.

(c) Sparx Systems 2018
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You can also make use of other facilities
to change the scale of the printed diagram
(the number of pages it takes up) and to
print or omit page headers and footers on
the diagram. By de-selecting the
'Printable' option on an element on a
diagram, you can omit that element and
its connectors from the printed diagram.
Shortcut: Ctrl+P
Print to PDF

Save the currently displayed diagram as a
PDF file. A browser displays to select the
PDF file name and directory path.
By de-selecting the 'Printable' option on
an element on a diagram, you can omit
that element and its connectors from the
diagram in the PDF output.

Recent
Documents

Select from a list of up to ten of the most
recently opened projects, to re-open the
selected project.

Search

Type the name of an operation or
command that you want to locate; a list of
options relating to the search text is
immediately displayed down the left hand
side of the dialog and, when you click on
an option, the appropriate dialog opens.

(c) Sparx Systems 2018
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Exit from Enterprise Architect.
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Show Panel
The 'Show' panel contains a single 'Portals' icon.

Clicking on this icon displays a list of the Portals and
toolbars that you might use to set up the user interface to
support a particular area of work. When you click on a
Portal name the corresponding Portal displays on the left or
right of the work area (according to your personal settings).
Similarly, when you select the 'Show Toolbar | <toolbar
name>' option, the toolbar displays at the top of the work
area, just underneath the Ribbon bar.
The name of the selected Portal and each selected toolbar is
marked with a tick, so the list provides a summary of what
Portal and toolbars are active.

The Portals and Toolbars
(c) Sparx Systems 2018
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Portal/Option Description
Perspective

(c) Sparx Systems 2018

Provides a range of model Patterns from
which you can generate model structures
for particular areas of work. The Patterns
are organized into groups within
Perspectives, and presented for selection
through the 'Model Patterns' tab of the
Model Wizard. The system-provided
Perspectives are:
· Standard UML Modeling
· Strategy
· Analysis, such as Mind Mapping and
Requirements modeling
· Requirements
· UX Design
· Business Modeling
· Software Engineering
· Systems Engineering
· Database Engineering
· Enterprise Architecture
· Information Exchange
· Construction, such as Road Maps and
Test Management
· Management
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The Portal also includes a category for
Perspectives that you have created
yourself, which provide the Patterns from
MDG Technologies that you have
specified in the Perspective.
Workspace

Provides links to the system-provided
workspaces that you might use to lay out
the Enterprise Architect work area, and to
any workspaces that you have created
yourself. The categories provided are:
· My Workspaces
· Core modeling
· Design
· Software management
· Simulation
· Construction
· BABOK and the BABOK Reader

Window

Provides links to the Enterprise Architect
windows and displays that you use to
develop a model and create and manage
the objects within it. These facilities are
grouped under the activity areas of:
· Exploring the model
· Displaying object properties
· Managing the display of diagrams

(c) Sparx Systems 2018
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Working with specialized tools
Tracing relationships between objects
Enabling collaboration between team
members
Managing tests
Managing resource tasks
Project management and maintenance
Developing code and document
templates

Provides links to run searches that locate
recent activities of various types across
the model. The searches are grouped to
identify:
· Recently created elements, Linked
Documents, diagrams and discussions
· Recent formal reviews
· Recent informal discussions and chats
· Recently started, finished, overdue or
active tasks
· Results of recently-run tests
· Recently reported and implemented
Changes
· Recently reported and investigated
Defects
· Recently reported and investigated
Issues
Page 36 of 694
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Extend

Lists the MDG Technologies currently
active in your model - such as ArcGIS
and NEIM (4.0) - and for each one
provides links to the facilities for working
with those technologies within Enterprise
Architect.

Execute

Provides a wide range of options that
help you to:
· Perform Execution Analysis on your
model - building and running the
Analyzer scripts
· Open the Record & Analyze, Profiler,
Debugger and/or Testpoints dialogs for
monitoring the execution of your
modeled application
· Set up and perform simulations of the
execution of your application
· Control the progress of a simulation
· Access various windows that display
specific aspects of debugging an
application
· Control the progress of a debug
· Set up and run recording of the
execution of an application
· Display the dialogs to prepare to profile
the execution of an application

(c) Sparx Systems 2018
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Create and edit code from the model

Revisit

Provides links to the working sets,
diagrams, documents and system
windows that you currently have open,
and the diagrams and source files that
you have recently opened and then closed
again. The Portal also has options to
re-open other files that you might have
opened from within Enterprise Architect.

Guidebook

Provides links to the library of Enterprise
Architect User Guides in PDF format.
The Portal initially displays with ten
categories of document, each of which
can be expanded to a list of the PDF
documents in that category.

Learning

Provides links to either the web version
of the Enterprise Architect User Guide,
or the locally-installed Help if you have
downloaded that. The Portal also
provides links to a number of useful web
pages on the Sparx Systems website, such
as the Resources, Tutorials, Webinars and
Video Demos pages.

Show
Toolbar

Select this option to display a list of the
ten standard Enterprise Architect

(c) Sparx Systems 2018
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Toolbars, from which you can select the
Toolbars to dock above the central work
area or in some other convenient location
on the screen. You can hide each Toolbar
again by deselecting the name in the list.

(c) Sparx Systems 2018
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Start Ribbon
The 'Start' ribbon provides a range of facilities for exploring,
navigating and viewing the information in the repository.
These include tools to navigate and search for items, to view
the important events, messages, discussions and work that is
relevant to a modeler on a given day, and to view and
change your workspace settings, including styles and
preferences. This ribbon also provides access to the Help
facilities, including registering licence keys and checking
for updates.

Panels
Panel

Description

Explore

You can use the 'Explore' panel to
navigate the repository and explore its
contents. Most repositories will contain
thousands - if not tens of thousands - of

(c) Sparx Systems 2018
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elements, and having tools to navigate
through and locate items of interest is
critical when working in the repository.
There are a number of Browsers that are
tree views, showing the hierarchical
relationships of Packages (folders),
elements, diagrams, features, resources,
views, items and more. The 'Properties'
option provides access to a collection of
windows that provide information about
the model and system activity. They
provide a rich set of methods for viewing
information about elements as you
navigate through them in diagrams or the
Project Browser. The Notes window
provides descriptive text, the Summary
window lists the important aspects of an
element and the Properties window
provides details of an element's metadata
and more. The 'Trace' option provides
facilities for following relationships and
linkages between elements through the
model. The Search helps you to find
elements, diagrams and Packages
regardless of their location.
View

(c) Sparx Systems 2018

The 'View' panel helps you to define the
look and feel of the application, setting
preferences that change the style of the
interface to suit the work role you are
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performing. You can define any number
of workspace layouts, saving sets of
windows that are specific to a role that
ultimately increases your productivity as
a modeler. There is a wide range of
preferences you can set to tailor the way
the application behaves under your login,
including setting colors, fonts and
diagram styles.
Collaborate

(c) Sparx Systems 2018

Enterprise Architect is a powerful
collaboration platform and allows any
number of people to work on models and
diagrams at the same time, in a
cooperative and team effort. The
collaboration tools include Reviews and
Discussions of elements, the Team
Library, Model Mail - which contains
messages from other modelers - the
Project Calendar listing important events,
the 'My Journal' daily reminder facility,
Gantt Charts listing work allocations and
Kanban diagrams where tasks are
presented. The tools ensure that
communication about the elements,
diagrams, lists and matrices are available
in the model and links can be created
back to these items from the collaboration
tools. The 'Collaborate' panel
conveniently brings these tools together,
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ensuring that you are informed about
what you need to attend to and made
aware of information that is important to
your role.
Help

(c) Sparx Systems 2018

The 'Help' panel provides access to the
powerful Help system and to a wide
range of on-line facilities to support your
use of the tool, including the management
of Licence Keys. The Help system
contains both overviews of functional
areas of the application and detailed
topics on how to use specific tools,
helping you to be highly productive. The
Help is normally accessed as an on-line,
web-based system, but you can select to
download the file-based Help to provide a
local Help system. You can also open the
Learning Center library, which provides
user-focused guidance for common tasks.
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Explore Panel
You can use the 'Explore' panel to navigate the repository
and explore its contents. Most repositories will contain
thousands - if not tens of thousands - of elements, and
having tools to navigate through and locate items of interest
is critical when working in the repository. There are a
number of Browsers that are tree views, showing the
hierarchical relationships of Packages (folders), elements,
diagrams, features, resources, views, items and more. The
'Properties' option provides access to a collection of
windows that provide information about the model and
system activity. They provide a rich set of methods for
viewing information about elements as you navigate through
them in diagrams or the Project Browser. The Notes window
provides descriptive text, the Summary window lists the
important aspects of an element and the Properties window
provides details of an element's metadata and more. The
'Trace' option provides facilities for following relationships
and linkages between elements through the model. The
Search helps you to find elements, diagrams and Packages
regardless of their location.

Available Facilities
(c) Sparx Systems 2018
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Facility

Description

Browse

Click on this icon to select from a list of
tools for displaying the structure and
content of the model, including:
· Project Bowser - displays the 'Global'
tab of the Project Browser, which lists
the entire contents of the project
· Context Browser - displays the
'Context' tab of the Project Browser,
which shows only the selected node
and its contents
· Navigator - displays and hides the
Navigator bar, which helps you to
navigate the hierarchy of Packages in
the repository using a textual
breadcrumb control, showing you the
current Package location
· Element Browser - shows a summary
of the added properties of the selected
element
· Team Library - use to review and add
to a hierarchically-structured repository
of comments, reports, reviews and
documents on any structure, feature or
aspect of the project or of other, related
projects

(c) Sparx Systems 2018
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Model Views - use to capture
information on the objects in your
model from different aspects that you
define yourself, helping you to
encapsulate your model under the areas
in which you are interested
Resources - a repository of
project-standard and re-usable
document generation templates, MDG
Technologies, Relationship Matrix
profiles, commonly-used model
elements, stylesheets, UML Profiles
and Patterns, with facilities for creating
and modifying these structures and
facilities and, in some cases, for
applying the facility to the current
model directly from the window
System Output - displays the data that
Enterprise Architect generates during
each of a range of processes; the data
from each type of operation generally
has its own window tab

Click on this icon to select from a list of
Properties pages and windows for the
features and internal contents of
elements, such as the:
· Properties dialog - displaying the name,
status, and general properties of the
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object
Notes window - displaying any notes
created for the object
'Requirements' page of the
Responsibilities window
'Constraints' page of the
Responsibilities window
'Scenarios' page of the Responsibilities
window
Features window for attributes,
operations, receptions, Parts/Properties,
Interaction Points and Connection
Points
Tagged Values window - add, edit and
delete Tagged Values on the
currently-selected element
Summary - displaying the Summary
View showing the object properties
Linked Document - displaying the
Document window showing the
'Linked Document' tab
Construct - displaying the Construct
window to add resources and project
management items to the object

Click on the drop-down arrow to select
from a list of options for reviewing
relationships and relationship chains and
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performing a Gap Analysis on the model
or part of the model:
· Relationships -provides a
comprehensive view of all relationships
of one or more selected elements,
showing the type, direction, stereotype,
source and target elements, and
characteristics of the source and target
elements
· Traceability - helps you follow the
connections in a chain of elements,
starting with a single element to
establish the dependencies radiating
from that element
· Relationship Matrix - shows how sets
of elements in one Package are linked
to each other, or to elements in another
Package, and helps you to add and
delete relationships where necessary
· Gap Analysis Matrix - helps you
explore the implementation of features
in the model, and identify potential
gaps between solution architectures
Search

(c) Sparx Systems 2018

Click on the drop-down arrow to display
this selection of search facilities that you
can use to locate objects in the model, or
code in source files.
· Model - display the Find in Project
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view, which provides access to the full
range of standard and customized
searches in your project
Files - locate and open source files
having specific characteristics, using
the 'Find in Files' dialog
Recent Diagrams - display the 'Find in
Project' view defaulted to an executed
specific search for recently modified
(that is, Active) diagrams. The default
time period is the three days prior to
today's date
Recent Elements - display the 'Find in
Project' view defaulted to an executed
specific search for recently modified
(that is, Active) elements. The default
time period is the three days prior to
today's date
Recent Tasks - display the 'Find in
Project' view defaulted to an executed
specific search for Active Tasks (those
that are in progress)
Diagram - display the Find in Project
view, pre-loaded with the Diagram
Details search to locate diagrams of a
specific name or type
Package - display the Find in Project
view, pre-loaded with the Find Package
search to locate Packages of a specific
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name or type
Browse for Diagram - locate and select
a specific diagram using the 'Select
Classifier' dialog, which shows the full
hierarchy of Packages in the model
Browse for Package - locate and select
a specific Package using the 'Find
Package' dialog, which shows the full
hierarchy of Packages in the model
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View Panel
The 'View' panel helps you to define the look and feel of the
application. You can set preferences that change the style of
the interface to suit the work role you are performing. You
can define any number of workspace layouts, saving sets of
windows that are specific to a role that ultimately increases
your productivity as a modeler. There is a range of
preferences you can set to tailor the way the application
behaves for you individually, including setting colors, fonts
and diagram styles.

Available Facilities
Facility

Description

Perspective

Click on the drop-down arrow to display
these commands:
· Select a Perspective - switch to or open
the Perspective Portal, from which you
can select a Perspective to apply to
your Enterprise Architect user interface
· Open Model Wizard - display the

(c) Sparx Systems 2018
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Model Wizard at the 'Model Patterns'
tab, showing the last-selected
Perspective
· Clear Current Perspective - reset the
system windows and dialogs to display
all Patterns and not any group defined
by a Perspective
· Customize List of Available
Perspectives - display the Perspective
Sets window, where you can filter the
Perspectives displayed for selection, or
customize your own
· Help - display the Help topic
Introducing Perspectives
Workspace

(c) Sparx Systems 2018

Click on the drop-down arrow to display
these options:
· Select a Workspace - displays the
'Workspace Layout' dialog at the
'Workspace' tab, from which you can
select a system-provided Workspace to
apply
· Select a Window - switches to the
Window Portal, from which you can
select a window to add to the current
Workspace
· Save Current Window Layout - save
the current work area layout as a new
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workspace
My Workspaces - displays the
'Workspace Layout' dialog at the 'My
Workspaces' tab, on which you can
create a new custom Workspace or
select and apply an existing customized
Workspace
My Working Sets - displays the
'Manage Working Sets' dialog, on
which you can define the windows and
dialogs you want to automatically
display when you next log on to
Enterprise Architect, either to pick up
where you left off or to form a 'home
base' for your day-to-day work
Set My Default Package - displays the
'Find Package' dialog, from which you
select a default Package to select and
expand in the Project Browser when
the model is loaded; this does not
affect, nor is it affected by, any default
diagram selected to open when the
model is loaded
Set My Default Diagram - set either a
specific diagram as your default User
diagram, or no diagram (which still
blocks the Model default diagram - if
set - from being displayed
automatically)
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Clear My Default Diagram - cancel the
setting of a your user default diagram;
the Model default diagram, if set, will
display automatically
Show Start Page - show or hide the
Start Page; this setting persists through
shut down and restart, until you
specifically change the option
Always on Top - force the main
Enterprise Architect window to be on
top of all other windows
Show All Ribbons - if you have applied
a Ribbon Set to only show a subset of
ribbons, this option restores all ribbons
to the ribbon band
Manage Views - provides a further
menu of options for controlling how a
selected view is displayed:
- Float View - display the current
View as a floating window, allowing it
to be displayed in 'Full Screen'
mode or to be moved to a different
display monitor
- Focus View - set the input focus
back to the View that last had focus
(intended to be accessed via
command shortcut keys (Ctrl+Shift+0))
- Reload View - load the latest
information from the model database,
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to update the display of the current
View
- Close View - close the current
View; you will be prompted to save
any
unsaved modifications
- Close All Except Current - close all
Views except the current view; you
will be prompted to save any
unsaved modifications
- Close All - close all Views; you
will be prompted to save any unsaved
modifications
- Save All Modified Views - for
every View that is currently open, save
to
the model database any
modifications to the appearance of the
View;
these include modifications such as
changes to color, size or position
- Auto Hide Active Window autohide the currently active window
- Auto Hide All Docked Windows autohide all open and docked windows
- Close Active Window - close the
currently active window
Preferences
(c) Sparx Systems 2018

Click on the drop-down arrow to display
the 'Preferences' dialog, on which you can
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set the general options of Enterprise
Architect. You can control how the
system behaves when you open a project,
including setting the home directories and
web pages the project refers to and how
the Project Browser responds when items
are selected in it.
Full Screen

Click on this icon to toggle Enterprise
Architect in and out of 'Full Screen'
mode.

Visual Style

Displays the 'Application Look' dialog,
on which you can select from a range of
visual styles, themes and accent colors.
You can also choose options such as
displaying window tabs at the top or
bottom of the windows and displaying
element properties using tree or list style
displays.
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Collaborate Panel
Enterprise Architect is a powerful collaboration platform
and allows any number of people to work on models and
diagrams at the same time, in a cooperative and team effort.
The collaboration tools include Reviews and Discussions of
elements, the Team Library, Model Mail - which contains
messages from other modelers - the Project Calendar listing
important events, the 'My Journal' daily reminder facility,
Gantt Charts listing work allocations and Kanban diagrams
where tasks are presented. The tools ensure that
communication about the elements, diagrams, lists and
matrices are available in the model and links can be created
back to these items from the collaboration tools. The
'Collaborate' panel conveniently brings these tools together,
ensuring that you are informed about what you need to
attend to and made aware of information that is important to
your role.

Available Facilities
Facility

Description

Discussions

Displays either the Discussions window

(c) Sparx Systems 2018
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(main icon), on which you can manage
current discussions of elements and
diagrams, or a menu (drop-down arrow)
providing these options:
· Discuss - to display the Collaborate
window at the 'Discuss' tab, on which
you can create a new discussion or add
to an existing discussion on a specific
element or diagram
· Discussion History - to display the
Discussions window, on which you can
manage the separate discussions of
elements recorded in the model
· Find Recently Discussed Elements - to
run a report that presents elements that
have been the subject of discussion in
the last x days (you specify the number
of days in the 'Search Term' field)
· Chat - to display the Collaborate
window at the 'Chat' tab, ready to
participate in an exchange of brief
comments on any point, with members
of one of the defined user security
groups
· Chat History - executes a report that
lists all Chat items recorded over the
specified period (default 3 days); you
can filter the Chat items by Discussion
Group in the report
(c) Sparx Systems 2018

Page 58 of 694

User Guide - User Interface
·

Reviews

21 December, 2018

Help - to display the Informal
Discussions Help topic

Displays either the Collaborate window
(main icon), on which you can set up and
manage reviews of elements or diagrams,
or a menu (drop-down arrow) providing
these options:
· Review - to display the Collaborate
window at the 'Review' tab, on which
you can join a review and create new
discussion points or responses within
that review, on any element or diagram
· Review History - to display the
Reviews window at the 'History' tab,
showing the elements included in a
selected review; you can switch to the
'Details' tab to show the details of a
selected reviewed element
· All Reviews - to display the Reviews
window, listing all current and recent
reviews of elements
· Help - to display the Formal Review
Elements Help topic

Team Library Click on this icon to open the Team
Library, which you use to review and add
to a hierarchically-structured repository
of comments, reports, reviews and
(c) Sparx Systems 2018
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documents on any structure, feature or
aspect of the project or of other, related
projects.
Mail

The Model Mail facility provides you
with the ability to send, receive and
respond to emails within the project team,
under your User Security ID, either as an
individual user or as a member of a group
that has a shared mail inbox.

Calendar

Displays the Project Calendar, defaulted
to today's date, on which you can check
for scheduled meetings and reminders of
events, and add items for today or any
day in the future.

My Journal

Enterprise Architect provides a great
facility for maintaining a daily journal, in
which you can type all kinds of ideas,
comments, notes, suggestions, events,
to-do lists and other reminders of what
you have done or intend to do within the
model. This is a great way to keep the
momentum flowing day to day. The
facility is simple to use, allowing you to
quickly jot down your thoughts as they
occur to you.

(c) Sparx Systems 2018
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My Kanban

Displays the Kanban diagram that you
have set as your personal default.

My Gantt

Displays a Gantt chart listing the tasks
that have been allocated to you and that
are not yet complete.

(c) Sparx Systems 2018
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Help Panel
The 'Help' panel provides access to the powerful Help
system and to a wide range of on-line facilities to support
your use of the tool, including the management of Licence
Keys. The Help system contains both overviews of
functional areas of the application and detailed topics on
how to use specific tools, helping you to be highly
productive. The Help is normally accessed as an on-line,
web-based system, but you can select to download a
file-based version of the Help to provide a local Help
system. You can also open the Learning Center, which
provides user-focused guidance for common tasks,
especially those specific to your own use of the system that
you have documented yourself.

Available Facilities
Facility

Description

Help

The Help icon displays a menu
containing a wealth of options for
opening and exploring the Help,
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obtaining information from a number of
other sources, and requesting support
from Sparx Systems.
· Open Help System - opens the Help as
a set of pages in HTML format, either
on the web or local to your system,
beginning with the Introduction to
Enterprise Architect topic
· Search Help - opens the 'Find in Files'
search facility, which you use to
specify and search for a text string in
the Help
· Go to Help Topic - opens a specific
Help topic that you identify by name, if
you already know the topic you want to
display
· Open Keyboard Accelerator Map displays the 'Help Keyboard' dialog,
which identifies which keyboard keys
have been mapped to Enterprise
Architect commands; you can
customize these mappings if necessary
· Configure Google Translate - displays
a short dialog in which you specify the
language into which you want to
translate the online Help when you
display a page; the requested page is
passed to the Google Translate site and
displayed in the specified language
(c) Sparx Systems 2018
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(this option does not operate on the
downloaded local Help)
· Explore Online Resources - opens a
submenu of options for accessing
resources on the Sparx Systems web
site:
- Install Help Locally - displays a
prompt to download the 'EA
UserGuide' installer file
(EAUserGuide.msi), which you use to
install the Help files locally
- User Forum and News - opens the
Sparx Systems User Forum,
which you can read as a guest or as
a logged-in user
- Request a Feature - opens the
standard form for submitting a
request for a feature you would
like to see in Enterprise Architect
- Bug Report Page - opens the
standard form for reporting the
details of a bug you have found in
Enterprise Architect (also
prompts you for your registered
user ID and password)
- Automation Interface - opens the
Sparx Systems web page on the
Automation Interface, providing a
number of examples of its use
- Introducing UML - accesses the
(c) Sparx Systems 2018
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Sparx Systems online UML tutorials
- Pricing and Purchase Options displays details on purchasing or
upgrading Enterprise Architect
over the internet
Open the Example Model - opens the
EAExample model within the current
instance of Enterprise Architect
Register and Manage Your License
Key(s) - configure and manage the
license keys used to register Enterprise
Architect and its Add-Ins
Check for Updates - displays the Sparx
Systems web page on the latest build
and its release notes
View the License Agreement - displays
the Enterprise Architect End User
License Agreement
Ordering Information - displays
information on how to purchase
Enterprise Architect
Read Me - displays the Readme.txt file,
which details the changes and
enhancements in Enterprise Architect,
build by build
About EA - displays a window
showing your installation details,
including the program version, your
registration key, your repository
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connection, the Enterprise Architect
edition and your user id
Home Page

Click on this option to open the Home
page of the Sparx Systems web site.

Libraries

Click on the drop-down arrow to display
these commands;
· Learning Center - displays the
Learning Center as a view in the
central workspace area
· Download - download the Learning
Center library from the Sparx Reusable
Asset Service Registry
· Manage - install, enable and disable
Library files

Register

Click on this option to open the 'Licence
Management' dialog and register a new
Enterprise Architect license key.

(c) Sparx Systems 2018
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Design Ribbon
The 'Design' ribbon is used to develop and visualize a model
by creating diagrams, matrices and lists of important aspects
of the system. Requirements and other specifications can be
created and viewed and, regardless of the technology or
language of expression, compelling representations can be
created, viewed and tied together to form either powerful
blueprints of a system to be implemented or documentation
of an existing system.

The Design Ribbon Panels
Panel

Description

Package

The 'Package' panel provides facilities to
create and manage folders (Packages).
New models can be added that typically
contain a number of other Packages.
These Packages form the structure of the
model and can be used to group elements,
diagrams or other Packages. You can
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work on the contents of a Package as a
series of textual descriptions in the
Specification Manager. A Package can
also be viewed as a list of elements that
will include other Packages, or as a Gantt
chart describing the allocation of
resources to the elements in the Package.
Snapshots of Packages - including the
complete model - can be taken and
comparisons made to the current
Package.
Diagram

(c) Sparx Systems 2018

The 'Diagram' panel contains a set of
facilities for creating and managing
diagrams and the elements they contain.
Diagrams are a powerful way of
presenting and visualizing a model's
elements and their connections. Different
types of diagram can be easily
constructed using the Diagram Toolbox,
each page of which provides the elements
and connectors for creating a specific
type of diagram. Any diagram can be
enhanced by a range of overlays that
transform the diagram into an expressive
view such as a Kanban board, a Roadmap
diagram, or swimlanes that allow
elements to be allocated to different
aspects such as responsibility or
ownership. A diagram can also be viewed
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as a list of elements or as a Gantt chart
describing the allocation of resources to
the elements, or as a textual specification.
Element

The 'Element' panel provides facilities to
create, edit and manage the elements that
are the building blocks of models.
Elements can be created and specified
with attributes, operations, Receptions,
Tagged Values, Scenarios, Requirements
and Constraints.

Impact

The 'Impact' panel provides a set of tools
for viewing how elements are related to
each other in the repository. While
diagrams provide one way of visualizing
the relationships, the Traceability
window, the Relationship Matrix and the
Gap Analysis Matrix present the
information in a compelling and often
more appealing format. The matrices
allow visual analysis to be performed and
they can be exported to Spreadsheets if
more detailed analysis is required.
Decision tables can be created for
individual elements.

Tools

The 'Tools' panel provides the powerful
Transformation tools for transforming a
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model from one format or technology to
another.
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Package Panel
The 'Package' panel provides facilities to create and manage
folders (Packages). New models can be added that typically
contain a number of other Packages. These Packages form
the structure of the model and can be used to group
elements, diagrams or other Packages. A Package can also
be viewed as a list of elements that will include other
Packages, or as a Gantt chart describing the allocation of
resources to the elements in the Package.

Available Facilities
Facility

Description
Click on the icon itself to open the Model
Wizard view, which provides Patterns
from a wide range of technologies that
you can use to quickly generate new
models in your project.
Alternatively, click on the drop-down
arrow and select either the option to use
the Model Wizard, or the 'Insert a simple
Package' option to create a new child
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Package under the currently selected
Package. The 'New Package' dialog
displays, on which you specify whether
to create the Package from a Pattern (with
child structures), with a child diagram, or
as a Package only.
Click on the drop-down arrow to select
from a number of facilities that you can
use to manage Packages in the model.
· Properties - maintain the properties of
the current Package, using the
'Properties' dialog
· Manage Baselines - display a short
menu from which you can select to
display the 'Baselines' dialog for the
selected Package, to create and
compare Baselines of the Package with
the current version, or to execute a
report that finds and lists all the
Baselines in the model
· Advanced - display a menu of options
for performing operations on the
selected Package:
- Update Status - provide a bulk
update on the Status, Phase and
Version of the selected Package and its
elements
- Apply Auto Naming - apply
(c) Sparx Systems 2018
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configured auto naming conventions to
existing elements in the selected
Package
- Toggle Level Numbering - toggle
the display of automatically applied
level numbering within the
Specification Manager
and the Project Browser, for
elements within the currently displayed
Package
- Generated Report Options - display
a dialog on which you specify whether
to include the selected Package
in generated reports, or
specifically exclude it from the reports
- Reset DBMS Options - display the
'Manage DBMS Options' dialog to
change the DBMS Type and/or Owner
of one or
more database objects
- Apply Transformation - display the
'Model Transformation' dialog, from
which you select and apply a model
transformation on the elements of
the current Package
Clone Structure as New Version - copy
the structure of the selected Package
and paste it into the Project Browser as
a new Package and contents; a prompt
displays for you to enter a version
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number for the new Package, followed
by a browser on which you select its
parent Package
Show in Relationship Matrix - select to
display the elements of the current
Package in the Relationship Matrix,
using the Package as the Source, the
Target, or both
Validation - display a short menu of
options to create validation rules and
run and cancel a validation of the
current Package
Copy to Clipboard - immediately copy
the selected Package to the clipboard
Paste from Clipboard - paste a Package
held on the clipboard as a child of the
selected Package
Search for Package - display the Find
in Project view, pre-loaded with the
'Find Package' search to locate
Packages of a specific name or type
Browse for Package - display a 'Project
Browser' dialog listing only Packages,
through which you can easily locate
and select a specific Package from
within the model hierarchy
Lock Package - display the 'Lock
Package' dialog for the selected
Package, on which you restrict changes
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to the Package
Click on this icon to display the
Specification Manager, a document-based
interface to a selected Package in the
model, providing the means of creating
and reviewing elements as text
representations of objects in the Project
Browser. When you select this option, the
'Design' ribbon changes to the
'Specification-Specify' ribbon.
Click on this icon to display the selected
Package in the Package Browser window,
in List View mode.
Click on this icon to display the selected
Package in the Package Browser window,
in Gantt View mode.
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Diagram Panel
The 'Diagram' panel contains a set of facilities for creating
and managing diagrams and the elements they contain.
Diagrams are a powerful way of presenting and visualizing
a model's elements and their connections. They can be
enhanced by a range of overlays that transform the diagram
into an expressive view such as a Kanban board, a Roadmap
diagram, or swimlanes, which allow elements to be
allocated to different aspects such as responsibility or
ownership. A diagram can also be viewed in a number of
other formats, such as a list of elements or a Gantt chart
describing the allocation of resources to the elements.

Available Facilities
Facility

Description
Click on this icon to display the Diagram
Toolbox (if it is not already open); the
Diagram Toolbox is a panel of icons
specific to a diagram type that you can
use to create elements and connectors on
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a diagram.
Click on this icon to create a new
diagram under the selected Package or
element. The 'New Diagram' dialog
displays, through which you can create a
new diagram of any type under any
technology supported by Enterprise
Architect, based on a diagram Pattern.
Click on the drop-down arrow to display
a list of options for actions to apply to the
selected diagram.
· Properties - maintain the properties of
the current diagram, using the diagram
'Properties' dialog
· Advanced - provides a short menu of
options for:
- Comparing the current diagram
with a previously-captured Baseline of
the diagram
- Saving the current diagram as a
Profile
- Adding the current diagram to a
Working Set
· Clone as New Version - copy the
currently-selected diagram in the
Project Browser and paste it into the
Project Browser as a new diagram; a
(c) Sparx Systems 2018
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prompt displays for you to enter a
version number for the new diagram,
followed by a browser on which you
select its parent Package
Lock - display the 'Lock Diagram'
dialog for the currently-open diagram,
on which you restrict changes to the
diagram
Swimlanes - divide the currently-open
diagram into logical areas or partitions
using the 'Swimlanes' page of the
'Swimlanes and Matrix' dialog
Kanban - convert the currently open
diagram to Kanban format, using the
'Kanban' dialog
Roadmap - convert the currently open
diagram to a roadmap with a timescale,
using the 'Roadmap options' dialog
Make all Elements Selectable - click on
this option to make all the elements on
the current diagram selectable, so that
they each can be worked on
Configure Z Order - display the
'Modify Z Order' dialog, on which you
set the Z order of each element on the
diagram
Set as My Default - set the current
diagram as your User Default diagram
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Search for Diagram - display the Find
in Project view, pre-loaded with the
'Diagram Details' search to locate
diagrams of a specific name
Browse for Diagram - display the
'Select Classifier' browser, through
which you can locate and open a
diagram in your model
Change Type - change the diagram
type

Click on the drop-down arrow to display
a list of options to display the currently
open and selected diagram:
· In the standard graphical display
format
· As a tabular, editable list of elements
(Diagram List)
· In a Gantt Chart format, showing the
Project Resources assigned to each
element
· With each element represented by a
text description in the Specification
Manager
· Toggle Inline Specification View - for
the graphical display format, select
between displaying and hiding a
Specification view of the diagram
(c) Sparx Systems 2018
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elements in the right half of the
diagram

Notes
If an element is:
· Selectable, you can move it around the diagram and
perform right-click context-menu operations
· Unselectable, you cannot move it around the diagram and
the only right-click operation available is to make the
element selectable
The 'Make all Elements Selectable' option has no effect on
double-click operations on the element, such as displaying
child diagrams.
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Element Panel
The 'Element' panel provides facilities to manage elements,
which are the building blocks of models. Elements can be
created and specified with attributes and operations. You
can also define scenarios for the activities that the element
represents.

Available Facilities
Facility

Description
Click on the drop-down arrow to display
a short list of options for adding elements
to the model:
· Insert New Element into Model define and add a new element to the
currently-selected Package or element
and, if required, the currently open
diagram, using the 'New Element'
dialog
· Insert Multiple New Elements - add a
number of individual elements to the
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currently-open diagram, using the
'Create Multiple Elements' dialog
Insert Related Elements - identify
elements that are related to the
currently selected element and, if they
are not on the currently-open diagram,
add them to it
Insert Existing Elements - add an
existing element to the currently-open
diagram; the option displays the 'Select
Element' browser, which you use to
locate the element to add

Click on the drop-down arrow to display
a list of commands you can use to
identify, research, update and protect the
element you have selected in a diagram
or in the Project Browser.
· Lock - open the 'Lock Element' dialog
through which you can set or clear
editing locks on the selected element
· Clone Element as New Version - copy
the structure of the selected element
and paste it into the Project Browser as
a new element and contents; a prompt
displays for you to enter a version
number for the new element, followed
by a browser on which you select its
parent Package or element
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Edit Linked Document - open the
Linked Document editor for the Linked
Document on the currently-selected
element
Parents and Interfaces - add or delete
Generalization and Realization
relationships to Parent or Interface
Classes, using the 'Set Parents and
Interfaces' dialog
Overrides and Implementations - set
the system to automatically override
methods from parent Classes and from
realized Interfaces, using the 'Override
Operations/Interfaces' dialog
Change Type - change the type of the
selected element, using the 'Select
Element Type' dialog
Find in Diagrams - find the selected
element in every diagram in which it
has been used; if the element is used in
more than one diagram, the 'Element
Usage' dialog displays
Find in Project Browser - highlight in
the Project Browser an element
selected from a diagram
Bookmark - add or remove a
Bookmark on the selected element on
the diagram; the element is marked
with a red triangle
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Find Elements with Linked Documents
- display the Find in Project view,
pre-loaded with an executed search for
elements that have Linked Documents;
right-click on an item and select the
'Edit Linked Document' option to
review the element's document
Find Elements with Linked Documents
modified recently - opens the Find in
Project view preloaded with an
executed search for elements that have
Linked Documents that have updated
within the last seven days (you can
re-execute the search with a different
number of days); right-click on an item
and select the 'Edit Linked Document'
option to review the element's
document
Search Model - display the Find in
Project view, through which you can
search for the use of any aspect of an
element across the model

Click on this icon to display a short menu
of options for editing the element
properties, including Tagged Values and
Linked Documents:
· Properties - define the properties of the
element using the dockable Properties
(c) Sparx Systems 2018
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window
Notes - create and review the notes on
the element, using the Notes window
Linked Document - create or review
the Linked Document on the element,
using the 'Linked Document' tab of the
Document window
Tagged Values - add, edit and delete
Tagged Values on the
currently-selected element, using the
Tagged Values window
Properties Dialog - define the
properties of the selected element using
the element's 'Properties' dialog
Element Browser - show a summary of
the added properties of the selected
element, in the Element Browser

Click on the drop-down arrow to display
a list of options for creating and editing
the features of the selected element on the
Features window, including:
· Attributes - display the 'Attributes' page
to create, manage and delete attributes
· Operations - display the 'Operations'
page to create, manage and delete
operations and their properties
· Receptions - display the 'Receptions'
(c) Sparx Systems 2018
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page to create, manage and delete
Receptions
Parts / Properties - display the 'Parts /
Properties' page to view, create,
manage and delete structural elements
such as Parts and Properties on the
selected element
Interaction Points - display the
'Interaction Points' page to view,
manage, add and remove
edge-mounted elements (such as Ports)
that form the primary interaction points
of complex, composite elements
Connection Points - if the selected
element is a State, this tab helps you
manage Entry and Exit Points
specifically

Click on this icon to display a short menu
of options:
· Overview - a summary list of the
Requirements, Constraints and
Scenarios in the selected element
· Requirements - create, edit and delete
internal requirements of the selected
element, using the 'Requirements' page
of the Responsibilities window
· Scenarios - create, edit and delete
scenarios using the 'Structured
(c) Sparx Systems 2018

Page 86 of 694

User Guide - User Interface

·

·

·

(c) Sparx Systems 2018

21 December, 2018

Specification' tab of the 'Scenarios'
page of the Responsibilities window
Constraints - create, edit and delete
constraints on the selected element,
using the 'Constraints' page of the
Responsibilities window
Find Scenarios - locate and list all
elements that contain structured
scenarios
Help - display the top-level Help topic
on Scenarios
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Impact Panel
A model is a structure of Packages and elements, most of
which have interactions with each other at various levels.
The 'Impact' panel provides a set of facilities for establishing
how the objects interact and - equally important - where
actions and interactions are missing.

Available Facilities
Facility

Description

Traceability

Click on this icon to follow the
connections in a chain of elements,
starting with a single element to establish
the dependencies radiating from that
element, using the Traceability window.

Matrix

Click on this icon to examine how sets of
elements in one Package are linked to
each other, or to elements in another
Package, using the Relationship Matrix.
You can also add and delete relationships
using the Matrix.
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Gap Analysis

Click on this icon to explore the
implementation of features in the model,
and to identify potential gaps between
solution architectures, using the Gap
Analysis Matrix.

Decisions

Click on the drop-down arrow to display
a short menu of options for working with
Decision Tables for the selected element.
· Manage Decisions - create and
configure a simple Decision Model for
the current element, using the Decision
Table Editor
· Find Decisions - locate and list all
elements that contain Decision Tables
· Help - display the top-level Help topic
on Decision Models
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Tools Panel
The 'Tools' panel provides a very significant model
development facility that streamlines the construction or
generation of domain-specific or platform-specific models.

Available Facilities
Facility

Description

Transform

Click on the drop-down arrow to display
options for applying Transformation
Templates in building physical models
from more abstract content.
· Apply Transformation - display the
'Model Transformation' dialog, from
which you select and apply a model
transformation on the elements of the
current Package
· Transform Selection - display the
'Model Transformation' dialog, from
which you define and perform one or
more transformations on the selected
elements, to generate new model
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content
Transform Templates - edit and
configure the templates used to
perform transformations, in the
Transformation Editor view
Help - display the Model
Transformation Help topic
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Layout Ribbon
The 'Layout' ribbon can be used to create sophisticated
views of a model alignment of elements and sections to
create high-quality diagrams. Diagrams are one of the most
powerful and compelling ways of visualizing information.
The appearance of elements in diagrams can be completely
changed by adding border, fill and text colors, creating
meaning and appeal. Diagram Filters and Layout tools can
be used to automatically change the appearance of diagrams,
and Swimlanes and Roadmaps can be configured, adding
rich presentations. A filter can be applied to hide elements
that don't meet a specific condition, and a range of helpers
can assist with element alignment.

Panels
Panel

Description

Diagram

The 'Diagram' Panel provides a collection
of tools for managing the use of diagrams
and for manipulating the appearance and
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presentation of elements in a diagram.
Undo

The 'Undo' panel provides options to roll
back - or undo - the changes in a
diagram's appearance, or to re-establish
undone changes.

Style

The 'Style' panel contains a range of tools
for applying different styles to the
elements in a diagram, to emphasize their
importance or relevance in the context of
the diagram. An element's fonts, fill and
borders can be colored and styled, and the
settings can be individually copied to
other elements or saved as a style that can
be applied to other elements as a group.

Alignment

The 'Alignment' panel provides a series
of tools that can be used to refine the
positions of the diagram's elements
relative to each other. Groups of elements
can be selected and their edges or centers
aligned vertically or horizontally. An
element's position in the visual stack can
be altered by moving them forward or
backwards, and you can display a
convenient grid that can be configured so
that elements and connectors 'snap' into
position on the grid.
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Tools

The 'Tools' panel provides a series of
facilities for laying out, viewing or
filtering the elements in a diagram. These
are powerful tools that assist in working
with large or detailed diagrams. Diagram
Filters can be used to hide elements that
aren't relevant in a certain context. The
Pan and Zoom window helps you change
a diagram's magnification, and to quickly
traverse a large diagram. The Diagram
Layout facility can automatically change
and organize the layout of elements in a
diagram.

Filter

The 'Filter' panel helps in emphasizing
aspects of a diagram, filtering out
elements so that only the relevant or
important elements are clearly visible
whilst the other elements are muted. The
filtering can be based on a variety of
element properties that can be set for
exact matches, presence of text strings or
ranges of dates. The tool is invaluable for
quickly locating and visualizing
particular elements in a diagram.

Helpers

The 'Helpers' panel contains a series of
specialized tools for working with the
elements in a diagram, to save time,
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preserve layouts and enhance
visualization.

Notes
·

·

·

You can also temporarily display an abbreviated toolbar
of formatting options beside an element or connector; for:
- Elements, select one or more elements on the diagram
and click on the 'paintbrush' icon beside
the element (and, for multiple selected elements, the
icon)
- Connectors, right-click on the connector; the toolbar
appears above the context menu
To set the global appearance of all elements throughout a
model, use the 'Preferences' dialog; select the 'Start >
View > Preferences' ribbon option, then select 'Diagram |
Standard Colors' and 'Diagram | Appearance' from the
options tree
To override the global appearance and define a default
appearance for a selected element (or several selected
elements) on all diagrams on which it occurs, right-click
on the element and choose the 'Appearance | Default
Appearance' option
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Diagram Panel
The 'Diagram' panel provides a collection of tools for
managing the use of diagrams and for manipulating the
appearance and presentation of elements in a diagram.

Available Facilities
To activate these facilities, open a diagram in the Diagram
View. Some facilities are available even when a diagram is
not open.
Facility

Description

Save

Click on the icon to save changes to the
current diagram.

Manage

Click on the drop-down arrow to display
a list of options for managing the
diagram's behavior.
· Add to Working Set - add the diagram
to a working set to open when you
open the model
· Compare to Baseline - compare the
current diagram layout with the layout
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captured in a Baseline
Change Type - change the diagram
type
Sequence Communication Messages (in a Communication diagram) change
the sequence of messages
Set as User Default - set the current
diagram to automatically display when
you open the model
Set as Model Default - set the current
diagram to automatically display when
any user opens the model

Click on the drop-down arrow to display
a list of options for configuring the
appearance of the current diagram.
· Standard mode - defaults to selected to
apply the normal rendition of the
diagram; if the current diagram is in
'hand-drawn' or 'white board' mode,
select this option to revert to normal
display
· Hand Drawn - display the current
diagram in 'hand drawn' mode
· White Board - display the current
diagram in 'white board' mode
· Set Visible Relationships - display the
'Set Visible Relations' dialog through
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which you select the relationship
connectors to show or hide on the
current diagram
Show Diagram Property Note - display
the diagram property note on the
current diagram
Theme & Appearance Options - set the
theme and appearance options for all
diagrams that you review, using the
'Diagram > Themes' page of the
'Preferences' dialog
Show Status Colors (All Diagrams) display status colors on the status
compartment or borders of all
status-applied elements on all diagrams
you review; deselect to display the
elements with the default element fill
and shadow colors
Configure Status Colors - set the status
types and colors, using the 'Status' page
of the 'General Types' dialog
Reset Local Element Colors - reset the
fill, line and font colors of all elements
on the selected diagram to the defaults,
so that the rendering can use the
previous color level (such as standard
colors or stereotype colors)
Hide Page Borders (All Diagrams) hide the printable-page border lines on
Page 98 of 694

User Guide - User Interface

21 December, 2018

all diagrams that you review; deselect
the option to redisplay the borders
(overridden by the 'Hide page borders
(current diagram)' setting on the
'Diagram' page of the 'Diagram
Properties' dialog)
Edit
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Click on the drop-down arrow to display
a list of options for selecting, copying and
pasting elements on the current diagram.
· Properties - set the diagram properties
using the 'Diagram Properties' dialog
· Select All Elements - select every
element in the diagram
· Select Elements by Type - specify an
element type and - if appropriate stereotype, and select all elements of
that type in the diagram
· Copy Selected Element(s) - copy all
selected elements to the clipboard
· Clear Current Selection - clear all
selected elements in the diagram
· Make All Elements Selectable - set all
elements in the current diagram to
Selectable, so that you can move them
around the diagram and perform
operations on them (make elements
unselectable by right-clicking on them
and clicking on the 'Unselectable'
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option)
Paste as Reference - paste elements
from the clipboard into the diagram as
links to the original elements (the
elements being copied from a different
diagram)
Paste as New - paste elements from the
clipboard into the diagram as new
elements; the 'Paste Elements as New'
dialog displays, on which you change
the names of the new elements
Paste Image as Element - paste a single
image of the copied element(s) and any
connectors between them from the
clipboard into the current diagram; the
image is enclosed within a System
Boundary, and the element images
cannot be selected or moved within the
boundary
Autosize Selected Elements - returns
the selected element(s) to the default
size for the element type, or to the
minimum size that can show the
element contents; the resizing operates
from the center of the element, so that
you do not have to reorganize the
diagram layout

Click on this icon to divide the
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currently-open diagram into logical areas
or partitions using the 'Swimlanes and
Matrix' page of the 'Diagram Properties'
window (an instance of the dockable
'Properties' window that reflects the
properties of the currently selected
modeling object).
Roadmap

Click on this icon to convert the currently
open diagram to a Roadmap with a
timescale, using the 'Roadmap options'
dialog.

Persistent
Zoom

This option provide a number of zoom
settings that you can apply to your
diagram:
· 75%
· 100%
· 150%
· 200%
When you select a zoom level, it persists
when you close and re-open the diagram.

Notes
The 'Set as User Default' and 'Set as Model Default' options
(c) Sparx Systems 2018
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are available in the Corporate, Unified and Ultimate editions
of Enterprise Architect; User Security must be enabled.
The User Default diagram overrides the Model Default
diagram; the User Default setting is itself overridden by a
project shortcut, which defines displays to present on
opening the project.
To cancel a User Default diagram, either:
· Create a dummy diagram, set it as the User Default and
delete it, or
· Delete the original diagram (if it is no longer relevant)
This still blocks the Model Default diagram, whilst security
is enabled; to re-establish the Model Default diagram, set it
as the User Default.
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Undo Panel
When working with diagrams, it is quite common for a
modeler to make a series of changes and then decide to
revert to a previous state of the diagram, using the Undo tool
to step back through all the unsaved changes that have been
made. If necessary, the changes can be reinstated using the
Redo tool. For practical purposes, there is no limit to how
many consecutive unsaved changes can be undone or
redone.

Available Facilities
Facility

Description

Undo

Click on this icon to reverse the last
unsaved and unreversed change made to
the diagram.

Redo

Click on this icon to re-establish the last
undone and unsaved change made to the
diagram.
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Style Panel
The 'Style' panel provides a range of tools for applying
different styles to the elements and connectors in a diagram,
to emphasize their importance or relevance in the context of
the diagram. An element's fonts, fill and borders, and a
connector's line, can be colored and styled, and the settings
can be individually copied to other elements and connectors,
or grouped and saved as a style that can be applied to other
elements and connectors.

Available Facilities
Facility

Description

Style List

Click on the drop-down arrow on this
field and select an existing style to apply
to the selected object(s) in the diagram.

Save Style

Click on this icon to display a short menu
of options for creating styles.
· Save as New Style - save the style of
the selected object under a new name
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(for example, after changing the
appearance of the object); a dialog
displays in which you type the new
style name, and when you click on the
OK button the style is added to the
'Style List' field
Save Style - save the style of the object
under its existing style name (after
changing the appearance of the object)
Refresh List - change the 'Style List'
field setting back to 'Default Style'
Delete Current Style - delete the style
currently shown in the 'Style List' field;
the field reverts to 'Default Style' but
the objects using that style stay as they
are

Get Style

Click on this icon to copy the style of the
currently selected object, to immediately
apply to other objects.

Apply Style

Click on this icon to apply the style
copied using the 'Get Style' icon to the
currently selected object. You can keep
clicking on new objects and on this icon
to apply the style to several objects. As
long as the style characteristic applies to
the object (such as line width and line
color) you can apply the style to any kind
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of object, although you would usually
apply a style to closely related objects.
Set Font

Click on this icon to set the text font,
style, size and effects for the selected
element(s). (You can also select from a
small range of text colors.)

Text Color

Click on this icon to select from a wide
range of colors in which to display the
text of the selected element(s).

Fill Color

Click on this icon to select from a wide
range of colors to set as the fill color of
the selected element(s).

Line Color

Click on this icon to select from a wide
range of colors to set for the borders of
the selected element(s) or lines of the
selected connector.

Line Width

Click on the 'spinner' arrows to set the
selected element border or connector line
width to a value between 1 (thinnest) and
5 (thickest).
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Alignment Panel
The 'Alignment' panel provides a series of tools that can be
used to refine the positions of the diagram's elements
relative to each other. Groups of elements can be selected
and their edges or centers aligned vertically or horizontally.
An element's position in the visual stack can be altered by
moving them forward or backwards, and you can display a
convenient grid that can be configured so that elements and
connectors 'snap' into position on the grid.

Available Facilities
Most of the options on this panel become available when
you select two or more elements together (press Ctrl or Shift
as you click on the elements). Usually, the last-selected
element is the reference element against which the others
align; this element is indicated by a hatched border.
Facility

Description

Make Same
Height

Click on this icon to make all selected
elements the same height as the reference
element.
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Make Same
Width

Click on this icon to make all selected
elements the same width as the reference
element.

Make Same
Size

Click on this icon to make all selected
elements the same height and width as
the reference element.

Align
Vertically

Click on this icon to align the centers of
all selected elements vertically with the
center of the reference element.

Align
Horizontally

Click on this icon to align the centers of
all selected elements horizontally with
the center of the reference element.

Bring to Top

Move the selected elements to the top of
the diagram relative to other elements
(the top of the Z-Order).

Send to Back

Move the selected elements to the back of
the diagram relative to other elements
(the bottom of the Z-Order).

Align Left

Click on this icon to align the left edges
of all selected elements vertically with
the left edge of the reference element.
Shortcut: Ctrl+Alt+Left Arrow
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Align Right

Click on this icon to align the right edges
of all selected elements vertically with
the right edge of the reference element.
Shortcut: Ctrl+Alt+Right Arrow

Align Tops

Click on this icon to align the top edges
of all selected elements horizontally with
the top edge of the reference element.
Shortcut: Ctrl+Alt+Up Arrow

Align
Bottoms

Click on this icon to align the bottom
edges of all selected elements
horizontally with the bottom edge of the
reference element.
Shortcut: Ctrl+Alt+Down Arrow

Space
Horizontally

Click on this icon to evenly separate the
selected elements by the same amount
horizontally.

Space
Vertically

Click on this icon to evenly separate the
selected elements by the same amount
vertically.

Snap to Grid

Click on this icon to display a short menu
of options for applying a grid to help you
position elements on each diagram you
review. If all of the options are

(c) Sparx Systems 2018

Page 110 of 694

User Guide - User Interface

21 December, 2018

deselected, you can move and resize
elements freely.
· Standard Grid - make elements 'snap' to
the nearest grid point when you move
or resizing them
· Smart Placement - place elements even
distances away from other elements
and space elements evenly; for
Sequence diagrams, this helps position
Notes on Messages
· Show Grid - display the grid on the
diagram as pale gray dots against the
diagram background
· Show smart placement guides - display
instant lines on the diagram to indicate
where critical points (top, bottom,
sides, center of sides) on the element
being moved or resized lie in relation
to the original position of the element
or to another element or connector way
point
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Tools Panel
The 'Tools' panel provides a suite of facilities for aligning,
viewing or filtering the elements in a diagram. These are
powerful tools that assist in working with large or detailed
diagrams. Diagram Filters can be used to obscure elements
that aren't relevant in a certain context. The Pan and Zoom
window helps you change a diagram's magnification, and to
quickly traverse a large diagram. The Diagram Layout
facility can automatically change and organize the layout of
elements in a diagram.

Available Facilities
Facility

Description

Diagram
Filters

Click on this icon to display the 'Diagram
Filters' dialog, which you use to create
and apply filters for selectively muting
parts of the diagram that are not relevant
to an aspect you are investigating.

Pan and

Click on this icon to display the Pan &
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Zoom

Zoom window, which helps you to scan
across large diagrams and 'dive into' areas
of interest.

Diagram
Layout

Click on this icon to display a menu of
options that you can use to select,
configure and apply a wide range of
diagram layouts to the current diagram.
These options include:
· Apply Default Layout - automatically
apply the default standard Digraph
layout to the current diagram
· Open Diagram Layout Tools - display
the 'Layout Tools' dialog, through
which you can select, configure and
apply one of the predefined diagram
layouts to the current diagram
· <diagram layouts> - the eleven
predefined diagram layouts, each
option automatically applies the current
settings for that layout from the 'Layout
Tools' dialog to the current diagram;
note that the 'Digraph' option applies
any settings you have adjusted,
whereas the 'Apply Default Layout'
option ignores such adjustments
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Filter Panel
The 'Filter' panel helps in emphasizing aspects of the
currently-open diagram, quickly filtering out elements
outside a context so that only the relevant or important
elements are clearly visible whilst the other elements are
muted. The context can be derived from a variety of element
properties (as defined in the Properties window), some of
which can be set to an exact match, the presence of text
strings or a date range. The tool is invaluable for quickly
locating and visualizing particular elements in a diagram.

Fields
The three fields are unlabelled and are referred to by their
position on the panel.
Field

Description

Top Left

This field identifies the type of filter to
apply. It defaults to the value 'Filtering
Off'. Click on the drop-down arrow and
select the filter type.
To expose the full list of filter types,
either use the vertical scroll bar or drag
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the 'dotted line' bar down as far as is
necessary. The filter types include:
· Relationships - filters for elements that
are the source or target of the same
type of connector as the selected
element
· Hierarchy - filters for elements on the
diagram in the same hierarchy as the
selected element, both above and below
that element in the hierarchy
· Name / Alias - filters for elements
having the specified text string in the
'Name' or 'Alias' fields
· Alias - filters for or against elements
having the specified text string in the
'Alias' field
· Author - filters for or against elements
created by the specified author(s) (as
shown in the 'Author' field)
· DateCreated - filters for or against
elements created before, on or after the
specified 'Created' date
· DateModified - filters for or against
elements modified before, on or after
the specified 'Modified' date
· Difficulty - filters for or against
Requirement-type elements (Change,
Feature, Issue) of the specified
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difficulty (see the element's 'Properties'
dialog 'General > Main' page)
GenType - filters for or against
elements of the specified code
generation language (such as Java)
specified in the 'Language' field
Filename - filters for or against
elements having the specified code
generation file path and name in the
'Filename' field
Keywords - filters for or against
elements having the specified text in
the 'Keywords' field
Name - filters for or against elements
having the specified text string in the
'Name' field
Notes - filters for or against elements
having the specified text string in the
'Notes' field (see the element's
'Properties' dialog, 'General' page)
ObjectType - filters for or against
elements having the specified object
type as defined in the 'Type' field
Phase - filters for or against elements
having the specified phase as defined in
the 'Phase' field
Version - filters for or against elements
having the specified object type as
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defined in the 'Version' field
Priority - filters for or against
Requirement-type elements (Change,
Feature, Issue) of the specified priority
(see the element's 'Properties' dialog
'General > Main' page)
RequirementType - filters for or
against Requirement-type elements
(Change, Feature, Issue) of the
specified type (see the element's
'Properties' dialog 'General > Main'
page)
Scope - filters for or against elements
having the specified scope value, as
defined in the 'Scope' field ('Details'
page of the 'Properties' dialog,
'Advanced' section of the Properties
window)
Status - filters for or against elements
having the specified status, as defined
in the 'Status' field
Stereotype - filters for or against
elements having the specified
stereotype as defined in the 'Stereotype'
field
Selectable - filters for or against
elements that have been flagged as
selectable, using the element context
menu
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Printable - filters for or against
elements that have been flagged as
printable, using the element context
menu
For some filter types, one or both of the
remaining two fields might not be
required and they will be grayed out.
·

Top Right

This field defines the operator to apply to
any property or value you define; that is,
whether the element property or text
contains, is equal to, or is not equal to the
defined value, or is within a specified
range of values.
Click on the drop-down arrow and select
the appropriate operator.

Bottom

Type the value or range of values to be
matched against the element property or
text.
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Helpers Panel
The 'Helpers' panel contains a series of specialized tools for
working with the elements in a diagram. These perform
useful function that will save time, preserve layouts and
enhance visualization. The 'Sweeper' and 'HV Lock' tools
move multiple elements vertically, horizontally or
diagonally in the diagram. The 'Presentation' tool can be
used to show which element is in focus during a workshop
or meeting. The 'Show Direction' tool indicates the direction
of relationships connected to the selected element.

Available Facilities
To apply each of these tools to your diagram, click on the
checkbox against the tool name. The options remain
selected across diagrams and work sessions until explicitly
turned off again.
Facility

Description

Sweeper

When the Sweeper is on, you can move
sections of the diagram in one direction
vertically, horizontally or diagonally.
Click on the diagram and move the
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cursor; the section of diagram ahead of
the cursor in its direction of movement is
moved in the same direction.
HV Lock

When the HV Lock is on, when you click
on an element and start to move it
horizontally or vertically, the movement
becomes restricted to that direction. So if
you start to move the element vertically,
you cannot move it horizontally until you
release the mouse button and start another
movement. The lock prevents any
diagonal movement.

Presentation

When the 'Presentation' option is
selected, the borders of selected elements
are a simple solid colored line. There are
no diagram icons (such as the Quick
Linker arrow), movement handles or
hatching. You cannot select and work on
connectors.
Whilst you can still move and resize the
element(s), you might use this option
when you are examining element content
rather than element placement on the
diagram, or using the diagram for display
rather than change.

Show

When this option is selected, the physical
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direction of connectors on the selected
element are indicated by color: incoming
relationships are red, and outgoing
relationships are green. If the element is
not selected, the connectors are not color
coded.

Perpendicular When this option is selected, connectors
Lines
are forced to adopt a vertical or horizontal
position when they are adjusted.
Connectors that are not adjusted when
this option is selected will remain at
whatever angle they present.
Not all types of connector are affected by
this setting.
Reorder
Messages
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This option enables and disables the
ability to swap the order of messages on a
Sequence diagram. When this option is
enabled, if you drag a message up or
down a lifeline beyond the position of the
next or previous message, the messages
swap positions. If this option is disabled,
then dragging a message will only extend
or reduce the spacing between the
message being dragged and its preceding
message.
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Specialize Ribbon
The 'Specialize' ribbon provides facilities to enable and
access Add-Ins (extensions written in COM) and MDG
Technologies that interact with the Enterprise Architect user
interface to extend and specialize the product's capabilities.
When an Add-In is added to Enterprise Architect, either by
inclusion with the installer or by subsequently importing
into Enterprise Architect, it can be assigned to the particular
area of functionality that it supports (using the
EA_GetRibbonCategory function), and is represented by an
icon in an 'Add-In' panel in the appropriate ribbon. Icons for
unassigned Add-Ins are shown on this 'Specialize' ribbon, in
the 'Add-Ins' panel.
The contents of this ribbon therefore depend on what
Add-Ins and Technologies you have installed and enabled,
and whether they have been assigned to a particular
functional area of Enterprise Architect.

Panels
Panel

Description

Tools

The 'Tools' panel provides a collection of
facilities to create and run automation
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scripts, to design and create data models
or import existing database schemas into
your model and for accessing external
data sources.
Technologies

This panel provides the icons for
managing and publishing MDG
Technologies in Enterprise Architect, and
also an icon for each enabled MDG
Technology available in your installation
of Enterprise Architect.
Click on the 'Manage' icon to open the
'MDG Technologies' dialog. This dialog
helps you to add and configure paths to
additional technology files and to activate
or deactivate the built-in technologies.
Click on the 'Publish' icon to access
options for working with MDG
Technologies in general
Each Technology icon displays a
drop-down list of options for working
with the Technology.

Add-Ins

This panel provides two icons for
enabling and configuring Add-Ins:
· Manage - display the 'Manage Add-Ins'
dialog, which you use to enable or
disable Add-Ins for use; an Add-In that
is disabled is not loaded when you start
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up Enterprise Architect, and no icon
appears for it in the ribbons
· Windows - display the Add-In window
containing any window that has been
defined to display in this space, for the
currently active Add-In
If your system includes unassigned
Add-Ins, an icon for each one is included
in this panel.
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Tools Panel
The 'Tools' panel provides facilities for working with
various kinds of schemas. The powerful Database Builder is
accessed from this panel, as well as facilities for importing
existing database schemas from a wide range of supported
database products, generating DDL scripts from your
database model, and managing and editing the templates
used in generating those DDL scripts.
Also accessed from this panel is the model Scripting
window, which provides the means to manage, create and
edit automation scripts to work with your model.

Available Facilities
Facility

Description

Database
Builder

Click on this icon to add, edit and
manage database models for a wide range
of DBMS products, using the Database
Builder view.

Schema
Composer

Click on the drop-down arrow to display
options for creating and managing
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custom profiles for the generation of
industry-specific XSD files.
· Open Schema Composer - display the
Schema Composer view, which you
use to create Schema profiles and
generate XSD files from them
· Import for Schema Composer - import
a Schema Composer profile from an
external file, using the 'Schema
Importer' dialog
· Find Schema Composer Profiles execute a standard search to locate all
Schema Composer profiles in the
project
· Help - display the The Schema
Composer Help topic
Scripting

Click on this icon to display the Scripting
window, through which you can add, edit
and manage model based scripts in
JavaScript, JScript and VB.Net.

Integration

This icon opens the External Data facility
for defining how the data from external
sources is represented in Enterprise
Architect.
When developing a model in Enterprise
Architect you could connect to an
external application such as TFS or JIRA
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as the data source. You would then
indicate how data items in one
application are reflected in the other.
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Technologies Panel
The 'Technologies' panel provides the icons for managing
and publishing MDG Technologies in Enterprise Architect,
and also an icon for each enabled MDG Technology
available in your installation of Enterprise Architect. This
topic identifies some of the Technologies that might be
represented here. Each Technology icon displays a
drop-down list of options for working with the Technology.
These options might include:
· Help - open the Help file for the Technology
· About - display a short panel of information on your
installation of the Add-In
· Connect to External Model - connect to a project created
in another application, to which the Technology provides
a bridge
· Import <data> - import data defined in the Technology
into Enterprise Architect
· Export <data> - export data from Enterprise Architect to
data structures specific to the Technology

Available Facilities
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Facility

Description

Manage

Click on the 'Manage' icon to open the
'MDG Technologies' dialog. This dialog
helps you to add and configure paths to
additional technology files and to activate
or deactivate the built-in technologies.

Publish

Click on the 'Publish' icon to access these
options for working with MDG
Technologies in general:
· Publish Diagram as Pattern - create a
Pattern file from the currently-open
diagram, using the 'Save Diagram as
Pattern' dialog
· Publish Diagram as UML Profile create and export a Profile file based on
the currently-open diagram, using the
'Save UML Profile' dialog
· Publish Package as UML Profile create and export a Profile file based on
the current Package, using the 'Save
UML Profile' dialog
· Generate MDG Technology - open the
MDG Technology Creation Wizard to
guide you through the process of
creating and integrating the structures
and resources appropriate to an MDG
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Technology of your own design
Import MDG Technology - import an
MDG Technology into the model either
for your own use or for all users of the
model; the 'Import MDG Technology'
dialog displays
Import UML Profile - import a UML
Profile file

ArcGIS

Provides access to facilities that help you
create ArcGIS models; the ArcGIS
system supports the development and
management of geodatabases.

ArchiMate2

Provides access to the facilities of the
MDG Technology for ArchiMate 2, one
of the business modeling tools integrated
with Enterprise Architect. It offers a
common language for describing the
construction and operation of business
processes, which you can use to describe,
analyze and visualize clearly the
relationships between business domains.

ODM

Provides access to the facilities of the
MDG Technology for the Ontology
Definition Metamodel (ODM), the
implementation of the Object
Management Group's ODM for
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Enterprise Architect. It provides ontology
modeling capabilities within Enterprise
Architect, enabling you to develop
large-scale ontologies within the
fully-integrated modeling environment,
for your project domain.
GML

Provides access to the facilities of the
MDG Technology for Geography
Markup Language (GML) application
schemas, which integrates the Open
Geospatial Consortium's GML 3.3 with
Enterprise Architect, providing an XML
grammar for geographical feature
modeling capabilities.

NIEM 2.1

Provides access to the facilities of the
MDG Technology for National
Information Exchange Model (NIEM)
release 2.1, which provides a common
framework that is used to define how
information can be shared between
systems, government agencies and
organizations.

NIEM

Provides access to the facilities of the
MDG Technology for National
Information Exchange Model (NIEM),
releases greater than 2.1.
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Eclipse

The MDG Link™ for Eclipse is designed
to support simultaneous UML
development in both Enterprise Architect
and Eclipse, adding extra functionality to
the code generation abilities of Enterprise
Architect and merging the changes with
minimal effort. Click on the icon to
display a short menu of options for using
the Add-In.
· View Project Connections - display the
'Eclipse Connections' dialog, to review
the connections between Enterprise
Architect Packages and Eclipse
Projects
· Options - display the 'Options' dialog
on which you set up the Eclipse
installation path for Enterprise
Architect to use to access Eclipse
· Help - open the integrated Help for the
MDG Link for Eclipse
· About - display a panel of information
on your installation of the MDG Link
for Eclipse

Visual Studio

The MDG Link™ for Visual Studio.NET
is designed to support simultaneous UML
development in both Enterprise Architect
and Visual Studio, adding extra
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functionality to the code generation
abilities of Enterprise Architect and
merging the changes with minimal effort.
Click on the icon to display a short menu
of options for using the Add-In.
· View Project Connections - display the
'Visual Studio Connections' dialog, to
review the connections between
Enterprise Architect Packages and
Visual Studio Projects
· MDG Options - display the 'MDG Link
Options' dialog to set or cancel
Enterprise Architect as the tool for
editing source code, and to
automatically check for changes on
merge (or not)
· Import Build Scripts - import build
scripts into Enterprise Architect from
Visual Studio
· Export Linked Package List - export a
linked-Package list from Enterprise
Architect into Visual Studio
· Import Linked Package List - import a
linked-Package list into Enterprise
Architect from Visual Studio
· Help - open the integrated Help for the
MDG Link for Visual Studio
· About - display a panel of information
on your installation of the MDG Link
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for Visual Studio
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Add-Ins Panel
This panel provides the facilities for enabling Add-Ins and
displaying any windows that they define. The panel also
provides icons to access unassigned Add-Ins.

Available Facilities
Facility

Description

Manage

Displays the 'Manage Add-Ins' dialog,
which you use to enable or disable
Add-Ins for use; an Add-In that is
disabled is not loaded when you start up
Enterprise Architect, and no icon appears
for it in the ribbons.

Windows

Displays the Add-In window, which
contains any window that has been
defined to display in this space, for the
currently active Add-In.

<unassigned
Add-Ins>

An Add-In that is not assigned to an
'Add-Ins' panel in a specific ribbon will
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have an icon in this 'Specialize > Add-Ins'
ribbon panel, as illustrated by the
'Zachman Framework' icon in the
example at the top of this topic.
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Publish Ribbon
The 'Publish' ribbon brings together all the tools for
publishing, documenting and importing and exporting
valuable model assets in a wide range of formats and styles,
ranging from publications for corporate audiences to
spreadsheets, XML schemas, Patterns, Reusable Assets and
much more. The model is the repository of valuable
organizational information and knowledge, and people who
don't access the model directly can still get access to this
knowledge through this panel of tools.
The publishing system provides a great deal of flexibility,
and outputs and inputs can be tailored to exactly what an
audience requires. This includes the flexible Documentation
engine, with its in-built and user defined templates and
styles that can produce high quality corporate publications
directly from the model. Elements and diagrams can be
imported and exported, including exchanging information
with spreadsheet tools and saving to reusable Patterns and
assets.

Panels
Panel
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Report

The 'Report' panel groups together a set
of tools used to extract information from
the model in a variety of useful formats,
including docx, pdf and HTML.

Diagram

The 'Diagram' panel provides facilities to
generate both hard and electronic copies
of diagrams from the model, and to scale
images of the diagrams when they are
generated

Tools

The 'Tools' panel provides options to
create customized document templates, to
check the spelling in the current Package
or the whole model, and to create and edit
entries in the Project Glossary.

Model
Exchange

The 'Model Exchange' panel contains
tools for controlling Packages and
importing and exporting parts of the
model in the XML based model exchange
format XMI, and to formats that can be
opened in a spreadsheet. The Reusable
Asset Server (RAS) is a valuable resource
for either sourcing existing model
fragments or saving parts of the current
model for reuse on future initiatives.

Technologies

The two facilities available through the
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'Technologies' panel enable you to
generate files from the Enterprise
Architect model in a format that can be
used specifically in one of a range of
supported technologies, and to import
files from the same range of technologies
and convert them for use in Enterprise
Architect.
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Report Panel
The 'Report' panel provides a set of tools for extracting
information from the model for output in a variety of useful
formats, including DOCX, PDF and HTML.

Available Facilities
Facility

Description

Documentati
on

Click on this icon to access a short menu
of documentation options:
· Generate Rich Text Documentation generate a document from the content
of the model; generate rtf, pdf or docx
format, from built-in or customized
templates
· Open a Document File - open an
existing document file in RTF or
DOCX format, for manual editing
· Create a Document File - create a new
document for manual editing and
export it in RTF or DOCX format
· Run Diagram Report - generate a
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'Diagram Only' report on the current
Package - the 'Export Diagrams to RTF
Document' dialog displays, on which
you specify the file location, diagram
file format and certain other
parameters, to capture images of all
diagrams in the current Package
HTML
Report
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Click on this icon to select from two
options for publishing documents on the
web:
· Standard HTML Report - publish a
document to an internal or internet
website as static web pages, in standard
HTML
· Publish to Joomla! - generate an
HTML document to a Joomla!
database, for internet distribution
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Diagram Panel
The 'Diagram' panel provides facilities to generate both hard
and electronic copies of the currently-open and selected
diagram from the model.

Available Facilities
Facility

Description

Print

Click on this icon to display a short menu
of options for printing the diagram:
· Print - print the diagram directly on the
default printer
· Preview - display an image of how the
diagram will appear if it is printed
· Setup - display the 'Print Setup' dialog
to configure the default printer on
which the diagram will be printed,
which you would have selected on the
Windows 'Control' panel
· Print to PDF - print the diagram to a
PDF file instead of to a printer - a
browser displays to select the PDF file
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name and directory path; by
de-selecting the 'Printable' option on an
element on a diagram, you can omit
that element and its connectors from
the diagram in the PDF output
Image

Click on this icon to save an image of the
current diagram. A small menu displays
from which you can select to:
· Save to File - a browser displays in
which you select where to save the file,
and the format in which to save the file
· Save to Clipboard - the image is
immediately saved to the Enterprise
Architect clipboard
· Scale Image To - a list displays of
percentage scale options to apply to the
diagram images saved to file in bitmap
format, with a tick beside the current
setting (likely to be the default of
133%); this list and the 'Scale Saved
Bitmaps to' field on the 'Diagram' page
of the 'Preferences' dialog are parallel
and changes to one are automatically
reflected in the other
Images saved in any format other than
bitmap are not scaled
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On the 'Diagram' page of the
'Preferences' dialog, selecting the
'Apply scale to clipboard' checkbox
also applies the selected scale to bitmap
images saved to the clipboard
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Tools Panel
The 'Tools' panel provides options to create customized
document templates, to check the spelling in the current
Package or the whole model, and to create and edit entries in
the Project Glossary.

Available Facilities
Facility

Description

Document
Templates

Click on this icon to manage, create and
modify the templates used in generating
documents in RTF, PDF or DOCX
format.

Glossary

Click on this icon to display options for
viewing and editing the terms defined in
the Project Glossary:
· Glossary View - display the Glossary
window, listing all terms defined in the
Project Glossary
· Edit - display the 'Glossary' dialog,
which provides options to add, edit,
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and delete glossary terms and modify
the display of terms
Spelling
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Click on this icon to access the project
Spell Checking facilities. A short menu
displays from which you can select to:
· Spell Check Project - the 'Spell Check'
dialog displays, on which you specify
what model components to check
· Spell Check Current Package - the
'Spell Check' dialog again displays, but
in this context you do not have to set
any parameters
· Spelling Options - configure the spell
checker using the 'Spelling Options'
dialog
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Model Exchange Panel
The 'Model Exchange' Panel contains tools for controlling
Packages and for importing and exporting parts of the model
both in the XML based model exchange format XMI, and in
other formats that can be opened in a spreadsheet. The
Reusable Asset Server (RAS) is a valuable resource for
either sourcing existing model fragments or saving parts of
the current model for reuse on future initiatives.

Available Facilities
Facility

Description

Reusable
Assets

Click on this icon to open the Reusable
Asset Service (RSA) view in the central
work area. The RSA provides a simple
and convenient mechanism for modelers
to distribute or download reusable model
structures, information, corporate
directives and standards. The shared
repository is accessible via a Cloud
Service connection, making it accessible
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for distributed teams.
Publish As...

Click on this icon to publish a Package at
any level in the model as an external file
in one of several XML formats, including
XMI 1.1, XMI 2.1, ArcGIS and BPMN
2.0 XML. The 'Publish Model Package'
dialog displays.

CSV

Click on this icon to access the CSV
Import and Export facilities, and to create
and maintain the CSV specifications that
define how the imports and exports
proceed. You can also display the
summary Help topic for CSV transfers.

Package
Control

Click on this icon to display a menu of
options for storing and managing
Packages by creating XMI files from
them (Package Control), supporting
lightweight version management and
model exchange.
· Configure - set up Package Control
using the 'Package Control Options'
dialog
· Save to File - save the Package to its
configured XML file (from the
Package Control option), using the
'Export Package to XML' dialog
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Load from File - replace the Package
from its saved XMI file, using the
'Import Package from XML' dialog
View XMI File for Controlled Package
- review the content of the (exported)
XMI file for the Package, in the Code
Editor
Compare Package to XMI - compare
the current version of the Package with
the exported XMI file for the Package
(the 'Compare Model to File' option in
Managing Baselines)

Export XMI

Click on this icon to display options for
exporting the current Package to an XMI
file for use in other models and/or
different modeling tools.
· Export XMI for Current Package export the Package to a file in one of
several XMI formats, using the 'Export
Package to XMI' dialog
· Batch Export Controlled Packages export a number of controlled Packages
to XMI in a batch process, using the
'Batch XMI Export' dialog

Import XMI

Click on this icon to display options for
importing an XMI file to update one or
more Packages in the model.
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Import Model XMI - import a Package
from an XMI file in one of several
XMI formats, using the 'Import
Package from XMI' dialog
Merge Model XMI into Current
Package - import an XMI file for the
Package and merge the content of the
file with the Package; you might do
this with a sequence of XMI files for
the Package, such as when a number of
people are working on the same
Package offline and storing their work
in separate XMI files
Batch Import Controlled Packages import model Packages from an import
set for controlled Packages, using the
'Batch XMI Import' dialog
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Technologies Panel
The two facilities available through the 'Technologies' panel
enable you to generate files from the Enterprise Architect
model in a format that can be used specifically in one of a
range of supported technologies, and to import files from the
same range of technologies and convert them for use in
Enterprise Architect.

Available Facilities
Facility

Description

Publish

Display a menu of options for Publishing
(exporting) Enterprise Architect model
information in a specific format for
consumption by other tools or processes.
A wide range of output formats is
supported, and you can further tailor the
output by including or excluding diagram
information, Enterprise Architect specific
extensions and so on. You would tailor
your published file for the capabilities of
the tool or process expected to consume
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it.
The 'Normative XMI 2.4.2' option
provides a quick means of exporting
model information in the latest
UML/XMI combination with no
Enterprise Architect extension
information or diagram information. This
format is most useful for standards
development and for base interoperability
with other UML based tools.
Note that you should not use this menu to
Publish model information for
consumption by other users of Enterprise
Architect. For that purpose, use the
options in the 'Model Exchange' panel.
Import
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Display a menu of options for importing
XMI/XML from a variety of formats.
ArcGIS, EMX, Rhapsody, OWL/RDF,
BPMN 2.0, DMN 1.1 and MDZIP are
specifically supported, but a wide range
of other tools' XML output can be
imported into Enterprise Architect using
the 'Other Tools/Formats' menu option.
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Construct Ribbon
The 'Construct' ribbon presents the tools and facilities for
visualizing and managing the tasks and the resources needed
to construct a system, from the allocation of human
resources to tasks, to the powerful Kanban boards and Gantt
chart for visualizing the progress of work done. Teams can
collaborate directly in the tool and manage a wide range of
variations to model elements - including Issues and Defects
- and tests can be defined and results recorded.

Panels
Panel
Task
Management
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Description
The 'Task Management' panel is a
collection of tools for managing human
resources and their allocation to elements
that represent tasks to be completed.
Kanban diagrams can be used to visualize
boards of elements and a Gantt chart
shows the duration of assigned tasks and
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other important views. The Resource
Allocation window is used to assign
resources to elements representing work
to be done. There are several searches
that list a variety of useful views, such as
Overdue Tasks, Tasks Starting Today,
and more.
Testing

The 'Testing' panel is used for creating
and managing all aspects of testing. The
Testing window conveniently collects all
the tests for an element, and allows new
tests to be created and existing ones to be
managed. The tests can be fully described
and Inputs, Acceptance Criteria, Results,
Status and more can be defined for each
test. There are several predefined
searches that can be run to find recent test
results, such as the recent test that have
passed. A configurable Test Report can
also be generated, creating a single
document that describes all tests or any
combination of tests.

Change
Management

The 'Change Management' panel is used
for describing important items that apply
to an element. Enterprise Architect is a
powerful platform for managing any
initiative and can keep track of variations
in the life time of any element.
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Regardless of the methods or processes
that are being used elements such as
Requirements, User Stories, Business
Rules, Components and others will
change, have issues, require tasks, have
defects and events and decisions will be
made about them. All of these variations
can be created and managed and a series
of useful searches are conveniently made
available to find items such as recently
requested changes, incomplete tasks and
many more.
Status
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The 'Status' panel provides facilities for
obtaining an overview of the project
status, including Quality Assurance
reports, Task and Issue reports, and
project Use Case Metrics.
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Task Management Panel
The 'Task Management' panel is a collection of tools for
managing human resources and their allocation to elements
that represent tasks to be completed. Kanban diagrams can
be used to visualize boards of elements, and a Gantt chart
shows the duration of assigned tasks and other important
views. The Allocation window is used to assign resources to
elements representing work to be done. There are several
searches that list a variety of useful views, such as Overdue
Tasks, Tasks Starting Today, and more.

Available Facilities
Facility

Description

Kanban

Click on the drop-down arrow to display
a list of options for using Kanban
diagrams to effectively manage tasks and
work assignments necessary to construct
the model and its deployable artifacts.
· Find Kanban Diagrams - open the 'Find
in Project' tab containing an executed
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search for finding Kanban diagrams in
the model; double-click on an entry to
open that Kanban diagram
Open Project Kanban - if a Kanban
diagram has been set up with the work
assignments and tasks for the overall
project, open that diagram
Open My Kanban - if a Kanban
diagram has been set up with your
work assignments and tasks, open that
diagram
New Standard Kanban - create a new
standard Kanban diagram to contain
active work assignments and tasks,
which you can customize as required
New Backlog Kanban - create a new
Kanban diagram to contain work
assignments and tasks that have not yet
been allocated to a resource
New Iteration Kanban - create a new
Kanban diagram to contain active work
assignments and tasks associated with
the current iteration or sprint
New Complete Kanban - create a new
Kanban diagram to contain work
assignments and tasks that have been
completed and are processing through
to deployment and maintenance
One Stage Workflow - create a
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single-stage Kanban workflow diagram
from a Pattern
Two Stage Workflow - create a
two-stage Kanban workflow diagram
from a Pattern, including a Backlog
Kanban and an Iteration Kanban
Three Stage Workflow - create a
three-stage Kanban workflow diagram
from a Pattern, including a Backlog
Kanban, an Iteration Kanban and a
Complete Kanban

Resources

Click on this icon to display the Resource
Allocation window to assign resources to
Task, Issue, Change and other
project-level elements.

Gantt

Click on this icon to display the Project
Gantt View, to review the breakdown of
work for the project and for specific
sections of the project. The display
defaults to the 'Resource View' tab, but
you can also select the 'Element View'
and 'Report View' tabs.

Active Tasks

Click on this icon to display a short menu
of options for searching for and charting
tasks within the model.
· Active Tasks - open the Find in Project
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view and execute a pre-loaded search
for Active tasks; click on an item to
display the resource allocation details
in the 'Assigned Resources' dialog
Chart of Active Tasks - create a chart
within the selected open diagram
showing the currently active tasks
Tasks Ending Today - open the Find in
Project view and execute a pre-loaded
search for tasks scheduled to complete
today
Tasks Starting Today - open the Find in
Project view and execute a pre-loaded
search for tasks scheduled to begin
today
Overdue Tasks - open the Find in
Project view and execute a pre-loaded
search for tasks that are now overdue
Chart of Overdue Tasks - create a chart
within the selected open diagram
showing the currently overdue tasks

Click on this icon to display a short menu
of options for searching for and charting
completed tasks within the model.
· Recently Completed - open the Find in
Project view and execute a pre-loaded
search for recently-completed tasks;
click on an item to display the resource
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allocation details in the 'Assigned
Resources' dialog
Chart of Completed Topics - create a
chart within the currently-active
diagram showing the
recently-completed tasks
Chart for Time Period - create a chart
within the currently-active diagram
showing the tasks completed during a
defined period
All Completed - open the Find in
Project view and execute a pre-loaded
search for all tasks completed within
the lifetime of the project

Click on this icon to display a menu of
options for searching for and charting the
deployment of resources over various
periods of time.
· 30 Day Task Summary (Brief) provide a brief summary of the tasks
performed by resources over the
previous month
· 30 Day Task Summary (Full) - provide
a full summary of the tasks performed
by resources over the previous month
· 30 Day Resources - search the project
for tasks that have started in the last 30
days where the resource name matches
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(fully or partially) the text in the
<Search Term>
30 Day Roles - search the project for
tasks that have started in the last 30
days where the role name matches
(fully or partially) the text in the
<Search Term>
30 days grouped by resource (Chart) create a chart within the
currently-active diagram showing the
tasks started during the last month,
grouped by resource
30 Day Task Summary (Chart) - create
a chart within the currently-active
diagram showing the tasks started
during the last month
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Testing Panel
The 'Testing' panel is used for creating and managing all
aspects of testing. The Testing window conveniently
collects all the tests for an element, and allows new tests to
be created and existing ones to be managed. The tests can be
fully described and Inputs, Acceptance Criteria, Results,
Status and more can be defined for each test. There are
several predefined searches that can be run to find recent
test results, such as the recent tests that have passed. A
configurable Test Report can also be generated, creating a
single document that describes all tests or any combination
of tests.

Available Facilities
Facility

Description

Tests

Click on this icon to display a menu of
types of Test that you can define for the
current element, using the Testing
window.
· All - display the Testing window with
no test type defined in the 'Class Type'
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field; you might select this option if
you are developing a test but not yet
certain of what type it should be, or if
you are creating a suite of tests of
different types
Inspection - display the Testing
window set to work on Inspection tests
Unit - display the Testing window set
to work on Unit tests
Integration - display the Testing
window set to work on Integration tests
System - display the Testing window
set to work on System tests
Acceptance - display the Testing
window set to work on Acceptance
tests
Scenario - display the Testing window
set to work on Scenario tests

Click on this icon to display a list of
options for generating reports on
recently-performed tests, and to represent
the results of those tests in various forms
of chart.
· Tests on Recently Modified Elements open the Find in Project view and
execute a pre-loaded search for tests
that have defined for recently-modified
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elements (defaulting to modification
within the last 7 days)
Recent Test Results - open the Find in
Project view and execute a pre-loaded
search for tests that have been run
within the last 7 days
Add Pie Chart - generate, in the
currently-open diagram, a Pie Chart of
the test status statistics from the last
seven days, per status type
Add Bar Chart - generate, in the
currently-open diagram, a vertical Bar
Chart of the test status statistics from
the last seven days, per status type
Test Results from last week - generate,
in the current diagram, a horizontal,
stacked bar chart showing the test
status statistics for each day of the last
week
Test Results from last 30 days generate, in the currently-open
diagram, a horizontal, stacked bar chart
showing the test status statistics for
each day of the last 30 days, the most
recent date being at the bottom of the
chart
Test Results weekly summary generate, in the currently-open
diagram, a horizontal, stacked bar chart
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showing the test status statistics for
each week of the current year
Recent Test Passes - open the Find in
Project view and execute a pre-loaded
search for tests that have been given a
Pass status within the last 7 days
Recent Test Failures - open the Find in
Project view and execute a pre-loaded
search for tests that have been given a
Fail status within the last 7 days
Recently Deferred Tests - open the
Find in Project view and execute a
pre-loaded search for tests that have
been given a Deferred status within the
last 7 days

Not Run

Click on this icon to open the Find in
Project view and execute a pre-loaded
search for tests that are currently open but
have not been run within the last 7 days.

Not Checked

Click on this icon to open the Find in
Project view and execute a pre-loaded
search for tests that are currently open but
have not been checked within the last 7
days.

Report

Click on this icon to display the 'Generate
Test Documentation' dialog, which you
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use to generate a report on the test
records of one or more test types lodged
against the elements of the current
Package.
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Change Management Panel
The 'Change Management' panel is used for describing
important model management items that apply to an
element. Enterprise Architect is a powerful platform for
managing any initiative and can keep track of variations in
the life time of any element. Regardless of the methods or
processes that are being used, elements such as
Requirements, User Stories, Business Rules and
Components will change, have issues, require tasks, have
defects and events, and decisions will be made about them.
All of these variations can be recorded and managed, and a
series of useful searches are conveniently made available to
find items such as recently requested changes and
incomplete tasks.

Available Facilities
Facility

Description

Changes

Click on the drop-down arrow to display
a menu of options for performing
searches and generating charts to manage
and visualize changes to elements in the
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model.
· Show Changes Window - display the
Changes window, which you use to
record and manage specific requests for
changes to the selected element
· Verified Changes - open the Find in
Project view and execute a pre-loaded
search for elements having Change
items with the status 'Verified'
· Recently Requested Changes - open the
Find in Project view and execute a
pre-loaded search for elements having
Change items that have been recorded
within the last 7 days
· Chart Requested Changes - create a
chart in the currently-open diagram,
showing recently-requested changes
· Recently Completed Changes - open
the Find in Project view and execute a
pre-loaded search for elements having
Change items that have been completed
within the last 7 days
· Chart Completed Changes - create a
chart in the currently-open diagram,
showing recently-completed changes
· New Changes - open the Find in
Project view and execute a pre-loaded
search for elements that have new
(c) Sparx Systems 2018
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Change items
Incomplete Changes - open the Find in
Project view and execute a pre-loaded
search for Change items that have not
been completed

Click on the drop-down arrow to display
a menu of options for performing
searches and generating charts to manage
and visualize records of defects raised
against elements in the model.
· Show Defects Window - display the
Defects window, which you use to
record and manage specific reports of
defects in the selected element
· Verified Defects - open the Find in
Project view and execute a pre-loaded
search for elements having Defect
items with the status 'Verified'
· Recently Reported Defects - open the
Find in Project view and execute a
pre-loaded search for elements having
Defect items that have been recorded
within the last 7 days
· Chart Reported Defects - create a chart
in the currently-open diagram, showing
recently-reported Defect items
· Recently Resolved Defects - open the
Find in Project view and execute a
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pre-loaded search for elements having
Defect items that have been resolved
within the last 7 days
Chart Resolved Defects - create a chart
in the currently-open diagram, showing
recently-resolved Defect items
New Defects - open the Find in Project
view and execute a pre-loaded search
for elements that have new Defect
items
Unresolved Defects - open the Find in
Project view and execute a pre-loaded
search for Defect items that have not
been resolved

Click on the drop-down arrow to display
a menu of options for performing
searches and generating charts to manage
and visualize records of issues raised
against elements in the model.
· Show Issues Window - display the
Issues window, which you use to
record and manage specific reports of
issues with the selected element
· Verified Issues - open the Find in
Project view and execute a pre-loaded
search for elements having Issue items
with the status 'Verified'
· Recently Reported Issues - open the
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Find in Project view and execute a
pre-loaded search for elements having
Issue items that have been recorded
within the last 7 days
Chart Reported Issues - create a chart
in the currently-open diagram, showing
recently-reported Issue items
Recently Resolved Issues - open the
Find in Project view and execute a
pre-loaded search for elements having
Issue items that have been resolved
within the last 7 days
Chart Resolved Issues - create a chart
in the currently-open diagram, showing
recently-resolved Issue items
New Issues - open the Find in Project
view and execute a pre-loaded search
for elements that have new Issue items
Unresolved Issues - open the Find in
Project view and execute a pre-loaded
search for Issue items that have not
been resolved

Click on the drop-down arrow to display
a menu of options for performing
searches and generating charts to manage
and visualize records of tasks opened
against elements in the model.
· Show Tasks Window - display the
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Tasks window, which you use to record
and manage specific reports of tasks
opened against the selected element
Verified Tasks - open the Find in
Project view and execute a pre-loaded
search for elements having tasks with
the status 'Verified'
Recently Requested Tasks - open the
Find in Project view and execute a
pre-loaded search for elements having
tasks that have been recorded within
the last 7 days
Chart Requested Tasks - create a chart
in the currently-open diagram, showing
recently-requested tasks
Recently Completed Tasks - open the
Find in Project view and execute a
pre-loaded search for elements having
tasks that have been completed within
the last 7 days
Chart Completed Tasks - create a chart
in the currently-open diagram, showing
recently-completed tasks
New Tasks - open the Find in Project
view and execute a pre-loaded search
for elements that have new tasks
Incomplete Tasks - open the Find in
Project view and execute a pre-loaded
search for tasks that have not been
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completed
Events
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Click on the drop-down arrow to display
a menu of options for performing
searches and generating charts to manage
and visualize records of events reported
against elements in the model.
· Show Events Window - display the
Events window, which you use to
record and manage specific reports of
events lodged against the selected
element
· Recently Reported Events - open the
Find in Project view and execute a
pre-loaded search for elements having
events that have been reported within
the last 7 days
· Chart Reported Events - create a chart
in the currently-open diagram, showing
recently-reported events
· Recently Completed Events - open the
Find in Project view and execute a
pre-loaded search for elements having
events that have been marked as
complete within the last 7 days
· Chart Completed Events - create a
chart in the currently-open diagram,
showing events that were recently
marked as complete
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High Priority Events - open the Find in
Project view and execute a pre-loaded
search for elements that have events
with the status High Priority
Open Events - open the Find in Project
view and execute a pre-loaded search
for events that are currently open

Click on the drop-down arrow to display
a menu of options for performing
searches and generating charts to manage
and visualize records of decisions
associated with elements in the model.
· Show Decisions Window - display the
Decisions window, which you use to
record and manage specific records of
decisions associated with the selected
element
· Verified Decisions - open the Find in
Project view and execute a pre-loaded
search for elements having decisions
with the status 'Verified'
· Recently Created Decisions - open the
Find in Project view and execute a
pre-loaded search for elements having
decisions that have been recorded
within the last 7 days
· Chart Created Decisions - create a chart
in the currently-open diagram, showing
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recently-created decisions
Recently Effective Decisions - open the
Find in Project view and execute a
pre-loaded search for elements having
decisions for which the Effective date
has passed within the last 7 days (that
is, the decision has become effective)
Chart Effective Decisions - create a
chart in the currently-open diagram,
showing recently-effective decisions
New Decisions - open the Find in
Project view and execute a pre-loaded
search for elements that have new
decisions
Decisions with no Effective date - open
the Find in Project view and execute a
pre-loaded search for elements that
have no Effective date recorded

Effort

Click on this icon to open the Effort
window, on which you can create and
maintain Effort records for the
currently-selected element.

Risks

Click on this icon to display the Risks
window, on which you create and
maintain records of Risks to the work on
the selected element.
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Click on this icon to display the Metrics
window, on which you create and
maintain records of metrics that have an
influence on the work on an element.
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Status Panel
The 'Status' panel provides facilities for obtaining an
overview of the project status.

Available Facilities
Facility

Description

QA Report

Click on this icon to display the QA
Reports view, which has separate tabs
that enable you to run and display these
system-provided status reports:
· Testing Details
· Maintenance Details
· Dependency Details
· Implementation Details

Task &
Issues

Click on this icon to access the Project
Status view, which provides tabs that
summarize the status of each task or issue
that relates directly to the current project,
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and a third tab that summarizes the
statistics of the project.
Review the project statistics, on the
'Project Statistics' tab. This simply lists
the numbers of Packages, diagrams,
elements, connectors, elements of each
type and element features of each type in
the project.
For certain items, such as element risks,
metrics and effort, if there are no
instances of that particular object type it
is still listed but with a count of 0.
Use Case
Metrics
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Click on this icon to display the QA
Reports view at the Use Case Metrics tab,
to calculate Use Case metrics for the
model.
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Simulate Ribbon
The 'Simulate' ribbon presents a range of tools for
configuring, building and running simulations.
Enterprise Architect supports simulations based on both
Behavioral Models and Executable StateMachines, with the
ability to start, pause and resume execution of a simulation,
as well as setting break points and viewing Call Stacks or
local variables. A number of pre-defined model searches are
also provided to assist with locating model artifacts related
to your simulations.

Panels
Panel

Description

Core

The 'Core' panel brings together a range
of tools for working with Behavioral
Model simulations. It provides access to a
number of windows that allow you to
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control a simulation, set up simulation
triggers and signals, set breakpoints,
inspect local variables or view the Call
Stack. It also offers a number of
pre-defined model searches for retrieving
recently modified StateMachines and
Activity Graphs.
Run

The 'Run' panel provides a number of
buttons to control execution of an active
simulation, such as Start, Pause, Step
Over, Step In, Step Out and Stop.

Executable

Executable StateMachines provide a
powerful means of rapidly generating,
executing and simulating complex state
models. In contrast to dynamic simulation
of State Charts using Enterprise
Architect's Simulation engine, Executable
StateMachines provide a complete
language-specific implementation that
can form the behavioral 'engine' for
multiple software products on multiple
platforms.
The 'Executable' panel provides a number
of facilities for working with Executable
StateMachines. You can access facilities
to configure Analyzer Scripts that
determine how code is generated,
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compiled and executed for the Executable
StateMachine. There are commands for
you to generate, build and execute the
code that runs the simulation, as well as a
facility to view the generated code in the
built-in code editor.
Decision
Analysis

The 'Decision Analysis' panel helps you
to perform simulations of models created
under Enterprise Architect's
implementation of the Decision Modeling
and Notation (DMN) facility, developed
by the Open Modeling Group. This
facility enables you to open a DMN
Simulation and set up DMN Expressions,
and to locate and work from DMN
Configuration Artifacts.

Process
Analysis

The 'Process Analysis' panel provides
facilities to manage and run BPMN
simulation models, based on the BPSim
standard.

System
Behavior

The 'System Behavior' panel provides
access to the 'SysML Simulation
Configuration Manager' view, where you
can configure and manage SysML based
simulations as well as access a
pre-defined search to retrieve SysML
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configuration artifacts.
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Core Panel
The 'Core' panel brings together a number of tools for
working with Behavioral Model simulations. It provides
access to a range of windows that allow you to control a
simulation, set up simulation triggers and signals, set
breakpoints, inspect local variables or view the Call Stack. It
also offers a number of pre-defined model searches for
retrieving recently modified StateMachines and Activity
Graphs.

Available Facilities
Facility

Description

Dynamic
Simulation

Click on this icon to display a short menu
providing these options:
· Open Simulation Window - display the
Simulator control window, from which
you can manage, activate and control
simulations
· Apply Simulator Layout - apply a
workspace layout that contains the
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most commonly used simulator
windows in a convenient arrangement
You can also execute searches to find
Activities, StateMachines, Interactions
and other objects related to running
simulations, or StateMachines and
Activity Graphs that have been recently
modified. You can specify the time
period (number of days) from which to
draw the results.
Events

Click on this icon to open the Simulation
Events window, to work with signals and
triggers that are used as input to the
currently active simulation.

Breakpoints

Click on this icon to display the
Breakpoints window for the Simulator.
Breakpoints can be set on model elements
to halt simulation and inspect variables.

Local
Variables

Click on this icon to display a list of
Local Variables and their values from the
current simulation. The simulation must
be halted at a break point in order to
display variables.

Call Stack

Click on this icon to display the Call
Stack for the current simulation.
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Run Panel
The 'Run' panel provides a number of buttons to control
execution of the active simulation.

Available Facilities
Facility

Description

Start

Begin or continue execution of the
currently active simulation.

Pause

Pause execution of the current simulation

Step Over

Step over a transition or a control path
that enters a different process or
StateMachine space

Step In

Step into a sub-process in the current
simulation

Step Out

Step out of a sub-process or sub-machine
state and return to the parent process or
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StateMachine
Stop
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Halt execution of the current simulation
at the current execution point.
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Executable Panel
Executable StateMachines provide a powerful means of
rapidly generating, executing and simulating complex State
models. In contrast to dynamic simulation of State Charts
using Enterprise Architect's Simulation engine, Executable
StateMachines provide a complete language-specific
implementation that can form the behavioral 'engine' for
multiple software products on multiple platforms.
The 'Executable' panel provides a number of facilities for
working with Executable StateMachines. You can access
facilities to configure Analyzer Scripts that determine how
code is generated, compiled and executed for the Executable
StateMachine. There are commands for you to generate,
build and execute the code that runs the simulation, as well
as a facility to view the generated code in the built-in code
editor.

Available Facilities
Facility

Description

Statemachine
s

Click on the drop-down arrow to display
a list of options for working with
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Executable StateMachine Artifacts to
configure, generate and run code-based
simulations.
· Generate, Build and Run - generate,
build and run the current Executable
StateMachine Artifact, according to the
Analyzer Script configuration
· Apply Perspective - apply the
Perspective for Executable
StateMachines to your modeling
environment; the Model Wizard
displays, presenting the Executable
StateMachine Patterns
· Generate - generate the current
Executable StateMachine Artifact,
according to the Analyzer Script
configuration
· Build - build the current Executable
StateMachine Artifact, according to the
Analyzer Script configuration
· Run - start a simulation of the current
Executable StateMachine Artifact,
according to the Analyzer Script
configuration
· Find Executable StateMachines - run a
pre-defined search to locate all
Executable Statemachine Artifacts in
the model
· Analyzer Scripts - display the
(c) Sparx Systems 2018
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'Execution Analyzer' dialog, where you
can configure Analyzer Script options
for the current Executable
StateMachine Artifact
View Source - view the source code
generated for the current Executable
StateMachine Artifact
Help - display Help information about
Executable StateMachines; this opens
in your default web browser

Page 191 of 694

User Guide - User Interface

21 December, 2018

Decision Analysis Panel
The 'Decision Analysis' panel helps you to perform
simulations of models created under Enterprise Architect's
implementation of the Decision Modeling and Notation
(DMN) facility, developed by the Open Modeling Group.
This facility enables you to open a DMN Simulation, set up
DMN Expressions and locate and work from DMN
Configuration Artifacts.

Available Facilities
Facility

Description

Open DMN
Simulation

Select this option to open the DMN
Simulation window, through which you
can create and edit
DMNSimConfiguration Artifacts, run a
DMN simulation and generate and test a
DMN Server.

DMN
Expression

Select this option to display the DMN
Expression window. The content of this
window depends on the DMN component

(c) Sparx Systems 2018

Page 192 of 694

User Guide - User Interface

21 December, 2018

you select in a diagram or the Project
Browser. If you have not selected any
component, the window is blank.
Apply
Perspective

Select this option to apply the Perspective
for DMN to your modeling environment.
The Model Wizard displays, presenting
the DMN Patterns.

Find DMN
Configuratio
n Artifacts

Select this option to immediately execute
a search for DMNSimConfiguration
Artifacts in the model. The results of the
search are listed on the Find in Project
window.
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Process Analysis Panel
The 'Process Analysis' panel provides access to the
Configure BPSim window, and also a pre-defined search to
retrieve BPSim configuration artifacts.

Available Facilities
Facility

Description

BPSIM

Click on the drop-down arrow to display
a short menu providing these options:
· Open BPSim Manager - display the
Configure BPSim window, through
which you can configure, execute and
analyze simulations of BPSim models
· Apply Perspective - apply the
Perspective for BPSim to your
modeling environment; the Model
Wizard displays, presenting the BPSim
Patterns
· Find BPSim Configuration Artifacts open the Model Search window and
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load a pre-defined set of search
parameters to find Business Process
Simulation configuration Artifacts
containing simulation parameters for
executing BPMN 2.0 simulations
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System Behavior Panel
The 'System Behavior' panel provides access to the
Configure SysML Simulation view, where you can
configure and manage SysML based simulations as well as
access a pre-defined search to retrieve SysML configuration
artifacts.

Available Facilities
Facility

Description

Modelica

Click on the drop-down arrow to access
the SysML Simulation configuration and
management view, or to access a
pre-defined model search that retrieves
SysML configuration Artifacts.
· SysMLSim Configuration Manager display the Configure SysML
Simulation view to build and run
simulations using SysML and Open
Modelica
· Apply Perspective - apply the Modelica
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Sim Perspective to your modeling
environment; the Model Wizard
displays, presenting the SysML 1.5
Patterns
Find SysMLSim Configuration
Artifacts - open the Model Search
window and load a pre-defined set of
search parameters to find SysMLSim
configuration artifacts
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Code Ribbon
The 'Code' ribbon collects together all the tools for working
with programming and database languages, including
powerful tools to reverse engineer, forward engineer and
synchronize code and models. A system can be designed
from requirements down to visual models of the components
and code elements, and then generated to programming or
database code.

Panels
Panel

Description

Import

The 'Import' panel provides facilities for
importing existing projects from other
tools, to create or add to an Enterprise
Architect project, and for importing code
files in a range of programming
languages into your model, creating new
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model elements that represent the classes
in those files.
Source Code

The 'Source Code' panel brings together a
number of facilities for working with
source code. Here, you can generate
source code from the model and
synchronize the model from the source
code. You can also edit and merge source
code files.

Schema

From the 'Schema' panel, you can access
facilities for importing XSD files, WSDL
files and DB Schema, and for generating
XSD and WSDL files from your model.
You can also edit XSL Transformations,
and edit and debug language grammars.

Configure

Within the powerful Execution Analyzer
you can specify how the model is used to
generate a built product, including how
an application will be compiled,
debugged and simulated. Source code
files can be located and opened. The
'Services' icon provides options to start,
stop and test Satellite and Agent services.

Build and
Run

The 'Build and Run' Panel provides tools
to create software products directly from
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models. The panel also provides
commands to Run, Test and, Deploy an
application.
Add-Ins
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If any Integrated Development
Environment applications have been
installed on your system and made
available through the MDG bridge
technologies for the products, access
icons would probably be assigned to the
'Add-Ins' panel of the 'Code' ribbon, as
illustrated at the start of this topic.
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Import Panel
The 'Import' panel provides facilities for importing existing
projects from other tools, to create or add to an Enterprise
Architect project, and for importing code files in a range of
programming languages.

Available Facilities
Facility

Description

Project

Click on the drop-down arrow to display
a list of options for importing project
code from certain popular development
products into the current project. For
example:
· Import a Visual Studio Solution
· Import a Mono Solution
· Import an Eclipse Project
· Import a Netbeans Project
Having imported the material, you can
perform a comparison between the
external project source code and the
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Enterprise Architect model to check for
Class differences, using the 'Compare
with Model' option, and you can refresh
the Enterprise Architect model to update
it with any changes to the source.
File
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Click on the drop-down arrow to display
a list of options for importing code files
from a variety of sources, selecting from
a range of popular coding languages.
· Import Directory - display the 'Import
Source Directory' dialog from which
you import a complete directory tree in
one pass; language and other options
can be specified within the dialog
· ActionScript Files - import
ActionScript files into the current
model
· C Files - import C files into the current
model
· C# Files - import C# files into the
current model
· C++ Files - import C++ files into the
current model
· Delphi Files - import Delphi files into
the current model
· Java Files - import Java files into the
current model
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PHP Files - import PHP files into the
current model
· Python Files - import Python files into
the current model
· Visual Basic Files - import Visual
Basic files into the current model
· VB .Net Files - import VB.Net files
into the current model
· Binary File - import a binary file;
supported file types are: Java JAR files
and .NET PE or IL format (exe, dll)
· Windows .RC File - import a Windows
C/C++ .RC file into the model, as a
series of screen definitions
If you have developed model structures
for any customized programming
language, those languages are also
included in the list.
·
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Source Code Panel
The 'Source Code' panel brings together a number of
facilities for working with source code. Here you can import
existing source code files into your model, creating new
model elements that represent the classes in those files. You
can select a Class in your model, then click a button to open
the code editor window and automatically load the source
code file associated with that Class. Facilities for editing
Code Generation Templates and Language Grammars are
also accessed from this panel, as are the commands to
generate source code from the model and synchronize the
model from the source code.

Available Facilities
Facility

Description

Synchronize

Click on this icon to display options to
synchronize the currently selected model
elements with their associated source
code files, or to synchronize the whole
Package containing the selected elements.
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Generate

Click on this icon to display options to
generate source code for:
· The currently selected model
element(s), or
· A single element, with options, or
· All elements in the current context
Source code is generated into the file that
is associated with each individual
element. Code is generated only for
elements that are of type Class or
Interface.

Edit

This icon provides a collection of tools
for viewing and editing source code files
associated with elements in the current
model. Also provided are tools that
generate source code for a particular
element or synchronize an element to
reflect changes in its associated source
code file.
· Open Source File - display a 'File
Chooser' dialog to browse for a source
code file to open in the code editor
window
· Search in Files - display the 'Find in
Files window, to locate files of a
selected type containing a specified
code string
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Edit Element Source - open the code
editor window and load the source code
file associated with the currently
selected element
Browse Element Source - open a
docked source code window and load
the source code file associated with the
currently selected element, for
browsing through
Edit New Source File - create and
populate a new source code file
Open in External Editor - launch the
configured External Editor and load the
source code file associated with the
currently selected element

This option is enabled when there is a
user-defined Merge command defined in
the currently active Analyzer script.
Select it to execute the command and
perform the defined operation.
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Schema Panel
From the 'Schema' panel, you can access facilities for
importing XSD files, WSDL files and DB Schema, and for
generating XSD and WSDL files from your model.

Available Facilities
Facility

Description

DDL

Click on this icon to display a short menu
providing access to tools used for
designing, importing and creating data
models.
· Import a DB Schema - display the
'Import DB Schema' dialog, through
which you can specify a database
schema to import from a target DBMS
· Export a Database Schema (DDL) display the 'Generate DDL' dialog,
from which you can export the current
model selection as DDL script,
targeting a particular DBMS
· Edit the DB Schema (DDL) Templates
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- display the 'DDL Template Editor', in
which you can edit the templates used
to create DDL scripts for each DBMS
Open the Database Builder - display
the Database Builder view, in which
you can add, edit and manage database
models, targeting a wide range of
supported DBMS products

The XSD (XML Schema) icon provides
access to a collection of tools for
importing, exporting and viewing both
XSD files and WSDL files.
· Import an XML Schema (XSD) File display the 'Import XML Schema'
dialog for importing an XSD file to a
model Package; choose a file to import
and specify a range of options to apply
when importing the file
· Export an XML Schema (XSD) File display the 'Generate XML Schema'
dialog for generating the current
Package to an XSD file; specify a path
for the export file and specify a range
of options to apply when exporting the
Package
· Edit an XML/XSD File - choose a file
to be opened in the code editor window
· Import a Web Services (WSDL) File Page 208 of 694
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display the 'Import WSDL' dialog,
where you can choose a file to import
into the selected Package
Export a Web Services (WSDL) File generate either a «WSDLnamespace»
stereotyped Package or a «WSDL»
stereotyped Component (Document) to
WSDL files
Open the Schema Composer

XSLT

Opens the XSLT Debugger, to debug an
XSL Transformation.

Grammars

Display the Grammar Editor window, an
advanced facility that allows you to view,
add, edit and manage language
grammars, used for importing source
code.
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Configure Panel
The 'Configure' panel provides facilities for performing code
analysis, structuring models of code and setting up VEA
Satellite and Agent Services. The panel also provides access
to tools such as the Debugger, Profiler, Execution Recorder
and the Testpoints Window.

Available Facilities
Facility

Description

Analyzer

Click the drop-down arrow to access a
menu of Analyzer tools.
· Edit Analyzer Scripts - display the
Execution Analyzer window, where
you can create and manage scripts that
define the build, run, test, deploy and
simulate functions for the current
Package
· Edit Active Script - display the
Execution Analyzer window to edit the
currently-active Analyzer script
· Show Testpoints Window - display the
Analyzer Test Points window, to
configure, execute and work with
dynamic test suits and test cases
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Find Test Suites and Test Sets - search
the model for Test Suites and Test Sets
Open Debugger - display the Analyzer
Debug window to facilitate debugging
and testing of the current application
Open Profiler - display the Analyzer
Profiler window, from which you can
perform application performance
profiling and execution inspection of
the current application
Open Recorder - display the Analyzer
Recording window, from which you
can set recording points, record
program execution and create diagrams
based on recordings
Open Object Workbench - open a
simple Object Testing window, from
which you can make ad hoc calls on
Object methods; available for Java and
.NET objects

Click on the drop-down arrow to display
a list of options for managing templates,
which determine the way source code is
imported into and generated from your
model.
· Edit Code Templates - display the
Code Template Editor window, where
you can review and edit the templates
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used for generating source code from
your model
Configure Local Paths - display the
'Local Paths' dialog, where you can set
up and manage a list of Local Path
definitions, used for path substitutions
in collaborative environments
Set Package as Namespace Root - set
the selected Package as the Namespace
root, for code generation
Suppress Namespace - ignore the
current subordinate Package when
generating Namespaces and showing
Package paths
Define Preprocessor Macros - manage
a list of preprocessor macros that will
be used when C and C++ code is
imported into the model
Configure Code Engineering Datatypes
- manage the list of Datatypes that are
used in Code Engineering
Reset Source Language - display the
'Manage Code Generation' dialog to
change the source language and other
generation options for all Classes in the
selected Package
Set Live Code Generation - update
your source code instantly as you make
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changes to your model
Services
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These options enable you to control local
supporting VEA services. Those services
might run a native Linux program, for
example, or build a project.
· Start the Satellite Service running
· Stop the Satellite Service running
· Test if the Satellite Service is running
· Start the Agent Service running
· Stop the Agent Service running
· Test if the Agent Service is running
· Test if the Codeminer Service is
running
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Build and Run Panel
Enterprise Architect's Analyzer Scripts are used to define
the behavior of various commands, such as Build, Run and
Deploy, which are available in the Execution Analyzer. Any
number of scripts can be defined in a model and each user
can set their own active script, independent of other users of
the same model. The active script governs the behavior of
the Execution Analyzer's commands.
The 'Build and Run' panel provides facilities for executing
Execution Analyzer commands such as Build, Run, Test and
Deploy, so you can easily build, run and test a project's
source code, all from the one place.

Available Facilities
Facility

Description

Build

Click the drop-down arrow to display a
short menu of commands for building
application source code
· Build - build the current application,
according to the currently active
Analyzer script
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Clean - run the Analyzer Clean
command to delete intermediate files
from the current application
Rebuild - run the Analyzer Clean and
Build commands as defined in the
currently active Analyzer script
Cancel Build - cancel the currently
executing build

Run

Execute the Analyzer 'Run' command
defined by the currently active Analyzer
script.

Test

Execute the Analyzer 'Test' command
defined by the currently active Analyzer
script.

Deploy

Execute the Analyzer 'Deploy' command
defined by the currently active Analyzer
script.
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Execute Ribbon
The 'Execute' ribbon provides a comprehensive set of
facilities for running units of code and analyzing how the
code executes, checking system use and data use and
whether there are errors. If there are errors in the code, you
can isolate them and correct them, testing those corrections
as well.

Panels
Panel

Description

Analyze

The 'Analyze' panel brings together a
collection of powerful tools for analyzing
the execution of an application. The tools
available are a fully featured Debugger,
an execution Profiler and a stack trace
Recorder. There are also facilities for
running the application and recording
Test Point output, for subsequent
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analysis.
Windows

The 'Windows' panel provides access to a
suite of windows associated with the
debugging process, each of which
provides information on an aspect of the
application being debugged, particularly
at a breakpoint.

Run

The 'Run' panel provides a set of buttons
for building and running an application
that is being analyzed. The active
Analyzer Script defines the behavior of
the Analyze tools, by specifying the
commands that are executed and the
settings and parameters for those
commands. After making modifications
to the code base, you can simply click on
'Build', then click on buttons to begin
execution of the updated application,
pausing or stepping through code as
required.
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Analyze Panel
The 'Analyze' panel brings together a collection of powerful
tools for analyzing the execution of an application. The tools
available are a fully featured Debugger, an execution
Profiler and a stack trace Recorder. There are also facilities
for running the application and recording Test Point output,
for subsequent analysis.

Available Facilities
Facility

Description

Debugger

Click on the drop-down arrow to display
a list of options for starting and using the
Debugger.
· Open Debugger - open the Debug
window; this window provides a
toolbar for controlling Debugger
operations such as run, step-into,
step-over, pause and also displays
debug output messages
· Start Debugging - start the application,
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according to the debug options of the
active analyzer script
Attach to Process - display a list of
executing processes - select and attach
to a process for debugging purposes
Apply Debug Layout - apply a
workspace layout containing windows
useful for debugging, set out in a
convenient arrangement
Create Stack Diagram - create an
Interaction diagram based on the
current execution stack; available only
when execution is halted at a
breakpoint
Set as JIT Debugger - set Enterprise
Architect as the default Just In Time
debugger; for Windows systems only
Process First Chance Exceptions enable processing of First Chance
Exceptions
Switch to Profiler - switch dynamically
from the Debugger to the Profiler,
allowing performance monitoring and
execution tracing

The Profiler is used to record stack trace
information for an application that is
being analyzed, at pre-determined
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sampling intervals.
Click on the drop-down arrow to display
a list of commands for starting and
working with the application Profiler.
· Open Profiler - open the Profiler
window; this window provides a
toolbar for controlling Profiler
operations and displays a summary of
the collected sample data
· Attach to Process - display a list of
executing processes - select and attach
to a process to enable execution
profiling and activity monitoring of
that process
· Apply Profiler Layout - apply a
workspace layout containing windows
useful for application profiling, set out
in a convenient arrangement
· Start - reattach the Profiler to the last
profiled application process (where
available), otherwise start the
application specified in the debug
options of the active analyzer script and
attach the Profiler to that application
process
· Resume - begin or resume collection of
profiling data
· Stop - detach the Profiler from the
application process; the application
(c) Sparx Systems 2018

Page 220 of 694

User Guide - User Interface

·

·

·

·

·

·

·

Recorder
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process will continue to run - click on
the Start button to re-attach to that
process
Create Report from Current Data create a detailed execution call graph
and overall summary, showing
functions called and number of times a
function was active when the Profiler
inspected execution
Load Report from File - load a profiler
report from a saved file
Save Report to File - save the collected
profile data to a file
Stop Process on Exit - an option to stop
the application process when the
Profiler is detached from that process
Show Debug Output - optionally show
debug output as the Profiler executes
Discard Current Data - discard all
collected sample data in preparation for
a new run
Switch to Debugger - dynamically
switch from Profiling to Debugging to
allow finer grained inspection of
application behavior

The Recorder is used to record
information about function calls made by
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an application that is being analyzed.
Click on the drop-down arrow to display
a list of commands for starting and
working with the Recorder.
· Open Recorder - open the Record &
Analyze window; this window provides
a toolbar for controlling Recorder
operations such as run (the
application), manual record, auto
record, stop recording and also displays
the recorded function call information
· Apply Recording Layout - apply a
workspace layout optimized for use of
the Recorder
· Synchronize Model to Source Code synchronize the source code of the
current application with the model, to
ensure correct recording and creation
of diagrams
· Attach to Process - attach the Recorder
to an executing process
· Start Recorder - start the application
specified the debug options of the
active analyzer script and attach the
Recorder to that application process;
recording will begin when execution
hits a recording marker that has been
set in the source code
· Manual Record - use the manual record
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functions to start and stop recording
while stepping through source code in
the Debugger
Auto Record - automatically begin
recording an execution trace, without
manual intervention, once execution
hits a recording marker that has been
set in the source code
Step Thru - step through executing
code while recording an execution
trace
Stop Recording - stop recording the
execution trace of the application
process; the application process will
continue to run
Save Recording to Model (Artifact) save the recorded execution trace to a
model artifact
Save Recording to File - save the
recorded execution trace to a file in the
local file system
Load Recording - load a recorded
execution trace from a previously
saved file
Clear Recording Data - discard any
recorded execution trace in preparation
for recording a new trace
Create Sequence Diagram - create a
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Sequence (Interaction) diagram from
the current execution trace; requires
that model and code are synchronized
Create Call Graph - create a Call Graph
from the current execution trace;
requires that model and code are
synchronized
Create Class Diagram - create a Class
diagram using the elements that are
instantiated and accessed in the current
recording
Create Test Point Diagram - create a
Test Point diagram and Test Sets based
on the elements and their active
members that were hit during the
recorded session
Show/Hide Execution Point - show or
hide the current execution point during
the recording process; hiding this
results in a faster recording time

Test Points are a scheme by which rules
and constraints governing the behavior of
objects can be taken from the model to
create Test Cases to verify the
application.
Click on the drop-down arrow to display
a list of options for working with Test
Points and Test Cases.
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Show Testpoints Window - open the
Test Points window to manage,
configure and run Test Points and
associated Test Cases, Sets and Suites
Find Test Suites and Test Sets - search
the current model for Test Suites, Test
Sets and related elements used in
managing Test Point based verification
Open Object Workbench - open a
simple Object testing environment for
Java and .Net; instantiate objects and
dynamically call their methods
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Windows Panel
The 'Windows' panel provides access to a suite of windows
associated with the debugging process, each of which
provides information on an aspect of the application being
debugged, particularly at a breakpoint.

Available Facilities
Facility

Description

Breakpoints

Click on this icon to open the
Breakpoints & Markers window, which
you use to manage and configure source
code breakpoints and other markers.

Call Stack

Click on this icon to open the Call Stack
window, which displays all the
currently-running threads in a process, at
a breakpoint.

Local
Variables

Click on this icon to open the Locals
window, which displays the local
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application variables at a breakpoint.
Watches

Click on this icon to open the Watches
window, which lists the customer
variables by name when the application is
at a breakpoint.

Modules

Click on this icon to open the Modules
window, which lists the modules an
application has loaded and is using at run
time.

Memory
Viewer

Click on this icon to open the Memory
Viewer window to view a piece of
memory when the application is paused at
a breakpoint.

Open File

Display a browser dialog from which you
can select a file to be opened in the
internal code editor.

Search Files

Open the Find in Files window to search
the local file system for source files that
contain particular text.
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Run Panel
The 'Run' panel provides a set of buttons for building and
running an application that is being analyzed. After making
modifications to the code base, you can simply click on
'Build', then click on buttons to begin execution of the
updated application, pausing or stepping through code as
required. The active Analyzer Script will determine the
behavior of the debugger tools, by specifying the commands
that are executed as well as the settings and parameters for
those commands.

Available Facilities
Facility

Description

Analyzer

Display the Execution Analyzer window,
which lists - by Package - all Analyzer
Scripts defined in the model. From this
window, you can create, edit and manage
scripts that specify the commands and
parameters required to build, test, run,
debug, deploy and simulate your
applications. The window's toolbar
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buttons provide for control of script tasks
such as build, run, test and deploy, and
also provide access to a range of
debugging facilities.
Services

These options enable you to start, stop
and test local supporting VEA services.
Those services might run a native Linux
program, for example, or build a project.
· Start Satellite Service
· Stop Satellite Service
· Test Satellite Service Status
· Start Agent Service
· Stop Agent Service
· Test Agent Service Status

Build

Click on the drop-down arrow to display
a short menu of commands for building
application source code:
· Build - build the current application,
according to the currently active
Analyzer script
· Clean - run the Analyzer Clean
command to delete intermediate files
from the current application
· Rebuild - run the Analyzer Clean and
Build commands as defined in the
currently active Analyzer script
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Cancel Build - cancel the currently
executing build

Start

Click on the drop-down arrow to display
a short menu of commands:
· Run - resume execution of the
application process that is currently
being debugged - if no process is
currently being debugged, then start the
application specified in the debug
options of the active analyzer script and
attach the Debugger to that application
process
· Attach to Process - display a list of
executing processes, select and attach
to a process for the purpose of
debugging
· Show Execution Point - display and
highlight the line of source code that
corresponds to the current execution
point

Pause

Pause execution of the application being
debugged.

Step Over

Execute the next line of source code,
without pausing inside any methods
called by that line. The execution point
will move to the next source line in the
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current context.
Step In

Execute the next line of source code,
stepping into any method that is called.
Execution is paused before executing the
first executable line in the called method.
If source code for the called method is
not available, the debugger will return
immediately to the calling code.

Step Out

Automatically run to the end of the
current context/method and return to the
calling context. Execution will pause
again, upon return to the calling context.

Stop

Terminate execution of the application
being debugged.
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Configure Ribbon
The 'Configure' ribbon is used for managing the way a
repository is used, from setting up reference data, security
and Version Control to audits and integrity checks.
Enterprise Architect is a powerful and flexible platform and
can be configured to suit any enterprise, business or
technical team.

Panels
Panel

Description

Security

The 'Security' panel collects together a set
of facilities for using and managing
security in the model. Security helps
teams collaborate by allowing individuals
to intentionally signal that they are
working on a part of the model.

Version

The 'Version Control' panel is used for
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Control

working with the powerful Version
Control facility in the tool, allowing you
to manage changes and versions of model
content for individual Packages or the
entire model. Version Control
Configurations can be defined using the
'Project Configuration' or 'Package
Configuration' options, and checked for
all versioned Packages using the 'Check
Configuration' option. There is a range of
options to view the history of changes
and to revert the model to a previous
version if desired. There are also options
to work offline and to compare the status
reported by the model and the Version
Control provider.

Model

The 'Model' panel provides facilities to
configure options for the current model,
to check and repair the integrity of the
model database, to transfer project data
from one database to another and to
configure auditing settings for recording
changes to the model database.

Reference
Data

The 'Reference Data' panel is used to set
up and manage the metadata for a model.
Reference Data is typically created when
the model is initiated, but some of this
data such as Resources and Images will
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be added to as the model evolves. There
is a wide range of options, from setting
up auto naming counters for elements,
creating Stereotypes, Tagged Value
Types and Cardinalities, to setting up
people, Status, Priority and much more.
Resources store a wide range of
additional model content such as
Templates, Profiles, Patterns and
Relationship Matrices. Images can be
saved in the model and used to replace
the conventional geometric
representations with descriptive and
compelling images that resonate with
non-technical audiences.
User Tools
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The 'User Tools' panel provides access to
a series of external tools useful to you
while working on the model. Windows
Explorer can be useful when working
with importing and exporting content
from the model, including CSV files for
exchange with a spreadsheet tool, XML
Schema files, Database and Source code
files and the generation of
Documentation. Open Database
Connectivity (ODBC) settings can be
accessed to assist when working with live
databases, and system information can be
viewed.
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Security Panel
When Security is enabled on a project, users are required to
provide a User ID and password to login to that project.
Project Security helps teams to collaborate by allowing
individuals or groups to intentionally signal that they are
working on specific parts of the model.

Available Facilities
The 'Security' panel collects together a set of facilities for
managing security in the model, such as enabling Project
Security, specifying which security mode to use, defining
the lists of authorized users and user groups, and assigning
permissions to users and groups to grant access to various
aspects of Enterprise Architect's functionality.
Facility

Description

Administer

Click on the drop-down arrow to display
a selection of commands for configuring
security in the model.
· Require User Lock to Edit - enable
pessimistic locking on the current
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project; in this mode, users must apply
a personal lock to model elements and
diagrams before any modifications can
be made
Apply Locks to Connectors - set a
global lock on all connectors with a
locked source element, so that those
connectors cannot be deleted and their
properties cannot be edited
Manage My Locks - display a dialog
that lists all locks applied by the
current user; locks can be reviewed and
also released using this dialog
Login as Another User - log in to the
Enterprise Architect project as another
user
User Settings - display a short menu of
options to:
- Change Password - display the
'Change Password' dialog for your
own, currently logged in, user ID
- Set Avatar - assign an avatar image
(in an Image Asset Artifact) to
your user ID
- Show user avatars - display (or, if
unselected, hide) all user avatars
in Chat and Discussion entries, in
your work sessions
- Set User Default Diagram - set the
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currently open, in-focus diagram
as your default user diagram
- Set User Default Kanban - set the
currently open, in-focus Kanban
diagram as your default user
Kanban diagram
Encrypt Password - provides legacy
support for older models hosted on
Oracle and SQL Server database
systems; administrators can create an
encrypted password that is distributed
to modelers, thus avoiding the need to
distribute the DB connection password
Enable Security - toggle (either enable
or disable) the state of Project Security
for the current project; you are
prompted to supply an Authorization
Key before the security state is changed

Users

This command displays the 'Security
Users' dialog, where new users can be
defined and permissions can be granted to
those users. Users can be added to
existing User Groups. The dialog also
provides for import of user definitions
from Windows Active Directory lists.

Groups

This command displays the 'Security
Groups' dialog, where new User Groups
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can be created and users can be added to
those groups. Permissions can be granted
to User Groups using this dialog.
Locks
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This command displays the 'Manage
Locks' dialog. The dialog shows a list of
all elements and diagrams within the
model that have active locks. You can
also filter to show only items with User
Locks or Group Locks. The list of items
can be sorted by lock type, item name,
locking user, locking group, or the time
of lock application. The dialog can be
used to select some or all of the locked
items, and then to unlock the selected
items.
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Set User Avatar
When you are contributing to element discussions or Chats,
your contributions are indicated by your user ID. You can
also define an icon that represents your User ID - that is, an
Avatar - to display in front of your ID, so that your
statements can be more easily recognized in the
conversation. This avatar is defined for your user ID within
the model.
User security must be enabled in order to identify each user
and hence display their avatars in the discussions.
If you do not want to show users' avatars in the discussions
that you are reviewing, you can hide them.

Define an Avatar
1. Create and/or locate a suitable image to use as your
avatar.
2. In Enterprise Architect, drag the 'Image Asset' icon from
the 'Artifact' page of the Diagram Toolbox onto a
diagram.
3. The 'Select an Image' dialog automatically displays;
browse for and select the image you have identified to use
as your avatar.
4. Save the diagram.
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Assign the Avatar
1. Select the ribbon option 'Configure > Security >
Administer > User Settings > Set Avatar'.
2. The 'Select image for avatar' dialog displays. Browse for
and select the Image Asset Artifact you created earlier.
3. Click on the OK button. The image is associated with
your user ID.
4. Open the Collaborate window ('Start > Collaborate >
Discussions > Discuss') and create a discussion item, then
click away from it. Your avatar should now display
against the message you have created.
You can repeat the process with a different image if you
decide to change your avatar.

Hide all avatars
If you do not want to show avatars in the Discussions or
Chats in your own work sessions, deselect the 'Configure >
Security > Administer > User Settings > Show user avatars'
option.
To display avatars again, re-select the option.
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Version Control Panel
The 'Version Control' panel provides facilities for
configuring and managing the powerful Version Control
facility in the tool. Version Control Configurations can be
defined using the 'Project Configuration' option and
validated for all versioned Packages using the 'Check
Configuration' option. There are options to work offline and
also to compare the status recorded in the model against that
reported by the Version Control provider.

Available Facilities
Facility

Description

Project
Configuratio
n

Displays the 'Version Control Settings'
dialog, in which you can define new
Version Control Configurations, or
re-specify the Working Copy Folder of an
existing Version Control Configuration.

Package
Configuratio

Configure a single Package for Version
Control. Display the 'Package Control
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n

Options' dialog to specify the Version
Control Configuration and the name of
the file to use in controlling the selected
Package.

Work Offline

Toggles Version Control in and out of
'Offline' mode. The 'Offline' mode allows
modelers to work with Version
Controlled Packages, even when there is
no connection to the Version Control
server. Packages can be 'checked-out'
offline and modified, but can only be
'checked-in' once a connection to the
Version Control server has been
re-established.

Re-Synch
Status

Query the Version Control server to
retrieve the check-out status of the file
associated with each of the Version
Controlled Packages in the current
project. Where it is necessary and
appropriate to do so, the status of the
Package is updated in the project
database to match the status reported by
the Version Control system. For example,
if a Package is marked in the project
database as checked-out to the current
user, but the Version Control server
reports the associated file as not
checked-out, then the Package flags will

(c) Sparx Systems 2018

Page 243 of 694

User Guide - User Interface

21 December, 2018

be updated to show 'not checked-out'.
Check
Configuratio
n
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This command scans all Version
Controlled Packages within a project,
checking the validity of the Version
Control settings for each Package. The
validation process scans the model
database and verifies that the Version
Control Configuration associated with
each Version Controlled Package is fully
specified in the current model. It also
queries the corresponding Version
Control provider to find the status of the
Package file associated with each Version
Controlled Package. The results of the
validation process are sent to the System
Output window.
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Model Panel
The 'Model' panel provides facilities to configure options for
the current model, to check and repair the integrity of the
model database, to transfer project data from one database to
another and to configure auditing settings for recording
changes to the model database.

Available Facilities
Facility

Description

Options

Displays the 'Manage Project Options'
dialog, through which you configure
options for the current model, including
required and banned MDG Technologies,
code generation and general options.

Auditing

Open the Audit View to configure and
view audit management information for
the current model.

Integrity

Occurrences such as network crashes or
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failed XMI imports can sometimes
compromise the integrity of information
in the model database. Clicking on the
'Integrity Check' drop-down arrow
displays a list of commands for
addressing these kinds of issue and for
general database maintenance.
· Project Integrity - displays the 'Project
Integrity Check' dialog; used for
examining database records to check
for 'orphaned' records or inaccurate or
unset identifiers
· Reset IDs - displays the 'Reset Auto
Increment Columns' dialog; used to
re-sequence Auto ID numbers,
eliminating gaps that occur from
repeated import/export of Packages,
thereby avoiding the maximum value
allowed by the database
· Project Compare - displays the 'Project
Compare' dialog, with which you can
compare one model database against
another, at a table record level
· Run Patch - displays the 'Run Patch'
dialog, which provides a means to run
patches that could be provided by
Sparx Systems, to update the database
structure of the current model
· Manage .EAPX/.EAP File - clicking on
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this item displays a pop-up menu with
these options:
- Repair .EAPX/.EAP File - use this
option to repair a .EAPX or .EAP file
that
has become damaged due to
system or network outages
- Compact .EAPX/.EAP File removes deleted records from the
database
tables
- Update .EAPX/.EAP File Indexes updates the selected .EAPX or .EAP
file to the
latest set of indexes (schema 1220)
- Make Design Master - prepare a
.EAPX/.EAP file for the creation of
database replicas
- Create New Replica - create
database replicas from the Design
Master file
- Synchronize Replicas - merge the
changes made to each replica
with the Design Master
- Remove Replication - remove from
the database the additional
information that is required for
managing database replication
- Resolve Replication Conflicts where two users have made conflicting
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changes to the model database,
manually decide which change will
override the other
Manage Firebird
- Update Index Statistics - optimize
indexes on Firebird databases

Clicking on the drop-down arrow
displays a short menu of facilities for
copying or sharing project data between
one project and another.
· Project Transfer - display the 'Project
Transfer' dialog; use this dialog to copy
the tables and records of one project
database to another
· Shared Repository - set up a shared
repository for basic reference data to be
shared between multiple
implementation models
· Export Reference Data - display the
'Export Reference Data' dialog; used to
select specific types of Reference Data,
for export to an XML file
· Import Reference Data - display the
'Import Reference Data' dialog; used to
import Reference Data from an XML
file into the current model
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Reference Data Panel
The 'Reference Data' panel is used to set up and manage the
metadata for a model. Reference data such as Resources and
Images is generally added as the model evolves. A wide
range of additional model content such as Templates,
Profiles, Patterns and Relationship Matrices can be stored as
Resources. Images can be saved in the model and used as
alternatives to the conventional geometric representations of
elements, to appeal to non-technical audiences.

Available Facilities
Facility

Description

Settings

Click on the drop down arrow to display
a menu of options for setting a wide
range of project-level parameters.
· Auto Names and Counters - set up and
manage the use of automatic name
generation
· Namespace Roots - manage a list of
Namespace roots for the current model;
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used mainly for code generation
Project Template Package - specify a
Package that holds diagrams and
elements that will be used as templates
for all new elements
Preprocessor Macros - manage a list of
preprocessor macros that will be used
when C and C++ code is imported into
the model
Code Engineering Datatypes - manage
the list of Datatypes that are used in
Code Engineering
Database Datatypes - manage the list of
Datatypes that are used in Database
Engineering
Colors - provides options to define and
manage a set of standard colors for use
in the current project
- Get Project Custom Colors
- Set Project Custom Colors

Click on this icon to display the 'Image
Manager' dialog. The Image Manager
provides facilities for storing images in
the current model, that can then be used
as alternatives to the standard geometric
shapes normally used to represent
elements on your model diagrams. Stored
images can be previewed, renamed and
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updated using this facility.
Resources

Click on this icon to display the
Resources window, from which you can
manage a variety of custom resources,
model Patterns, templates and
technologies.

UML Types

Displays the 'UML Types' dialog, from
which you can manage basic model
information, such as Stereotypes, Tagged
Value types and Cardinality settings.

Project Types Provides a range of facilities for
managing various Types of reference data
used in a project.
· People - manage the list of people
associated with the model, including
authors, resources, roles and clients
· General Types - manage project
factors, such as Status types,
Constraints, Difficulty and Priority
· Project Indicators - configure indicators
such as Metric, Risk and Effort types
· Maintenance - define and manage Test
types
· Estimation Factors - set up and manage
a list of estimation factors used for Use
(c) Sparx Systems 2018
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Case Estimation

(c) Sparx Systems 2018

Page 253 of 694

User Guide - User Interface

21 December, 2018

User Tools Panel
The 'User Tools' panel provides access to external tools. A
pre-defined selection of tools includes Windows Explorer,
ODBC Data Sources and System Information. You can
extend this list with any other tools of your choice.

Available Facilities
Which user tools appear in the list depends on what has
been configured on your workstation. For example, you
might add 'WINE Console' for the purpose of setting up
Subversion clients for Enterprise Architect under WINE.
Facility

Description

Windows
Explorer

Launches 'Windows Explorer'.

System
Information

Displays System Information pertaining
to your personal workstation.

ODBC Data
Sources

Launches the 'ODBC Data Source
Administrator' dialog, from which you
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can set up ODBC drivers for various
DBMS, thereby enabling Enterprise
Architect to connect to repositories
hosted in that DBMS.
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Specification - Specify Ribbon
The 'Specification - Specify' ribbon provides a selection of
facilities that you might use when creating and editing
model elements as a text-based specification, using the
Specification Manager. The ribbon becomes available when
the Specification Manager is open.

Panels
Panel

Description

Element

The 'Element' panel offers a range of
facilities for working with the elements
that are displayed in the Specification
Manager view. There are facilities for
adding new elements and viewing and
editing element properties.

Display

The 'Display' panel provides a range of
options that make it possible to tailor the
appearance of the Specification Manager
view, to better display the information
you want to examine. There are options
providing visual cues, such as
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highlighting the selected element and
using bold fonts to emphasize element
names, as well as options to filter the list
of elements that are displayed.
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Element Panel
The 'Element' panel brings together a range of facilities for
working with the elements that are displayed in the
Specification Manager view. There are facilities for adding
new elements, and for viewing and editing the Properties of
elements, as well as generating documentation in a number
of formats.

Available Facilities
Facility

Description

Element
Type

Click on the drop-down arrow to display
a range of options for filtering the type of
element created when you select to add a
new element using the Specification
Manager Add New button (not the
drop-down arrow):
· <Any> - when selected, and when you
click on the Add New button, the 'New
Element' dialog displays from which
you select the type of element to create

(c) Sparx Systems 2018

Page 258 of 694

User Guide - User Interface
·

·

·

·

·

(c) Sparx Systems 2018

21 December, 2018

Other - displays the full list of work
sets from which you select a specific
element to add to the list in the
<element types> section of the
drop-down
<element types> - a list of element
types that you have selected to create,
using the 'Other' option; click on one of
these, and every time you click on the
Add New button an element of that
type is created, until you specifically
select a different type
Clear Recent Items - clears the
<element types> list; a prompt displays
to confirm the operation, as it can be a
lengthy job to reconstruct the list of
selected element types
Note that if you have a specific element
type selected, that type is not cleared
from the list; selecting the <Any>
option allows you to clear the final
element type from the list
Use Last Created Type - sets the type
of element created to the type of the
last-created element
Limit Display to Selected Type - filters
the Specification Manager display to
only show elements of the selected type
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Click on the drop-down arrow to display
a short menu of options for adding
elements:
· Add Default - add a new element of the
default element type, which is the
currently-selected type of those set
using the 'Element Type > Other'
option
Alternatively, if no element type is
selected, the 'New Element' dialog
displays; use this to create an element,
the type of which becomes the default
type
· Add Child - add a new element as a
child of the currently selected element;
if a default element type has been
specified, an element of that type is
created, otherwise the 'New Element'
dialog is displayed, prompting you to
choose a type
· Repeat Previous - repeat the previous
element insertion action, creating a new
element of the same type, as a sibling
to the previously inserted element
· Show Toolbox - open and display the
Diagram Toolbox showing the
Common, Artifact and other 'pinned'
pages, or switch focus to the currently
opened Toolbox; you can drag element
Page 260 of 694

User Guide - User Interface

·

·

Documentati
on

(c) Sparx Systems 2018

21 December, 2018

icons from the Toobox to create
elements in the Specification Manager,
switching to other Toolbox pages if
necessary
Add Other - display the 'New Element'
dialog, prompting you to choose an
element type and create an element of
that type
Add Multiple Elements - display the
'Create Multiple Elements' dialog,
through which you can add several
elements to the Specification Manager
in one operation

Clicking on the drop-down arrow
displays a list of commands for
generating documentation and reports
based on the current Package, in a range
of different formats. Also available is a
facility for spell-checking the notes of
elements belonging to the current
Package.
· Generate Documentation
(RTF/PDF/DOCX) - displays the
'Generate Document' dialog, where you
can specify a range of parameters and
options that control generation of a
report document; you can select
document templates that control which
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elements are included in the report,
choose from a range of cover pages and
style sheets, and specify the file output
path and file format
Publish as HTML - displays the
'Publish as HTML' dialog, from which
you can create a report on the current
Package for display as a web page; the
dialog allows you to specify a range of
parameters and options to control the
report generation, such as style
templates, diagram themes, image
formats and the output file path name
Publish as Joomla! Article - opens the
'Publish as Joomla! Article' dialog; use
this dialog to specify connection details
for the Joomla! database, the content
template and diagram theme to use, as
well as which element information to
include, then initiate the generation
CSV Import/Export - opens the 'CSV
Import/Export' dialog from which you
can import and export element data
from Enterprise Architect, using CSV
files for exchange with spreadsheet
tools; the 'CSV Import/Export' dialog
allows you to define file specifications
that control which element properties
are exported and imported, as well as
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specifying the actual file to use for the
export or import
QA Reports and Metrics - open the QA
Reports window, which provides a
number of pages, each of which
provides facilities for reporting on a
particular aspect of the elements in the
current Package, namely Testing,
Maintenance, Dependency Details,
Implementation Details and Use Case
Metrics; each page provides a
particular set of parameters and options
to control that type of report generation
Spell Check Current Package - display
the 'Spell Check' dialog, which is used
to run the spell checker to review the
notes of all elements within the current
Package

Click on this button to begin editing the
element's Notes. If the Notes are hidden,
or displayed in Preview mode, the Notes
window will be used for editing,
otherwise the Notes field or column
within the Specification Manager will be
used. With the element selected, the
Space bar can be used as a keyboard
shortcut to begin editing.
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Edit
Selection

Click on this button to begin editing the
current element's Name. With the element
selected, the Enter key can be used as a
keyboard shortcut to begin editing.

Apply Auto
Naming

Display the dialog 'Apply Auto Naming
to Elements'. If you have set up
auto-naming conventions for the names
and/or Aliases of specific types of
elements, you can apply those naming
conventions to all of the elements of
those types in the currently selected
Package, in one operation. The dialog
groups by type those elements that have
defined auto-naming conventions, and
shows the effects of applying the
conventions to the element names and/or
Aliases. You can update the names of all
the elements in the Package, or select
only certain elements to update. The
facility for configuring auto-naming
conventions can be accessed via this
dialog.

Move Up

Click on this button to move the selected
element up in the Specification Manager
list. The element's position is also
reflected in the Project Browser.
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Click on this button to move the selected
element down one place in the
Specification Manager list. The element's
position is also reflected in the Project
Browser.
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Display Panel
The 'Display' panel provides a range of options that make it
possible to tailor the appearance of the Specification
Manager view, to better display the information you want to
examine. There are options providing visual cues, such as
highlighting the selected element and using bold fonts to
emphasize element names, as well as options to filter the list
of elements that is displayed.

Available Facilities
Facility

Description

Notes Format

Click on the drop-down arrow, to a
display a brief menu of commands for
customizing the visibility and style of
displayed element notes:
· Preview - show the Notes in Preview
mode; this limits the Notes displayed to
a maximum size and uses the Notes
window for editing
· Full Notes Inlined - show the complete
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Notes text for each element underneath
the element name; in this mode you can
create, edit and delete Notes text in the
Specification Manager and perform the
same operations as are available in the
Notes window context menu
Full Notes in Column - show the
complete Notes text for each element in
a new column next to the element
names; you have the same freedom to
edit the text as for 'Full Notes Inline'
Document View - columns are hidden
and Notes are displayed inline; use the
Enter key as a keyboard shortcut to
begin editing.
Hide - show no Notes at all; to edit or
view the Notes, open the Properties
window or docked Notes window

Clicking the drop-down arrow displays
options for applying level numbering and
indenting notes for elements contained
within the current Package.
· Enable - toggle the display of
automatically applied level numbering
within the Specification Manager and
the Project Browser, for elements
within the currently displayed Package
· Indent Description - if you have
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enabled level numbering, this option is
available to indent the element
description under each element name,
to align with the element name
Show
Columns

The Specification Manager can display a
wide range of properties for the elements
in the selected Specification Package,
with each property being shown in a
separate column. This command opens
the 'Field Chooser' dialog, allowing you
to customize the display of the columns
so that you show as many or as few as
you need, in an appropriate sequence.

Tagged
Value
Column

Display the 'Add Tag Value Column'
dialog. This dialog allows you to add a
specific Tagged Value to the list of
columns displayed by the Specification
Manager. If the current element already
has the named Tagged Value, the value
can be edited, otherwise the Tagged
Value must first be added to that element.

Bold Names

Use this option to turn on or off, the use
of Bold element names in the
Specification Manager view.
When on, all element names, including
the names of child elements, are
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displayed using bold font.
Collapsible
Regions

Use this option to enable the use of
Expansion boxes on parent elements.
If an element has child elements, you can
configure the Specification Manager to
either:
· Hide the child elements but provide an
expansion box that you can click on to
open and collapse the element
hierarchy (select the 'Collapsible
Regions' option), or
· Automatically display the child
elements indented underneath the
parent element (deselect the
'Collapsible Regions' option)

Highlight
Selection

Use this option to actively highlight the
currently selected row. When you click
on an element name or property, the
Specification Manager defaults to
indicating the selection with side bars
and/or underlines. You can, if you prefer,
also highlight the entire row of data for
the element, by selecting the 'Highlight
Selected Row' option. This is only
relevant when columns are visible.

Filter Bar

Use this option to show or hide the Filter
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Bar, which allows filtering of the visible
items in the Specification Manager view.
The Filter Bar displays underneath the
column headings and consists of a row of
fields, one field per column. As you type
a value into one of these filter fields,
element rows in the Specification
Manager list are hidden unless the value
in the corresponding column contains the
value in the filter field.
Element Icon

This option defaults to selected, to
display an element icon in front of each
element name in the Specification
Manager. The icon is a pictorial
representation of the element type, and
matches the element type icon shown
against the element in the Project
Browser. Deselect the checkbox to hide
the element icons.

Add New
Button

This option defaults to selected, to
display the Add New button and its
associated drop-down menu at the bottom
of the Specification Manager display.
Deselect the option to hide the button.

Font Size

Across the Specification Manager view,
the various display components such as
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parent element names, child element
names, Notes/property values and column
headings each have their own font size.
You can select to increase or decrease the
font sizes as a set across the display,
relative to the current sizes.
Specify the default font size based on
preference:
· Small
· Medium
· Large
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Document Edit Ribbon
The Document Edit ribbon provides a set of tools and
facilities for working with documents such as imported
document files and Linked Documents. It becomes available
when you open an editable document within Enterprise
Architect.

Panels
Panel

Description

File

The 'File' panel helps you to manage
internal document files, the way the
content displays, file security and objects
you can add to the content (such as
hyperlinks).

Edit

The 'Edit' panel provides a wide range of
facilities for manipulating and checking
the text within a document, and searching
the content for specific text strings.
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Font

The 'Font' panel helps you to completely
control the Fonts in a document,
including setting Bold, Italics and font
types and size. The color of text and
background can be altered to create
visually attractive documents.

Paragraph

The 'Paragraph' panel helps you to format
all aspects of paragraphs in a document
including left, right and center alignment
and justification. Text indentation, bullets
and numbered lists can be added to create
well formatted documents. Line spacing,
document styles and table borders can be
set to facilitate reading.
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File Panel
The 'File' panel helps you to manage internal document
files, the way the content displays, file security and objects
you can add to the content (such as hyperlinks).

Available Facilities
Facility

Description

Save

Click on this icon to save any changes
you have made to the document file. (The
icon is not available if no changes are
pending).

File

Click on the drop-down arrow and select
from a number of options for
manipulating the file contents as a whole.
· Import File - import the contents of an
existing document into the current file
· Save As (Export to File) - save your
document to a different document file
· New (Clear Document) - clear the
current contents of the document for
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redesign
Reload from Repository - reload the
file contents from the previously-saved
version
Page Layout - display the 'Page Setup'
dialog and set the page margins for the
file
Printer Setup - display the 'Print Setup'
dialog and confirm or reselect the core
parameters such as page size, or click
on the Properties button to define more
advanced settings
Print - display the 'Print' dialog to
define the print job for the document
Print Preview - display the document as
it would appear when printed

Click on the drop-down arrow to display
options for displaying the document
content on the screen.
· Page Layout Mode - toggle the text
display between page layout and
window layout
· Borderless Mode - toggle between the
setting of the 'Page Layout Mode'
option and a full-screen view of the
document with no margins
· Horizontal Ruler - display or hide the
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ruler at the top of the page, showing tab
stops and paragraph indentation marks
Vertical Ruler - display or hide the
ruler against the left edge of the page,
indicating the depth of the top and
bottom margins of the page
Status Ribbon - display or hide the
status ribbon at the bottom of the
editing panel, showing the current page
number, line number and column
number
Hidden Text - show text marked as
'Hidden' using the 'Font | Hidden Text'
option
Field Names - toggle between
displaying field names in the text and
displaying the field values
Hyperlink Cursor - toggle the cursor
icon when you 'mouse over' a
hyperlink, between the default image (a
line or arrow) and a pointing hand
Page Header/Footer - display or hide
the text of page headers and footers

Click on this icon to select from a set of
options for protecting the document from
being edited or deleted, so that it is safe
from accidental change. The Document
Editor defaults to locking against
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protection, so you first turn off the lock
and then protect either the whole
document or a selected block of text.
· Protect Document - toggle between
setting a lock to prevent any editing or
deletion of the entire document, and
removing protection so that changes
can be made
· Text Selection Lock - remove the lock
against setting protection on the text of
the document
· Snap to Grid - (defaults to on) applies a
grid to the tab markers and paragraph
indents, so that they snap to the nearest
sixteenth of an inch
· Watermark Picture - display an image
file browser and select an image to use
as a watermark in the document
· Remove Unused Lists - clear unused
list formats from the file when you
save it, to reduce file size
Model Link
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Click on this icon to select from options
to create a link between a text string that
you highlight in the document and a new
or existing object in the model.
· Glossary Definition - display the
'Glossary Detail' dialog, to create a
Project Glossary entry for the
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highlighted text string
New Model Element - display a short
list of types of object to create (or
select the 'Other' option to access a
wider range of object types) to generate
an object of that type from the
highlighted text string, in the current
Package; the object is linked to the
highlighted text in the document
Link to Existing Element - display the
'Select Classifier' dialog, through which
you browse for and select an element to
link to a highlighted text string
Hyperlink - create a hyperlink from the
highlighted text to an existing object in
the model; the 'Hyperlink Details'
dialog displays, through which you
specify the type of object to link to, and
its location

Click on this icon to display a list of page
magnification options between 75% and
200%, and an option to set a custom
magnification of the page anywhere
between 10% and 500%.
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Edit Panel
The 'Edit' panel provides a wide range of facilities for
manipulating and checking the text within a document, and
searching the content for specific text strings.

Available Facilities
Edit
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Click on this icon to display and select
from a list of editing operations you can
perform within your document. This list
includes facilities for tracking changes,
setting the direction of text flow, and
setting up list overrides.
· Cut - remove a highlighted text string
and hold it in the clipboard
· Copy - copy a highlighted text string
and hold it in the clipboard
· Paste - paste a text string from the
clipboard into the document at the
cursor position
· Paste Special - paste a
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specially-formatted object from the
clipboard into the document, such as
formatted text or an OLE object
Edit Picture - open the appropriate
graphics editor for the selected image,
to edit the image
Undo - roll back the last unsaved
change made; you can undo a
succession of unsaved changes
Redo - re-establish the last unsaved
change that has been undone; you can
redo a succession of undone changes
Select All - highlight the text of the
whole document for performing an
operation on it
Repaginate - repaginate the document,
and update the 'Page Number' and
'Page Count' fields and the Table of
Contents
Edit Section - display the 'Section
Parameters' dialog, on which you set up
the document properties to apply to the
text between two section breaks
Edit Style - display the 'Edit Stylesheet'
dialog, through which you create and
edit styles to apply to either paragraphs
of text or characters
Edit Input Field - display the 'Input
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Field Parameters' dialog, through
which you create or edit a field at the
cursor position in the document, for the
document users to enter data in
Edit Frame/Drawing Object - display a
short list of options for editing or
re-positioning a frame or drawing
object, including setting the direction
of text flow within the object
List and Overrides - display a list of
options for setting up paragraph
numbering list items, overrides and
levels
Page Header/Footer - display a
hierarchy of menus for creating, editing
and deleting the page headers and
footers of the document
Edit Footnote/Endnote - select to add
or edit either an end-note or the
footnotes of the current page
Track Changes - display a menu of
options for enabling and using Change
Tracking in the document
Apply Comment - create a comment of
the selected text, which displays in the
outside page margin
Edit OLE Object - open the appropriate
editor to edit the embedded OLE object
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Inline IME - set the document to accept
both single-byte characters and
double-byte characters, without having
to switch to an external Input Method
Editor (IME) application (double-byte
characters are complex characters used
in languages such as Japanese and
Cyrillic)
Document Text Flow - display the
'Document Text Flow' dialog, on which
you set the text flow for the whole
document to left-to-right, right-to-left,
or the default for the system

Click on this icon to display and select
from a list of text breaks, objects, special
text structures and special characters to
insert in the document at the cursor
position.
· Insert Break - display a short menu
from which you select to insert a page
break, section break or column break
· Embed Picture - insert an image file as
a picture in the document
· Link Picture - insert a link to an image
file in the document
· OLE Object - display the 'Insert Object'
dialog, from which you can select the
appropriate application to create the
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OLE object in the document
Insert RTF File - insert the complete
contents of another document file
Frame - inserts a small frame at the
cursor position, which you can then
drag to the appropriate size
Drawing Object - display the 'Select
Drawing Object' dialog and select to
insert a text box, rectangle or line,
which you can then drag to the
appropriate size
Page Number - insert a page number
field at the cursor position
Page Count - insert a page count field
at the cursor position
Date and Time - display the 'Insert
Current Date and Time' dialog, which
you use to create data and/or time
fields in the page layout, in one of a
selection of formats
Footnote/Endnote - select to insert a
footnote or an endnote linked to a
marker in the text; a dialog displays in
which you enter the marker character
and the note text
Bookmark - display the 'Bookmark'
dialog, which you can use to create,
locate and delete bookmarks in your
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document
Table of Contents - display a short
dialog in which you define the highest
and lowest heading levels to reflect in
the Table of Contents (you must define
the appropriate Table of Contents level
styles before doing this); when you
click on the OK button, the Table of
Contents generates
Data Field - display the 'Data Field
Parameters' dialog, in which you enter
the field name and the data value of
your own data field to insert in the
document
Text Input Field - display the 'Input
Field Parameters' dialog, in which you
enter the field name and characteristics
of a field in which the document users
can enter their own information
Checkbox Field -display the 'Checkbox
Field Parameters' dialog, in which you
define a checkbox that the document
users can select or clear
Selection Field - display the 'Selection
Field Parameters' dialog in which you
define a drop-down list field for which
the document users can select one of a
set of values to display
Hyperlink - display the 'Insert
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Hyperlink' dialog, on which you enter
the hyperlink text and the identifier for
the object being linked to, either within
the model or external to it
Non-breaking Space - insert a
non-breaking space at the cursor
position, so that if the document text
flows to a new page at that point, the
words linked by the space are kept
together
Non-breaking Dash - insert a
non-breaking dash at the cursor
position, so that if the document text
flows to a new page at that point, the
words linked by the dash are kept
together
Optional Hyphen - insert a hyphen at
the cursor position

Click on this option to remove a
highlighted text string and hold it in the
clipboard.
Click on this option to copy a highlighted
text string and hold it in the clipboard.
Click on this option to paste a text string
from the clipboard into the document at
the cursor position.
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Click on this icon to display a short menu
of options for locating a text string in the
document.
· Search - open the 'Search Text' dialog,
to specify the text string to locate and
the initial search parameters
· Search Forward - continue the search
forwards towards the end of the
document, to the next occurrence of the
defined text string
· Search Backward - continue the search
back towards the start of the document,
to the next occurrence of the defined
text string
· Replace - open the 'Replace Text'
dialog to search for a text string and
replace it with another, in selected text
or throughout the document
· Go to Line - display a short dialog in
which you specify the number of a line
in the document to 'jump' the cursor to
Click on this icon to display a set of
simple options for checking the spelling
in the document.
· Spell Check - start a spell check on the
document, and respond to all apparent
spelling errors
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Auto Spell Checking - set the system to
automatically check all existing text
and new text as it is typed or imported
into the document, underlining
apparent errors in red
Thesaurus - display the 'Thesaurus'
dialog in which you can check for
alternative or opposite terms for the
selected text string
Spelling Options - display the 'Spelling
Options' dialog, on which you identify
the text features to include or ignore in
the check, the language dictionary to
apply, what speed and accuracy of
check to accept
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Font Panel
The 'Font' panel helps you to completely control the Fonts in
a document, including setting Bold, Italics and font types
and size. You can alter the color of the text and highlighting
to create visually compelling documents.

Available Facilities
For many of these facilities, you can either select an icon
from the panel or an equivalent option from the 'Font'
drop-down menu.
Font
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Click on this icon to display a list of
options for changing the appearance of a
selected string of characters. These
options include:
· Normal - return changed text to the
Normal, unformatted style
· Bold - display and print the selected
text in bold
· Underline - underline the selected text
with a single line
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Double Underline - underline the
selected text with a double line
Italic - italicize the selected text
Subscript - make the selected text a
subscript
Strike - run a single line through the
selected text
Double Strike - run a double line
through the selected text
All Caps - change all selected
characters to upper case
Small Caps - change all selected
characters to small capitals
Fonts - display the 'Font Selection'
dialog, from which you select the
typeface and point size to apply to the
selected characters
Style - display the 'Select a Style'
dialog, from which you select a defined
style to apply to the selected characters
Text Highlight - display the 'Color'
dialog from which you select and apply
a background highlight color for the
selected text string
Spacing - display the 'Character
Spacing' dialog, on which you select to
expand or compress the spacing
between characters to a number of
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Twips that you define, or return the
spacing to Normal
Horizontal Scaling - display the
'Horizontal Character Scaling' dialog,
on which you set the width of the
selected characters to less than or
greater than 100%
Hidden - hide the selected text and
close up the remaining text; you can
reveal the hidden text using the 'View >
Hidden Text' option on the 'File' panel
Boxed - place a simple rectangular
frame around the selected text
Protect - prevent any changes to the
selected text; available if the 'Manage >
Protection Lock' option is deselected
on the 'File' panel
Hyperlink - make the selected text into
a hyperlink

Click on the drop-down arrow and click
on the text style to apply to the selected
text.
Click on the drop-down arrow and click
on the name of the typeface to apply to
the selected text.
Click on the drop-down arrow and click
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on the point size to apply to the selected
text. You can also type a point size into
the field.
Click on this icon to clear any formatting
you have applied to the selected text
using the other facilities of the 'Font'
panel.
Toggle the selected text between bold and
normal type.
Toggle the selected text between italics
and normal type.
Click on the icon to underline the
selected text with a single line, or to
remove the underline. Click on the
drop-down arrow and select:
· Double Underline - underline the
selected text with two lines, or to
remove the double underline
· Underline Color - display a color
palette from which you can select a
color for the existing underlines, or
define a color not presented in the
palette
Click on the icon to put a single
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strike-through line across the selected
text, or to remove the line. Click on the
drop-down arrow and select the 'Double
Strikethrough' option to do the same with
a double line through the text.
Subscript

Superscript

Character
Case

Highlight
Text

Text Color
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Click on this icon to toggle the selected
text between a subscript (below the level
of the adjacent text) and normal.
Click on this icon to toggle the selected
text between a superscript (above the
level of the adjacent text) and normal
text.
Click on the drop-down arrow and select
an option for changing the case of the
selected text:
· lowercase - convert all characters of the
selected text to lower case
· UPPER CASE - convert all characters
of the selected text to upper case
Click on the drop-down arrow to display
the 'Color Palette', and select or define a
color to show behind the selected text as
a highlight.
Click on the drop-down arrow to display
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the 'Color Palette', and select or define a
color in which to display the selected
text.
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Paragraph Panel
The 'Paragraph' panel helps you to format all aspects of
paragraphs in a document including left, right and center
alignment and justification. Text indentation, bullets and
numbered lists can be added to create well formatted
documents. Line spacing, document styles and table borders
can be set to facilitate reading the text.

Available Facilities
For many of these facilities, you can either select an icon
from the panel or an equivalent option from the 'Paragraph'
drop-down menu.
Table
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Click on this icon to display a list of
facilities for setting up and formatting a
table in your document. For options that
apply to cells, you can apply the settings
to the whole table, just the selected cells,
just the column(s) containing the selected
cells, or just the rows(s) containing the
selected cells.
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Insert Table - display the 'New Table'
dialog and specify how many rows and
columns to create; the table defaults to
showing the gridlines
Insert Row - add a row above the
current row, with the same row
properties
Insert Column - add a column to the
left of the current column, with the
same column properties
Merge Cells - merge the selected cells
into one cell, across or down the table,
or both
Split Cell Horizontally - split the
selected cell into two columns within
the row
Split Cell Vertically - split the selected
cell into two rows within the column
Delete Cells - display the 'Delete Table
Cells' dialog, in which you specify
whether to delete just the selected cells,
the rows containing the selected cells,
or the columns containing the selected
cells
Row Position - display the 'Table Row
Alignment' dialog, in which you align
the row borders with the left margin,
the page center or the right margin,
either just for the selected row or for
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the whole table
Row Height - display the 'Row Height'
dialog, in which you set the row height
to automatically adjust to the row
contents, or to only adjust above a
minimum height or to always be an
exact height (which you specify, in
Twips), for just the selected row or for
all rows in the table; content that
exceeds a fixed row height is not
visible in the table
Header Row - set the first row of the
table as a header row, which will be
duplicated at the top of each section of
the table flowing onto a new page
Keep Row Together - set the selected
rows to stay together if the table would
be split by an automatic page break at
those rows
Row Text Flow - display the 'Table
Text Flow' dialog, on which you
specify whether the text should flow
left-to-right or right-to-left, or the
direction of the system default; you can
apply the setting to selected rows or to
the whole table, and the rows are
aligned with the left or right margins of
the page to match the text flow
Cell Width - display the 'Set Cell
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Width' dialog, on which you specify
the width of the selected cells and the
indent of text within the cells, in Twips
Cell Border Width - display the 'Set
Cell Border' dialog on which you set
the width of the lines at any or all of
the top, bottom, left and right of the
selected cells, with the border around
either the selected cells as a block or
around each individual cell
Cell Border Color - display the 'Set
Cell Border Color' dialog, on which
you select one color for all the lines of
the cell borders or a color for each or
any of the border lines, clicking on the
border-name button to select the color
to apply
Cell Shading - display the 'Cell
Shading' dialog, on which you select a
shading of the background of the
selected cells, from 0% (no shading)
darkening to 100% (black)
Cell Color - display the 'Cell Color
Selection' dialog, on which you click
on the Set Color button and on a
background color for the selected cells
Cell Vertical Align - display the 'Cell
Vertical Alignment' dialog, on which
you align the text in the cells to the top,
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center or bottom of the cell, or the
baseline of the lowest top line of text
(if you have applied special formatting
to a cell within the selection)
Cell Rotate Text - display the 'Cell
Text Rotation' dialog, in which you set
the text to display horizontally (as
normal), rotated by 90 degrees
anticlockwise to flow from the bottom
of the cell to the top and left to right, or
rotated by 90 degrees clockwise to flow
from the top of the cell to the bottom
and right to left; this is especially
useful when the cells are in the outside
columns and act as labels for the
content of the body of the table
Select Current Column - select the
whole column containing the
currently-active cell
Show Gridlines - display or hide the
pale blue table and cell borders on the
screen, so that you can visualize the
layout of the table; the grid is not
printable - if you intend to print the
table, you must define the borders as
having at least minimum width

Click on this icon to display a list of
facilities for formatting the selected
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paragraphs of text in your document.
· Normal - align the text so that new
lines begin parallel with the left margin
of the page and flow to the right
· Center - align the text so that new lines
begin at the center of the page and flow
equally towards the left and right
margins of the page
· Right Justify - align the text so that
new lines begin parallel with the right
margin of the page and flow to the left
· Justify Both - align the text so that lines
begin and end parallel with the left and
right margins respectively
· Double Space - separate the lines
within the selected paragraph with
double line spacing
· Indent Left - indent the selected
paragraph one tab space in from the left
margin; each selection indents the text
one more tab space
· Indent Right - indent the selected
paragraph one tab space in from the
right margin; each selection indents the
text one more tab space
· Hanging Indent - indent the paragraph
except for the first line one tab space
· Keep Together - if there is a possibility
(c) Sparx Systems 2018
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that the selected text will be split by a
page break, set the text to be moved to
the top of the next page as a single unit
Keep With Next - if there is a
possibility that the selected paragraph
will be separated from the next by a
page break, set the paragraph to move
onto the same page as the next
paragraph
Widow/Orphan Control - prevent the
first and last lines of the selected
paragraph from being separated from
the rest of the text by a page break; at
least one other line will stay with or
move with the separated text
Page Break Before - set the selected
paragraph to print at the top of a new
page
Border and Shading - display the
'Paragraph Box' dialog, on which you
select to add borders above, below, to
the sides and - for multiple-column text
- between the columns of the selected
text, to format the borders as a single or
double thin line or thick line, to set the
color of the borders, and to add a
shaded background to the selected text;
as you increase the percentage shading,
the text color changes to contrast with
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the background
Paragraph Spacing - display the
'Paragraph Spacing' dialog, on which
you set the line spacing within the
paragraph to one of three standard
spacings, or to a point-spacing that you
define, or to a multiple line spacing that
you define; you can also set extra
spacing to apply before and/or after the
paragraph
Background Color - displays the 'Color'
dialog, on which you select a color as
the background of the selected text;
note that the text color does not
automatically change to contrast with
the background, and if this option is
used with the 'Border and Shading'
option it blocks that text change
Bullet - convert the selected lines of
text to a bullet list, or to convert a
bulleted list to unbulleted paragraphs
Numbering - convert the selected lines
of text to a numbered list, or to convert
a numbered list to un-numbered
paragraphs
Increase Level - increase the indent of
the selected text and move it further in
from the left margin
Decrease Level - if the selected text is
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indented from the left margin, reduce
the indent and draw the text closer to
the margin
List Numbering - display the 'Apply
paragraph numbering using Lists'
dialog, which you use to apply a
hierarchical numbering system to the
paragraphs in the document
Set Tab - display the 'Set a Tab
Position' dialog, on which you set the
interval for tab points, the type of tab
point, and what kind of lead-in line the
tab has, if any
Clear Tab - display the 'Clear a Tab
Position' dialog and select a single tab
from the list to clear
Clear All Tabs - clear all tab settings
from the document
Style - display the 'Select a Style'
dialog, on which you select a pre-set
style to apply to the selected text
Text Flow - display the 'Paragraph Text
Flow' dialog, on which you select the
direction in which text flows from the
opening words - Left-To-Right,
Right-To-Left, or the system default
direction

Click on this icon to convert the selected
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lines of text to a bullet list, or to convert a
bulleted list to unbulleted paragraphs.
Numbers

Decrease
Indent

Increase
Indent
Show
Paragraph
Markers
Fill
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Click on this icon to convert the selected
lines of text to a numbered list, or to
convert a numbered list to un-numbered
paragraphs.
If the selected text is indented from the
left margin, click on this icon to reduce
the indent and draw the text closer to the
margin.
Click on this icon to increase the indent
of the selected text and move it further in
from the left margin.
Click on this icon to toggle the display of
paragraph markers ( ) throughout the
document.
Click on this icon to display a selection of
colors, and select one to use as the
background color for the selected block
of text. If you want to clear the
background color, select the 'No Color'
option. If you want to use a color that is
not offered in the selection, click on the
'More Colors' option and select or define
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the color you require.
Left
Alignment
Center
Alignment
Right
Alignment
Left and
Right
Alignment
Line Spacing
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Click on this icon to align the left ends of
the selected lines of text with the left
margin of the page.
Click on this icon to align the centers of
the selected lines of text with the vertical
center of the page.
Click on this icon to align the right ends
of the selected lines of text with the right
margin of the page.
Click on this icon to align the ends of the
selected lines of text with the left and
right margins of the page.
Click on this icon to display a list of
conventional line spacings, and options to
customize line spacing and paragraph
spacing.
· 1.0
)
· 1.5
)
set the line spacing in the
highlighted text to the selected value
· 2.0
)
· 3.0
)
· Line Spacing Options - display the
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'Paragraph Spacing' dialog, on which
you set the line spacing within the
paragraph to one of three standard
spacings, or to a point-spacing that you
define, or to a multiple line spacing that
you define; you can also set extra
spacing to apply before and/or after the
paragraph
Borders and
Shading

(c) Sparx Systems 2018

Click on this icon to display a list of
options for adding borders to the table
cells you have selected - individual cells,
groups of cells, rows, columns or the
whole table. Other table-formatting
options are available from the 'Table'
option.
· Bottom Border - convert the gridline to
a black border along the bottom of the
selected cell(s)
· Top Border - convert the gridline to a
black border along the top of the
selected cell(s)
· Left Border - convert the gridline to a
black border along the left edge of the
selected cell(s)
· Right Border - convert the gridline to a
black border along the right edge of the
selected cell(s)
· No Border - remove any borders
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around and between the selected cells
All Borders - convert the gridline to a
black border around the selected cell(s)
and - for multiple cells - between the
selected cells
Outside Borders - convert the gridline
to a black border around but not
between the selected cells
Inside Borders - convert the gridline to
a black border between but not around
the selected cells
Insert Table - display the 'New Table'
dialog and specify how many rows and
columns to create in a new table
starting at the cursor position; the table
defaults to showing the gridlines
View Gridlines - toggle between
showing and hiding the pale blue table
outlines on the screen display; the
gridlines are not printable, so if you
want to show borders on the table in
the printed document, add cell borders
Borders and Shading - display the 'Cell
Shading' dialog, through which you
identify which grouping of table cells
to shade and the depth of shading to
apply
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User Button
This feature is available from Enterprise Architect Release
14.1.
For models with user security enabled, the name of the
currently logged in user will display in the ribbon header in
the top right of the screen.

If you click on the user's name, a drop down menu displays
providing a set of user options.

User Button Menu
Me Description
nu
Ite
m
R
e
m
e
m

Select this option to securely store the current user's
login credentials for the current model. The next
time the user attempts to open the model, the stored
credentials will be used instead of prompting the
user for their credentials.
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be
r
M
e

Note:
· This requires the option 'Allow 'Remember Me' to
be enabled on the 'Security Users' dialog
· The credentials are stored on the current computer
and can not be transferred between computers,
users or models

C
ha
ng
e
Pa
ss
w
or
d

Change the password for the logged in user.

Se Set an image to be used as an avatar for the logged in
t
user.
A
va
tar
L
og
In
as
A
no

Display the Login panel, on which you log into the
model as another user.
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Toolbars
Enterprise Architect provides a set of toolbars containing
convenient shortcuts to a wide range of common functions
that you can perform on your project as a whole through to
the individual modeling units. You can also customize the
toolbars by deleting and reordering the default button set.
The toolbars are initially displayed in the toolbar banner at
the top of the work area, but you can display them at the
foot of the work area, drag and dock them within the work
area, or float them over the application; this is useful when
you are using a certain set of functions a lot in a particular
area.
You can also dock toolbars to the edge of the Enterprise
Architect work area by dragging them by the title bar and
placing them against the appropriate edge.

Available toolbars
·
·
·
·
·
·
·

Default Tools Toolbar
Project Toolbar
Diagram Toolbar
New (UML) Elements Toolbar
(Current) Element Toolbar
(Current) Connector Toolbar
Code Engineering (Generation) Toolbar
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Navigator Toolbar
Debug Toolbar
Simulation Toolbar
Build Toolbar
Record (& Analyze) Toolbar
Workspace Layouts Toolbar
Status Bar
Notes Toolbar

Each toolbar has a drop-down arrow at the right-hand end.
This can be enabled or hidden using the 'Visual Style'
sub-menu. If you click on this drop-down arrow, the 'Add or
Remove Buttons' option displays. Select this option to show
a context menu listing the toolbars that are displayed on the
same line as the current toolbar, and an option to customize
toolbars - both your own and the system-provided toolbars.
You can select one of the toolbars identified on the context
menu to list the icons available through that toolbar. Click
on the icons as necessary to hide or show them in the
toolbar.
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Navigator Toolbar
The Navigator toolbar identifies the location of the Package
or diagram you are currently working in, and provides
options to change the focus to another level of the Package's
branch, perform relevant operations on the Package, and
locate other Packages in the model.

Access
Ribbon

Show > Portals > Window > Explore >
Navigator
Start > Explore > Browse > Navigator

Navigator Toolbar Options
Icon/Option

Action
Click on this icon to move one level
further up the location path, to the current
Package's parent Package. The child
Package is cleared from the path.
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Click on this icon to move one level
further down the Package's location path,
to the child Package that was previously
opened in this work session. If a child of
the current Package has not been opened,
the icon is not available.
Displays a 'breadcrumb trail' of branch
nodes under which the current Package is
located. You can continue to expand the
'breadcrumb' path to show a branch of the
child Packages contained within the
current Package.
A double chevron (<<) to the left of the
Package path indicates that you have
explored the Package branch to several
levels below the current Package, and it is
out of view to the left. Click on the
chevron to display the current Package
again.
As you click on the last Package in a
path, a list of its child Packages and
diagrams displays, from which you select
the next object for the path. If you click
on a diagram, the diagram opens in the
Diagram View. The listed diagrams
include child diagrams both of the
selected Package and of elements in that
(c) Sparx Systems 2018
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Package. The names of the child
diagrams of elements are preceded by the
parent element name.
If you click on an expanded path node,
the child nodes are closed and cleared
from the path.
As you select a Package or diagram, that
branch of the Project Browser is
expanded and the Package or diagram
you select is highlighted. This also sets
the context for any tools and utilities you
open to work on a Package.
In this field, type the name of a Package
and click on the icon to locate that
Package anywhere in the model, directly
using the Model Search facility.
Click on this icon to return focus to the
Start Page.
Click on this icon to display a set of
buttons, each of which invokes a task or
process that you can perform with the
current Package as the focus or target.
These tasks include:
· Highlight the Package in the
condensed, Package-only hierarchy of
the Find Package window
(c) Sparx Systems 2018
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Display the Package contents in the
Package Browser view
Display the Package contents in the
Specification Manager
Add a Model Package to the current
Package, using the Model Wizard
Add a new child Package to the current
Package
Add a new diagram to the current
Package
Use the Model Search to locate a text
string in the Package
Use the File Search to locate files
associated with the current Package
Access the Portals View through which
you can perform a wide range of other
operations on the Package

Navigator Toolbar Context Menu
If you right-click on a Package in the 'breadcrumb trail' a
context menu displays, providing a number of options for
reviewing the selected Package.
Option

(c) Sparx Systems 2018
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Specification
Manager

Open the Specification Manager to show
the element hierarchies contained in the
selected Package.

Show Gantt
Chart

Open the Element View of the Project
Gantt Chart, showing the elements in the
Package that have resources allocated to
them.

Show
Contents

Open the Package Browser and display
the contents of the selected Package

Go to
Package

Open the 'Find Package' dialog and
review the Package hierarchy of which
the selected Package is a part.

Add Model

Open the Model Wizard and use this to
create models underneath the selected
Package.

Add Package

Open the 'New Package' dialog and use
this to add child Packages to the selected
Package.

Add Diagram

Open the 'New Diagram' dialog and
create a new child diagram under the
selected Package.

Copy Path

Copy the Package path to the clipboard.
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You can then paste the path into a Model
Mail, Team Library Post or other text in
your model, as a reference to the
Package.
You can also capture a Package path by
right-clicking on the Package in the
Project Browser and selecting the
'Copy/Paste | Copy Node to Clipboard'
option.
Go To Path

Open the 'Select Package' dialog. Type or
paste into the 'Path' field a Package path
you want to follow.
· If typing, use a period (.) as the
separator between Package names in
the path; for example:
BusinessProcedures.Accounting.Recov
eries.Bad Debt Process
· If pasting, you might copy the path
from a message posted through any of
the communication facilities in the
model, or directly from the model itself
(see Copy Path)
Click on the OK button. The 'Navigator'
path field is updated, and any Package
content display you have open is
refreshed with the content of the Package
at the end of the path.
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Default Tools Toolbar
The Default Tools toolbar provides instant access to the
most commonly used tools in Enterprise Architect,
including file management, printing and technology
facilities.

Access
Ribbon

Show > Portals > Show Toolbar >
Default Tools

Default Tools Options
Icon/Option

Action

New Project

Click on this icon to create a new
Enterprise Architect project (as a .EAP,
.EAPX or .FEAP file).
Shortcut: Ctrl+N
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Open Project

Click on this icon to open an existing
project.
Shortcut: Ctrl+O

Save Current
Diagram

Click on this icon to save changes to the
current diagram.
Shortcut: Ctrl+S

Cut

Click on this icon to cut the selected
element(s) from the diagram and copy
them to the Enterprise Architect
clipboard.
Shortcut: Ctrl+X

Copy

Click on this icon to copy the selected
element(s) from the diagram to the
Enterprise Architect clipboard.
Shortcut: Ctrl+Space
Ctrl+C

Paste

Click on this icon to paste elements from
the Enterprise Architect clipboard as a
reference on the current diagram.
Shortcut: Shift+Insert
Ctrl+V

Undo

Click on this icon to undo the last action.
Shortcut: Ctrl+Z
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Redo

Click on this icon to redo the last undone
action.
Shortcut: Ctrl+Y

Print Preview

Click on this icon to display the current
diagram as it will appear when printed.

Page Setup
for Current
Diagram

Click on this icon to configure print
settings for the current diagram.

Print
Diagram

Click on this icon to print the current
diagram.
Shortcut: Ctrl+P

Package
Browser

Click on this icon to display the content
of the current Package as a list of editable
elements.

Project
Search

Click on this icon to display the Find in
Project window, to define, manage and
run model searches.
Shortcut: Ctrl+Alt+A

Technology
List

Click on the down-arrow and select the
active technology, to provide the
appropriate sets of Toolbox pages and the
diagram Space Bar context element menu
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options.
Help
Contents

Click on this icon to access the Enterprise
Architect Help.
Shortcut: F1

Notes
·

·

·

The Cut and Copy buttons are only enabled when an item
is selected on the current diagram
You can move this toolbar to any dockable position; it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
'Show > Portals > Show Toolbar > Default Tools' ribbon
option
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Workspace Layouts Toolbar
As you perform work on your model you use various
toolbars and windows; you will quite likely use the same
toolbars and windows regularly, in an arrangement that suits
the way in which you use the system. Rather than having to
re-open and arrange these tools at the start of each work
session, you can use either a predefined or a customized
work environment - or workspace. Workspaces:
· Automatically open and organize all the tools appropriate
to an area of work such as Requirements Management,
Code Engineering or Debugging
· Help a new user by:
- Opening the tools that are appropriate to a task so that
they can immediately get started, and
- Showing the user what tools they should become
familiar with for that area of work
· Help you switch rapidly to work environments for either
successive or completely different areas of work
· Re-establish a work environment that you have
accidentally or deliberately changed
To select, create and maintain workspaces you can use the
Workspace Layouts toolbar, which you can leave in the
Toolbar ribbon, dock to any main window edge or float
freely in a convenient location for quick access.
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Access

Workspace Toolbar Options
Icon/Option

Action

Save
Workspace
Layout As

Click on this icon to save the current
workspace layout under an existing name
or a new name, using the 'Save Custom
Workspace Layout' dialog.

Manage
Workspaces

Click on this icon to open the
'Workspaces' tab on the 'Workspaces and
Commands' dialog, to change to a
different workspace layout, create or edit
a layout, or delete a layout.

Select Layout Click on the drop-down arrow and select
an existing workspace layout to
immediately apply.
User-defined layout names have a
preceding asterisk; system-provided
layouts are not marked with an asterisk.

(c) Sparx Systems 2018

Page 325 of 694

User Guide - User Interface

(c) Sparx Systems 2018

21 December, 2018

Page 326 of 694

User Guide - User Interface

21 December, 2018

Project Toolbar
The Project toolbar provides tools for performing routine
tasks such as creating Packages, diagrams and elements,
searching the model and generating documentation.

Access
Ribbon

Show > Portals > Show Toolbar > Project
Tools

Project Toolbar Options
Icon/Option

Action

Reload
Project

Click on this option to close and reload
the current project, to bring in changes
made by other users sharing the project.
Shortcut: Ctrl+Shift+F11

New

Click on this option to create a new
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Diagram

diagram under the currently selected
Package, in the Project Browser.
Shortcut: Ctrl+Insert

New Package

Click on this option to create a new child
Package under the currently selected
Package, in the Project Browser.
Shortcut: Ctrl+W -

New Element

Click on this option to create a new
model element under the currently
selected Package or element, in the
Project Browser.
Shortcut: Ctrl+M

Find in
Project
Browser

Click on this option to run a simple
search within the Project Browser.
Shortcut: Ctrl+Shift+F

Find in
Project

Click on this option to search the entire
project or the selected Package using
pre-defined and customized searches.
Shortcut: Ctrl+F

Generate
Documentati
on

Click on this option to define and
generate Document reports on the
currently-selected Package.
Shortcut: F8
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Project Issues Click on this option to display the 'Project
Issues' dialog to review and create project
issues.
Project
Glossary

Click on this option to display the
'Glossary' dialog to review and create
glossary terms.

Set Options

Click on this option to display the
'Preferences' dialog, through which you
can personalize project display and
behavior options for your own login to
the project.
Shortcut: Ctrl+F9

Notes
·

·

You can move this toolbar to any dockable position; it
retains that position in subsequent sessions
You can hide or show the toolbar by selecting the 'Show >
Portals > Show Toolbar > Project Tools' ribbon option

(c) Sparx Systems 2018

Page 329 of 694

User Guide - User Interface

21 December, 2018

Diagram Toolbar
The Diagram toolbar provides tools to lay out and improve
the appearance of diagrams, including zoom controls to
better manage large diagrams and quickly identify key areas
of interest.

Access
Ribbon

Show > Portals > Show Toolbar >
Diagram

Diagram Toolbar Options
Icon/Option

Action

Align Left

Click on this option to align the left edges
of the selected elements.
Shortcut: Ctrl+Alt+Left Arrow

Align Right

Click on this option to align the right
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edges of the selected elements.
Shortcut: Ctrl+Alt+Right Arrow
Align Tops

Click on this option to align the top edges
of the selected elements.
Shortcut: Ctrl+Alt+Up Arrow

Align
Bottoms

Click on this option to align the bottom
edges of the selected elements.
Shortcut: Ctrl+Alt+Down Arrow

Bring to Top

Click on this option to bring the selected
elements to the top of the Z order, in front
of other elements on the diagram.

Send to Back

Click on this option to move the selected
elements to the bottom of the Z order,
behind other elements on the diagram.

Previous
diagram

Click on this option to display the
previous open diagram.
Shortcut: Alt+Left Arrow

Next
Diagram

Click on this option to display the next
open diagram.
Shortcut: Alt+Right Arrow

Home

Click on this option to display the default
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Diagram

Model Diagram (or default User
Diagram) if one has been defined.

Zoom In

Click on this option to zoom into
(magnify) the diagram by 10 percent.

Zoom Out

Click on this option to zoom out of
(shrink) the diagram by 10 percent.

Fit to View

Click on this option to adjust the diagram
size to fit within the Diagram View
screen.

Size View to
Page

Click on this option to adjust the diagram
size to fit within the page margins shown
on the screen.

Zoom to
100%

Click on this option to display the
diagram content at 100% of default size,
regardless of the Diagram View screen
size.

Layout
Diagram

(Not applicable to Behavioral diagrams)
Click on this option to automatically
layout the diagram in the Digraph layout
format.

Diagram
Properties

Click on this option to display the
diagram 'Properties' dialog, on which you
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can adjust the diagram display and
behavior properties.
Paste
Appearance

Click on this option to apply to the
selected element a set of appearance style
settings as defined for an element in the
'Default Appearance' dialog and loaded
into the Painter.

Delete
Selected

Click on this option to delete the selected
element(s) from the diagram.
Shortcut: Ctrl+D

Notes
·

·

·

·

Any actions that result in a change in diagram content and
appearance (including Zoom) are saved as changes to the
diagram
The Diagram toolbar can be docked to any main window
edge or floated freely in a convenient location for quick
access
You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
'Show > Portals > Show Toolbar > Diagram' ribbon
option
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UML (New) Elements Toolbar
The UML Elements toolbar provides facilities for quickly
and easily inserting UML and Technology elements into a
diagram, as well as notes, text, hyperlinks, diagram notes
and Diagram Legends. You can also add connectors to a
diagram using this toolbar.

Access
Context
Menu

On the Toolbar band, right-click and
select Modeling Toolbars > New Element

UML Elements Toolbar Options
Icon/Option

Action

New Element

Click on this option to add a new element
or connector to the current diagram.
The 'Toolbox Shortcut' menu displays,
from which you select the UML or
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Technology element or connector to
insert.
Shortcut: Space bar
New
Boundary

Click on this option and click on the
current diagram to add a simple
Boundary element to the diagram.

New Note

Click on this option and click on the
current diagram to add a new 'Note'
element to the diagram.
When you add the Note to the diagram
the Notes window displays, into which
you type the Note text.

New Text
Element

Click on this option and click on the
current diagram to add a simple text
element to the diagram.
When you add the Text element to the
diagram the Element Notes window
displays, into which you type the text.

Diagram
Click on this option and click on the
Note Element current diagram to add a Diagram
Properties Note to the diagram.
New
Diagram
Legend
(c) Sparx Systems 2018

Click on this option and click on the
current diagram to add a Diagram Legend
element to the diagram.
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The 'Legend' dialog displays, on which
you define the appearance of the Legend
element itself and the appearance of the
legends it defines.
New
Hyperlink

Click on this option and click on the
current diagram to add a Hyperlink
element to the current diagram. You can
use this element as a hyperlink to, for
example, a web page, file or help topic.
The 'Hyperlink Details' dialog displays.

New Note
Link

Click on this option, click on the current
diagram and 'drag' between a Note
element and the element it annotates, to
link the Note to the element.

Notes
·

You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
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Element Toolbar
The Element toolbar provides a number of options for
performing common operations on a selected element, such
as viewing the element's properties, operations or attributes.
You can also use it to specify the visibility of the element's
features and compartments, and to lock that element.

Access
Ribbon

Show > Portals > Show Toolbar >
Element

Element Toolbar Options
Icon/Option

Action

Edit
Properties

Click on this option to display the
element 'Properties' dialog, through
which you can view and edit the
properties of the selected element.
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Shortcut: Alt+Enter
Set Parent

Click on this option to display the 'Set
Parents and Interfaces' dialog, through
which you can set the parent or
implement interfaces for the selected
element.
Shortcut: Ctrl+I

Operations

Click on this option to display the
'Operations' page of the Features window,
through which you can create and edit
operations for the selected element.
Shortcut: F10

Attributes

Click on this option to display the
'Attributes' tab of the Features window,
through which you can create and edit
attributes for the selected element.
Shortcut: F9

Show
Features

Click on this option to display the
'Compartment Visibility' dialog, through
which you can specify which
compartments and information to display
for the selected element.
Shortcut: Ctrl+Shift+Y

Set

Click on this option to display the
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Runstate/Initi
alization

'Override Attribute Initializers' dialog,
through which you can set the element
run state, attribute initializers or - for
Parts - property value.
Shortcut: Ctrl+Shift+R

Find Element
Usage

Click on this option to find all other
diagrams in which the selected element is
used:
· If the element is not used in any other
diagram, there is no further action
· If the element is included in other
diagrams, the 'Element Usage' dialog
displays, listing those diagrams, and
you can choose which diagram to
explore
Shortcut: Ctrl+U

Find in
Project
Browser

Click on this option to highlight the
selected element in the Project Browser.
Shortcut: Alt+G

Configure
References

Click on this option to display the
'Custom References' dialog, on which
you can view the properties of other
elements and diagrams in the model to
which the selected element has custom
cross-references.
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Shortcut: Ctrl+J
Lock
Element

Click on this option to apply or release a
lock on the selected element. The element
is then blocked against or made available
for editing, respectively, depending on
which locking policy your system is
operating under.

Add Tagged
Value

Click on this option to display the
'Tagged Value' dialog, through which you
can add a Tagged Value to the selected
element(s).
Shortcut: Ctrl+Shift+T

Notes
·

·

You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by selecting the 'Show >
Portals > Show Toolbar > Element' ribbon option
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Current Connector Toolbar
The Current Connector toolbar provides a number of options
for quickly modifying the properties, style and direction of a
connector, showing and hiding a connector and/or its labels,
and pinning each end of the connector.

Access
Ribbon

Show > Portals > Show Toolbar >
Connector

Current Connector Toolbar Options
Icon/Option

Action

Connector
Properties

Click on this option to display the
'<connector type> Properties' dialog, on
which you can view and edit the
properties of the selected connector.
Shortcut: Enter key
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Connector
Style

Click on the drop-down arrow and select
the appropriate connector line style from
the list. The options are:
· Direct Route
· Auto Routing
· Custom Routing
Shortcut: Ctrl+Shift+D
Ctrl+Shift+A
Ctrl+Shift+C

Attach Note
or Constraint

Click on this option to display the 'Link
Relations' dialog, which you use to attach
a note or constraint to the selected
connector and to any other existing
connectors in the current diagram.
Double-click on the Note element to
display the 'Notes' dialog on which to
type in the text.

Show or Hide Click on this option to display the 'Label
Connector
Visibility' dialog, which you use to
Labels
specify which of the eight possible label
positions around the selected connector
are to be displayed.
Show and
Hide
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Relationships

you can show or hide each of the
relationships between elements within the
current diagram.
Shortcut: Ctrl+Shift+I

Reverse
Direction

Click on this option to simply reverse the
direction of the selected connector.

Pin
Connector
Ends

Click on the down-arrow to select the end
of the selected connector to pin to the
source and/or target elements. The pinned
end cannot be dragged off the point on
the element border to which it has been
fixed.
Some connector line styles (such as the
Tree styles) are not compatible with
pinning the connector ends; if a pinned
connector is changed to one of these
styles, the connector ends will be
unpinned.

Notes
·

·

You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
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'Show > Portals > Show Toolbar > Connector' ribbon
option
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Code Generation Toolbar
The Code Generation (Engineering) toolbar provides
options to import, generate, synchronize and open source
code. Some of these options display convenient menus to
quickly set, for example, the default language and default
database type for the project.

Access
Ribbon

Show > Portals > Show Toolbar > Code
Engineering

Code Generation Toolbar Options
Icon/Option

Action

Default Code
Language

Click on the drop-down arrow and click
on a coding language in the list, to set
that language as the default applied to all
newly created Class elements.
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Default
Database
Type

Click on the drop-down arrow and click
on a database type in the list, to set that
database type as the default applied to all
newly created database elements.

Import

Click on the drop-down arrow to locate
and select source files to import for
reverse engineering code into new Class
and Interface elements in the current
diagram.
Firstly, click on a coding language in the
drop-down list to identify the file types to
locate; this selection overrides the
project's default language for this
particular import.
When you have selected a language, a
browser dialog displays through which
you browse for the file location and select
from files with the extensions appropriate
to the coding language you selected.
When you click on a file, the system
immediately imports it and generates
elements from the file, in the current
diagram. The progress of the reverse
engineering is shown on a 'Progress'
dialog; click on the Close button when
the process is complete.

Generate

Click on this option to generate source
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Source Code

code for the currently selected single
Class element, through the 'Generate
Code' dialog.
Shortcut: F11

(Batch)
Generate
Source Code

Click on this option to batch-generate
source code for multiple selected Class
elements.
A 'Progress' dialog displays and, if no
target file is specified in the element, a
prompt for the location of a file to
generate the code into.
Shortcut: Shift+F11

Synchronize
Element with
Source

Click on this option to synchronize the
selected Class element with its associated
source code.
The synchronization completes as a
background task.
Shortcut: F7

Open Source
Code

Click on this option to open the source
code of the selected Class, in the default
code editor.
The source code must have been
generated, and the selected element must
be a Class. Otherwise no action is taken.
Shortcut: F12
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Notes
·

·

You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by selecting the 'Show >
Portals > Show Toolbar > Code Engineering' ribbon
option
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Record & Analyze Toolbar
The Record & Analyze toolbar provides access to tools for
recording the execution of program source code. From this
toolbar you can:
· Begin manual or automation recording of the currently
active application
· Step through manual execution
· Generate Sequence diagrams from a recording session

Access
Ribbon

Show > Portals > Show Toolbar > Record

Record & Analyze Toolbar Options
Icon/Option

Action

Recorder
Command

Click on the drop-down arrow to show a
menu of commands for recording the
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List

execution of Analyzer scripts.

Recording

Click on this icon to begin or resume
recording of the current program.

Manual
Record

Click on this icon to manually step-record
the current thread.

Auto Record
Selected
Thread

Click on this icon to auto-record an
execution trace for the current thread.

Step Through

Click on this icon to step into a function,
record the function call in the History
window, and step back out.
The option is enabled for manual
recording only.
Shortcut: Alt+;

Stop
Recording

Click on this icon to end the recording of
program execution.

Notes
·

The toolbar can be docked to any main window edge or
floated freely in a convenient location for quick access
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You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
'Show > Portals > Show Toolbar > Record' ribbon option
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Build Toolbar
The Build toolbar provides access to tools for building
program source code. From this toolbar you can:
· Build the currently active application
· Run the compiled application
· Run your Test and Deployment scripts

Access
Ribbon

Show > Portals > Show Toolbar > Build

Build Toolbar Options
Icon/Option

Action

Active
Analyzer
Script

Display the name of the currently active
analyzer script.

Execution

Click on this icon to display the
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Execution Analyzer window, which you
use to manage the Analyzer scripts for
your model.
Shortcut: Shift+F12

Build Current Click on this icon to execute the Build
Package
script for the selected Package.
Shortcut: Ctrl+Shift+F12
Cancel Build

Click on this icon to cancel execution of
the Build script currently in progress.

Run
Executable

Click on this icon to execute the Run
script for the selected Package.
Shortcut: Ctrl+Alt+N

Run Test
Script

Click on this icon to execute the Test
script for the selected Package.
Shortcut: Ctrl+Alt+T

Run
Deployment
Script

Click on this icon to execute the Deploy
script for the selected Package.
Shortcut: Ctrl+Shift+Alt+F12

Run Merge
Script

Click on this icon to execute the Merge
script for the selected Package.
Shortcut: Ctrl+Alt+M

(c) Sparx Systems 2018

Page 354 of 694

User Guide - User Interface

21 December, 2018

Notes
·

·

·

The toolbar can be docked to any main window edge or
floated freely in a convenient location for quick access
You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
'Show > Portals > Show Toolbar > Build' ribbon option
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Debug Toolbar
The Debug toolbar provides access to tools for debugging
program source code. From this toolbar you can:
· Attach to running processes
· Open a number of debugger windows
· Run, pause or terminate program execution
· Step over, step into or step out of program statements

Access
Ribbon

Show > Portals > Show Toolbar > Debug

Debug Toolbar Options
Icon/Option

Action

Drop-down
Command

Click on the drop-down arrow and select
options from the menu for attaching to a
running process and accessing a range of
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debugging windows.

Debug

Click on this option to begin or continue
execution of the current program.
Shortcut: F6

Pause-Resum
e

Click on this option to pause or resume
execution of the current program.

Step Over

Click on this option to step over the next
statement in the program.
Shortcut: Alt+F6

Step In

Click on this option to step into the next
function call in the program.
Shortcut: Shift+F6

Step Out

Click on this option to step out of the
current function call.
Shortcut: Ctrl+F6

Debug Stop

Click on this option to stop debugging the
current program.
Shortcut: Ctrl+Alt+F6
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Notes
·

·

·

The toolbar can be docked to any main window edge or
floated freely in a convenient location for quick access
You can move this toolbar to any dockable position and it
retains that position in subsequent sessions
You can hide or show the toolbar by clicking on the
'Show > Portals > Show Toolbar > Debug' ribbon option
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Status Bar
The Status bar displays at the bottom of the Enterprise
Architect work area. It shows information on the current
operation and certain key settings, and provides a 'zoom bar'
for adjusting the scale of the diagrams you view.
You can hide the Status bar itself by selecting the 'Hide
Status Bar' option on the 'General' page of the 'Preferences'
dialog ('Start > View > Preferences > General > Window
Behavior') and hide sections of the information that the
Status bar shows by right-clicking on it and de-selecting
either or both of the options:
· Zoom Slider
· Status Indicators

Access

Status Bar Sections
Section

Information

Object

Shows the type and name of the
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Type/Name

currently-selected diagram, or of the
currently selected element in the diagram,
or the status of the currently-displayed
Model Search.

Creation data

Shows the date and time at which the
current diagram was created and last
modified, the percentage zoom of the
current display, and the normal page size
of the diagram.

Element/Feat
ure Name

Shows the name of the currently-selected
element, attribute or operation.

Position and
Size

Shows the coordinates of the top left
corner of the selected element, and the
width and height of the element.

Zoom
Control

Allows a zoom to be applied to all
diagrams, regardless of existing zoom
levels and without impacting other users.
Values range from 100% to 150%.

Status
Indicators

Indicates the status of the Caps Lock,
Num Lock and Scrl Lock keyboard keys,
and the Connect to Cloud facility (bold
indicates 'in use', pale indicates 'off').

Display

A triangle in the bottom right corner
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indicates that the screen is not
maximized; you can drag the screen
corner to increase the size of the window.

Notes
·

The zoom facility has the same function as the 'Scale view
by' field on the 'Diagram Appearance' page of the
'Preferences' dialog; changes in the 'zoomed' display scale
of a diagram update this field and are applied to any other
diagrams that you open
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Introducing the Enterprise Architect
Windows
As you work on your project, creating and reviewing model
structures, you can make use of a wide range of system
windows that help you locate and focus on particular types
of object or object properties. To make your modeling tasks
even easier, you can fix these windows in a convenient
place on your screen, move them around, set them as
callable tabs or autohide them.
Using Workspace Layouts, accessible from the Ribbon bar
or from the Portal bar, you can also quickly load different
sets of windows that target particular tasks. You can also
save your favorite layouts and recall them when required.
You can access these windows through the ribbon options,
especially those under the 'Start > Explore > Browse' and
'Start > Explore > Properties' ribbon options.

Which are the Standard windows?
Window
Project Browser - The Project Browser is the primary
mechanism for navigating through and exploring your
model and is the starting point for many of the most
important features in Enterprise Architect. It lists the
model Packages, diagrams, elements and element features
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in a hierarchical structure, reflecting the arrangement of
Packages and elements within your model.
Properties window - The Properties window provides an
immediate method of viewing and editing the range of
properties of a selected object - element, diagram,
connector, attribute or operation.
Notes window - Notes are the main documentation
feature you use to describe an element, diagram, feature
or connector; in the documentation that Enterprise
Architect generates, notes feature prominently. You can
record and view notes on a modeling object using the
Notes window.
Responsibilities window - the Responsibilities window is
a three-tabbed window through which you can quickly
add, view, edit and delete rules applied to the selected
element. The entities that impose such rules are
requirements, scenarios, and constraints applied to the
element.
Model Views - The Model Views window provides a
mechanism for representing areas of your model in any of
a number of different ways, to capture a particular aspect
of the structure or purpose of the model.
Traceability window - Using the Traceability window you
can quickly see what elements are immediately linked to
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the selected element and in what relationships, and what
elements are indirectly linked via a chain of relationships.
You can also select a diagram and explore the
relationships of all elements in that diagram.
Tagged Values window - Tagged Values are a convenient
method of adding additional information to an element or
connector, beyond what is directly supported by UML. A
Tagged Value is the value of a property of a modeling
item, the property being called a tag.
You can create, view and edit Tagged Values for the
currently-selected modeling object using the Tagged
Values window.
Relationships window - The Relationships window lists
all the relationships of the currently-selected element, and
shows the properties of each relationship.
Element Browser - You can use the Element Browser to
summarize, review and manage a wide range of added-on
properties of the selected element. These added-on
properties include methods, attributes, Tagged Values,
relationships and responsibilities.
Team Library - The Team Library window provides a
structured internal forum that your team can use to
discuss aspects of the model content and development.
Diagram Toolbox - The Diagram Toolbox is a panel of
(c) Sparx Systems 2018

Page 364 of 694

User Guide - User Interface

21 December, 2018

icons that you drag onto a diagram to create elements and
connectors. Related elements and connectors are
organized into Toolbox pages, each page containing the
elements or connectors used for a particular type of
diagram.
Diagram Filters - You use the Diagram Filters window to
modify the display of diagram components so that
relevant items are immediately identified for the reader's
attention, without damaging the structure and integrity of
the model.
Layout Diagrams - The Layout Diagrams window
provides a set of diagram layout formats that you can
apply to a diagram you have created, to automatically
reorganize the layout to make it more readable.
Pan and Zoom window - The Pan and Zoom window
enlarges the current diagram by a percentage you define,
and displays a thumbnail view of it with a shaded
rectangle. As you move the shaded rectangle with the
mouse, the diagram shows the magnified items of the
structure underneath the rectangle.
Resources window - The Resources window provides
useful shortcuts and re-use functions for creating and
applying stock components in the current model. The
window contains a tree structure of Document templates,
Relationship Matrix profiles, Stylesheets, Patterns and
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commonly-used model elements. The window can also
provide access to UML Profiles and MDG Technologies,
although this is not the recommended route to these
facilities.
Source Code Viewer - The viewer displays the generated
source code for a selected Class element, and provides a
number of facilities for editing that source code.
Scripting window - The Scripting window hosts a flexible
and easy to use scripting capability to create scripts in
JavaScript, Microsoft JScript or VBScript. Using a built
in 'Repository' object, you can programmatically inspect
and/or modify elements within the currently open model.
The window provides tools to edit, run, debug and
manage your scripts.
Debug window - The Debug window provides a set of
facilities for starting, managing and halting a debug
session on the code generated from elements of your
model.
Maintenance window - The Maintenance window, or
workspace, lists the maintenance records (defects,
changes, issues and tasks) for a selected element, ready
for modification or addition. The window provides
several facilities for managing the maintenance records.
Testing window - The Testing window, or workspace,
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lists the test records for a selected element, ready for
modification or addition. The window provides several
facilities for managing the test records.
Learning Center - The Learning Center provides quick
access to a range of context-specific task guides in a
number of work areas of the system, such as Getting
Started, Modeling or Testing.
Project Management window - There are four versions of
the Project Management window, to record and manage
the resources, effort, risk and metrics associated with the
work in developing the area of the model represented by
the selected element.

Notes
·

On the Testing, Maintenance and Project Management
windows, any descriptive text, history, input or results for
a selected item are also displayed in the Notes window;
you cannot edit this text in the Notes window
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Dock Windows
When you are doing work using one or more of the
Enterprise Architect windows, you can re-position and/or
group the windows to make them easier to use. You can
easily move any window around the application workspace
and either dock (anchor) it against the top, bottom, left or
right edge of the workspace for long-term use, or just drop it
where it is most convenient for the moment (that is, leave it
floating).
All the windows are resizable, so you can also drag the
window margins to make the window a convenient size and
shape to display either just a column or row, or a large
section of the information it contains.

Dock a Window Against an Edge
Notice that the window docking is an insert, not an overlay;
in the illustration (step 3), the left border of the Start Page is
moved to sit just under the 'ticked man' icon in the toolbar.
The docking behavior varies depending on whether you
have already docked other windows on the screen, whether
you use the navigation compass or the compass point icons,
and where you drag the docked window before you release
the mouse button. If you drag and release the window over:
· A point of the navigation compass in the center of the
screen, the window sits inside existing docked windows
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(for example, in the illustration a window released on the
bottom, top or left icons of the navigation compass would
be docked to the right of the Traceability window)
· A separate compass point icon on the edge of the screen,
the window is docked on the outside edge of the screen
and existing docked windows are pushed inwards
· A point of the navigation compass at the edge of the
screen (only when there is already a docked window
there) the window is docked within the area occupied by
the previously docked window (for example, in the
illustration you could dock your new window as the left,
right, top or bottom segment of the Traceability window
space; the Traceability window itself is reduced in size to
accommodate the new docked window, but you can then
adjust the margins of the two docked windows to improve
readability)
· The center of the navigation compass at the edge of the
screen (only when there is already a docked window
there) the window is docked as a tab of a window frame;
see Dock Windows into a Frame
The highlighted area always indicates exactly where the
moved window will be docked, so you have an indication of
the effect before you release the window.
Ste Action
p
1

Click on the title bar of the window and start to drag
it towards the appropriate edge of the workspace. A
set of positioning icons display, consisting of a
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navigation compass in the body of the application
workspace and a compass pointer in the middle of
each edge.

2

Drag the window onto a compass point.
The screen display shades the area that the window
will fill, once you release the mouse button.

3

Release the mouse button to dock the window.
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The docked window initially fills the
previously-highlighted space, but you can drag the
margins to resize the window, if required.

Dock Windows into a Frame
A docked window does not overlap any other window, so if
you are docking several windows you progressively fill up
the workspace; however, you can avoid this by combining
the docked windows in a single tabbed frame by either:
· Dragging the title bar of each window up to the title bar of
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the first docked window, or
Dragging each window over the 'tabbed frame' icon in the
middle of the navigation compass, when the compass is
over the previously-docked window that you want to
combine the dragged window with; when you release the
mouse button, the window becomes a tab of the frame

The Project Browser becomes a tab.

You can move and re-dock a frame of windows as if they
were a single window.
To separate a window from a tabbed frame, click on the
window's tab at the bottom of the frame and drag it away.
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Close Docked Windows
If you do not want to have a docked window open any
longer, click on the window header and press Ctrl+F4. This
just closes the selected window; if the window is in a tabbed
frame, the other windows in the frame remain open.

Floating Windows
To float a window anywhere on the screen, click on its title
bar and drag it to where you want it to sit. The navigation
compass displays, but you ignore it in this situation.
Floating windows can overlay each other, which is
convenient if you want to compare information displayed in
two windows. You can drag one window under or over
another so that the relevant pieces of information are
adjacent, do your check, then move the windows apart
again.
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Autohide Windows
If you are using docked windows, you can have them
available for use but kept minimized or hidden until you
actually need to use them. The windows are represented by
tabs in the top, bottom, left or right margins of the work
area.

When you move the cursor over the tab, the window
displays and you can work within it. As soon as you move
the cursor out of the window, it automatically contracts into
the margin tab again. This means that you have the
maximum work area for performing your main task, with
the convenience of still being able to immediately use any of
a wide range of other windows.
If you have 'hidden' a tabbed frame of docked windows, the
'open' hidden window is represented by the tab, whilst the
others are indicated by an icon. In the illustration, the
Project Browser is the open hidden window in the frame
containing (continuing downwards) the Tagged Values
window, Package Browser and Model Views window. You
move the cursor over an icon to expand both the tab and the
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associated window.

Autohide a Window or Set of Windows
·

·

To set the displayed window to 'autohide', click on the
button in the top right corner of the window; any other
windows in the same frame as the open window are set to
'autohide' as well
To turn off 'autohide' for a particular window, or set of
windows within a frame, click on the button

Notes
·

·

You can only autohide docked windows; if you want to
autohide a floating window, dock it against a margin first
When you select an autohidden window, it immediately
displays against the nearest work area margin; you can
make the autohidden window slide out of and into the
margin by selecting the 'Animate Autohide Windows'
checkbox on the 'Window Behavior' page of the
'Preferences' dialog ('Start > View > Preferences >
General > Window Behavior')
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Code Editors
Enterprise Architect provides a number of editors that you
can use across the development environment to maintain
scripts, code and templates. Each editor has its own features,
but they are all based on a common Code Editor control.
You can have several code editors (or files within a code
editor) open at the same time, as separate tabs in the
Enterprise Architect central work area (the 'Diagram View').
You can also close the editors individually or all together,
leaving views of other types (such as diagrams or Document
reports) still open.

Code Editors
Editor

Detail

Shape Script
Editor

When you create a Shape Script to alter
the appearance of an element or
connector through the use of a stereotype,
you create and edit the script using the
Shape Script Editor, which provides a
number of facilities including
Intelli-sense for Shape Script attributes
and functions.

Code

You use the Code Generation Template
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Generation
Template
Editor

Editor to create and edit templates that
control the generation of code from your
model elements. The facilities include
Intelli-sense for a wide range of macros.

Transformati
on Template
Editor

You use the Transformation Template
Editor to create and edit templates that
control the transformation of model
structures from one domain to another
(typically a generic domain to a code
language specific domain).

Custom SQL
Search Filter
Editor

The Custom SQL Search Filter Editor is
available through the Model Search
facility, to define your own SQL searches
for locating information in your model.

Database
View Editor

The 'Database View editor' is available
within the 'View definition' field of a
database View element 'Properties'
dialog. You create the View definition in
SQL, using Intelli-sense for basic SQL
keywords and functions.

HTML and
CSS Style
Editor

You use the HTML and CSS Style Editor
to create web style templates from which
to generate HTML reports. These
templates incorporate a large number of
HTML Template Fragments, which you
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edit to customize the reports for your
specific purposes.
Source Code
Viewer

You use the Source Code Viewer to both
display and edit the source code files that
you have generated or imported for an
element. The Viewer/Editor is quite
adaptable, and you can access it and use
it in different ways for different types of
source code file.

Script Editor

Enterprise Architect provides a flexible
and easy to use scripting capability to
create scripts in JavaScript, Microsoft
JScript or VBScript for programmatically
inspecting and/or modifying elements
within the currently open model. You use
the Script Editor to create and edit scripts,
and to run, debug and stop an open script.

(c) Sparx Systems 2018

Page 378 of 694

User Guide - User Interface

21 December, 2018

Other Windows
Most of the standard windows you use in Enterprise
Architect have a specific, task-oriented purpose. However,
two windows have broader functions.

Broad-function windows
Window

Detail

System
Output
Window

This window displays the data that
Enterprise Architect generates during
each of a range of processes. The data
from each type of operation generally has
its own window tab.

Web Browser This view, or window, provides access to
internet facilities within your Enterprise
Architect work area.
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The System Output Window
The System Output window is used to display information
generated by internal Enterprise Architect processes, or by
Add-Ins and other third-party tools. The output from each
type of operation is generally displayed on its own tab
within the window. The System Output window can provide
useful information during long-running processes and batch
operations; through this window you can, for example:
· Validate information - many validation processes within
Enterprise Architect write out their results to this window
· Review progress information during the launch of
external processes
· Review command line output from Build and Test scripts
· Check parse errors generated during import of various
types of files
· Check Audit information
· Re-dock the Model Search results into a System Output
window tab for more convenient reference during various
operations

Access
Ribbon
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Ctrl+Shift+8

Options available on output data
Right-click on an item and select the appropriate context
menu option to:
· Copy the selected item to the clipboard
· Copy all items to the clipboard
· Save the output to an external file
· Clear the output from the window
· Rollback selected 'Get All Latest' updates to a Version
Controlled Package
You can also:
· Drag the selected items or text out of the System Output
window and onto a diagram to quickly create a named
element
· Double-click on model validation errors or parsing errors
to display the source of the error
· Switch between tabs to view different categories of
information from different tools

Notes
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(Corporate, Unified and Ultimate editions of Enterprise
Architect, with Auditing turned on) the 'Audit History' tab
of the System Output window shows a history of changes
to any element or connector selected from the:
- Audit View
- Package Browser
- Diagram List
- Project Browser, or
- Current diagram
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The Web Browser
The Web Browser provides access within Enterprise
Architect to internet facilities such as email, websites and
search engines; you define the default home website, search
engine and email exchange address on the 'General' page of
the 'Preferences' dialog. The Web Browser displays as a
tabbed view in the application work area, where the Start
Page and Diagram View display.

Access
Keyboard
Shortcuts

Ctrl+Alt+W

Options
To access the:
· Email exchange server, click on the
icon in the toolbar;
the appropriate email login window displays
· Web search engine (such as Google), click on the
icon
in the toolbar; the search engine screen displays
· Home web site, after displaying other web pages, click on
(c) Sparx Systems 2018
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the icon in the toolbar
To go directly to another website or email server (your
internet security permitting), in the 'Address' field type or
select the website http address and click on the Go button.

(c) Sparx Systems 2018

Page 384 of 694

User Guide - User Interface

21 December, 2018

Perspectives
Enterprise Architect provides a wide range of built-in
modeling languages and technologies, and sometimes it can
be difficult to identify the right tool or combination of tools
to meet your exact modeling requirement or scenario. The
Perspectives facility helps you to quickly and effectively
filter the overall modeling capability to a Perspective Set of
technologies that are relevant to a domain, such as
Requirements modeling, and further refine the tools for
more specific tasks within that domain, such as Business
Rule modeling, in a Perspective.
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Perspectives:
· Are selections of Technologies - some specific to one of
the many modeling languages - and their model and
diagram Patterns
· Are tailored to domain-specific modeling scenarios; when
you work in a specific domain, you can apply a
Perspective to expose appropriate facilities and hide all
others
· Remove the significant distraction of having to identify
and assess multiple technologies before proceeding with
your work
(c) Sparx Systems 2018

Page 386 of 694

User Guide - User Interface

21 December, 2018

Help you to select and apply an environment of particular
modeling languages or Technologies, enabling you to
work effectively and efficiently on the task at hand
· Help you to switch easily and quickly between tools when
your modeling focus changes; you simply select another
Perspective from the list of Perspective Sets (which
identify the domain they support) and Enterprise Architect
then hides the features of the previous Technologies and
applies the new environment
Initially you can select from the thirteen built-in Perspective
Sets and the more than 60 Perspectives they provide. As
your experience in modeling with Enterprise Architect
develops and your work becomes more specific, you can
create your own custom Perspectives. This helps you work
within a Technology that you might have recently imported
and activated, or apply a combination of Technologies that
are not associated in the built-in sets.
·

Overview
You select and switch to the required Perspective through
the 'Perspective' option at the top right of the screen, or
through the 'Start > View > Perspective' ribbon option, or
through the Perspective Portal in the Portals window.
Selecting a built-in Perspective automatically brings up the
Model Wizard, which provides a rich set of new model
patterns and guidance notes, filtered to narrow down the
available patterns, technologies, diagram types and other
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modeling constructs to the precise set required, with similar
actions on the Toolbox and dialogs. This helps you to
quickly build accurate, focused models with minimal 'noise'
and maximum fidelity.

Applying a Perspective mainly takes effect through the
Model Wizard, 'New Diagram' dialog, Diagram Toolbox
and 'Stereotypes' dialog, for creating model structures. The
Model Wizard and the 'New Diagram' dialog also allow for
swapping Perspectives instantly, making it easy to find and
change to the exact modeling tools required.
As a huge boost to models encompassing several disciplines
and modeling domains, selecting a Perspective provides its
Technology as an available development tool, whilst all
existing model structures that make use of the hidden
Technologies still render and work as normal. If you have a
model that contains, say, a BPMN View and a SysML
View, you might apply a Perspective to support the creation
of BPMN structures and see only BPMN templates and
Toolbox items in your BPMN development. But if you open
a SysML diagram during this work, you will still see the
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SysML Toolbox pages, Properties pages and options that
enable you to properly examine that diagram.
To further enhance your modeling experience, you can also
use the Perspective Sets window to filter the Perspectives,
hiding complete Perspective sets or individual Perspectives.
This enables you to reduce the list of Perspectives offered
for selection to just those you are likely to use.
For specific instructions on using Perspectives, see the
Using Perspectives Help topic.

System Perspectives
Enterprise Architect provides a rich set of more than 60
Perspectives built directly into the application. These have
been crafted to align with the multitude of roles that
modelers perform; these are grouped into Sets that make
finding the right Perspective quick and easy, and include:
· Business sets for Strategy, BPMN, Business Analysis and
more, helping the business user focus on their current task
· SysML, MBSE, Software, Simulation and others, for the
Systems Engineer and Software Engineer
· Archimate, TOGAF, Zachman Framework and
GRA-UML, version-specific sets that provide the most
common tools for the needs of Enterprise Architects
· SPEM, Process Guidance and MDG Technology Builder
for Project Managers
Each set contains a number of relevant and useful
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Perspectives. This diagram shows an example of three
Perspective Sets, each of which contains a number of
Perspectives.

For a more comprehensive description of the built-in
Perspectives, see the Types of Perspective Help topic.

Custom Perspectives
In addition to the built-in Perspectives, you can create any
number of your own Perspectives on the 'My Perspectives'
tab. While the built-in, or system, Perspectives typically
contain a single language or technology - for example the
BPMN (Business Process Model and Notation) Perspective
allows you to focus on just BPMN - custom Perspectives
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allow you to open a number of technologies at the same
time. For example, if you regularly create prototypes you
might want to create a 'Prototyping' Perspective that groups
the technologies and modeling languages you use in that
work.

Custom Perspectives do not automatically open the Model
Wizard; as they combine facilities, the system cannot
determine which sets of Patterns to automatically present.
These custom Perspectives can be created, modified and
deleted as the roles you perform change over time. For
information on creating custom Perspectives, see the
Customizing Perspectives Help topic.
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Using Perspectives
You can access both built-in and custom Perspectives from
a number of different points. This makes it easy to start your
work in the appropriate environment with the required
Perspective from any point, and to quickly and smoothly
switch to a different Perspective if the need arises.
Conversely, if you prefer to have a wider range of tools and
languages immediately available to you, you can select the
appropriate 'All <perspective group name>' option in the
Model Wizard or
list to filter for all Perspectives
for a domain.

Access
Currently, selecting a built-in Perspective will take you to
the Model Wizard. Some access paths first take you to the
Perspectives Portal, and when you select a Perspective from
there the Model Wizard opens and you choose the
appropriate Patterns to use (if required).
Other paths take you directly to the Model Wizard, where
you first select the Perspective and then the Patterns to use
(if required).
Selecting a custom Perspective does not open the Model
Wizard, because custom Perspectives generally expose
combinations of Technologies and facilities, and the system
cannot determine which Technology to open the Wizard at.
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Ribbons

Start > View > Perspective > Select a
Perspective (takes you to the Perspective
Portal) > <perspective group> >
<perspective>
Start > View > Perspective > Open
Model Wizard > Model Patterns >
Perspective
Show > Portals > Perspective >
<perspective group> > <perspective>
Design > Package > Insert > Insert Using
Model Wizard > Model Patterns >
Perspective

Context
Menu

Click on Package > Add a Model using
Wizard > Model Patterns > Perspective

Other

Start Page | Open a Portal | Perspective
Portal > <perspective group> >
<perspective>
(Top right corner of screen) >
>
<perspective group> > <perspective>
('My Perspective' options just apply the
custom Perspective)
Navigator Toolbar :
:
>
<perspective group> > <perspective>
In the 'New Diagram' dialog, click on the
Select From button and select the
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required Perspective

Use a Perspective
Having selected a Perspective, and depending on what
Perspective that is, you would expect to see impacts on the
Model Wizard, 'New Diagram' dialog, Diagram Toolbox
and 'Stereotypes' dialog, each offering fewer options more
specific to the Technology or operations you are working in.
For Perspectives related to Code Engineering, the code
editors and code generators might also have a narrower
focus.
As you develop models and/or engineer code, you will see
the structures you require and not have to pick them out
from many other structures of no relevance to the work you
are doing.

Filter Perspectives Available
You are unlikely to use all the Perspectives available in
Enterprise Architect, so if you prefer you can exclude
Perspectives - or even whole Perspective Sets - that you do
not need from display in the Model Wizard and
selection lists. You do this using the 'Perspective Sets'
dialog:
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Start > View > Perspective > Customize List of Available
Perspectives
The 'Perspective Sets' dialog displays, showing the 'Global
Perspectives' tab. If you want to exclude a complete
Perspective Set, deselect the checkbox against that category
in the 'Perspective Sets' panel.
Otherwise, if you want to just exclude individual
Perspectives, click on the parent Perspective Set name and
deselect the checkbox against the Perspective name in the
'Perspectives' panel. In this illustration, the CMMN and
Erikson-Penker Model Perspectives have been excluded
from display.

Note that if you exclude a Perspective Set, the checkboxes
against the individual member Perspectives remain selected.
However, the Perspectives do not show in the selection lists
in, say, the Model Wizard.
If you decide to show any excluded Perspectives again,
return to the dialog and select the appropriate checkboxes.
Alternatively, show all Perspectives as explained in Revert
to All Perspectives.
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Revert to All Perspectives
If you have filtered your list of Perspectives, or been
working within a specialized Perspective such as
Requirements or a customized Perspective, and you want to
return to a non-specific environment, either:
· Select the 'Start > View > Perspective > Clear Current
Perspective' ribbon option, or
· Click on the Reset button on the 'Perspective Sets' dialog,
or
· Select
> Manage > Show All Perspectives

Notes
·

·

A Perspective hides all Technologies that are not
specifically associated with it; if you use custom
Technologies in your work, add them to a custom
Perspective with any built-in Technologies you want to
use, so that all your specialized tools are available
together
An individual Technology might not present all facilities
you need (for example, ICONIX does not have a diagram
profile, so a Perspective that just exposes ICONIX does
not allow you to create diagrams); select or create a
custom Perspective that includes a Technology that adds
the missing facilities (in this case, the UML Technology)
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In order to function when included in and presented by the
Perspective, a Technology must remain enabled in the
'Manage Technologies' dialog
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Customizing Perspectives
Whilst Enterprise Architect provides a huge range of
Perspectives to select from, you might need to create others
more specifically tailored to your area of work, or to expose
Technologies that you have recently imported.
The methods for tailoring Perspectives to match your work
environment are described here.
Before starting, review the Technologies available to you in
Enterprise Architect and identify and enable those you want
to apply in a Perspective, either individually or in
combination. This is particularly important for any custom
Technologies you have, as selecting a Perspective makes
available only those Technologies it specifically contains
and hides all others - including your custom Technologies.

Access
These access options display the 'Perspective Sets' dialog,
through which you can create customized Perspectives.
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Ribbon

Start > View > Perspective > Customize
List of Available Perspectives > My
Perspectives
Design > Diagram > Insert > 'Hamburger'
icon > Manage > Customize > My
Perspectives

Other

(Top right corner of screen) >
>
Manage > Customize > My Perspectives

Create Custom Perspective
(c) Sparx Systems 2018
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Ste Action
p
1

Click on the New button. The 'Select MDG
Technologies' dialog displays.

2

In the 'Set Name' field, type a name for the custom
Perspective. Then select the 'Add' checkbox against
each MDG Technology to make visible.
You can click on the All button and then deselect the
checkbox against each Technology to hide, or click
on the None button to clear all selected checkboxes
and then re-select those against Technologies you
want to keep visible.
If you want to group your selections by Technology,
click on the 'Group Categories by Technology'
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checkbox.
3

When you have added the necessary Technologies to
the Perspective, click on the OK button. The
Perspective name displays in the 'Create Perspective'
panel, and the Technologies in the Perspective are
listed in the 'MDG Technologies' panel in
alphabetical order.
Notice that all buttons at the bottom of the window
are now enabled.

4

If you prefer to:
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List the Technologies in the Perspective in a
different sequence, click on each Technology
name in turn and use the Up Hand button or Down
Hand button to move the Technology name to the
correct position in the sequence
Remove a Technology from the Perspective, click
on the Technology name and click on the X button
to redisplay the 'Select MDG Technologies' dialog,
listing just the Technologies that are in the
Perspective; clear the 'Add' checkbox against the
Technology to be removed, and click on the OK
button
Add another Technology to the Perspective, click
on the + button to redisplay the 'Select MDG
Technologies' dialog, listing the Technologies that
are not already in the set; select the 'Add'
checkbox against the required Technology, and
click on the OK button

Click on the Save button and, if you have finished
setting up or changing a Perspective, click on the
Close button.

Delete a Custom Perspective
If you no longer want to use a custom Perspective, you can
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delete it from the list of those available.
On the 'My Perspectives' tab of the 'Perspective Sets' dialog,
click on the custom Perspective name and then on the Delete
button.
In response to the confirmation prompt, click on the Yes
button.
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Types of Perspective
There is a wide selection of built-in Perspectives provided
within Enterprise Architect, each containing a suite of
Patterns. This topic is a reference, describing each
Perspective Set and Perspective. You can also create your
own custom Perspectives, which are included as the last
item in the list of Perspective Sets.
To select and apply any of these Perspectives, see the Using
Perspectives Help topic.

Perspectives
Category

Perspectives

UML

The UML category provides the
Perspectives for normal UML modeling,
including:
· All UML Modeling - all modeling tools
and objects provided by the other
Perspectives in this group
· Structural - the modeling tools and
objects for structural UML models,
such as:
- Package diagrams
- Class diagrams
- Object diagrams
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- Composite Structure diagrams
- Component diagrams
- Deployment diagrams
Behavioral - the modeling tools and
objects for behavioral UML models,
such as:
- Use Case diagrams
- Sequence diagrams
- Timing diagrams
- Interaction Overview diagrams
- StateMachine diagrams
- Communication diagrams
- Activity diagrams

The Strategy category provides
Perspectives for:
· Mind Maps - the basic Mind Map
diagram
· Strategy modeling, such as:
- Organizational Charts
- Value Chains
- Strategy Maps
- Balanced Scorecards
- One-level and Two-level
Flowcharts
- Decision Analyses with Trees and
with Decision Tables
- SWOT Analyses
· Risk Analysis - the Risk Taxonomy
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Threat Community diagram
Analysis

The Analysis category provides
Perspectives for:
· White Boarding - diagram structures in
Whiteboard and/or Hand-drawn mode
· Simple Analysis, based on a Two
Activity Process
· Case Management Model & Notation
(CMMN) analysis, with a:
- Claims Management example
- Basic 5-Task Plan
- Three Choice Tasks Pattern
- Two Phase Case Plan
· Erikson Penker modeling, the basic
business process
· Web Modeling, based on a simple Java
Server Page (JSP) model

Requirements The Requirements category provides
Perspectives for:
· Creating a range of Requirement
Hierarchy diagrams, and a
Requirement Specification View
· Working with Decision Modeling
Notation (DMN) to:
- Create a simple Decision diagram
with a Decision Table
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- Set up a DMN Business
Knowledge Model
- Model a DMN Decision
Setting up a Business Rule model
Setting up one-level and two-level Data
Flow models

UX Design

The UX Design category provides a
number of Perspectives for modeling user
interfaces on various devices, including:
· Wireframing for various phone and
tablet devices
· IFML Interaction flows on desktop
applications, information entry,
interaction on wireframe devices, and
information searches
· A basic Enterprise Architect user
interface model for a window with lists
and combo boxes
· An alternative simple user interface
· Win 32 User Interface modeling

Business
Modeling

The Business Modeling category
provides these Perspectives:
· BPMN - Patterns for:
- BPMN 2.0 modeling
- BPEL 2.0 Starter model
· BPSim - Patterns for BPMN 2.0 and
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Engineering
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BPEL 2.0 modeling, plus:
- Patterns for Business Process
Simulation (BPSim) constructs and
- Patterns for a number of BPSim
Case Studies
Business Model Patterns for Business
Use Case models and Use Case
Realization
Business Interaction model Patterns
BABOK - a wide range of Patterns
supporting models for:
- Strategies
- Collaboration activities
- Analyses
- Business Processes
- Project Management activities
- Standard business documents
BIZBOK - Patterns for modeling
BIZBOK activities

The Software Engineering category
provides Perspectives for software
development, including:
· Code Engineering, modeling programs
in a number of programming languages
· Service Oriented SOMF 2.1, for
several Conceptual Association types
· SoaML, for modeling aspects of basic
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service provision
XSLT Feature demonstrations, such as
XSLT transforms and debugging
ICONIX modeling
GOF Patterns for Creational, Structural
and Behavioral models

The Systems Engineering category
provides Perspectives to support systems
Engineering projects under:
· SysML1.5, with a wide range of
Patterns for generating:
- Project structures
- Requirements diagrams
- Use Case diagrams
- Activity diagrams
- Block Definition diagrams
- Internal Block diagrams
- Parametric diagrams
- State Machine diagrams
- Libraries
- Model elements
- Modelica Case Studies
· UAF, with Patterns for:
- Strategic Views (St-xx)
- Operational Views (Op-xx)
- Services View (Sv-xx)
- Personnel Views (Pr-xx)
- Resources Views (Rs-xx)
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- Security Views (Sc-xx)
- Projects Views (Pj-xx)
- Standards Views (Sd-xx)
- Actual Resources Views (Ar-xx)
- Dictionary View (Dc)
- Requirements View (Rq)
- Summary and Overview (SmOv)
- Information View (If)
- Parameters Views (Pm-xx)
- The SysML 1.5 sets (as listed,
except for Modelica Case Studies)
UPDM with Patterns for:
- UPDM Frameworks (DoDAF and
MODAF)
- DoDAF All Viewpoints (AV-n)
- DoDAF Capability Viewpoints
(CV-n)
- DoDAF Data and Information
Viewpoints (DIV-n)
- DoDAF Operational Viewpoints
(OV-n)
- DoDAF Project Viewpoints (PV-n)
- DoDAF Services Viewpoints
(SvcV-n)
- DoDAF Standard Viewpoints
(StdV-n)
- DoDAF Systems Viewpoints
(SV-n)
- MODAF All Views (AV-n)
Viewpoints
Page 410 of 694

User Guide - User Interface

·

Database
Engineering

(c) Sparx Systems 2018

21 December, 2018

- MODAF Acquisition (AcV-n)
Viewpoints
- MODAF Operational (OV-n)
Viewpoints
- MODAF Service Oriented Views
(SOV-n) Viewpoints
- MODAF Strategic Views (StV-n)
Viewpoints
- MODAF System Viewpoints
(SV-n)
- MODAF Technical Standards
Views (TV-n) Viewpoints
Executable State Machines, with
various Patterns including a set to
demonstrate case studies

The 'Database Engineering' category
provides sets of Perspectives for
modeling a range of DBMS repositories,
including:
· Starter Model and Model Structure
Patterns for each of the main DBMSs
supported by Enterprise Architect
· Patterns for simple Entity Relationship
models
· Patterns for simple ArcGIS projects
and workspaces
· A simple Enterprise Architect Data
Modeling diagram Pattern
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Enterprise
Architecture

The Enterprise Architecture category
provides a number of Perspectives for
Enterprise Architecture frameworks,
including:
· ArchiMate, supplying Patterns for:
- Basic viewpoints such as
Organization, Application Usage and
Service Realization
- Motivation Viewpoints such as for
Stakeholders, Principles and
Requirements Realization
- Strategy Viewpoints
- Implementation and Migration
Viewpoints
· TOGAF, with Patterns for:
- A Starter Model
- The Architecture Development
Method
- The Enterprise Continuum
- The Technical Reference Model
- Catalogs
· Zachmann Framework
· GRA-UML annotations library and
starter model

Information
Exchange

The Information Exchange category
supports a number of built-in
technologies, providing Perspectives and
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basic model Patterns for:
· Ontology Definition (ODM)
· Geographic GML
· Archetype Modeling Language
· NIEM 3.0, 3.1, 3.2 and 4.0 Reference
Models and NIEM 3 and 4 starter
models
· SIMF
· Universal Business Language
· UPCC 3.0
· UMM 2.0 Profile
Construction
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The Construction category provides these
Perspectives:
· Project Roadmaps, for a range of
management work areas
· Kanban workflows
· Document Publishing for types of
Project document
· Dashboards and Charts for various
scenarios
· Reviews and Discussions to define the
structure and function of these team
collaboration activities
· Test Management to define how tests
are planned and managed
· Change Management to define a model
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for managing issues and changes
Resource Management to define how
resources are identified and managed
Legends to define how diagram
legends are set up and used

Management

The Management category provides
Perspectives to support:
· SPEM
· Process Guidance - working up process
templates
· The Enterprise Architect Script Library
· The MDG Technology Builder

My
Perspectives

The 'My Perspectives' category holds the
Perspectives that you have created for
yourself, using the 'Start > View >
Perspective > Customize List of
Available Perspectives' option. For
further details, see the Customizing
Perspectives Help topic.
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Portals
The Portals provide a high level, logical grouping of
Enterprise Architect's tools and facilities, to form an entry
point into specific features that you might need to apply.
They provide access to common tools, custom searches,
window layouts and Perspectives. For example, if you want
to run searches for particular information in the model, or
access the windows that are appropriate to a particular set of
actions, you can select a Portal to identify and provide
access to those facilities. This makes it easier to set up a
work environment within the system, and carry out your
tasks in a smooth sequence.

Access
Ribbon

Show > Portals > <select Portal>

Keyboard
Shortcuts

Shift+Alt+P

Other

Start Page : Open a Portal | <select
Portal>
Navigator Toolbar :
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The Portals window
The Portals window displays on either the left- or right-hand
side of the Enterprise Architect work area. It contains the
currently-selected Portal and, under the title bar, a Portal
selection button for changing the selected Portal.
Once the Portals window is displayed, it remains visible
until you specifically select to hide it, or to auto-hide it as a
tab on the side of the display, using the Portals window
context menu options (see the Portals Window Context
Menu table later in this topic).

Portals
The system currently provides nine Portals, each consisting
of a collapsible hierarchy of option groups and options. If a
Portal is too long to display the entire contents at once, a
scroll button displays at the top and/or bottom of the Portal.
Click on these buttons to scroll the Portal contents up or
down (or use the scroll wheel on your mouse, or the
keyboard arrow keys).
Portal
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Perspective

Provides a range of model Patterns from
which you can generate model structures
for particular areas of work. The Patterns
are organized into groups within
Perspectives, and presented for selection
through the 'Model Patterns' tab of the
Model Wizard, and through the 'New
Diagram' dialog. The Portal also includes
a category for Perspectives that you have
created yourself, which provide the
Patterns from MDG Technologies you
have specified in the Perspective.

Workspace

Provides links to the system-provided
workspaces and working sets that you
might use to lay out the Enterprise
Architect work area, and to any working
sets and workspaces that you have
created yourself. The categories provided
are:
· Customised ('My Workspaces')
· Core
· Design
· Software
· Simulation
· Construction
· BABOK
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Window

Provides links to the Enterprise Architect
windows that you might use. The
windows are grouped under the areas of:
· Exploring the model
· Properties
· Diagrams
· Specialized Tools
· Trace
· Collaborate
· Test
· Task
· Maintenance
· Templates

Status

Provides links to run searches that locate
recent activities of various types across
the model. The searches are grouped to
identify:
· Recently changed elements, documents
and discussions
· Recent formal reviews
· Recent informal Discussions
· Recently active Tasks
· Results of recently-run tests
· Recently reported and investigated
Changes
· Recently reported and investigated
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Defects
Recently reported and investigated
Issues

Extend

Lists the MDG Technologies currently
active in your model - such as ArcGIS or
NEIM - and for each one provides links
to the facilities for working with those
technologies within Enterprise Architect.

Execute

Provides a wide range of options that
help you to:
· Perform Execution Analysis on your
model - building and running the
Analyzer scripts
· Record, Profile, Debug and Simulate
the execution of your modeled
application
· Access various windows that display
specific aspects of debugging and
simulating an application
· Create and edit code for your
application

Revisit

Provides links to the working sets,
diagrams, files, documents and system
windows that you recently had in use, and
the diagrams that you have open

(c) Sparx Systems 2018

Page 419 of 694

User Guide - User Interface

21 December, 2018

currently.
Guidebook

Provides links to the library of Enterprise
Architect User Guides in PDF format.
The Portal initially displays with ten
categories of document, each of which
can be expanded to a list of the PDF
documents in that category.

Learning

Provides links to either the web version
of the Enterprise Architect User Guide,
or the locally-installed Help if you have
downloaded that. The Portal also
provides links to a number of useful web
pages on the Sparx Systems website, such
as the Resources, Tutorials, Webinars and
Video Demos pages.

Portals Window Context Menu
Right-click on the Portals Window title bar to display the
context menu. You can select the options in this table:
Portal

Description

Dock Left

Docks the Portals window on the left
hand side of the work area.
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Dock Right

Docks the Portals window on the right
hand side of the work area.

Auto Hide

Condenses the Portals window to a tab on
the edge of the work area. Mouse-over
the tab to re-open the Portals window,
move the cursor off the window to return
it to a tab.

Hide

Hides - and effectively closes - the
Portals window. To re-open the window,
select the appropriate option under the
'Show > Portals' ribbon icon or the
appropriate icon on the Start page.

Auto
Collapse
Groups

Automatically collapses the
currently-selected group of options when
you expand another group.

<list of
portals>

If you right-click anywhere in the Portals
window other than the window title, the
list of Portals displays. Click on a Portal
name to change to that one in the
window.
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Perspective Portal
The Perspective Portal provides a number of work
Perspectives grouped by general work area. Each
Perspective filters the modeling windows and dialogs to
present only the modeling Patterns you might use in the
work defined by the Perspective. When you select a
Perspective the Model Wizard displays, showing the 'Model
Patterns' tab and providing the model templates that you
might use to initially create a model supporting the type of
work.
For example, if you select the 'Construction > Kanban'
Perspective the Model Wizard presents three Kanban
Patterns for one-stage, two-stage and three-stage workflows.
As you open or refresh other windows, such as the 'New
Diagram' dialog, the objects you can initially select are
filtered to provide - in this example - only Patterns for
developing Kanban diagrams.
The Perspectives you can select from the Portal, the Patterns
they provide, and the facilities for managing Perspectives
are described in the Perspectives section under 'Modeling
Tools | Building Models' in the Help.

Access
Ribbon
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Keyboard
Shortcuts

Shift+Alt+P :
Perspective

Other

Start Page | Open a Portal | Perspective

|

Navigator Toolbar :
:
:
| Perspective
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Workspace Portal
The Workspace Portal provides links to apply defined
workspaces to your Enterprise Architect user interface.

Access
Ribbon

Show > Portals > Workspace

Keyboard
Shortcuts

Shift+Alt+P : Select Portal | Workspace

Other

Start Page | Open a Portal | Workspace
Navigator Toolbar :
:
:
| Workspace

Facilities
Category

Options

My
Workspaces

This section provides the Workspaces
that you have customized for your
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particular use.
Core

The options in this category apply some
of the basic workspaces to your work
area. These include:
· Basic Diagramming
· Collaborate
· Core Modeling
· Default
· Explore
· Wide View

Design

The options in this category apply some
of the model design workspaces to your
work area. These include:
· Database Modeling
· Gap Analysis
· Requirements
· Schema Design
· Trace by Matrix
· Use Case Modeling

Software

The options in this category apply some
of the software development workspaces
to your work area. These include:
· Code Editing
· Debug
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Profile
Record
Software Engineering

Simulation

The options in this category apply some
of the simulation workspaces to your
work area. These include:
· BPSim
· DMN-Sim
· Simulation
· SysML-Sim

Construction

The options in this category apply some
of the project construction workspaces to
your work area. These include:
· Change
· Maintenance
· Resource Management
· Support
· Task Management
· Testing
· Work Items

BABOK
Guide

The BABOK Reader option applies the
BABOK workspace to your work area.
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Window Portal
Provides links to the Enterprise Architect windows you use
to navigate through, develop and manage your models.

Access
Ribbon

Show > Portals > Window

Keyboard
Shortcuts

Shift+Alt+P :

Other

Start Page | Open a Portal | Window
Navigator Toolbar :
:
| Window

| Window

:

Facilities
Type

Facilities

Explore

Provides links to display the:
· Project Browser - if the Project
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Browser is not currently open, this
option opens it on the left of the
workspace
Context Browser
Element Browser
Navigator
Resources window
Model Views
Model Search
File Search
System Output window

Properties

Provides access to these facilities:
· Properties Window
· Notes dialog
· Tagged Values window
· Summary screen
· Document window
· Features dialog
· Requirements window
· Construct screen

Specialized
Tools

Provides access to these facilities:
· Specification Manager
· Scenario Builder
· Constraints, through the
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Responsibilities window
Decision Table Editor
Database Builder
Schema Composer

Diagram

Provides access to these facilities:
· Diagram Filters
· Pan and Zoom window
· Diagram Layout tools

Trace

Provides access to these facilities:
· The Traceability window
· Relationships window
· Relationship Matrix
· Gap Analysis Matrix

Collaborate

Provides access to the team
communication facilities of:
· Finding All Reviews
· Finding All Discussions
· Conducting Reviews
· Conduction Discussions
· Model Mail
· Calendar
· Chat
· Team Library
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Test

Provides the facilities to create and
review Tests of all types supported by
Enterprise Architect.

Task

Provides access to these facilities:
· Project Gantt Chart
· Personal Gantt Chart
· Resource List

Maintenance

Provides access to the facilities for
recording and managing:
· Changes
· Defects
· Issues
· Tasks
· Events
· Decisions
· Effort
· Risks
· Metrics

Templates

Provides access to the facilities for
maintaining:
· Code Engineering Templates
· DDL Templates
· Document Templates
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Status Portal
The Status Portal provides links to searches that extract
information on the current status of objects in the model.
The searches are grouped to identify:
· Recently created elements, documents and discussions
· Recent posts, discussions and formal reviews
· Results of recently-run tests
· Recently reported and investigated Defects
· Recently reported and investigated Issues
· Recently started, finished or active tasks

Access
Ribbon

Show > Portals > Status

Keyboard
Shortcuts

Shift+Alt+P :

Other

Start Page | Open a Portal | Status
Navigator Toolbar :
:
> Status
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Facilities

Recent
Changes

These options execute searches for recent
changes to:
· Elements
· Discussions
· Linked Documents
· Diagrams

Reviews

These options help you to:
· Take part in a review
· Manage the current reviews
· Run a report to find open reviews
· Run a report to find active reviews

Discussions

These options help you to
· Take part in a discussion
· Manage the current discussions
· Run a report to find recently active
discussions
· Take part in a Chat
· Review previously active chats
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Tasks

These options help you to search for tasks
that have a specific status:
· Recently Finished
· Starting Today
· Overdue
· Ending Today
· Active
· 30 Day Summary

Tests

These options help you to search for tests
that have a specific status:
· Recent Results
· Recent Failures
· Recent Passes
· Recent Deferrals
· Recent Modified Elements
· Not Run
· Not Checked

Changes

These options help you to search for
changes that have a specific status:
· New
· Verified
· Recently Reported
· Recently Resolved
· Unresolved Issues
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Defects

These options help you to search for
defects that have a specific status:
· New
· Verified
· Recently Reported
· Recently Resolved
· Unresolved Issues

Issues

These options help you to search for
issues that have a specific status:
· New
· Verified
· Recently Reported
· Recently Resolved
· Unresolved Issues
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Extend Portal
The Extend Portal lists the MDG Technologies currently
active in your model, and for each one provides links to the
facilities for working with those technologies within
Enterprise Architect.

Access
Ribbon

Show > Portals > Extend

Keyboard
Shortcuts

Shift+Alt+P :

Other

Start Page | Open a Portal | Extend
Navigator Toolbar :
:
| Extend

| Extend

:

Facilities
The options provided in this Portal depend on what Add-Ins
and MDG Technologies are loaded and active for the model,
and what operations are supported between the technologies
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and Enterprise Architect.
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Execute Portal
The Execute Portal provides links to the facilities of the
system that help you to:
· Perform Execution Analysis on your model - building and
running the Analyzer scripts
· Record, Profile, Debug and Simulate the execution of
your modeled application
· Access various windows that display specific aspects of
debugging an application
· Run a number of searches for information on recent
Simulations

Access
Ribbon

Show > Portals > Execute

Keyboard
Shortcuts

Shift+Alt+P :

Other

Start Page | Open a Portal | Execute
Navigator Toolbar :
:
> Execute
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Facilities
Category

Options

Execution
Analyzer

These options provide the facilities to
create and execute scripts for building,
running and testing an application. Select:
· Open Source File - to display the 'Open
Source File' browser from which you
select a source file to view, and then
display the file content in the Code
Editor
· Edit Build Scripts - to display the
Execution Analyzer window, from
which you can select a Build Script to
edit
· Merge - to run the Merge script
associated with the selected Package
· Build - to build the selected Package
according to the active Build Script
· Deploy - to run the deployment script
associated with the selected Package
· Run - to run the executable script
associated with the selected Package
· Test - to run the testing script

(c) Sparx Systems 2018

Page 440 of 694

User Guide - User Interface

21 December, 2018

associated with the selected Package
Analyzer

Select from these options to open the
windows from which an Analysis session
starts. Select:
· Debugger - to open the Debug window
· Profiler - to open the Profiler window
· Recorder to open the Record &
Analyze window
· Testpoints to open the Testpoints
window

Simulator

The options in this section open a number
of windows that you might use in a
Simulation session. Select:
· Simulator to open the Simulation
window
· Triggers and Events to open the
Simulation Events window
· Breakpoints - to open the Breakpoints
& Markers window
· Local Variables - to open the Locals
window
· Call Stack - to open the Call Stack
window
· BPSim to open the Configure BPSim
window
· SysMLSim to open the Configure
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SysML Simulation window
Simulator
Control

The options in this section help you to
quickly control a simulation process.
Select:
· Start Simulation - to start debugging
· Step - to step over the next line of code
after a break
· Step In - to step into a function call in
the code
· Step Out - to step out of a function call
· Pause - to pause simulation
· Stop - to stop the simulation altogether

Coding

The options provided in this section help
you to create, edit and debug code.
· Language Grammar Editor - displays
the Grammar Editor for writing and
editing a grammar for code imported in
a new programming language
· Scripting - displays the Scripting
window at the 'Scripts' tab, for creating
scripts within script groups
· Source Code Editor - displays the
Source Code Editor, which helps you
to view, edit and maintain your source
code directly inside Enterprise
Architect
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XSLT Editor/Debugger - displays both
the XSLT Debugger screen and the
System Output window at the XSLT
Transformation tab, for converting an
input document into XML or other
document types using an XSLT
Stylesheet; the transformation is
modeled in an XML Transform
diagram, from which you can debug
and/or execute the stylesheet

The options in this section open a number
of windows that you might use in a
debugging session. Select:
· Breakpoints - to open the Breakpoints
& Markers window
· Call Stack - to open the Call Stack
window
· Local Variables - to open the Locals
window
· Memory - to open the Memory Viewer
window
· Modules - to open the Modules
window
· Watches - to open the Watches window
· Object Workbench - to display the
'Object Workbench' dialog
· Debugging Perspective - to display the
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set of debug windows, dialogs, toolbars
and menus that you might use in a
debugging session
Debug
Control

The options in this section help you to
quickly debug a running process or
application (through a debug script).
Select:
· Debug Run - to start debugging
· Step - to step over the next line of code
after a break
· Step In - to step into a function call in
the code
· Step Out - to step out of a function call
· Pause - to pause debugging
· Stop - to stop the debugging session
altogether

Record

The options in this section help you to set
up, start, record and analyze the
execution of the application code
developed from your model. Select:
· 'Apply Record Layout' - to open the
windows and dialogs that you would
use in performing Execution Analysis
on your model
· 'Recording Window' - to open the
Record & Analyze window to record
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the analysis of an application
'Start Recording' - to start a manual
recording of the current thread during a
debug session, managing it using the
'Step... ' functions
'Stop Recording' - to stop the current
recording session
'Auto Record Thread' - to begin
recording and not stop until either the
program ends, you stop the debugger or
you click on the 'Stop' icon
'Toggle Display of Execution Point' - to
toggle between highlighting the
execution point and not doing so
'Create Sequence Diagram' - to
generate a Sequence diagram from the
recording trace

The two options in this section are to
quickly set up a Profiling session on your
application. Select:
· Apply Profile Layout - to display all
windows and dialogs that you might
use in profiling the execution of your
application
· Show Profiler Window - to display the
Profiler window only
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Revisit Portal
The Revisit Portal provides links to the diagrams and system
windows that you currently have open, and the documents,
windows, diagrams and source files that you have recently
opened and then closed again.

Access
Ribbon

Show > Portals > Revisit

Keyboard
Shortcuts

Shift+Alt+P :

Other

Start Page | Open a Portal | Revisit
Navigator Toolbar :
> Revisit

> Revisit

:

Facilities
Category

Options

Working Sets

This category lists the working sets that
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you have applied recently. If you click on
a set name, the windows and dialogs
defined in that set are reapplied to your
work area.
Current
Diagrams

This category lists the diagrams that you
currently have open. When you click on a
diagram name, the focus changes to the
selected diagram.

Recent
Diagrams

This category list the diagrams that you
have opened and closed during the
current work session. You can click on a
diagram name to re-open that diagram
and resume work on it.

Documents

This category lists the Linked Documents
that you have opened recently. If you
click on a document name, the document
re-opens.

Recent
Windows

This category lists the windows that you
have opened and closed during the
current work session. If you click on a
window name, the window re-opens.

Recent Files

This category lists the source files that
you have opened and closed during the
current work session. You can click on a

(c) Sparx Systems 2018

Page 448 of 694

User Guide - User Interface

21 December, 2018

file name to re-open that file and resume
work on it.
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Guidebook Portal
The Guidebook Portal provides access to a library of PDF
documents held on the Sparx Systems website. These
documents discuss specific areas of Enterprise Architect's
functionality and use. The documents are grouped according
to the area of work they support, namely:
· Basics
· Repository
· Modeling
· Domains
· Guides (for Business Analysis, Business Modeling and
Enterprise Architecture)
· Project Management
· Publishing
· Simulation
· Execution
· Automation
To open a document, double-click on the document name.

Access
Ribbon
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Keyboard
Shortcuts

Shift+Alt+P :
Guidebook

Other

Start Page | Open a Portal | Guidebook

>

Navigator Toolbar :
:
:
> Guidebook
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Learning Portal
The Learning Portal provides links to a number of useful
Help pages or other web pages on the Sparx Systems
website, to present topical information quickly. The
information is displayed through the internal Web Browser,
in the center of the work area.
The options are organized in a sequence, giving very
specific information on a narrow subject such as keyboard
shortcuts through increasingly broad discussions of
facilities, features and concepts.

Access
Ribbon

Show > Portals > Learning

Keyboard
Shortcuts

Shift+Alt+P :

Other

Start Page | Open a Portal | Learning
Navigator Toolbar :
:
> Learning
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Facilities
Category

Options

Quick
Reference

The 'Quick Reference' option provides a
set of Help topics that give immediate
information on some of the collections of
tools of Enterprise Architect, such as
shortcut keys or the ribbons.

Help

The options in this group access the
top-level topic from each chapter of the
Help. Once you have displayed a
top-level topic, you can select
subordinate topics for more detailed
information on a subject, or return to the
Index to open a different chapter.

Special
Topics

These topics describe specific features
and facilities of Enterprise Architect, to
provide a direct and focused discussion of
a facility such as Kanban Diagrams or
Roadmaps.

Guides

These topics discuss broader subject
areas and work concepts, such as
Enterprise Architecture, Business
Analysis and Business Modeling.
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Webinars

Select the 'Webinars' option to open the
'Webinar Registration' page of the Sparx
Systems website, which:
· Describes upcoming webinars
(real-time seminars hosted via the
internet) scheduled by Sparx Systems,
and
· Provides links to the registration form,
for you to register your participation in
a webinar

About

The options in this section provide access
to a range of useful Sparx Systems web
pages, which contain information on and
demonstrations of Enterprise Architect
and other Sparx Systems facilities.
· 'Tutorials' - to open the 'Tutorials' page
of the Sparx Systems website, which
provides tutorials on general UML
modeling and doing work with
Enterprise Architect
· 'Resources' - to open the 'Help,
Tutorials & White papers' page and the
'Resources' page of the Sparx Systems
website, providing access to a wide
range of Enterprise Architect and UML
tutorials, demonstrations, examples,
base files, Add-Ins and general
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information
'MDG Technologies' - to open the
'MDG Products' page of the Sparx
Systems website, which provides a
brief description of, and the download
links for, each supported MDG Add-In
product for a selected edition of
Enterprise Architect - select your
installed edition from the drop-down
list
Enterprise Architect editions such as
Unified and Ultimate will
automatically register certain Add-In
products; however these Add-Ins are
not included in the default Enterprise
Architect installation and must be
downloaded separately
'3rd Party Extensions' - to open the
'Third Party Extensions' page of the
Sparx Systems website, which provides
listings of additional Enterprise
Architect Add-Ins developed by
partners and other members of the
Enterprise Architect community
'Newsletter' - to open the 'Newsletters'
page of the Sparx Systems website,
which provides links to view
newsletters previously released by
Sparx Systems, and to subscribe to
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receive future newsletters as they are
released
'Release History' - to open the 'Recent
Features' page of the Sparx Systems
website, which provides a full history
of changes in the most recent builds of
Enterprise Architect
You can also open the release history
and investigate the features of earlier
releases of the system, going back to
version 1.1.3, the very first commercial
release
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Keyboard Shortcuts
You can display the Enterprise Architect dialogs, windows
and views, or initiate processes, using menu options and
Toolbar icons. In many cases, you can also access these
facilities by pressing individual keyboard keys or
combinations of keys, as shortcuts. This table lists the
default keyboard shortcut for each of the functions. You can
also display the key combinations on the 'Help Keyboard'
dialog.
The shortcuts described here are operations on the model.
When a diagram is open, you can use special quick-keys
that make navigating and editing the diagram simple and
fast. These quick-keys are described in the Diagram
Shortcuts Help topic.

Access
Ribbon

Start > Help > Help > Open Keyboard
Accelerator Map

Notes
·

There are additional shortcuts using the keyboard and
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mouse in combination
If necessary, you can change the keyboard shortcuts using
the 'Keyboard' tab of the 'Customize' dialog

Opening Projects
Shortcut

Operation

Ctrl+N

Create a new Enterprise Architect project.

Ctrl+O

Open an Enterprise Architect project.

Ctrl+Shift+F
11

Reload the current project.

Adding Objects to the Project
Shortcut

Operation

Ctrl+Shift+M

Add a new model to the project, using the
Model Wizard.

Ctrl+Insert

Add a new diagram to a Package.
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Ctrl+M

Add a new element to a Package.

Shift+F3 or
Ctrl+click

Create a new element of the same type as
the last.

Ctrl+Shift+T

Add a Tagged Value to an element.

Ctrl+Shift+F
9

Add an attribute to an element.

Ctrl+Shift+F
10

Add an operation to an element.

Ctrl+F11

Add other types of feature to an element.

Insert key

Insert a new feature after the current
selection.

Locating Information
Shortcut

Operation

Ctrl+F,
Ctrl+Alt+A

Search for items in the project (search in
the model).
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Ctrl+Shift+F

Opens the Find in Files window at the
'Find File' tab, which you use as a File
System Explorer to quickly locate
specific files.

Ctrl+Shift+A
lt+F

Search files for data names and
structures.

Alt+G

Locate the selected element in the Project
Browser.

Shift+Alt+G

Locate a selected object in the Project
Browser.

Ctrl+U

Locate diagrams in which the element is
used.

Copying and Pasting

Ctrl+Space

Add a single element to the clipboard list.

Ctrl+C

Copy text, or element ID for pasting an
element on a diagram as a link.
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Ctrl+Shift+C

Copy an element, multiple elements or a
Package plus any underlying structure to
the clipboard for duplication in a target
Package.

Ctrl+X

Cut the selected text.

Ctrl+V

Paste text.

Viewing Information in Windows
Shortcut

Operation

Alt+0

Display the Project Browser.

Alt+1 or
Ctrl+2

View the Properties window.

Alt+2

View the Project Glossary.

Alt+4

View the Maintenance window, in
Default mode.

Alt+5

Display the Diagram Toolbox.
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Alt+6

Open the Resources window.

Alt+9

View the Element Browser.

Alt+Enter

Display the element 'Properties' dialog at
the 'General' tab.

Alt+\

Move focus to the Diagram View from a
docked window.

Enter key

View the element 'Properties' dialog
(when the element is selected).

Ctrl+Shift+1
or Ctrl+3

View the Notes window.

Ctrl+Shift+2

View the element Relationships window.

Ctrl+Shift+3

Display the Responsibilities window.

Ctrl+Shift+4

View the Traceability window.

Ctrl+Shift+5

Display Model Views.

Ctrl+Shift+6

View the Tagged Values window.

Ctrl+Shift+7

View the Resource Allocation window.
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Ctrl+Shift+8

View the System Output window.

Ctrl+Alt+R

View the Package Browser (Package
Contents).

Ctrl+Alt+U

Open the Team Library.

Ctrl+Alt+W

View the Web Browser.

F9

Display the Features window at the
'Attributes' tab.

F10

Display the Features window at the
'Operations' tab.

Ctrl+Shift+0

Set focus to the current window.

Shift+Alt+En
ter

Make the current view occupy the full
screen space.

Ctrl+F4

Close the current window.

Ctrl+Shift+F
4

Autohide the current window.

Generating Documentation
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Shortcut

Operation

F8

Generate documents and reports.

Shift+F8

Generate a Web Report in HTML.

Ctrl+Shift+F
8

Generate a 'Diagrams Only' report.

Deleting Objects from the Project
Shortcut

Operation

Ctrl+Delete

Delete selected element(s) from the
model (from the Project Browser and any
diagram in which the element occurs).

Ctrl+Shift+D
elete

Delete the selected feature from the
model.

Checking Spelling
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Shortcut

Operation

Ctrl+Shift+F
7

Spell check the current Package.

Ctrl+F7

Spell check the model.

Performing Code Engineering
Shortcut

Operation

Ctrl+Shift+P

Edit code generation templates.

Alt+7

Open the Source Code window.

Ctrl+Alt+Y

Open a source directory.

Ctrl+Alt+O

Open a source file.

Ctrl+Shift+U

Import a source directory.

Ctrl+Alt+K

Generate Package source code.

Ctrl+Alt+M

Synchronize Package contents.
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F11

Generate code on a selected element.

F7

Synchronize the current element.

Shift+F11

Batch generate selected elements.

Ctrl+R

Batch synchronize selected elements.

Ctrl+E or
F12

View source code in the default external
editor.

Ctrl+Alt+H

Edit Transformation templates.

Ctrl+H or
Ctrl+Alt+F

Transform selected elements.

Ctrl+Shift+H

Transform the current Package

Exchanging Data
Shortcut

Operation

Shift+F9

Check project data integrity.

Ctrl+Alt+V

Validate the current Package.
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Page 466 of 694

User Guide - User Interface

21 December, 2018

Ctrl+Alt+I

Import a Package from XMI.

Ctrl+Alt+E

Export a Package to XMI.

Ctrl+Alt+C

Import and export to data CSV files.

Performing Visual Execution Analysis
Shortcut

Operation

Ctrl+Shift+J

Create a Workbench Instance of a Class.

Shift+F12

Manage Analyzer Scripts on the
Execution Analyzer window.

Ctrl+Shift+F
12

Create a Build Script.

Ctrl+Alt+N

Create a Run Script.

Ctrl+Alt+T

Create a Test Script.

Ctrl+Shift+A
lt+F12

Create a Deployment script.
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Open the Debugger window.

F6

Start a Debug session.

Shift+F6

Step Into a function call.

Alt+F6

Step Over a function call.

Ctrl+F6

Step Out of a function call.

Ctrl+Alt+F6

Stop the debug session.
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Other Operations
Shortcut

Operation

Ctrl+Alt+B

Manage Baselines.

Ctrl+Alt+P

Configure Package Control.

Ctrl+Shift+L

Open a 'Lock <item>' dialog for the
selected Package, diagram or element.

F5

Refresh the selected Package in the
Project Browser.
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Ctrl+Alt+D

Create a Linked Document on an
element.

Ctrl+Shift+Y

Specify which element features are
visible on a diagram.

Ctrl+Shift+B

Manage structural (embedded) elements.

Ctrl+I

Set an element's parent or implement
interface(s).

Ctrl+Shift+O

Override inherited features.

Ctrl+J

Set cross references to other elements and
diagrams.

Ctrl+Shift+E
or F4

Configure an element's default
appearance.

Ctrl+Shift+W Select an alternative image for an
element.
F2

Edit the selected property value.

Ctrl+F9

Configure system options.
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Keyboard-Mouse Shortcuts
When you work on an aspect of your model within a
diagram, there are a number of operations you can perform
quickly using a combination of keyboard keys and the
computer mouse.

Keyboard/mouse combinations
Action

Shortcut

Create an
element of
the same type
as was last
created on
the diagram.

Ctrl+click

Display the
element
'Properties'
dialog for the
element
shown in the
scenario
'Context
References'

Ctrl+click
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tab.
Select a
number of
individual
objects for an
operation.

Ctrl+click each object

Select a
range of
objects for an
operation.

Shift+click on the first and last object in
the range

Move the
selected
elements
along the
horizontal
axis or
vertical axis.

Shift+hold left mouse button and drag

Create a bend Shift+hold left mouse button and drag
in and change
the direction
of the
connector
line.
Move the
(c) Sparx Systems 2018
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selected
elements in
any direction,
including
diagonally.
Zoom in to or Ctrl+ mouse scroll wheel
zoom out of
the diagram.
Pan the
diagram
horizontally
or vertically.
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Ctrl+Shift+hold left mouse button and
drag
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Diagram Shortcuts
When you have a diagram open, you can use a set of single
or combination keyboard keys to move between, select and
operate on the elements and connectors within the diagram.

Selecting and Marking Elements
Quick Key

Operation

Enter,
comma (,) or
period (.)

When no element is currently selected,
select the element nearest the top left
corner of the diagram or of the section of
diagram in view.

. (period)

When an element is selected, change
selection to the nearest child element
closest to the top left of the selected
parent element, on the diagram.

, (comma)

When an element is selected, change
selection to the parent element of the
selected child element, on the diagram

Arrow keys

Select the next element on the diagram
above, below, to the left or to the right of
the current element; when moving left or
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right, the selection tends to be upwards
rather than downwards.
S

Keep an element selected as you move to
another element (using the keyboard
arrow keys), so that you can select
multiple elements using the keyboard.

Q, F (element If no element property is selected,
name) or F2
highlight the element name for in-place
(property)
editing.
If you have selected an element property,
enable it for in-place editing.
F

Select the first editable feature of the item
in focus.
This is generally the element name but if
you select a Tagged Value that has
multiple system-defined values (such as
the SearchName tag) you can cycle
through the list of values to obtain the
correct one.

Shift+Space

Bookmark the current element with a red
marker.

? or /

Toggle selection between the current
(source) element and its connector.
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Inserting Objects, and Cutting and Pasting
Quick Key

Operation

Shift+Insert

Paste element(s) from the clipboard as
links to the original element(s). The
'Paste <element name>' dialog displays;
simply click on the OK button to paste
the element.

Insert or
Spacebar

Displays the 'Toolbox Shortcut' menu,
from which you can select to create and
add an element of one of a wide range of
types.

Ctrl+Shift+In
sert

Paste an element into the diagram as a
metafile image held on the clipboard.

F3

Create a new connector of the same type
as the last.

W

Add a way-point to the current connector.
(This does not act on every line style.)

Ctrl+Shift+I

Set the visibility of connectors.
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Positioning Elements
Quick Key

Operation

I

Toggle snap-to-grid on and off on the
diagram.

Alt+Z

Automatically size selected elements.

Alt+-

Space elements evenly, horizontally.

Alt+=

Space elements evenly, vertically.

Shift+arrow
keys

Move elements by small increments.

Ctrl+arrow
keys

Resize a selected element by small
increments.

Ctrl+Alt+Do
wn

Align the bottom edges of selected
elements.

Ctrl+Alt+Up

Align the top edges of selected elements.

Ctrl+Alt+Lef
t

Align the left boundaries of selected
elements.
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Align the right boundaries of selected
elements.

Saving and Undoing Changes
Quick Key

Operation

Ctrl+Z

Undo a change.

Ctrl+Y

Redo an undone change.

Ctrl+S

Save changes to a diagram.

Ctrl+T

Save an image to file.

Ctrl+B

Save an image to the clipboard.

Deletions
Quick Key

Operation

Delete key or

Delete selected element(s) in a diagram,
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Ctrl+D

but not from the model.

Ctrl+Delete

Delete selected element(s) in the diagram
from the diagram and from the model.

Displaying Details in Other Windows
Quick Key

Operation

N

Open and/or shift focus to the Notes
window.

P

Open and/or shift focus to the Properties
window.

R

Open and/or shift focus to the
Relationships window.

C

Display the Construct window

E

Display the Responsibilities window

V

Display the Tagged Values window

Z

If the Inline Specification Manager
window is open, set focus to that

(c) Sparx Systems 2018
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window.
O

When you have selected an operation,
open the Features window at the
'Operations' tab.

A

When you have selected an attribute,
open the Features window at the
'Attributes' tab.

G

Display the 'Generate Code' dialog for the
selected element, to generate code from
it.

Y

Synchronize the code generated from the
selected element with the element
content.

M

Display the 'New Element' dialog to
create a new element.

Ctrl+Shift+N

View the Pan and Zoom window.

Displaying Portals Windows
Quick Key
(c) Sparx Systems 2018
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1

Display the Perspective portal

2

Display the Workspace portal

3

Display the Window portal

4

Display the Status portal

5

Display the Extend portal

6

Display the Execute portal

7

Display the Revisit portal

8

Display the Guidebook portal

9

Display the Learning portal

Printing a Diagram
Quick Key

Operation

Ctrl+P

Print the active diagram.
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Customization
Enterprise Architect has a standard style and appearance,
which you can customize to suit your own work
environment. Several facilities are available for
customizing:
· The means of issuing commands to the system - such as
ribbons, toolbars and keyboard keys - and the commands
themselves
· The visual style and color of the user interface
· The windows you want to display together on the screen,
and their position on the screen (the 'Workspace Layout')
On occasion, you might want to use Enterprise Architect for
two distinct types of operation at the same time. You can do
this by storing registry settings - such as window layouts - to
a different path in the registry, by adding this command line
argument when you run Enterprise Architect:
/regkey:<regkeyname>
You can also configure a wide range of local options and
specific settings for using Enterprise Architect on your
workstation, through the 'Preferences' dialog. These options
apply to all models that you work in using Enterprise
Architect on your workstation.
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Visual Styles
It is possible to change the overall style and color of the
Enterprise Architect user interface to match the standard
styles (or themes) of a number of Microsoft Office and
Visual Studio product releases. The styles are applied
uniformly across all displays, dialogs, windows, views and
ribbons.
To test the style that you are selecting, simply click on the
Apply button.
This image illustrates the 'Microsoft Office 2016'® style,
using different themes and accent colors.

Access
Ribbon
(c) Sparx Systems 2018

Start > View > Visual Style > Visual
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Style

Reset the style of the user interface
Define the visual style you want to use, on the 'Application
Look' dialog.
Option

Action

(top field)

Click on the drop-down arrow and select
the application style you want to apply.

Theme

For certain application styles, you can
also apply a color theme.
If this field is enabled, click on the
drop-down arrow and select the required
theme color or tone.

Accent Color

For certain application styles, you can
also change the accent color for messages
and highlights.
If this field is enabled, click on the
drop-down arrow and select the required
accent color.

Code Editor

Click on the drop-down arrow and select
an option to apply, within the code editor
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views:
· The automatic default background
color of the code panel for the
application style
· A dark background for the code panel,
or
· A light background for the code panel
You can also re-set the dark and light
backgrounds on the 'Editor Language
Properties' dialog.
Diagram

Defaults to the diagram theme currently
set in the 'Preferences' dialog.
If you want to apply a different diagram
theme, click on the drop-down arrow and
select the required theme.

Workspace

Many of the workspace layouts have a
left orientation or a right orientation, most
easily observable in the side of the screen
that the Project Browser displays on.
You can use this 'Workspace Orientation'
field to specify the orientation you prefer
- click on the drop-down arrow and select
either 'Left' or 'Right' to automatically
position the Project Browser and related
displays in your preferred workspace on
the corresponding side of the screen.
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Default Note
Zoom

Click on the drop-down arrow and select
the percentage zoom or magnification
(from 90% up to 150%) to apply to the
text in the Element Notes window and
any text field that has the Notes toolbar at
the top.

Show Menu
Icons

Select this checkbox to display icons next
to the menu options (where they have
been assigned).
Deselect the checkbox to hide the icons
and show simple lists of text options.

Main View
Tabs use
Caption style

Select this checkbox to display the icons
and names of the main view tabs in a
larger format.

Main View
Tabs at
bottom
(restart)

When a main view has tabs, by default
the tab names display at the top of the
view.
If you prefer to display the tab names
along the bottom of the view, select this
checkbox.
The change does not take effect until you
shut down and restart Enterprise
Architect.

Property

By default 'Properties' dialogs and
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Sheets use
Tree style

various other screens present sections of
data on tabs.
If you prefer to display the sections of
data on dialog pages, where you choose
the pages from a tree or hierarchy on the
left of the dialog, select this checkbox.

Use Property
List for
Elements

By default element 'Properties' dialogs
show the main properties as a series of
fields on the right of the dialog.
If you prefer to display the properties as a
simple list of names and editable values,
select this checkbox.

Prefer
Property
dialogs

When this option is selected,
double-clicking on the editable Features
of an object in a diagram displays the
'Features' dialog. If the option is not
selected, double-clicking on an object
opens the Features window (if it is not
already open).

Increase Note Increases the paragraph spacing from the
Paragraph
default, in all new text in the Element
Spacing
Notes window and all text fields with the
Notes toolbar at the top. The change is
applied to all paragraph styles, including
bullet and number lists.
The paragraph spacing is increased in
(c) Sparx Systems 2018
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existing text when you open and close a
dialog containing that text.
When you deselect the option, all new
Notes text reverts to the default spacing.
Show Tips in
Status Bar
(restart)

Displays the tool-tips for ribbon options,
context menus, diagram objects and
toolboxes in the Status Bar at the foot of
the screen. This option defaults to
selected.
If you prefer to show the tooltip floating
near the moused-over object, clear the
checkbox. You must restart Enterprise
Architect to apply the selection.

Show Project
Browser H
Scrollbar
(restart)

Displays a horizontal scrollbar in the tab
ribbon at the top of the Project Browser.
Deselect the option to use the autoscroll
behavior provided by the current theme
(not all themes support autoscroll).

OK

Click on this button to save and apply the
changes, and close the dialog.

Cancel

Click on this button to cancel the changes
and close the dialog.

Apply

Click on this button to apply the changes
but keep the dialog open for further
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editing.
If a change takes immediate effect, you
can see it on any open windows and then,
if you prefer something different, change
the setting.
If you click on the Apply button and the
Cancel button, the changes still take
effect.
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Customize Dialog
It is possible to customize the Enterprise Architect toolbar
and keyboard commands and how they are displayed and
made available to you, tailoring the user interface to suit
your work methods and environment. You can also define a
number of external applications that you can activate from
the 'Tools' menu. You perform these tasks using the
'Customize' dialog.

Access
Ribbon

Start > View > Visual Style > Customize

Other

At the far right of any toolbar, click on
the drop-down arrow and on the 'Add or
Remove buttons | Customize' option

Notes
·

If a documented toolbar icon, keyboard combination or
menu facility does not appear to be available, select the
appropriate tab and click on the Reset button or Reset All
button to restore the toolbar, menu or key settings to the
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defaults; however, this also removes any customized
icons, options or combinations you might have set,
because it is possible that the customization itself has
displaced or affected the default setting
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Customize Commands
The Enterprise Architect toolbars provide a wide range of
functions, some of which are useful in several different
contexts. You might find it more convenient to have a
function command available either from a different toolbar
to the one it is currently set in, or from more than one
toolbar. You can customize which toolbar a command is
available from by generating a button or icon for the
command on either another existing toolbar or a new toolbar
that you create for this purpose. Conversely, you might
remove a command from its current toolbar, to simplify the
selection of tools from that toolbar.

Access
Ribbon

Start > View > Visual Style > Customize
> Commands

Manage Toolbar Commands
Task
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Add
Also display the appropriate toolbar,
Command To using:
Toolbar
· 'Show > Portals > Show Toolbar >
<toolbar name>
The toolbar icons are then highlighted
with a dark border as you select them.
On the 'Commands' tab:
1. Click on the appropriate command
category in the 'Categories:' panel.
2. Click on the command you need from
the list in the 'Commands:' panel.
3. Drag the command onto the toolbar; it
is immediately placed in the toolbar at
the cursor position.
4. Add any further commands you want.
5. Put the icons in the order you prefer,
by dragging each icon into position.
6. Click on the Close button to close the
'Customize' dialog.
7. If necessary, resize the toolbar or drag
it back into the top of the screen.
If the command has an associated icon,
the icon displays in the toolbar;
otherwise, the command name displays.
Delete
Command
from Toolbar
(c) Sparx Systems 2018

While the 'Customize' dialog is displayed,
right-click on the command icon or text
in the toolbar, and select the 'Delete'
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option. The command icon is
immediately removed from the toolbar.
The context menu does not display if the
'Customize' dialog is closed.
Change or
assign icon
for command
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All commands listed in the 'Customize'
dialog have a text label, and many have
associated icons, either system-defined
(default) or user-defined. If the command
has an icon, you can select to represent
the command in the toolbar by:
· The icon
· The text
· Both together
You have a range of other options for
changing how the command is
represented in the toolbar, such as:
· If the command does not have an
associated icon, assign one from an
image library
· Change the icon currently assigned to
the command to a different icon
· If the command has a system default
icon and you have changed it, restore
that default icon to the command
· Edit the icons in the library, and create
new ones; you can also copy an
existing icon and edit the copy
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These options are available through a
context menu that you display by
right-clicking on the icon in the toolbar
while the 'Customize' dialog is displayed.
The context menu does not display if the
'Customize' dialog is closed.
The changes apply only to the selected
toolbar. Any instances of the command in
other toolbars or menus are not affected.
Toggle
1. Right-click on the command icon or
command
text in the toolbar.
button
2. Select the context menu option you
between icon,
need - 'Image', 'Text' or 'Image and
text and both
Text'.
If the option has an icon, the selected
change is made. If the command has no
icon, the 'Button Appearance' dialog
displays. You can also toggle between the
image/text options on this dialog.
Assign icon
to command

(c) Sparx Systems 2018

1. Right-click on the command icon or
text in the toolbar.
2. Select the 'Button Appearance' option;
the 'Button Appearance' dialog
displays.
3. Select either the 'Image only' radio
button or the 'Image and text' radio
button.
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4. For a command with a default icon, the
'Use Default Image' radio button is
followed by the default icon; if you
have assigned a different image, you
can restore the default by selecting this
radio button.
Otherwise, select the 'Select
User-defined Image' radio button, and
click on an appropriate image from the
selection provided. You can add or edit
images in this selection.
5. Click on the OK button to apply the
changes to the toolbar.
(You can also restore the default icon by
right-clicking on the current icon in the
toolbar and selecting the 'Reset to default'
option.)
Copy a
toolbar icon

1. Right-click on the icon in the toolbar.
2. Select the 'Copy Button Image' option;
the image is copied to the clipboard.

Create and
edit icons

1. Right-click on the command graphic or
text in the toolbar.
2. Select the 'Button Appearance' option;
the 'Button Appearance' dialog
displays.
3. Select either the 'Image only' radio
button or the 'Image and text' radio
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button.
4. Select the 'Select User-defined Image'
radio button.
5. To create a new image, click on the
New button; to edit an existing
user-defined image, click on the image
and then on the Edit button.
The 'Edit Button Image' dialog
displays.
6. If you have copied another icon to edit
as a new icon, click on the Paste button
in the 'Tools' block.
7. Select a color and the appropriate
painting tool - the 'pencil' fills
individual squares, the 'filler' fills the
whole 'Picture' block, and the 'line'
creates lines of two or more squares
thick.
8. Create or edit the icon, working right
up to the border of the 'Picture' block if
necessary.
9. Click on the OK button to apply the
changes to the toolbar.
Change icon
text label
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1. Right-click on the command graphic or
text in the toolbar.
2. Select the 'Button Appearance' option;
the 'Button Appearance' dialog
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displays.
3. Select either the 'Text only' radio
button or the 'Image and text' radio
button.
4. In the 'Button text' field, highlight and
delete the existing text and type in the
new text.
5. Click on the OK button to apply the
changes to the toolbar.
Group Icons
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If necessary, you can indicate that the
command icons are arranged in groups.
To do this:
1. While the 'Customize' dialog is
displayed, right-click on the first
command icon or text in the group in
the toolbar, and select the 'Start Group'
option.
A vertical line displays to the left of the
icon. All icons to the right of the line
form a group, up to any subsequent line.
To remove the line and cancel the
grouping, repeat the step.
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Customize Toolbars
As well as tailoring the commands that are available through
the toolbars, you can modify the toolbars themselves; for
example, you can:
· Hide or show toolbars by selecting the appropriate
checkbox
· Rename toolbars
· Create new toolbars
· Delete toolbars
· Modify toolbar contents by dragging commands onto a
visible toolbar from the 'Commands' tab or from another
toolbar
· Reset a toolbar (or all toolbars) to the default contents and
position, and
· Display text labels under the toolbar icons, to indicate
what the icons do

Access
Ribbon
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Start > View > Visual Style > Customize
> Toolbars : New

Page 500 of 694

User Guide - User Interface

21 December, 2018

Create a New Toolbar and Populate it with
Commands
Ste Action
p
1

In the 'Toolbar Name' field, type a name for your
new toolbar and click on the OK button.
Your new toolbar is created. The toolbar and
'Customize' dialog are independently positioned, so
you might have to drag the 'Customize' dialog to one
side to expose your new toolbar.

2

If you want to display the name of each command
you put into your toolbar, select the 'Show text
labels' checkbox.
Otherwise leave the checkbox unselected.

3

To add commands to your new toolbar from another
toolbar, see step 6.
To add menu commands to your toolbar, click on the
'Commands' tab.
The 'Categories' list on the left of the tab represents
the Enterprise Architect menu structure. The
'Commands' list contains the commands in the
selected category; the list updates when you click on
a different category.
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4

Find and click on the command to add to your
toolbar in the Commands list.

5

Drag the selected command from the list into the
new toolbar.
If you selected the 'Show text labels' checkbox, your
toolbar should now resemble this:

If you did not select the 'Show text labels' checkbox,
your toolbar should resemble this:

6

If the command you require is on another toolbar,
display that toolbar and drag it to a position near
your new toolbar.
Press Ctrl and drag the required icon for the
command from the existing toolbar onto your new
toolbar.

7

Repeat steps 3 to 6 for each command that you want
to make available in your new toolbar.
When you have finished, click on the Close button
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on the 'Customize' dialog and drag your toolbar into
the toolbar ribbon or to any other convenient
position for you to use.

Notes
·

·

You can add as many commands to your toolbar as you
need; your new toolbar behaves the same way as other
toolbars - you can position it next to the other toolbars at
the top of the application workspace, dock it to the side of
the workspace or close it
You can also modify the display of toolbar options using
the 'Options' page of the 'Customize' dialog
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Add Custom Tools
You can extend the power of the Enterprise Architect
desktop by making external tools accessible from the
ribbons. You can create options that hyperlink to different
applications, compilers, batch scripts, automation scripts,
URLs or documentation. The tools can be either
commercially available or those you have configured
yourself.

Access
Ribbon

Start > View > Visual Style > Customize
> Tools :

Add and configure custom tools
Option

Action

Menu
contents

In the boxed, blank field in the list, type
in the name of the tool as it should appear
in the menu.
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Command

Either:
· Type the name of the tool .exe file to
use, or
· Click on the
button and browse to
the file location
The .exe file must have a valid filename.

Arguments

Type in any arguments required by the
tool

Initial
directory

(Optional) Type in the location of an
initial directory.

Close

Click on this button to close the
'Customize' dialog.
Your tool is added to the 'Tools' menu.
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Open External Tools
When configuring custom tools in Enterprise Architect, by
selecting 'Start > View > Visual Style > Customize > Tools',
you can:
· Specify the custom tool (application) using the
'Command' field
· Define a file to open using the 'Arguments' field

Example 1
This configuration opens the file c:\Temp\Customer
Account.cls using Wordpad. If you save from within
Wordpad the initial directory is c:\Temp.

If there are any spaces in the paths in the 'Command',
'Arguments' or 'Initial directory' fields, you must enclose the
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whole path in double quotes. For example:
"c:\Temp\Customer Account.cls" must have quotes, but
c:\Temp\CustomerAccount.cls does not have to have quotes

Example 2
This example opens the file c:\Temp\Customer Account.cls
using Visual Basic (VB). As VB is not installed with the
operating system, the whole file path for VB must be
included in the 'Command' field; you can locate and select
this path using the button. Again, if you save from within
VB the initial directory is c:\Temp.

(c) Sparx Systems 2018

Page 507 of 694

User Guide - User Interface

21 December, 2018

Pass Parameters to Applications
When configuring custom tools in Enterprise Architect, by
selecting 'Start > View > Visual Style > Customize > Tools',
you can define parameters to pass to an external application
using the 'Arguments' field.

Available parameters
Parameter

Passes

$f

A project name.
Notes: For example,
C:\projects\EAExample.eap

$F

The calling application.
Notes: That is, Enterprise Architect.

$p

The current Package ID.
Notes: For example, 144.

$P

The Package GUID.
Notes: A GUID for accessing this
Package.

$d

The diagram ID.
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Notes: An ID for accessing the associated
diagram.
$D

The diagram GUID.
Notes: A GUID for accessing the
associated diagram.

$e

A comma separated list of element IDs.
Notes: All elements selected in the
current diagram.

$E

A comma separated list of element
GUIDs.
Notes: All elements selected in the
current diagram.

(c) Sparx Systems 2018

Page 509 of 694

User Guide - User Interface

21 December, 2018

Customize Keyboard Shortcuts
Various context menu options can also be invoked using a
single keyboard key, or a combination of keys, referred to as
shortcuts. You can assign your own shortcut keys to either
the standard options or your customized options, to suit your
work practices or other applications.

Access
Ribbon

Start > View > Visual Style > Customize
> Keyboard

Create or modify a keyboard shortcut
Option

Action

Category

Click on the drop-down arrow and select
the name of the context menu containing
the command to assign a shortcut to.

Commands

Scroll through the list of commands and
click on the one to assign the shortcut
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key(s) to.
If the command already has a shortcut
key it is shown in the 'Current Keys' field.
Press New
Shortcut Key

Click on this field and press the shortcut
key(s) to assign to the command.
Press the actual keys to use; for example,
to assign F5 press the F5 key, do not
press F and then 5.

Assign

Click on this button to assign the key to
the command.
The button is disabled if the selected
keyboard shortcut is already used for
another command; if this occurs the
command it is assigned to is shown in the
'Assigned to' field, and you must select a
different shortcut key.

Remove

To remove a shortcut, select it in the
'Current Keys' field and click on this
button. The shortcut is immediately
removed.

Reset All

Click on this button to reset all
commands to the default set of shortcut
keys. All keys that you have assigned are
removed.
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Click on this button to close the dialog,
saving all keys that you have assigned.

Notes
· It is simpler to have one shortcut per command, although
you can assign more than one shortcut if necessary
· Modified shortcut keys are stored in the registry, so they
are available only to you and not to other users
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Customize Submenus
It is possible to customize your submenus to add or remove
shadow around the outline of each menu and to apply
animation to the way in which the submenus are opened.

Access
Ribbon

Start > View > Visual Style > Customize
> Menu

Animate Menu Display
Option

Description

Menu
animations

Click on the drop-down arrow and select
one of the options:
· None - the menus are instantaneously
displayed on selection
· Unfold - the menus unfold from the top
left corner diagonally downwards
· Slide - the menus slide out from the top
downwards
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Fade - the menus fade in
[Default] - similar to Fade

Menu
Shadows

Select the checkbox to display a shadow
along the right and lower edges of the
menu.
Clear the checkbox to display menus with
no shadow on the borders.

Close

Click on this button to close the
'Customize' dialog.
Your animation options take effect on the
menus.

Notes
·

When you perform a major upgrade of the system (such as
from release 12 to 13) the menus are reset and deleted
options are replaced.
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Customize Options
It is possible to customize the entire set of Toolbars to
display with large icons, and/or show a Screen Tip as you
mouse over each toolbar icon. The options take effect
immediately, so you can see what impact they have before
closing the dialog.

Access
Ribbon

Start > View > Visual Style > Customize
> Options

Customize Toolbar Display
Option

Description

Show Screen
Tips on
Toolbars

Select this checkbox to display a Screen
Tip as you mouse over each toolbar icon,
if a Screen Tip is defined for the icon.
The screen tip is predefined in Enterprise
Architect and cannot be edited.
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Show
shortcut keys
in Screen
Tips

If you have selected to show Screen Tips,
select this checkbox to include any
shortcut key combinations in the Screen
Tip text.
The shortcut keys are editable, and you
can add, change or remove the keys
assigned to any of the commands
represented by an icon. The current
shortcut key combination is added to the
Screen Tip text.

Large Icons

Select this checkbox to enlarge all the
Toolbox icons. This takes effect
immediately, so that you can see how the
display changes.

Close

Click on this button to save and commit
the settings.
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Workspace Layouts
As you perform work on your model you use various
toolbars and windows; you will quite likely use the same
toolbars and windows regularly, in an arrangement that suits
the way in which you use the system. Rather than having to
re-open and arrange these tools at the start of each work
session, you can use either a predefined or a customized
work environment or workspace.
Workspaces:
· Automatically open and organize all the tools appropriate
to an area of work such as Requirements Management,
Code Engineering and Debugging
· Help a new user by:
- Opening the tools that are appropriate to a task so that
they can immediately get started, and
- Showing the user what tools they should become
familiar with for that area of work
· Help you switch rapidly to work environments for either
successive or completely different areas of work
· Re-establish a work environment that you have
accidentally or deliberately changed
To select, create and maintain workspaces you use the
'Workspaces' page of the 'Workspace Layout' dialog, which
lists the currently-available system and user-defined layouts.

Access
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Start > View > Workspace > Select a
Workspace

Manage Layouts
Task

Description

Change
workspace
layout

The 'Last Applied Workspace' field at the
bottom of the 'Workspace Layout' dialog
identifies the layout last selected, before
any changes you might have made.
You can change the layout to:
· The original layout (as identified by the
'Last Applied Workspace' field),
discarding any changes you might have
made
· One of the other named layouts, or
· A new named, customized layout,
capturing the current screen layout and
including any changes you have made
to the previously-applied layout
To change the layout in use, either:
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Copy
workspace
layout

Delete
workspace
layout
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Click on the preferred layout name and
on the Apply button, or
Double-click on the required layout
name, or
Right-click on the layout name and
select the 'Apply' option

Right-click on the layout name and
select the 'Copy As New' option
The 'Save Custom Workspace Layout'
dialog displays.
In the 'Custom Workspace Layout' field,
type a name for the layout. By selecting
an existing name you can change an
existing layout to something different.
Click on the Save button.
If you already have tailored windows or
views open that you want to include in
your selected layout, select the 'Include
active custom views' checkbox.
·

Right-click on the (custom) layout name
and select the 'Delete' option. A prompt
displays for you to confirm or cancel the
deletion.
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Notes
·

·

If you apply a working set that invokes floating diagrams
or views, it will override the current workspace layout
with the layout that was in use when the working set was
defined
If you develop a workspace layout that would be useful
for your colleagues, you can share it with them by
incorporating it in an MDG Technology that they can
download

(c) Sparx Systems 2018

Page 520 of 694

User Guide - User Interface

21 December, 2018

Customizing Ribbon Sets
The Enterprise Architect ribbons provide access to the
functions and facilities of the system, grouped according to
work area. If you only work with the facilities of a certain
area, such as Coding or Simulation, you can create a Ribbon
Set to present just those facilities and hide other facilities
that you do not use. You might hide certain panels of a
ribbon, or the whole ribbon.
When you open Enterprise Architect, the Start ribbon is
expanded in the ribbon bar by default. You can also set a
different ribbon to be the default expanded on opening the
system.

Access
Ribbon

Start > View > Workspace > My
Workspaces > My Ribbon Sets

Create a Ribbon Set
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Ste Action
p
1

When you click on the 'My Ribbon Sets' tab, the
'Create Ribbon Set' and 'Configure Ribbons' panels
display.

2

Click on the New button, and in the 'Create New
Ribbon Set' dialog type a name for the Ribbon Set.
Click on the OK button to add the new name to the
'Create Ribbon Set' panel and to make it the focus of
the 'Configure Ribbons' panel.
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3

To hide a complete ribbon, clear the 'Enable'
checkbox against the ribbon name.
To hide selected panels within a ribbon, click on the
white arrowhead to the left of the ribbon name, to
display a list of panels that the ribbon contains. For
each panel to hide, clear the 'Enable' checkbox
against the panel name.
Clearing all the panel checkboxes for a ribbon also
hides the complete ribbon (you cannot display an
empty ribbon).

4

If you want to redisplay a panel or ribbon, select the
corresponding 'Enable' checkbox. Selecting a panel
within a hidden ribbon shows the ribbon again.
Selecting to show a hidden ribbon selects the
checkboxes against all its panels; you can then clear
individual panels as required.
If you have cleared a number of ribbons and/or
panels, you can restore the complete set of ribbons
and panels by clicking on the Reset button.

5

If you want to change the default ribbon expanded
on opening Enterprise Architect, click on the
drop-down arrow in the 'Default Ribbon' field at the
foot of the page and select the appropriate ribbon
name.
If you have hidden a complete ribbon in the
'Configure Ribbons' panel, that ribbon is not
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available for selection in the 'Default Ribbon' field.
The Reset button also sets the field back to the 'Start'
ribbon.
6

Click on the Save button to save your settings, and
on the Close button to close the Perspectives
window.

Notes
·

·

You cannot hide the 'Start' ribbon, 'Specification Specify' ribbon or 'Document - Edit' ribbon, or any panels
that they contain
If you no longer want to keep a Ribbon Set, click on the
name in the 'Create Ribbon Set' panel and click on the
Delete button and on the OK button in the confirmation
prompt; if there are no Ribbon Sets left, the system reverts
to the default of a full set of ribbons with all panels
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Working Sets
As you perform work on your model, you open various
windows, diagrams and views, and you will probably need
to return to these same views in a later work session. At the
end of your work session, you can capture your current
work environment as a working set, which you use to return
to that exact environment later, either when you choose to or
by having the system automatically recreate it when you
next log on to Enterprise Architect. You can also create a
working set as an empty definition to which you add
specific windows, diagrams and views, from either the
'Working Sets' tab or from a Working Set Artifact element.
You can use the working set to pick up your work from
where you left off, or as a set of 'home pages' to start from
each day. You can also open multiple working sets, which
combines the views from each set. This can be useful to
check the progression between different stages in a piece of
work.
A working set is initially a personal list, not visible to or
active for any other user. You can convert it into a global set
to share with other users of your model; for example, if a
working set shows a cross-section of an aspect of the model
you want to demonstrate or have reviewed.

Access
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Start > View > Workspace > My
Working Sets

Manage working sets
Option

Action

Create a
working set
from open
diagrams or
files

Either:
· Click on the first icon in the toolbar, or
· Right-click on the body of the tab and
select the 'Create Working Set' option,
or
· Right-click on the body of the tab and
select the 'Create Working Set From'
option, and either the 'Open Diagrams'
or 'Open Files' sub-option as
appropriate
The 'Create Working Set' dialog displays,
listing the diagrams and views that are
currently open, in the order in which they
were opened. If necessary, you can
change the order using the 'hand' buttons
at the bottom of the dialog.
Select the checkbox against each item
that you want to retain in the working set,
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or click on the Include All button. If you
selected the 'Create Working Set From'
option, the checkboxes against the open
diagrams or the open files are already
selected.
In the 'Name' field, type a name for the
working set.
You can either:
· Immediately click on the OK button to
create the working set from the selected
items, or
· Add other selections as described for
Create a new working set
Create a new
working set
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Either:
· Click on the first icon in the toolbar, or
· Right-click on the body of the tab and
select the 'Create Working Set' option,
or
· Switch to an open diagram, drag a
'Working Set' icon from the 'Artifacts'
page of the Diagram Toolbox onto the
diagram, right-click on the new
Working Set Artifact element and
select the 'Edit Working Set' option
The 'Create Working Set' dialog displays.
In the 'Name' field, type a name for the
working set.
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To add a diagram or view, click on the
Add Other button and select an option
from the list:
· Add Diagram
· Add Matrix Profile
· Add Search
· Add Team Library
· Add Document Template
· Add Resource Document
You are prompted to select the required
diagram, profile, search, Team Library
topic, document report template or
Resource document name(s); each view
is then added to the list with its checkbox
selected.
Click on the Add Other button again, to
select the next item.
When you have all the diagrams and
views you need, click on the OK button
to create the working set.
Open an
existing
working set
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A Working Set created on the 'Working
Sets' tab is indicated by this icon .
A Working Set created as an Artifact
element is indicated in the list by this
icon .
Click on a working set name and either:
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Select the third icon in the toolbar or
· Right-click and select the 'Open
Working Set' context menu option
Enterprise Architect opens all the
diagrams and views listed in that set.
If you already have a working set open,
the 'new' set of views is added to the
original set, with the last-listed diagram
or view on top and in focus.
You open one Model Search, Matrix
profile or Team Library at a time;
therefore, the last-opened Search, profile
or Team Library replaces the previous
instances.
·

Automaticall
y apply a
working set
when the
model is
opened
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Right-click on the working set name and
select the 'Apply when model opens'
option.
This option is a toggle that turns the same
option off for the previous working set on
which it was selected.
The folder turns green, indicating that the
option is 'on' for this working set.
When you close the model and
subsequently open it, the diagrams and
views in the working set are
automatically opened.
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Share a
working set

Right-click on the working set name and
select the 'Share Working Set' option.
The folder icon on the left of the working
set name in the list now contains an icon
depicting the globe, and the working set
is available in the 'Working Sets' tab of
every other user of the model.
This setting is not reversible; to make the
global list into a personal list, make a
copy of it.

Add an open
view or
diagram to a
working set

If, in your work, you open a diagram or
view that you decide to add to a working
set:
· Click on the 'Working Sets' tab,
right-click on the required set name and
select the 'Add Active View' option
The open view is added to the working
set.

Duplicate a
working set

If you want to use a variation of a
working set without losing the original,
you can create a copy and amend that
copy as required.
Right-click on the source working set and
select the 'Copy as New' option.
The 'Create Working Set' dialog displays.
In the 'Name' field, type a name for the
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working set.
Each of the listed diagrams and views is
already selected; make any changes you
require, and click on the OK button to
save the list as a new working set.
Edit a
working set

To change the diagrams and views in a
working set, or change the set name, click
on the set name and either:
· Click on the second icon in the toolbar
or
· Right-click and select the 'Edit' option
The 'Create Working Set' dialog displays.
Make any changes you require, and click
on the OK button to save the changes.

Delete a
working set,
or a view in
working set

Expand the working set and select a
specific item (to remove that item) or the
set name (to move the whole set)
Either:
· Click on the fifth icon in the toolbar or
· Right-click on the set and select the
'Delete Working Set Item' option
A prompt displays to confirm the
deletion; click on the Yes button.
The item or set is removed.
If you delete a working set that you have
opened, the diagrams and views from that
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set remain open until you specifically
close each one or close Enterprise
Architect.
Note:
· When you create a Working Set on a
diagram, using the icon from the
'Common' page of the Diagram
Toolbox, the Working Set persists in
the Personal Tasks view if you delete
the element from the diagram, but not
if you delete the element from the
Project Browser/model
Save floating
window
layout in
working set

If any of the selected diagrams or views
in your working set are floating windows,
the 'Create Working Set' or 'Edit Working
Set' dialog includes the item 'Save
Workspace Layout'.
Select this checkbox; the working set
captures the complete current workspace
layout, including the locations of the
floating or docked views.
Next time you load the working set, the
captured workspace layout is reapplied.

Track
working
set/views last
opened

You might use several working sets in a
work session, and close some views and
open others.
To capture the diagrams and views you
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actually have open when you close down
Enterprise Architect, right-click on the
body of the tab and select the 'Store Main
Tab View History' option. A new, empty
working set folder displays at the top of
the list - 'Windows open when Model was
last closed'.
When you reopen the model in a new
work session, this new folder is
automatically populated with a list of the
diagrams and views that were open when
you last closed the model; this is a
read-only set that cannot be edited.
You can expand the set and double-click
on specific windows to re-open them, or
right-click on the set and use the 'Open
Working Set' option to reopen all the
diagrams and views you had open before.
However, it is recommended that you use
the 'Apply when model opens' context
menu option on the set; thereafter,
whenever you open the model, all the
diagrams and views you had open when
you closed the model are automatically
re-opened.
Locate a
diagram from
the working
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select the 'Find in Project Browser'
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set in the
Project
Browser

option, or
· Click on the diagram name and click
on the 'Locate in Project Browser'
toolbar icon ( )
The section of the Project Browser
containing the diagram is expanded, and
the diagram name is highlighted.

Locate a
Working Set
Artifact
element in
the model

Either:
· Right-click on the element name and
select the 'Find in Project Browser'
option, or
· Click on the element name and click on
the 'Locate in Project Browser' toolbar
icon ( )
The section of the Project Browser
containing the element is expanded, and
the element name is highlighted.
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Local Options

Enterprise Architect has a wide range of default settings for
controlling how the system displays and works with models
and model elements. You can customize these settings to
define your preferred behavior of the system. Most of the
settings are stored in your registry so they are set for your
use only on any model you open. For a networked
workplace, registry settings can be copied down to any
network workstation you log in to. Otherwise, the settings
control operations under your login on the current machine
only.
The settings are grouped according to their actions on
specific functional areas, on a number of pages of the
'Preferences' dialog.

Access
Ribbon

Start > View > Preferences

Keyboard
Shortcuts

Ctrl+F9
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Option Groups
Group/Page

Action

General
Options

Control the behavior of the system as a
whole.
You can also define model-specific
options (such as the default directory
name for the shared files you define for
an element) using the 'Manage Project
Options' dialog.

Diagram
(New
Diagram
Defaults)

Set the general properties of all diagrams
you create.

Diagram Themes

Create and apply display themes for all
diagrams that you open.

Diagram Standard
Colors

Set the display colors and background
colors of objects and properties in
diagrams across the system.

Diagram Appearance

Control how elements are displayed on a
diagram.
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Diagram Behavior

Control how a diagram responds to
actions taken on it.

Diagram Sequence
(diagram
display)

Control the appearance and behavior of
Sequence diagrams specifically.

Objects
(display)

Configure the properties and behaviors of
elements created on your diagrams.

Links
(Connector
display)

Define the creation, behavior and
notation of connectors on your diagrams.

Communicati
on Colors (of
Communicati
on Messages)

Set the colors of Messages you create in
Communication diagrams.

XML
Specification
s

Configure the settings for working with
XML.

Source Code
Engineering

Set general user-specific options that
apply to all languages when you are
generating code from models
You can also define model-specific
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options (such as the default language in
which to generate code) using the
'Manage Project Options' dialog.
Code Editors

Configure options for the system internal
editor, and for the default editor for DDL
scripts.

Object
Lifetimes

Enable the creation of constructors and
destructors for Object Lifetimes.

Attribute/Ope Set the system actions on attributes and
rations
operations.
Code
language
specifications
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Define how the system handles a
particular language when generating
code, setting user-specific variables such
as the default source directory.
You can also define model-specific
options (such as the default file
extensions to apply when generating code
in the selected language) using the
'Manage Project Options' dialog.
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General Options
You can control how the system behaves when you open a
project, including setting the home directories and web
pages the project refers to.
The 'General' page has a child 'Window Behavior' page for
defining how dockable windows display on the system.

Access
Ribbon

Start > View > Preferences > General

Keyboard
Shortcuts

Ctrl+F9 | General

Control system behavior
Field/Button

Action

Author

Defaults to your Windows user name.
This value is applied to the 'Author' field
when you create new elements and
diagrams. Optionally, type in a new
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Author name, or click on the drop-down
arrow and select a name from the list
(which contains names defined on the
'Project Author(s)' page of the 'People'
dialog).
When user security is enabled, this field
will be populated with your Firstname
Lastname as defined in the 'Manage
Users' dialog, and it can only be modified
there, not on the 'General' page of the
'Preferences' dialog.
Clipboard
Format

Click on the drop-down arrow and select
the graphic format in which to save
images to the Microsoft Windows
clipboard; Metafile has the best detail.

Use Jet 4.0 requires
restart

Select the checkbox to set JET 4.0 as the
database engine; this ensures
compatibility with .eap files that are in
turn compatible with versions of MS
Access later than Access 97, and that
support unicode character sets.
If your project is not in a Jet 4.0 database,
you should also download a copy of the
Jet 4.0 EABase Model from the Sparx
Systems website, and do a 'File to File'
transfer of your model into the Jet 4.0
file.
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If the checkbox is not selected, the
database engine is Jet 3.5.
Use extended
« and »
characters

The checkbox defaults to selected to
apply the guillemet characters to
stereotype names; recommended for
double byte character sets.
Deselect the checkbox to hide the
guillemet characters.

Allow
custom RTF
tags in
reports

Select the checkbox to use customized
rich text format code in report templates
when you generate reports with the
'Legacy RTF Report Generator'.
In releases of Enterprise Architect from
7.0 onwards, with the notes-formatting
facility, this option is not really
necessary.

Default
Project

Either type in the file path and file name
of the project to open when you start up
Enterprise Architect, or click on the
button and browse for the project.

Project
Directory

Type in the default directory location for
the Enterprise Architect project files you
create.

Web Home

Type in the URL of the default home
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page to open when you click on the
Home button in the internal web browser.
Web Search

Type in the URL of the default web page
to open when you click on the Web
Search button in the internal web
browser.

Web Mail

Type in the email server address
(http://xxxxx/exchange/) for accessing
email within Enterprise Architect,
through the web browser.

Portal Guides

When you select a PDF User Guide from
the User Guide Portal, the system
downloads the file from the Sparx
Systems website. If you have stored the
User Guides in a different location, type
in either the local directory path or the
URL of the website into which you have
moved the files.

Confirm
Deletes

The checkbox defaults to selected to
display a confirmation prompt whenever
you delete a model component.
Only clear this checkbox to bypass the
prompt if you are an experienced user
and have taken other measures to identify
and recover from accidental deletes.
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Allow Free
Sorting

Select the checkbox to allow you to
manually reorganize elements within a
Package regardless of element type, in
the Project Browser.

Show
Stereotypes

The checkbox defaults to selected to
display element and feature stereotype
names as part of the object names in the
Project Browser.
Deselect the checkbox to hide the
stereotype names.

Project
Loading
Strategy

Click on the drop-down arrow and select
the model loading behavior for project
files; choose either:
· 'Load on Demand' (Lazy Load) or
· 'Preload Entire Model'
'Load on Demand' does not load the full
project view when you load a model;
instead, only the parts that are necessary
to display the visible portion of the tree
are loaded.
This means that the model loads faster
and you can begin work sooner, but at the
expense of later small delays as the
system loads specific portions of the
model.
For server connections, the 'Load on
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Demand' option is automatically set when
the connection is created.
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Window Behavior
You use the 'Window Behavior' page of the 'Preferences'
dialog for setting local options that determine how dockable
windows display on your system.

Access
Ribbon

Start > View > Preferences > General >
Window Behavior

Keyboard
Shortcuts

Ctrl+F9 | General | Window Behavior

Control Window Display
Select from the options listed here.
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Field

Description

Always open
maximized

The checkbox defaults to selected to set
Enterprise Architect to open in a
full-screen (maximized) window on
start-up.
Deselect the checkbox to set Enterprise
Architect to open in a smaller window.

Hide
Properties
Info Section

The checkbox defaults to selected to hide
the properties information bar at the
bottom of various displays such as the
element Properties window, 'Properties'
dialogs and Tagged Values window.
Deselect the checkbox to expose the
information bar.

Animate
Autohide
Windows

If you are using windows that have been
automatically hidden, they simply appear
in the workspace when you move the

(c) Sparx Systems 2018

Page 546 of 694

User Guide - User Interface

21 December, 2018

cursor over the window tab.
Select this checkbox to slide the windows
out into the workspace when you place
the cursor on the window tab.
Show
Toolbar
Customize
Button

Each toolbar can have a down-arrow
button on the end, which enables you to
customize the toolbar options. This
checkbox defaults to selected to show the
down-arrow button; deselect the
checkbox to hide the button, if you prefer.

Hide
Diagram
Caption Bar

The diagram caption bar normally
displays at the top or bottom of a
diagram. If you prefer, select this
checkbox to hide the caption bar.

Hide Status
Bar

The Status Bar normally displays at the
bottom of the Enterprise Architect work
area. It shows information on the current
operation and certain key settings, and
provides a 'zoom bar' for adjusting the
scale of the diagrams you view. If you
prefer to hide the Status Bar, select the
checkbox.
You can also hide sections of the
information that the Status Bar shows by
right-clicking on it and de-selecting either
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or both of the options:
· Zoom Slider
· Status Indicators
Show Tab
icons

Select this checkbox to show a
representative icon on the name tab of
each docked window.
Deselect the checkbox to hide these
icons.

Show
'auto-hidden'
windows on
mouse over

The checkbox defaults to selected to
show hidden windows when you drag the
cursor onto the window's tab using the
mouse. When you move the cursor off the
window, it no longer displays.
If you deselect the checkbox, you have to
left-click on the window's tab to display
the window.

Full Row
In a window that displays a hierarchy of
Select in Tree model elements - such as the Project
Controls
Browser - clicking on an item highlights
the selection. Selecting the 'Full Row
Select in Tree Controls' checkbox causes
the highlight to extend across the width
of the window. Deselecting the checkbox
restricts the highlight to the object name.
(c) Sparx Systems 2018
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Track
When this checkbox is selected, moving
Selection in
the cursor over an item in a hierarchy
Tree Controls window - such as the Project Browser causes an underline to display under the
element name, indicating that the item
has focus and can be selected. If you
deselect the checkbox, the listed items are
not underlined and none have focus until
they are explicitly clicked on.
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Diagram Options
In order to maintain consistency in the format, layout and
visibility of objects in your diagrams, you can define a
number of default settings to apply to all diagrams that you
display, whether you are creating them or reviewing them.
You can change or reverse many of these default settings for
your view of individual diagrams (whether you created them
or another user created them) on the diagram 'Properties'
dialog.

Access
Ribbon

Start > View > Preferences > Diagram

Keyboard
Shortcuts

Ctrl+F9 | Diagram

Control diagram set up
Field/Button

Action

Default Page

Show (underneath the field name) the
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Size

default page size for diagrams.
You set the default page size using the
Page Setup button.

Page Setup

Click on this button to define the page
dimensions for diagrams that you create.
The 'Page Setup' dialog displays, on
which you set the page size, orientation,
printer paper tray, and page margins.

Print with
Border

Select the checkbox to set the default to
printing a border on all diagrams you
have created.

Landscape

This checkbox is controlled from the
'Page Setup' dialog. When selected, any
diagrams that you create default to being
printed in landscape orientation.

Show Public
Features
Show
Protected
Features
Show Private
Features

Select any or all of the checkboxes to
automatically show Class features with
the scope of public, protected and/or
private on the diagrams you create.

Show
Diagram

Select the checkbox to display, by
default, the diagram details (name, parent
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Notes

Package, version and author) in the top
left corner of any new diagram that you
create.
Selecting this checkbox sets the 'Show
Diagram Details' checkbox to selected on
the 'Diagram Properties' dialog for the
new diagram.

Use Opaque
Diagram
Labels

Select any or all of the checkboxes to
specify which renditions of your
diagrams should have opaque diagram
labels; 'Screen' and 'Printing' are most
often applicable.
An opaque label is a connector or
element label that, when the label
overlaps the connector line or border,
hides the line rather than allowing it to
show through the label text.

Disable fully
scoped object
names

Select this checkbox to disable the use of
fully scoped object names for elements in
all diagrams.
A scoped object name has the format
MyClasses::foo, where the :: character
indicates that the Class is within another
namespace.
This option automatically deselects the
'Show Namespace' option in all new
diagrams and hides the
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'Namespace::element Name' in each
element, but does not hide the '(from
'Namespace')' label.
Alternatively, fully-scoped object names
can be disabled for a specific diagram via
the diagram's display options.
Allow
change of
Created Date

Select this checkbox to allow you to
change the diagram creation date on any
diagram, through the 'Diagram Properties'
dialog.

Zoom to best
scale

Select this checkbox to resize all
diagrams that you open to neatly fit the
monitor screen.

Auto-pan
with middle
mouse button

Select this checkbox to turn on
auto-panning using the middle mouse
button. In this case, when you hold down
the middle mouse button a black compass
icon displays, and as you move the cursor
away from this icon the diagram scrolls
in that direction.
If you deselect the checkbox, when you
hold down the middle mouse button a
white compass icon displays, and as you
move this icon the whole diagram moves
with it across or up and down the screen.
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Enable
Connector
line jumps

Defaults to selected, so that solid-line
connectors show 'hoop' icons or 'jumps'
when they cross, on all diagrams that you
open.
Deselect to disable line jumps so that
connectors simply cross with no 'hoop'
icon at the intersection.

Scale Saved
Bitmaps to

You can save images of diagrams to file,
suitable for using in published works,
using the 'Publish > Diagram > Image >
Save to File' ribbon option. This option
prompts you to specify the file location
and file format. If you select to save the
files in bitmap format, the images are
scaled to the default of 133%.
If you prefer to use a different scale, click
on the drop-down arrow and select one of
the other set values between 100% and
400%.
Images saved in formats other than
bitmap are not scaled.

Apply scale
to clipboard

You can also save images of diagrams to
the clipboard, in either bitmap or metafile
format (set in the 'Clipboard Format' field
on the 'General' page of the 'Options'
dialog), using the 'Publish > Diagram >
Image > Save to Clipboard' ribbon
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option.
If you have set the format to 'Bitmap',
you can save the images to the clipboard
scaled to the same percentage as is set for
saving to file, by selecting this checkbox.
You cannot scale metafile images.
Image
Memory
Limit

When you generate images for document
or web reports or save images to file, the
memory limit for storing this image
defaults to 48 MB. If the image is beyond
this limit, the system starts to scale down
the image.
You can click on the drop-down arrow
and select a lower or higher memory limit
for the image files of your diagrams. A
low memory setting means the system
scales the image sooner.

Diagram
Frames

Click on any or all of the checkboxes to
specify which saved images of your
diagrams will automatically include a
diagram frame around them - those saved
to disk, those printed out, and/or those
saved to the default system clipboard.
A diagram frame is a labeled outline
around the diagram image, providing
both a border and a reference. A SysML
Internal Block element can have its own
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diagram frame; if that frame is selected to
be shown, these Diagram Frames options
are ignored for the diagram.
These diagram frames are not the same as
the Diagram Frame element in which you
can enclose a diagram image or reference
when you drag the diagram from the
Project Browser onto another diagram.
Show
Tooltips

(c) Sparx Systems 2018

Select the checkbox to display a tool-tip
when the cursor is rolled over an element
on a diagram you have opened, or over
the background of the diagram itself.
If the 'Show tips in Status bar' option is
selected on the 'Application Look' dialog,
the tool-tip displays in the Status Bar; if
that option is not selected, the tool-tip
displays at the cursor position on the
diagram.
If you have selected the 'Show Tooltips'
checkbox, select the checkbox against
each item of information you want to be
displayed as part of a tool-tip.
If you select the 'Notes' checkbox, and
the tooltip is being displayed on the
diagram, consider whether the 'Max
Characters' value is appropriate to
represent the text of your element 'Notes'
fields. The 'Max Characters' field defines
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the maximum number of characters of
Notes text included in the tool-tip; if you
want to show less text or more, reset the
character limit accordingly.
Be aware that, if the tool-tip is being
displayed in the Status Bar, the 'Notes'
field text will not be included.
Close
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Click on this button to save the changes
you have made, and to close the
'Preferences' dialog.
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Diagram Theme Options
It is possible to apply a theme to all diagrams in the project
that you display on your workstation; that is, how the
diagrams and their contents appear when you display them
in the Diagram View. By applying a theme you can change
the color, font, gradient, line thickness and background
image (tile). Each design helps bring your diagrams to life
with brighter colors, better contrast and stylish new designs.
As you select a theme, the appearance settings are
immediately applied to any diagram that you have open.
Enterprise Architect includes a number of basic built-in
themes, which are useful to a wide range of users and are
good examples of how a theme can enhance the diagrams
that you have open.
You can also create your own themes, capturing the set of
colors, text font, line thickness and/or gradient properties
that you have currently defined in the 'Preferences' dialog,
on the:
· 'Gradients and Background' page
· 'Standard Colors' page
· 'Appearance' page, and
· 'Links' page
You select or deselect a checkbox for each set of properties
you want to include or exclude, from the 'Preferences' dialog
pages.
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Access
On the 'Preferences' dialog, select the 'Diagram > Themes'
page.
Ribbon

Start > View > Preferences

Keyboard
Shortcuts

Ctrl+F9

Configure themes for diagrams and elements
Option

Action

Name

Click on the drop-down arrow and select
the theme you want to either:
· Apply as the default appearance of
your diagrams
· Edit (user-defined theme)
· Use as the base for a new user-defined
theme, or
· Delete (user-defined theme)

Font

Select the checkbox to include the 'User
Font Face' and 'Font Size' settings from
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the 'Appearance' page of the 'Preferences'
dialog (click on the 'Configure Default
Element Fonts' button on the
'Appearance' page to set these fields).
Deselect the checkbox to retain the
previous font applied to the diagram.
Color

Select the checkbox to include the
element, connector and diagram colors
defined on the 'Gradients and
Background' page and the 'Standard
Colors' page.
Deselect the checkbox to retain the
previous set of colors applied to the
diagram.

Line
Thickness

Select the checkbox to include the
'Default Element Border Width' from the
'Appearance' page, and the 'Pen Width'
(for connector line thickness) from the
'Link' page of the 'Preferences' dialog.
Deselect the checkbox to retain the
previous set of line widths applied to the
diagram.

Gradient

Select the checkbox to apply the setting
of the 'Show Gradient Fill for Paper
Color' checkbox (which applies a color
gradient to the background color of the
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diagrams you display) and the 'Gradient
Fill Direction for an Element' field on the
'Gradients and Background' page of the
'Preferences' dialog.
Deselect the checkbox to retain the
previous color gradient settings applied to
the diagram.
Background
Image

Select the checkbox to incorporate the
currently-set diagram background image
in the theme.

Element
Shadows

Select the checkbox to incorporate the
currently-set element shadow setting (on
or off) and color in the theme.

Save

Click on this button to either:
· Create a new user-defined theme, or
· Save changes to an existing theme
The 'Diagram Theme' dialog displays for
the theme name. Either:
· Type in a name for the theme and click
on the OK button to create the new
theme, or
· Simply click on the OK button and
then click on the Yes button to save the
updates to the theme under the same
theme name
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Delete

(Only available if a user-defined theme is
selected.)
Click on this button to delete the selected
theme.
A prompt displays for you to confirm the
deletion. Click on the Yes button to
delete the theme, or on the No button to
cancel the deletion.

Close

Click on this button to close the
'Preferences' dialog.
If you have edited an existing theme, this
applies all changes to the theme to the
diagrams you have open.

Notes
·

·

You cannot edit or delete a built-in theme; you can use a
built-in theme as the base for a user-defined theme
A theme draws its properties from other pages of the
'Preferences' dialog, therefore if you select the 'Gradient'
checkbox the theme will apply the status of the 'Show
Gradient Fill for Paper Color' checkbox on the 'Gradients
and Background' page, when that status might be disabled
because you have applied a background tile image

(c) Sparx Systems 2018

Page 562 of 694

User Guide - User Interface
·

21 December, 2018

You can apply a different theme to an individual diagram,
on the 'Theme' tab of the diagram 'Properties' dialog
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Diagram Gradients and Backgrounds
When reviewing the diagrams in your model, you have a
range of options for managing the display and appearance of
the diagrams and their contents. These options include
setting the color and shading of the diagram and elements,
and the style of the page border of the diagram. You can
also, instead of using the color wash, select a tiled
background image for the diagrams you display, from a set
of system-supplied images or from images that you have
created or downloaded to a local system folder yourself.

Access
Ribbon

Start > View > Preferences > Diagram >
Gradients and Background

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Gradients and
Background

Diagram Background Options
Field/Button
(c) Sparx Systems 2018

Action
Page 564 of 694

User Guide - User Interface

21 December, 2018

Tile

Either:
· Type in the file path for a .jpg, .bmp or
.png graphics file to use as a
background for all your diagrams, or
· Click on the Select Tile button to the
right of the field and select a file (by
default from the Enterprise Architect
supplied tiles folder, but you can
browse to any other file location for the
required file)
The selected background is immediately
applied to any diagrams you have open,
and the field displays the location of the
background graphic file, such as:
C:\Program Files\Sparx
Systems\EA\BackgroundTiles\Aqua_03.j
pg
If you no longer want to apply a
background tile to your diagrams, click
on the Clear File button to clear the field.
All diagrams with a background tile will
include that background when saved as a
Diagram Image or a copy.

Paper

Click on the drop-down arrow to change
the background color of the diagrams you
display.
This field is disabled if you have selected
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a background tile. The field is re-enabled
when the file path is deleted from the
'Tile' field.
Page Border
Style
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Click on the drop-down arrow and select
the option for the type of page border you
want to use when displaying diagrams on
your monitor. You can choose from:
· Solid (the default) - pages are framed
by a solid dark gray line on the screen
· Dash - pages are framed by a broken
dark gray line
· Dash (with white line) - pages are
framed by a broken dark gray line on a
solid pale background
· Dot - pages are framed by a dotted dark
gray line
· Dot (with white line) - pages are
framed by a dotted dark gray line on a
solid pale background line
· Chiselled - pages are framed by a thin
black line bordered by a thicker dark
gray line to the right or below
If you cannot see the page border on a
diagram, right-click on the diagram and
select the 'Properties' option, then check
that the 'Hide Page Border (All
Diagrams)' or 'Hide Page Border (Current
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Diagram)' options are not selected.
Gradient

Click on the drop-down arrow and select
the direction of the color gradient to
apply to the background color of the
diagrams you display - Up or Down. You
set the background color itself in the
'Paper' field.
Select <none> to apply the background
color uniformly to the diagram
background.
This field is disabled if you have selected
a background tile. The field is re-enabled
when the file path is deleted from the
'Tile' field.

Element Fill Options
Option

Action

Gradient Fill
Direction For
an Element

Click on the drop-down arrow and select
the direction of the color gradient applied
to the element fill color.
Select <none> to apply the element fill
color uniformly to the element, with no
color gradient.
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Gradient
Style for
Element

Click on the drop-down arrow and select
the style to apply to the element fill color
gradient. The options apply:
· On the left or upper edge of each
element, a band of the gradient color
that fades in the direction of the fill,
and that has an angled line or curve on
the inner boundary
· On the right or lower side of each
element, a band of the gradient color
that fades at 90 degrees to the
first-defined gradient direction
Select '<none>' to have a single band of
color fading across the element in the fill
direction.

Fill

Click on the drop-down arrow and select
the fill color of all elements (except
Screen elements and Notes) on the
diagrams you display.
You can also change the element fill
color on the 'Standard Colors' page,
where you can define the fill color of
Screen and Notes elements as well.
You can quickly make fill color changes
using the 'Hue', 'Saturation' and
'Luminosity' fields, in combination. The
'Fill' field reflects the color changes as
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you make them, but having a diagram
open with large elements also shows the
changes immediately and very clearly.
Revert

Click on this button to reset the fill color
to the previously saved color. If you have
been testing new colors but have not
closed and re-opened the 'Preferences'
dialog, you can return to the color you
originally changed from.

Hue

Click on the slider icon and drag it along
the line to set the basic primary color or
combination of two primary colors. The
numerical value of the color (the H value
in the HSL code) displays in the field to
the right of the slider.

Saturation

Click on the slider icon and drag it along
the line to set the color saturation (the
degree of grayness in the color). The
numerical value of the saturation (the 'S'
value in the 'HSL' code) displays in the
field to the right of the slider.

Luminosity

Click on the slider icon and drag it along
the line to set the color luminosity (the
degree of light in the color, from none
(black) to full (white). The numerical
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value of the luminosity (the L value in the
HSL code) displays in the field to the
right of the slider.

Gradient Options
These options are ineffective if the 'Gradient Fill Direction
for an Element' field is set to '<none>'.
Field/Button

Action

Tint Amount

Click on the slider icon and drag it along
the line to set the degree of tint in the
color gradient. Moving from the left end
the slider sets completely black at the top
of the gradient, through no tint to
completely white at the top of the
gradient.
The percentage tint displays in the field
to the right of the slider, showing -50%
for the left end of the slider, 0% (the
default) in the center and 50% at the right
end.
To reset the Tint Amount to the system
default (which is a slight, dusky
gradient), click on the Default button.
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Click on the slider icon and drag it along
the line to set the degree of fill of the
gradient. From the left end the slider sets,
effectively, no gradient (0%) through to
starting the gradient immediately at one
edge of the element and building right
across the element (100%).
The percentage gradient fill displays in
the field to the right of the slider.
To reset the Fill Amount to the system
default (80%), click on the Default
button.
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Standard Colors
On a model diagram, the objects and texts are rendered in
the system default colors. You can change any of these
default colors to either one of a range of standard colors, or
a color that you define yourself. Another user viewing the
same model diagrams will still see the diagrams in either the
standard default colors or colors that user has selected for
their own use.
If you define and select a 'non-standard' color for an object
type, that color is shown in the color pallet whilst it is the
selected color for that object type. If you then select a
different color, the non-standard color is no longer available
in the pallet. You can, however, define up to 16 custom
colors (using the Define Colors button) that are permanently
available to use in changing the appearance of individual
elements through the 'Default Appearance' dialog and
'Diagram' page of the 'Preferences' dialog.

Access
Ribbon

Start > View > Preferences > Diagram >
Standard Colors

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Standard Colors
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Customize Diagram Element Colors
The color combo boxes on the 'Standard Colors' page help
you to customize the various colors that will be used to draw
elements (and their features) on all diagrams.
Ste Action
p
1

On the selected color combo box, click on the
drop-down arrow.
A 10x14 color pallet displays showing a range of
standard colors, with the system default color shown
above the pallet and a row of squares for custom
colors underneath. If custom colors have already
been defined (using the Define Colors button) they
are shown in the additional row.

2

If the color you want to use is shown on the pallet,
click on it to select it and to return to the 'Standard
Colors' page.

3

If the color you want to use is not shown, click on
the More Colors button.
The 'Color' dialog displays showing the 'Standard'
tab, offering a larger range of standard colors.
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4

If the color you want to use is shown on the pallet,
click on it to show that color in the 'New' panel and
(optionally) compare it with the currently-set color in
the 'Current' panel.
Click on the OK button to set the selected color and
to return to the 'Standard Colors' page.

5

If a suitable color is not available in the extended
pallet, click on the 'Custom' tab. This contains:
· A spectrum panel, with a 'sampler' icon; move the
icon around the panel to change the color shown in
the 'New' panel
· A 'Luminosity' bar; move the arrow on the right up
and down to change the intensity of the color
shown in the 'New' panel
· 'Hue', 'Sat'(uration) and 'Lum'(inosity) (HSL)
fields, and 'Red', 'Green' and 'Blue' (RGB) fields;
type and increment or decrement the decimal
values to either:
- make slight modifications to a color or
- exactly define a color for which you know the
HSL and/or RGB values
As you define the color it changes in the 'New'
panel; (optionally) compare it with the currently-set
color in the 'Current' panel and adjust it as necessary.
When you have defined your color, click on the OK
button to select it and to return to the 'Standard
Colors' page.
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6

As an alternative to selecting a standard color or
defining a new one, you can capture a color that is
used elsewhere on your current monitor screen.
Click on the Select button to redisplay the cursor as
an 'eye-dropper' icon; move this around the screen to
the color you want to sample.
Position the cursor so that the color is under the tip
of the 'eye-dropper' and shown in the 'New' panel.
Click the left mouse button to capture the color, then
click on the OK button to select it and to return to
the 'Standard Colors' page.

7

Click on the Close button to save your changes and
close the 'Preferences' dialog.

Elements
Element /
Component

Description

Fill

Define the fill color of all elements
(except Screen elements and Notes) on
the diagrams you display.
This color can also be changed on the
'Gradients and Backgrounds' page, and
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overridden by any other fill color
definition in your model, such as the
Layout ribbon fill setting, element default
appearance, Template Element Package
or stereotype definition.
Line

Define the line color of all element
borders on the diagrams you display.

Text

Define the font color of element text and
labels on the diagrams you display
(including Text elements).

Shadows

Define the color of element outline
shadows on the diagrams you display
(including Notes).

Attributes

Define the font color of attribute text in
the attribute compartment of all elements
on the diagrams you display.

Methods

Define the font color of method
(operation) text in the operation
compartment of all elements on the
diagrams you display.

Behaviors

Define the color for behaviors in Activity
diagrams you display.
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Define the color of text in the element
notes compartment of all elements on the
diagrams you display.

Notes & Constraints Elements
Element /
Component

Description

Fill

Define the fill color of Note and
Constraint elements on the diagrams you
display.

Text

Define the font color of Note and
Constraint text on the diagrams you
display.

Note Line

Define the line color of the borders on
Note elements on the diagrams you
display.

Constraint
Line

Define the line color of the borders on
Constraint elements on the diagrams you
display.
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Others
Element /
Component

Description

Connector
Lines

Define the line color of all connectors on
the diagrams you display.

Screen Fill

Define the fill color of Screen elements
on User Interface diagrams you display.

Custom
Colors

Click on the Define Colors button to
define a set of custom colors for you to
apply to diagram elements anywhere in
the model.

Use Dark
Theme Style

Select this option to apply a
system-managed color theme to certain
types of element (including Packages,
Navigation Cells, Hyperlinks and
Diagram Notes) on diagrams when a dark
Theme is applied to the diagrams. The
general effect is to make the element
colors brighter and richer. The option also
allows use of a diagram background color
when saving the diagram as an image or
copying it to the clipboard.
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Notes
·

·

To override the default appearance of a specific element
on all diagrams on which it is found, right-click on the
element and select the 'Appearance | Default Appearance'
option; the 'Default Appearance' dialog displays
To change the appearance of a specific element on the
current diagram only, use the 'Style' panel of the 'Layout'
ribbon
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Create Custom Colors
If the standard colors available through the color palettes do
not meet your requirements, you can define up to 16 custom
colors that you apply to individual elements and connectors
through the 'Connector Appearance' dialog and element
'Default Appearance' dialog.
By applying such custom colors within a template diagram,
you can render all elements of the same type with the same
custom color, for all users of the project.
If another user has a set of custom colors that you want to
use, or a project manager has defined colors specifically for
the project, they can export these colors to the project file
and you can then import them directly as your custom color
pallet. If you have your own colors in the pallet, they are
overwritten by the imported set.

Access
Ribbon

Start > View > Preferences > Diagram >
Standard Colors : Define Colors

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Standard Colors :
Define Colors
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Define your custom colors
Ste Action
p
1

On the 'Color' dialog, click on the Define Custom
Colors » button.
The 'Color' dialog is extended to provide color
selection fields on the right of the dialog.

2

Click on an empty block in the 'Custom colors' pallet
(or, if you are replacing a color, click on that color
block in the pallet) and on the:
· 'Spectrum' panel, move the 'sampler' icon around
the panel to change the color shown in the
'Color|Solid' box
· 'Luminosity' bar, move the arrow on the right up
and down to change the intensity of the color
shown in the 'Color|Solid' box
· 'Hue', 'Sat'(uration) and 'Lum'(inosity) (HSL)
fields, and 'Red', 'Green' and 'Blue' (RGB) fields;
type decimal values to either:
- make slight modifications to a color or
- exactly define a color for which you know the
HSL and/or
RGB values
As you define the color it changes in the
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'Color|Solid' box.
3

When you have finished creating the color, click on
the Add to Custom Colors button to add the color to
the selected Custom Colors block.

4

Repeat steps 2 and 3 for any other custom colors you
want to define.

5

Click on the OK button to close the 'Color' dialog
and return to the 'Standard Colors' page of the
'Preferences' dialog.

6

To make the custom colors available for your use,
select the 'Show Project Custom Colors in Color
Combo Boxes' checkbox.
Up to 16 custom colors are displayed at the end of
the color selection pallets on the 'Connector
Appearance' dialog and element 'Default
Appearance' dialog.

7

Click on the Close button to close the 'Preferences'
dialog.
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Get/Set Custom Project Colors
If more than one person is working on a project, you might
want to share a set of custom colors with other team
members, or possibly provide special colors for use across
the whole project. You would then:
· Capture the custom or project colors you have defined, in
the project file, or
· Retrieve a set of colors someone else has defined, from
the project file

Access
Ribbon

Configure > Reference Data > Settings >
Colors > Get Project Custom Colors
Configure > Reference Data > Settings >
Colors > Set Project Custom Colors

Set custom project colors in the project file
Ste Action
p
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1

Define the custom colors on the 'Standard Colors'
page of the 'Preferences' dialog.

2

Select the 'Set Project Custom Colors' option.
This message displays:
Project Custom Colors export successful. 16 custom
colors saved to the project file.

3

Click on the OK button.
Notify the appropriate users that the colors are
available for importing.

Get project custom colors from the project
file
Ste Action
p
1

Select the 'Get Project Custom Colors' option.
This message displays:
Project Custom Colors import successful. 16 custom
colors imported from the project file.

2

The custom colors are now available at the end of
the color pallets of the 'Default Appearance' dialog
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and 'Connector Appearance' dialog.
· If the colors do not show, select the 'Start > View
> Preferences' ribbon option and the 'Diagram >
Standard Colors' page, and select the 'Show
Project Custom Colors in Color Combo Boxes'
checkbox
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Diagram Appearance Options
It is possible to configure the appearance of diagrams and
elements in your models; that is, how diagrams and their
contents appear when displayed in the Diagram View. There
is a wide range of options you can set to create this display
configuration. As you select an option, it has immediate
effect on any diagram that you have open, so you can see
what the change in appearance is.

Access
Ribbon

Start > View > Preferences > Diagram >
Appearance

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Appearance

Configure the appearance of diagrams and
elements
Field/Button
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Configure
Default
Element
Fonts

Click on this button to set the default text
fonts to use on diagrams that you have
opened yourself.

Renderer

Render smooth curves and diagonal lines
in diagrams, so that staggered vertical or
horizontal pixels are less obvious. Click
on the drop-down arrow and select the
type of renderer you prefer to use:
· Basic is GDI32; it does not provide
anti-aliasing and gradient fills
· Enhanced-1 is parallel to Windows
GDI+ but internal to Enterprise
Architect; it provides anti-aliasing and
gradient fills, and operates well across
different platforms
· Enhanced-2 is Windows GDI+; this
can vary across different platforms,
performing better than Enhanced-1 in
some environments, and less well in
others
Experiment with these options and see
which works best for your system and
requirements.

GDI Plus
Metafiles
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diagrams.
Deselect the checkbox if you do not want
to use GDI+ metafiles.
Image
Quality

Defaults to 'High' to maximize image
drawing quality for scaled and resized
images on a diagram. The option does not
affect the drawing of EMF or WMF
images.
This setting has an effect on processing
performance of the diagram, so if a
diagram has many images and
performance is more important than high
image quality, you can reset the field to
'Low'.

Default
Click on the drop-down arrow and select
Element
the default element border width (1, 2 or
Border Width 3 pixels).
Scale view
by
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the percentage (from 0 to 50, in
increments of 10) by which you can
automatically increase the size of all
objects on a diagram you are viewing,
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changes in the 'zoomed' display scale of a
diagram update this field and affect any
other diagrams that you open.
This has no impact any other diagram
Zoom facility in the system.
Print in Color

Select the checkbox to print your
diagrams in color.
Deselect the checkbox to print the
diagrams in black and white.

Document
with
background
color

Select this checkbox to apply the
background color of the current theme to
all diagram images generated in the RTF
Generator, instead of the standard white.

HTML
Report with
background
color

Select this checkbox to apply the
background color of the current theme to
all diagram images generated in the
HTML Generator, instead of the standard
white.

Anti-aliased
text

Select the checkbox to force text
anti-aliasing in diagrams.
If you deselect the checkbox, the system
applies the MS Windows default setting.
Therefore, if you do not want to use
anti-aliasing, ensure that the Windows
anti-aliasing default is also set to OFF.
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Compress
text to fit
within
Element

Select the checkbox to compress element
text within the current element
boundaries, when text at zoom levels
other than 100% would not fit inside
those boundaries.
Deselect the checkbox to expand the
element boundaries under those
conditions.

Italic Note
Element Text

Select the checkbox to display the text of
Note elements in italics.

Use Element
Group Style

Select the checkbox to apply a different
fill color to each object type, with objects
derived from a common element having
the same color (for example, Object,
Boundary, Control and Lifeline elements
are the same color).
Overrides all other settings for element
fill colors.

Bold Element Select the checkbox to display element
Names
names in bold text.
Element
Shadows On
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Select the checkbox to display a shadow
around the bottom and right edges of
each element in a diagram.
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Invert rotated
text for
metafiles

Select the checkbox to use a different text
format when external metafile readers are
causing issues.

Round edges
for elements

Select the checkbox to soften the corners
of all elements that have a rectangular
appearance, so that they have rounded
corners.

Hand Drawn
Mode - Font

Click on the drop-down arrow and select
the font to be used in any diagram you
display that has the 'Hand Drawn
Diagram' option selected.

Default

Click on this button to re-set the font you
see used in hand-drawn diagram mode to
the system default (Segoe Print).

Italic

For diagrams displayed in Hand Draw
mode, select this checkbox to display text
in italics.

Use
Watermark

Select the checkbox to add a watermark
to any diagrams that you print.

Text

Type in the text to use as watermark text.
If the 'Use Watermark' checkbox is
selected, this text is displayed on any
diagrams that you print.
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Click on this button to save the changes
you have made, and to close the
'Preferences' dialog.
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Set User Default Fonts
A diagram in your model uses a standard font that is applied
to any diagram displayed in any model. You can override
this by setting a user-specific font that applies to any
diagram that you display in any model.
You can also define Model Fonts that apply to any diagram
that any user displays within the model; the Model font
overrides the User font, to ensure that all members of the
project team have a consistent and coherent view of the
model. This avoids the problem of one user creating a
diagram in a small font, and another user trying to view it in
a larger font, which distorts the diagram.

Access
Ribbon

Start > View > Preferences > Diagram >
Appearance : Configure Default Element
Fonts

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Appearance :
Configure Default Element Fonts

Control default diagram fonts
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Field/Button

Action

Font Face

Click on the drop-down arrow and select
the font typeface to apply to your
diagrams if no model font is specified.

Font Size

Click on the drop-down arrow and select
the font size to apply to your diagrams if
no model font size is specified.

Restore
Defaults

Click on this button to restore the system
defaults to the user 'Font Face' and 'Font
Size' fields.

OK

Click on this button to close the dialog
and save your changes.

Cancel

Click on this button to close the dialog
and discard your changes.

Notes
·

In the Corporate, Unified and Ultimate editions of
Enterprise Architect, if security is enabled you must have
'Manage Project Settings' permission to set, change or
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clear the 'Model Font' fields
User fonts are overridden by specifically-defined element
fonts, so that the element is viewed as designed regardless
of the model or user defaults; to define the font for a
specific element, right-click on the element in a diagram
and select the 'Appearance | Set Font' option
If you cannot read the diagrams because the default font
makes the objects and text too small, you can scale up all
objects (that is, all diagram displays) to a more readable
size for you only; the objects are not scaled up for other
users
Everything on the diagram is enlarged to the same extent,
so it remains in proportion and readable; to do this, return
to the 'Diagram Appearance' page of the 'Preferences'
dialog and enter a suitable percentage value in the 'Scale
view by' field
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Diagram Behavior Options
As you create and edit diagrams in your model, the system
can respond in different ways to the types of object you are
adding to a diagram. You can configure a range of options
to control what response the system makes to the object you
are adding or the action you are performing.

Access
Ribbon

Start > View > Preferences > Diagram >
Behavior

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Behavior

Control diagram behavior
Field/Button

Action

Auto
Instance

Select the checkbox to automatically
create object instances when dragging
certain element types - such as Class and
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Component - from the Project Browser
onto the diagram, with the dragged
element as the classifier.
Deselect the checkbox to paste the
element as a link.
This option has no effect on Sequence
diagrams.
Instance has
Classifier
style

Select the checkbox to automatically
apply the classifier style of the element
from which an instance is instantiated,
when the instance is created either
through the 'Paste Element' dialog or
when 'Auto Instance' is selected.
The classifier style is the default
appearance of the classifier, such as fill
color and text font.

Show Life
Lines

Select the checkbox to adjust the
alignment of life lines for Sequence
elements.

Layout uses
all relations

Select the checkbox to automatically take
connectors of all types into account when
you lay out the diagram; deselect the
checkbox to ignore Association
connectors in automatically laying out the
elements.
The elements with Association
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connectors are moved as if they do not
have those relationships, although the
connectors themselves are still depicted
on the diagram.
This option acts through the 'Layout >
Diagram > Edit > Properties > Diagram :
Set Layout Style' option, and through the
'Digraph' option of the Layout Tools
window ('Layout > Tools > Diagram
Layout > Open Diagram Layout Tools').
Auto Save
Changes

Select the checkbox to automatically save
your changes as you work. No prompts
are displayed asking you to save the
changes.
Deselect the checkbox to display prompts
to save your changes when you attempt to
close the diagram without having saved
it.

Show
'Hidden'
Parents

Select the checkbox to list each element's
parent elements that are not already part
of the diagram, in the top right corner of
the element in the diagram.
Deselect the checkbox to not list the
parent elements.

Auto Group
Elements

Select the checkbox to also move
contained elements when you are moving
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their container elements. Deselect the
checkbox to move the container elements
independently.
You can toggle to the opposite setting of
this option when moving an element on a
diagram, by pressing and holding Alt.
Show Linked
Items in
Package

Select the checkbox to include external
elements in the Package contents list in a
Package element on a diagram. For this to
take effect, the 'Package Contents'
checkbox must be selected on the
'Elements' tab of the 'Diagram Properties'
dialog for the diagram.
Deselect the checkbox to omit external
elements from the list.

Show
Package Item
Scope

Select the checkbox to display the scope
indicators (such as +, # and -) against the
elements in the contents list within a
Package element. For this to take effect,
the 'Package Contents' checkbox must be
selected on the 'Elements' tab of the
'Diagram Properties' dialog for the
diagram.
Deselect the checkbox to hide these
indicators in the list.

Shift-Mouse

Select the checkbox to enable you to
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Autoscroll

autoscroll around diagrams by pressing
and holding Shift and pressing the middle
mouse button while you move the mouse.

Use
Automatic
SubActivities

Select the checkbox to automatically
create a new Structured Activity element
when you drag one Activity diagram
from the Project Browser onto another
Activity diagram, and select the
'Hyperlink' option.

Always
Highlight
Context
Element

Select the checkbox to show a hatched
border around any element when you
select it, along with the tracking handles
(see Tracking Handle Size).
Deselect the checkbox to show only the
tracking handles when you select an
element.

Objects Snap
to Grid

Select the checkbox to make all elements
on a diagram always align with the
nearest grid point.
Deselect the checkbox to position
elements at a precise point regardless of
the grid.

Show Grid

Select the checkbox to display the grid
points as pale gray dots. If you specify a
large grid size the grid points can be hard
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to see.
Deselect the checkbox to hide the grid
points.
Grid Size

If you have selected the 'Objects Snap to
Grid' checkbox, type in the separation of
the grid points, in pixels.
If you deselect the 'Objects Snap to Grid'
checkbox the value is grayed out, but it
remains in the field and is applied again if
you re-select the checkbox.

Auto Tidy

Select the checkbox to automatically tidy
line angles for custom connectors; this
'nudges' the custom line into horizontal
and vertical increments.

Tidy line gap

Type in the maximum distance, in pixels,
that the 'Auto Tidy' option can adjust the
end point of a non-orthogonal line to
make it orthogonal, for custom
connectors.

Alias only

Select the radio button to display, on
elements with aliases, the alias instead of
the element name.
This option and the next two options take
action on diagrams for which the 'Use
Alias if Available' checkbox is selected
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on the 'Diagram Properties' dialog.
Alias and
Name

Select the radio button to display, on
elements that have aliases, both the
element name and the Alias in the format
'(Alias) name'.

Use alias
field for role

Select the checkbox to use the Alias
property of instances of elements to show
the Role property.

Enable
Presentation
Mode

Select the checkbox to display your
diagrams in Presentation Mode.
In Presentation Mode, you can display a
diagram in a presentation and, when you
click on an element on the diagram, the
element is highlighted with a solid
colored border. This provides a more
visually appealing highlight of the
element you are discussing.
In Presentation Mode, the 'tracking
handles' are hidden.

Highlight

Click on the drop-down arrow and select
the color in which to highlight elements
in Presentation mode.
You can select either:
· One of the available colors
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The More Colors button, or
· (If you have previously changed the
color) the Default color button (Aqua)
The More Colors button displays the
'Colors' dialog, from which you can select
a preset color from the 'Standard' tab or
define a custom color on the 'Custom' tab.
Click on the OK button to apply the new
color as the highlight in diagram
presentations.
·

Tracking
Handle Size

Click on the drop-down arrow and select
the size of the 'size change handles' or
'tracking handles' on an element,
connector or label in a diagram. These
display when you click on the object to
select it.
You can select:
· Small (the default, 8 pixels)
· Medium (12 pixels), or
· Large (16 pixels)
If 'Enable Presentation Mode' is selected,
the 'tracking handles' are hidden. You can
still expand or contract the element by
dragging on the corners, ends or
mid-points of the object.

Color

Click on the drop-down arrow and select
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the fill color of the 'tracking handles'
from the list:
· White
· Light Gray
· Dark Gray or
· Black
Reset BPMN
Prompts

Working on a BPMN 2.0 diagram can
result in certain prompts being displayed,
which you can hide by selecting the 'Do
not show this message again' checkbox
on each prompt.
Click on this Reset BPMN Prompts
button to clear that checkbox so that the
prompts are again displayed.

Close

Click on this button to save your changes
and close the 'Preferences' dialog.

Notes
·

If you have a diagram open when you reset any of these
diagram behavior options, you might need to close the
diagram and open it again to see the effect
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Sequence Diagram Options
When you are modeling using Sequence diagrams, there are
a number of rendering features that are specific to that
diagram type, such as the focus of the control indicator. You
can define default settings for these features, in addition to
the more-general diagram settings that you define on the
other diagram pages of the 'Preferences' dialog.

Access
Ribbon

Start > View > Preferences > Diagram >
Sequence

Keyboard
Shortcuts

Ctrl+F9 | Diagram | Sequence

Control Sequence diagram behavior
Field/Button

Action

Default page
layout is

Select the checkbox to set the default
orientation of your Sequence diagrams to
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Landscape

landscape.

Show
Sequence
Numbering

Select the checkbox to display sequence
numbers against the Sequence Messages
on the diagrams. (This option has
immediate effect.)

Assume right
to left
messages are
Return

Select the checkbox to automatically
render new Messages passing from right
to left as Return Messages.

Default
concurrency
is
Asynchronou
s

Select the checkbox to set the default
concurrency for Sequence Messages to
Asynchronous.
Deselect the checkbox to set the default
concurrency to Synchronous.

Enable
tooltips when
re-ordering
messages

Select the checkbox to display a tool-tip
when you attempt to move one Message
above or below another. The tool-tip is to
remind you that to swap the Message
positions, and thus re-order the Messages,
you must hold down the Alt key.
If you do not hold down the Alt key the
selected Message will move close to the
next Message but will not go past it.
To avoid displaying the tool-tip, deselect
the checkbox. This is only advisable if
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you are familiar with the requirement to
use the Alt key.
Width

Click on the drop-down arrow and select
the line width (in points, between 0 and
20) of the 'focus of control' rectangle (the
body at the start and end of a Message, on
the Lifeline).
(This option takes effect when a new
element is added, an existing element is
repositioned, or the diagram is closed and
re-opened)

Assume
message
returns

Select the checkbox to set implicit Return
Messages when none are explicitly drawn
(recommended).
Deselect the checkbox to use Return
Messages only when they are explicitly
created.

GarbageColle Select the checkbox to automatically
ct
truncate the Lifelines for elements that
have a defined lifecycle, by drawing an X
after the last Message (that is, assume
garbage collect rather than explicit
delete).
Name
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the caption bar text (at the top of the
Sequence diagram) is rendered. The
caption bar shows each element name
immediately over its element in the
diagram.
This feature is particularly useful for
non-English character sets.
Changes take effect immediately after the
'Preferences' dialog is closed.
Size

Click on the drop-down arrow and select
the font size of the caption bar text.
This overrides the font size set in the MS
Windows 'Font' dialog.

Use System

Select this checkbox to override (but not
overwrite) the 'Name' and 'Size' settings
with the system default heading font
definition.

Close

Click on this button to save the changes
you have made, and to close the
'Preferences' dialog.
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Object Display Options
In modeling with elements, you can configure the standard
contents of the elements you create and view and, in
diagrams, how they are rendered and how the system
responds to actions you take on them.

Access
Ribbon

Start > View > Preferences > Objects

Keyboard
Shortcuts

Ctrl+F9 > Objects

Control element appearance and behavior
Field/Button

Action

Version

Type in the default version number or
code for new elements.

Phase

Type in the default phase number or code
for new elements.
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Highlight
References

Select the checkbox to highlight
parameters in operations that are passed
by reference rather than value.

Reference
Char(s)

Type in a character or character string to
act as the reference.

Prefix/Suffix

Select the appropriate radio button to
display the 'Reference Char(s)' value as
either a prefix or a suffix on the operation
parameter.

Warn about
spaces in
class names

Select the checkbox to display a warning
message when a Class, operation or
attribute name has embedded spaces
(which can cause coding problems).
Deselect the checkbox to hide such
messages.

Classes
honor
analysis
stereotypes

Select the checkbox to show Classes as
their stereotype; for example, if a Class is
stereotyped as a Boundary, it appears as a
Boundary rather than a Class.
Deselect the checkbox to show the
element as its base type; that is, as a
Class.

Show

Select the checkbox to show a code letter
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stereotype
icon for
requirements

in the top right corner of Requirement (E,
for external), Change (C) and Issue (I)
elements.
Deselect the checkbox to hide the
indicator letter.

Support for
Composite
Objects

Select the checkbox to:
· Display a hashed border within a valid
parent element when you drag a
potential child element onto it in a
diagram
· Automatically embed the child element
in their parent element in the model,
when you drag and drop the child
element onto the parent element in a
diagram
· Automatically disengage the child
element from the parent (break the
child-parent relationship) in the model
when you drag the child element out of
its parent element
Deselect the checkbox to not display the
hashed border and to not embed the child
element in the parent in the model.

Auto-resize
marks
diagram
'dirty'

Select the checkbox to set auto-resizing
of elements as an unsaved change to the
diagram (displaying an asterisk on the
diagram tab), so that you must manually
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save the diagram to protect the change.
Deselect the checkbox to automatically
save autosizing changes.
Highlight
{abstract}
elements

Select the checkbox to indicate, on a
diagram, Classes set as abstract by
displaying the tag {abstract} below and to
the right of the Class name.

Allow
elongated
Use Cases

Select the checkbox to allow Use Cases
or Use Case extension points to elongate
to accommodate long names.
If you deselect the checkbox, Use Case
re-sizing is proportional and the 'make
same height/width' menu options are
blocked.

Show status
colors on
diagrams

Select the checkbox to display color
coding in Requirement, Change and Issue
elements on all diagrams.
Deselect the checkbox to display the
status bands and element shadows in the
standard fill and shadow colors. You can,
however, select an option in report
generation to still show the status colors
in diagrams in the report.
You can increase the range of element
types on which to use status color coding,
through the 'Status' page of the 'General

(c) Sparx Systems 2018

Page 613 of 694

User Guide - User Interface

21 December, 2018

Types' dialog ('Configure > Reference
Data > Project Types > General Types').
Copy
inheritance
links on
duplicate

Select the checkbox to duplicate
Inheritance and Realization connectors
when you copy their elements.

Show buttons
for selected
Object on
diagram

Select the checkbox to enable the display
of the floating toolbar buttons to the right
of an object when you select it.

Deselect the checkbox to not display
these toolbar buttons or element icons.
Show
«column»
stereotype

Select the checkbox to show the
«column» stereotype as a heading in
Table elements, when data modeling.
Deselect the checkbox to just display the
column names without the «column»
heading.

Extend
Complexity

Select the checkbox to extend levels of
complexity to five levels in the
'Complexity' field in the element
'Properties' dialog:
· 'Easy'
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'Medium'
· 'Difficult'
· 'Extreme'
· 'Unknown'
Deselect the checkbox to restrict the field
to three options (omitting 'Extreme' and
'Unknown').
·

UML 1.5
Components

Select the checkbox to perform your
modeling using UML 1.5 components
(Enterprise Architect versions from 4.0
onwards default to using UML 2.x).

Show State
Compartment

Select the checkbox to show, in a State
element, the State compartment divider
under the State name.

Show
Duplicate
Tags

Select the checkbox to enable duplicate
tag names to be shown in the element
Tagged Values compartment and in the
Tagged Values window for the element.
The system defaults to hiding duplicate
tag names, to avoid displaying inherited
and overridden Tagged Values. It is
useful to display the duplicate tags when
you are revising them; for example, when
you are adding namespaces and labels in
ODM.
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Group
Select the checkbox to group an element's
Operations
operations by their stereotype, in the
by Stereotype element's operations compartment on the
diagram.
The order in which the stereotypes are
listed is determined by the order of the
operations in the 'Operations' page of the
Features window for the element - if
operation AA with stereotype Z is the
first in the operation list, stereotype Z is
first in the stereotype list.
Deselect the checkbox to list the
operations ungrouped, in the order in
which they appear in the Features
window for the element.
Group
Attributes by
Stereotype
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Select the checkbox to group an element's
attributes by their stereotype, in the
element's attributes compartment on the
diagram.
The order in which the stereotypes are
listed is determined by the order of the
attributes in the 'Attributes' page of the
Features window for the element - if
attribute AA with stereotype Z is the first
in the attribute list, stereotype Z is first in
the stereotype list.
Deselect the checkbox to list the
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attributes ungrouped, in the order in
which they appear in the 'Attributes' page
for the element.
Sort Features
Alphabeticall
y

Select the checkbox to list element
features of each type alphabetically.
Features include Attributes, Operations,
Tags, Constraints and Test Cases.
Deselect the checkbox to list the features
in the order in which they are defined (if
not alphabetical) in the corresponding
dialog or window for the feature.
To observe the effects of selecting or
deselecting the checkbox, you must close
the diagram and reload it.

Disable
spelling

Select the checkbox to turn off automatic
spell checking.
Deselect the checkbox to resume
automatic spell checking.
The spelling checker operates on the
view, dialog or window where you
initially enter the text strings.

Advanced

Click on this button to specify which
types of element should be listed in
document reports and in diagram
Packages.
Some types of element do not appear in
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Packages and in document output by
default. You use this facility to include
such types.
Show
invoked
Activity
name (UML)

For UML and other non-SysML diagram
types. Select the checkbox to show
CallBehaviorAction names as
'Action:Activity'. Clear the checkbox to
show the names as 'Action'.

Show
invoked
Activity
name
(SysML)

For SysML diagram types. Select the
checkbox to show CallBehaviorAction
names as 'Action:Activity'. Clear the
checkbox to show the names as 'Action'.

Close

Click on this button to save the changes
you have made, and to close the
'Preferences' dialog.
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Connector Display Options

It is possible to configure a number of settings that control
the creation, behavior and notation for the connectors that
you define in your diagrams.

Access
Ribbon

Start > View > Preferences > Links

Keyboard
Shortcuts

Ctrl+F9 | Links

Control connector appearance and behavior
Field/Button

Action

Edit
Connector on
New

Select the checkbox to automatically
open the connector 'Properties' dialog
each time you create a new connector on
a diagram.
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Deselect the checkbox to simply create
connectors without displaying the
'Properties' dialog to assign a name or
properties.
Association
default =
source -- >
target

Select the checkbox to automatically set
the direction of new Associations,
flowing from source to target element
(that is, with an arrow head at the target
end).
Deselect the checkbox to create
Associations with no direction (no
arrowhead on the connector line.)

Generalizatio
n link style
Default =
Tree

Select the checkbox to show
Generalizations in vertical tree-style,
forming a hierarchy where multiple links
to elements exist.
Deselect the checkbox to create
Generalizations in Auto Route style.

Shade
Qualifier
boxes

Select the checkbox to lightly shade all
Qualifier boxes on Associations in the
diagrams you open (see Suppress
Qualifier Boxes).
Deselect the checkbox to prevent shading
of the Qualifier boxes.

Draw

Select the checkbox to draw Aggregate
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Aggregations
Reversed

and Composite connectors from target
element to source element (the diamond
on the source end of the line).
Deselect the checkbox (the default), to
draw these connectors from source to
target (the diamond on the target end of
the line).

Prompt on
connector
deletes

Select the checkbox to display a prompt
before deleting connectors, offering the
choice of hiding the connector on the
diagram or deleting it completely.
If you deselect this option, the delete
operation defaults to the last-set option on
the dialog.

Suppress
Link
Constraints

Select the checkbox to hide any
constraints set on connectors in the
diagrams you open.
Deselect the checkbox to allow the
constraints to display on the connector
lines.

Suppress
Qualifier
boxes

Select the checkbox to hide the qualifiers
(in their boxes) on Association
connectors.
Deselect the checkbox to show the
qualifiers on the diagrams you open.
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Show Uses
arrowheads

Select the checkbox to show an
arrowhead on the target end of each Use
connector in a Use Case diagram.
Deselect the checkbox to show the
connector as a simple line.

Show
'Override
Operation'
dialog on
new
connector

Select the checkbox to show the 'Override
Operation' dialog automatically when
adding Generalization and Realization
connectors between Classes and
Interfaces, if the target element has
features that can be overridden.

Suppress ' + '
Role Scope

Select the checkbox to hide the 'Public'
indicator (+, when Access = Public in the
connector role properties) of the source
and/or target role on a connector.
Deselect the connector to allow the +
symbol to display.
When changing this setting, you might
need to reload the diagram to see the
change take effect.

Strict
Connector
Syntax

Select this checkbox to check that each
new connector complies with UML,
BPMN 2.0 and SysML 1.2 & 1.3 syntax
as you add it, and to enforce compliance.

Pen Width

Click on the drop-down arrow and select
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the default connector line width (between
1 and 4 pixels).
Routing

Click on the drop-down arrow and select
the default connector style for new
connectors (Direct, Routed or Custom).

Enable

Select the checkbox to enable the Quick
Linker, showing the Quick Linker arrow
when you click on an element on the
diagram.
Deselect the checkbox to hide the Quick
Linker arrow and make the Quick Linker
unavailable.

Show Help

Select the checkbox to add a 'Help' option
at the end of the Quick Linker menu, to
display the Quick Linker Help topic.

Center to
center

Select this radio button to set the
orientation of the dashed guide line for
new connectors to anchor on the center of
the source element and, as you approach
the target element, the center of that
element.
The guide line displays both when you
are dragging the Quick Linker arrow and
when you have dragged a connector icon
from the Diagram Toolbox.
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Exact
placement

Select this radio button to set the
orientation of the dashed guide line for
new connectors to the exact point on the
element you drag from and the exact
position of the cursor as you drag to the
target element.
This option enables the 'Force
perpendicular line' checkbox.

Force
perpendicular
line

Select this checkbox to set the orientation
of the dashed guide line for new
connectors to a perpendicular line
between the source and target element
edges, wherever this is possible.
You can toggle between this effect and
the Exact Placement effect by holding
[Ctrl] as you move the cursor between the
source and target elements.

Close

Click on this button to save the changes
you have made, and to close the
'Preferences' dialog.

Notes
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For the 'Draw Aggregations Reversed' option, all tools
have the parent as the target and the child as the source of
the connector, which is a requirement of UML; only the
direction in which you drag the mouse to draw the
connector is changed
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Communication Message Colors
Communication diagrams illustrate how components
interact and exchange information in a process. They have a
large number of messages that indicate the timing or
sequence of events in the communication process. You can
define the sequence of these messages using sequence
numbers, which also help you to group messages within a
stage in the sequence. To help make the sequence easier to
see at a glance, you can also:
· Select to display the messages in color
· Set a color for each group of messages

Access
Ribbon

Start > View > Preferences >
Communication Colors

Keyboard
Shortcuts

Ctrl+F9 | Communication Colors

Notes
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Select the 'Use Communication Message Coloring'
checkbox to turn on message coloring in the
Communication diagrams you open; when you select this
option, Communication messages display in different
colors depending on the sequence group they belong to on
the diagram - for example, messages 1.n are black, 2.n are
red and 3.n are green
Click on the down arrow in the color field for each
numerical message group and click on the color to set for
that group; if you have more than eight groups in the
sequence the color pattern repeats, so group 9 messages
are the same color as group 1 messages, and group 10
messages are the same color as group 2 messages
Click on the Close button to save the changes you have
made, and to close the 'Preferences' dialog
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XML Specifications
Many of the model development and management tasks you
perform operate either directly or indirectly with XML. You
can set defaults on a number of settings to standardize the
way in which you use XML in your own modeling
activities. You can override several of these settings on any
specific XMI import or export, especially when publishing a
model Package in XMI to another modeling language or
tool.

Access
Ribbon

Start > View > Preferences > XML
Specifications

Keyboard
Shortcuts

Ctrl+F9 | XML Specifications

Notes
·

If 'Export Alternate Images' is set, and you have Packages
in your model under Version Control, then any alternative
images used in those Packages are also exported to the
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Version Control repository when you check in the
Packages; in this case, you would only select the
checkbox if the alternative images are subject to frequent
change
Otherwise, do not select this option and instead use the
'Configure > Model > Transfer > Export Reference Data'
and 'Import Reference Data' ribbon options to manage
alternative images

Set XML Specification Options
Field/Button

Action

Editor

Specify the default editor for reviewing
any XML documents you open within the
system. Either:
· Type in the location of the editor .exe
file, or
· Click on the
button and browse for
the location

Code Page

Defaults to windows-1252; if you do not
want to use this Code Page, type in your
preferred code page reference.
Setting a null encoding string results in
the encoding tag being entirely omitted
from the XML output.
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Click on the Default button to restore the
setting to the default Code Page.
Format XMI
Output

Select the checkbox to set formatting of
your XMI output into human-readable
form as the default.
Deselect the checkbox to show the XMI
as unformatted code.

Use DTD

Select the checkbox to default to using a
Data Type Definition (DTD) in your XMI
imports and exports. A DTD validates the
correctness of the model and checks that
no syntactical errors have occurred.
Deselect the checkbox to set the default
to not using a DTD.

Export
Diagrams

Select the checkbox to default to
including diagrams when you export
XML to another format or tool.

Export
Alternate
Images

Select the checkbox to export any
alternative images used in the model
when you export to XML.

Validate
XMI against
Schema/DTD

Select the checkbox to validate the XML
format against the schema or Data Type
Definition when loading an imported
XML file.
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Import using
single
transaction

Select the checkbox to make all XMI
import operations and all Paste Package
from Clipboard operations default to
being performed within a single
transaction.
Deselect this checkbox to make all XMI
imports and paste Package operations
default to being performed data item by
data item, so that one failure does not
block the whole operation (recommended
for large imports/copies).
In either case, in any specific XMI import
operation the setting can be overridden.

Write Log

Select the checkbox to write the
execution activity to a log file when you
import or export XMI.
Deselect the checkbox to not record the
activity of the import or export to a log
file.

Export
Diagram
Images

Select the checkbox to export diagrams as
images when you export to XML.

Image Type

If you select the 'Export Diagram Images'
option, click on the drop-down arrow and
select the image format to export to.
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Select from metafile, bitmap, .gif, .png
and .jpeg.
Create
placeholders
for missing
External
References
during XMI
1.1/2.1
Import
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Select the checkbox to show, during the
import of an Enterprise
Architect-exported XMI 1.1/2.1 file, any
missing:
· Diagram elements, using a Boundary
element as a placeholder
· Diagram connectors, using a
Dependency connector as a placeholder
When importing an Enterprise
Architect-exported XMI 1.1/2.1 file with
cross-Package references, use this option
to visually show the diagram items that
are not yet in the model.
A sample scenario would be, as shown
here, exporting 'Package2' to 'XMI 1.1'
from 'Master.EAP' and importing it into
'New.EAP' - the Classes 'Class1' and
'Class2' and the connector between them
are shown using a placeholder on the
diagram 'Package2'.
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If the file is for a Package under Package
Control or Version Control, and this
checkbox is not selected, it is overridden
if the 'For all packages, create
placeholders for external references'
checkbox is selected on the 'Version
Control Settings' dialog and/or 'Package
Control Options' dialog.
Prefix
Enterprise
Architect
Tagged
(c) Sparx Systems 2018

Select the checkbox to prefix any
Enterprise Architect Tagged Values
within any XMI 1.0 you create, with ea$.
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Values in
XMI 1.0 with
ea$
Update Last
Save Time

Select the checkbox to update the
timestamp of the last time each controlled
Package was saved.

Report Cross
Package
Reference
Deletions
(XMI 1.1)

Select the checkbox to report any
Package cross-references that would be
deleted when a Controlled Package from
an 'incomplete' model is exported to XMI
1.1.

Default XML
Directory

Type in the location of the default XML
directory to use when importing and
exporting XML, or click on the button
and browse for the location.

Close

Click on this button to save the changes
you have made, and to close the
'Preferences' dialog.
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Model-Specific Options
The 'General page' is the default page of the 'Manage Project
Options' dialog. It helps you to set those of the general
options that apply only to the model in which they are set,
and that affect all users of that model. One of these options
is specific to SysML Control Flows.
The 'Manage Project Options' dialog contains other pages
for identifying MDG Technologies, Code Engineering
options and code language options that also are specific to
the model.

Access
Ribbon

Configure> Model > Options

Control system behavior
Field/Button

Action

File
Directory

Type in the default directory name for the
shared files you define on the 'Files' tab
of an element's 'Properties' dialog
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(maximum 50 characters).
Minimum
Version

Click on the drop-down arrow and select
the minimum version of Enterprise
Architect required to open this model.

Minimum
Build

Type in the number of the earliest build
required to open this model.
Alternatively, click on the Select Current
button to set the build of the system that
the model is currently open in.

Font Face

Click on the drop-down arrow and select
the font in which to display all element
text in diagram renditions of elements.

Font Size

Click on the drop-down arrow and select
the font size in which to display all
element text in diagram renditions of
elements.

Clear

Click on this button to clear the 'Font
Face' and 'Font Size' fields.

Ignore image
transparency

Select this checkbox to ignore
transparency for all images in the model,
effectively rendering them as 24-bit
images.
Deselect the checkbox to show the
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transparency for all (32-bit) images on
which it has been used.
Message
Spacing

Type in the vertical gap (in points,
between 15 and 45) to maintain between
Sequence Messages on a Sequence
diagram.
This spacing can be overridden manually
by dragging a Message up or down.

SysML Options
Field/Button

Action

Dashed Line
for Control
Flow

Select this option to draw all control
flows on SysML diagrams as dashed
lines. Deselect this option to draw all
control flows on SysML diagrams as
solid lines.
This option does not affect control flows
on non-SysML diagrams, which will
always be drawn as solid lines.
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Notes
·

·

·

·

·

In the Corporate, Unified and Ultimate editions of
Enterprise Architect, if security is enabled you must have
'Manage Project Settings' permission to set, change or
clear the 'Font Face' and 'Font Size' fields, and to
enable/disable diagram image-maps
Similarly, if security is enabled you must have 'Configure
Project Prerequisites' permission to update the 'Minimum
Version' and 'Minimum Build' settings
You can also define User fonts on the 'Preferences' dialog
that apply to any diagram you display in any model; the
User font is overridden by the Model font, to ensure that
all members of the project team have a consistent and
coherent view of the model
Model fonts are themselves overridden by
specifically-defined element fonts, so that the element is
viewed as designed regardless of the model defaults; to
define the font for a specific element, right-click on the
element in a diagram and select the 'Appearance | Set
Font' option
It is recommended that a project authority sets the Model
font, and all project members abide by it and do not
change it without project approval; in editions where
security is enabled, changes can be restricted by allocating
permission only to the project authority
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Cloud Page
The Cloud page is generally maintained by a model or
project administrator. It provides options to:
· Configure the WebEA 'Properties' dialog for each element
and diagram to provide a URL that can be copied and sent
to a user (by, for example, email) so that they can directly
link to that object in WebEA
· Enable HTML pages for Linked Documents, and Diagram
Images and Image Maps for all Enterprise Architect
diagrams, to be generated and updated in cache for access
from WebEA

Access
Ribbon

Configure > Model > Options > Cloud

Configuration Options
Option

Description

URL

Type the IP address of the site hosting
this model in WebEA. For example:
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http://123.123.123.123:180
Model
Number

Type the position number of this model in
the list of models presented in the
WebEA 'Login' page. (As in the
[model_list] section of the WebEA config
file.)

Auto create
Diagram
Image and
Image Map
(each time a
Diagram is
saved)

(In the Corporate, Unified and Ultimate
editions) Select this checkbox to create
Diagram Images and image-maps for all
diagrams. These images and image-maps
will be automatically updated whenever
the diagram content changes.
This option is necessary for publishing
the model via the Pro Cloud in WebEA.
Deselect the checkbox to stop creating
images and image-maps for diagrams. A
prompt displays through which you
specify whether to retain or delete the
existing images and image-maps in the
model.

Auto create
HTML Page
(each time a
Linked
Document is
saved)

(In the Corporate, Unified and Ultimate
editions) Select this checkbox to create
HTML pages for all Linked Documents
in the model. These HTML pages will be
will be automatically updated whenever
the Linked Document content changes.
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This option is necessary for publishing
the model via the Pro Cloud in WebEA.
Deselect the checkbox to stop creating
HTML pages for Linked Documents. A
prompt displays through which you
specify whether to retain or delete the
existing HTML pages in the model.
Batch create
Diagrams
and/or
Linked
Documents
cache

(Only if you have selected the 'Auto
create Diagram Image and Image Map'
and/or 'Auto create HTML Page' options.)
Click on the 'Create' button to page
through the diagrams and Linked
Documents of the model, creating an
initial diagram image and image map for
each diagram and an initial HTML page
for each Linked Document.
You should only need to do this
occasionally, to force a wholesale update
of the cache; normally the individual
diagram images and Linked Document
pages are updated automatically when the
original object is changed.

Integrations

It is possible to connect a non-Cloud
model to the Integration Plugins provided
by Pro Cloud Server.
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To enable this feature:
· Tick the 'Enable' check -box
· Enter a connection string to a Pro
Cloud Server (it is not necessary to
include a 'Data Source' or 'DNS')
· Click 'Fill Providers' to populate the list
of available external data providers
· Tick any providers that should be made
available to this model
Note: The connection string for a Cloud
connection can be obtained via the
Manage Project window, by
right-clicking on a recent connection and
selecting 'Edit connection string'.

Notes
·

In the Corporate, Unified and Ultimate editions of
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Enterprise Architect, if security is enabled you must have
'Manage Project Settings' permission to set 'Auto create
Diagram Image and Image Map' and the WebEA URL
and model number
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Tutorial

Welcome to Enterprise Architect!
This quick-start tutorial helps you get up to speed with
Enterprise Architect.
As you read through this tutorial, it is recommended that
you have Enterprise Architect open so that you can try out
the tasks described. By the end you should be able to begin
modeling your own business/software projects with
Enterprise Architect.
Throughout the descriptions there are hyperlinks to more
detailed information on a range of topics.

Basic Tasks
Task
Creating a new project
Adding Views to your model
(c) Sparx Systems 2018

Page 644 of 694

User Guide - User Interface

21 December, 2018

Adding Packages to your model
Adding diagrams
Adding elements to your model Packages
Creating links between model elements
Refining the model
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Startup
When you install Enterprise Architect on your system, two
items are created:
· An Enterprise Architect icon on your Windows desktop
· A new program folder called Enterprise Architect
<version number> in your Windows 'Start > All
Programs' menu; this folder contains the execution option
'Enterprise Architect'
You can start Enterprise Architect by clicking on either of
these objects. After a short pause, the Start Page displays,
from which you can:
· Open a project file (.eap file, .eapx file or .feap file)
· Create a new project (.eap file, .eapx file or .feap file)
· Connect to a DBMS repository (Corporate and extended
editions)
· Connect to a project via the Cloud (Corporate and
extended editions)
· Return directly to one of the projects you most recently
opened
· Open one of a number of Portals to a set of facilities that
support an area of work in Enterprise Architect

Notes
·

If you changed the default system folder name during
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installation, the Enterprise Architect <version number>
folder in the 'All Programs' menu will have the name you
provided
By default, when you install Enterprise Architect, an
empty 'starter' project called EABase.eap is installed, as
well as an example project named EAExample.eap; we
recommend that new users select the EAExample file and
explore it in some detail while they become familiar with
UML and software engineering using Enterprise Architect
Enterprise Architect .eap files default to use JET 3.5 as
the database engine, which does not support unicode
character sets
Enterprise Architect .eapx files default to use Jet 4.0 as
the database engine, which does support unicode character
sets (for example, to provide user interface texts in
languages other than your Windows-defined native
language)
If you want to use unicode character sets, you must either
upsize to a DBMS repository or set JET 4.0 as the
database engine; resetting the database engine ensures
compatibility with .eap files that support unicode
character sets and that are in turn compatible with
versions of MS Access later than Access 97
If your .eap project is not in a Jet 4.0 database, you should
also download a copy of the Jet 4.0 EABase model from
the Sparx Systems website, and do an EAP to EAP
transfer of your model into the Jet 4.0 file
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Create a Project
A project is a single file or repository-based store for one or
more models.
· The first step in getting started with Enterprise Architect
is to either open an existing project, or create a new one
· In this example we create a new file-based project and add
a template-based model to kick-start our modeling
· Once your new project has been created it will have a
simple Use Case model added for you to explore and
tailor to your requirements
· You can re-open your project at any time by
double-clicking on it in a file browser
· It should also appear in the 'Recent' list on the Start Page

Create a New Project
Ste Description
p
1

Start Enterprise Architect.

2

When the 'Start' page displays, click on the 'New
File' option.
Result: The standard Windows file browser dialog
displays.
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File-based Enterprise Architect projects are named
with:
· A .eap extension (JET 3)
· A .eapx extension (JET 4)
You can also create projects on Firebird by clicking
on the drop-down arrow in the 'Files of type' field
and selecting the '*.feap' option.
3

Locate a suitable folder for your project and, in the
'File name' field, type in a distinctive name.
Click on the Save button to continue.
Result: Enterprise Architect creates a new project
file and places it in the specified location.
The project is then opened automatically. The
Project Browser window displays with the 'Model'
icon at the top.

4

Click on the
icon in the Project Browser toolbar;
the Model Wizard window displays, showing the
'Model Patterns' tab.
In the left hand column header, click on the
drop-down arrow and select 'UML > Behavioral' and
scroll down to 'Use Case Diagrams'. Select 'Basic
Use Case Model'.
Click on the Create Patterns button.
Result: The Model Wizard automatically creates a
new Use Case model for you, with an initial
diagram, some notes and default elements to help get

(c) Sparx Systems 2018

Page 650 of 694

User Guide - User Interface

21 December, 2018

you started.
5

Close the Model Wizard window.
At this stage all your changes have been saved to file
and do not require further action.
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Add a View to your Model
A View is a top level Package within a model. It can be
categorized by purpose, such as Use Case View, Component
View or Deployment View, the purpose being indicated by
using different types of icon. Views are used to add an
optional level of grouping of Packages, diagrams and
elements - the building blocks of your model.

Add a View
Ste Instruction
p
1

In the Project Browser, right-click on the 'Model'
icon (the model root node) and select the 'Add View'
option.
The 'Create New View' dialog displays.

2

In the 'Name' field, type an appropriate name for the
new View.

3

Click on the appropriate radio button to select an
icon for the View (we suggest Simple).

4

Click on the OK button.
The 'Create New View' dialog closes.
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The new View is created as a child of the Model root
node.

Notes
·

There are six types of View, which represent conventional
ways of categorizing the purpose of a Model View; these
Views represent different structural or behavioral aspects
of the same model
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Add New Packages
A Package is a container of model elements, and is
represented in the Project Browser as a 'folder' icon.
· A Package holds the model building blocks, such as
diagrams, elements and other Packages
· To begin developing your model, you create an initial
Package to hold your first diagrams and model structures

Access
There are numerous ways in which you can add a Package
to your model. Start by selecting the parent Package (or
View or Root node) in the Project Browser.
Then choose any of the methods outlined here.
Ribbon

Design > Package > Insert > Insert a
Simple Package

Context
Menu

Right-click on parent Package | Add a
Package

Keyboard
Shortcuts

Ctrl+W

Other

Project Browser tool bar |
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Add a Package to your model
On the 'New Package' dialog, complete the fields as
instructed.
Option

Instruction

Owner

Displays the name of the
currently-selected Package or View, to
which you are adding the new Package.
If this is not the required owner Package,
click on the button and select the
correct Package.

Name

Defaults to Package1. Overtype this with
the name of the new Package.

Select and
Apply Model
Pattern

Click on this radio button if you want to
create the new Package from a Model
Pattern.

Create
Diagram

Click on this radio button if you want to
immediately create a child diagram for
the Package.

Package
Only

Click on this radio button if you want to
just create a Package.
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OK

Click on this button to create the Package
in the Project Browser.
If you selected the 'Select and Apply
Model Pattern' radio button, the Model
Wizard view displays. Select the
appropriate Perspective and Model
Pattern to import. Click on the OK
button.
If you selected the 'Create Diagram' radio
button, the 'New Diagram' dialog
displays. Type in a name for the diagram
and select the appropriate Perspective
Group and Perspective (in the 'Select
From' panel) and the required diagram
type. Click on the OK button.
The new Package is inserted into the
Project Browser under the selected parent
Package or View.

Cancel

Click on this button to abort the changes
you have made and close the dialog.
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Create a New Diagram
A diagram is a visual representation of the elements of your
model and:
· Their attributes and characteristics
· How they are connected and/or interact with each other
Different diagram types show different aspects of the model
and the relationships between elements.

Add new diagrams to your model
Ste Action
p
1

Click on a Package or View in the Project Browser,
then either:
· Click on the Project Browser
button, or
· Press Ctrl+Insert, or
· Select the 'Design > Diagram > Insert' ribbon
option, or
· Right-click on the Package or View and select the
'Add Diagram' option
The 'New Diagram' dialog displays.

2

Enterprise Architect provides a default diagram
name that is the same as the parent Package name.
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Overtype this with your preferred diagram name, if
necessary.
3

Click on the 'Select From' header and select the
Perspective Group and Perspective most appropriate
to the area you are working in.
The panel below the header displays a list of
diagram groups; click on the required group.

4

In the 'Diagram Types' panel, click on the type of
diagram to create.
A description of the selected diagram type displays
in the field underneath this pane.

5

Click on the OK button.
· The 'New Diagram' dialog closes
· A new diagram is created as a child of the
currently selected Package
· The new diagram is opened in the Diagram View,
ready for editing

Notes
·

When you create a Package, if you leave the 'Create
Diagram' option selected, the 'New Diagram' dialog
displays automatically
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Create New Elements on a Diagram
Models are constructed from elements, each of which has its
own meaning, rules and notation. Generally, when you
create a new element in your model, you want to use that
element on a diagram. The simplest way to do this is to
create the element directly on the diagram. In this
procedure, we will use a Requirement element as the
example.

Create a new element on a diagram in your
model
Ste Action
p
1

Display the Properties window; select the 'Start >
Explore > Properties > Properties' ribbon option.
Also display the Diagram Toolbox; select the
'Design > Diagram > Toolbox' ribbon option

2

Display the diagram on which the elements are to be
created, in the Diagram View.
To open the diagram, double-click on the diagram
name in the Project Browser.
The diagram opens and the Toolbox is updated to
display the categories of elements and relationships

(c) Sparx Systems 2018

Page 660 of 694

User Guide - User Interface

21 December, 2018

that are applicable to that type of diagram.
In this example, we must change this to the Custom
toolbox. Click on to display the 'Find Toolbox
Item' dialog, and specify 'Custom'.
3

Click on the appropriate icon in the Toolbox to
select the type of element to create (in this example,
the Requirement element).
The element type is highlighted in the Toolbox.

4

Click on the diagram at the location where you want
to place the element.

The new element is created as a child of the Package
that contains the diagram, and is placed onto the
diagram at the cursor position.
The element's initial details are displayed in the
Properties window.
5

Use the Properties window to define the element's
name and other properties it should have.
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Right-click on the diagram background and select
the 'Save Current Changes' option.
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Notes
·

·

·

You can also drag or paste existing elements onto a
diagram from the Project Browser
If you are creating several elements of one type, after
creating the first just press Shift+F3 or Ctrl+click to create
the next element of that type
You can also create elements using shortcuts to the main
facilities of the Toolbox, using the 'Toolbox Shortcut'
menu; press the Insert key or Spacebar key to display this
menu
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Add Connectors
Connectors define specific relationships between specific
elements, so you usually create them directly on the diagram
by dragging the required relationship type from the Diagram
Toolbox. As for elements, the Toolbox automatically
presents the connector or relationship types appropriate to
the type of diagram currently displayed.

Define a relationship between two model
elements on a diagram
Ste Action
p
1

Display the Diagram Toolbox; either:
· Select 'Design > Diagram > Toolbox' or
· Press Alt+5
Also, if it is not already displayed, open the
Properties window ('Start > Explore > Properties >
Properties' ribbon option).

2

Open the diagram containing the elements to be
connected, in the Diagram View (double-click on the
diagram name in the Project Browser).
The selected diagram opens and the Toolbox is
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updated to display the categories of elements and
relationships that are applicable to that diagram type.
3

Click on the required connector in the Toolbox to
select the type of connector to draw.
The connector type is highlighted in the Toolbox.

4

Click on the source element in the relationship, then
drag across to the target element.
The selected connector is drawn between the two
elements.
The connector becomes the focus of the Properties
window.

5

Use the Properties window to define the
characteristics of the connector as required.

Notes
·

·

If you are creating several connectors of one type, after
creating the first just click on the appropriate source
element and press F3 to create the next connector of that
type
As you drag a connector path, you can press Shift to
create a bend in the connector; if necessary, you can put
several bends in the connector line, pressing Shift every
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time you want to change direction
To roll back the bends, keep holding the left mouse button
down and press the Backspace key as many times as is
necessary
To find out more about the type of connector you have
dragged on to a diagram, right-click on the connector and
select the 'Type Information' option, which displays a
Help page on the connector type
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Modify Properties
When you create an element and connect it to another
element, you usually have to define various characteristics
of both the element and the connector to identify the
purpose and function they represent. You do this using the
Properties window.
When you create elements, Enterprise Architect
automatically names and numbers them by type - for
example, Class1, Class2 - so you should at least change the
'Name' field to more easily identify each element. Enterprise
Architect does not automatically name connectors, but for
many connector types you can provide a name that describes
the purpose of the connection.

Modify the characteristics of a model
element or connector
Ste Action
p
1

Select the 'Start > Explore > Properties > Properties'
ribbon option. The Properties window displays.
Click on the element or connector for which to
define properties. The initial details for that object
display in the Properties window.
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2

Modify the element or connector characteristics as
required.

3

Click on the diagram background.
The element or connector details in the window are
saved; the diagrams that contain the element or
connector are updated as necessary, as is the Project
Browser.

Notes
·

·

You can also modify the properties of an element or
connector using the 'Properties' dialog, which is specific
to the selected object; select:
- For an element, the 'Design > Element > Properties >
Properties Dialog' ribbon option or
- For a connector, right-click on the connector and
select the 'Properties' menu option
On the 'Properties' dialog, click on the OK button to save
the changes and close the dialog
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Save Changes
Throughout much of your work in Enterprise Architect, any
changes you make are automatically saved when you close
the dialog (data entry window) on which you made the
changes. In some cases the dialog contains a Save button or
Apply button, which you can click on to save your changes
and then keep working on the dialog.

If there is no specific dialog, such as when
you create a diagram, you can save your
work by
Clicking on the Save icon in the Diagram toolbar ( )
· Pressing the Ctrl+S keyboard keys, or
· Right-clicking on the diagram and selecting the 'Save
Current Changes' menu option
Often, Enterprise Architect does not let you close a screen
without confirming that you want to save or discard your
changes. You can also save your diagram changes
automatically, by selecting the 'Auto Save Changes'
checkbox on the 'Diagram Behavior' page of the
'Preferences' dialog.
·
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Move Objects Around
You have created a project containing Packages, diagrams
and elements, and you have connected the elements.
How do you change where things are?

Move diagrams, elements and connectors
Task
Change the Project Browser list order - re-arrange the
order of items in the Project Browser
Move elements between Packages - move diagrams,
elements and child Packages from one parent Package to
another
Move elements on a diagram - re-arrange the position of
diagram elements
Move elements between diagrams - cut an element from
one diagram and paste it onto another
Move connectors on a diagram - re-link a source element
to a different target element
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Move Objects Within a Package
In the Project Browser, the contents of a Package are listed
in the order: diagrams, child Packages, elements.
· Elements are further arranged in order of type (but see
Notes)
· Within a type, components are initially listed in
alphabetical or numerical order
· You can change the order in which items are listed within
their groups

Adjust the order in which items are listed in
the Project Browser
Ste Action
p
1

Click on an item in the Project Browser, then click
on or in the toolbar at the top of the window.
The selected item is moved up or down in the Project
Browser accordingly, but remains within its
particular group of items.

2

To revert to listing components in alphabetical order,
in the Project Browser right-click on the Package
and select the 'Contents | Reset Sort Order' option.
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Notes
·

You can re-arrange elements in your preferred sequence
regardless of type, by selecting the 'Allow Free Sorting'
checkbox on the 'General' page of the 'Preferences' dialog
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Move Objects Between Packages
When creating the various diagrams, elements and Packages
that make up your model, at some point you might create
one of these objects under the wrong parent Package. It is
quite simple to relocate a model object from one Package to
another, either to a higher level Package, a lower level
Package or a different Package at the same level.

Move objects between Packages
Ste Action
p
1

In the Project Browser, click on and drag the model
item to be relocated from its existing position, and
drop it onto the new parent Package.
The dragged item and all of its child items are
relocated to the target Package.

Notes
·

Moving elements in the Project Browser does not affect
the use of elements in diagrams
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Moving an element or Package has no effect on any
relationships that the element, Package, or elements
within the Package have
Moving a diagram generally does not affect the location
of elements in Packages
However, elements of certain types, such as Initial Node,
Decision and Final Node, are used only within one
diagram and have no meaning outside that diagram; if you
move a diagram containing these elements, they are
moved to the new parent Package with the diagram
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Move Elements in a Diagram
To improve the understanding of a diagram or to simply
improve the presentation, you might want to adjust the
position of the elements on your diagram.

For coarse adjustments
Ste Action
p
1

Click on a diagram element and drag it to its new
position.

For fine adjustments
Ste Action
p
1

Click on a diagram element to select it.

2

While holding down the Shift key, press the
keyboard arrow keys to move the selected element
one pixel at a time in the direction of the arrow.
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Move Elements Between Diagrams
If an element is present in one diagram but not in another,
you can simply move or copy the element from one diagram
into the other. You can also cut multiple elements from one
diagram and paste them into another, and simply paste one
element or multiple elements as links to the original
elements. If you cut elements from a diagram, the elements
are not cleared from the source diagram until they are pasted
into the target diagram.

Move elements from one diagram to
another
Ste Action
p
1

In the Project Browser, double-click on the name of
the diagram that contains the element to be moved.
The diagram opens in the Diagram View.

2

Click on the element in the diagram to select it.

3

Either:
· Click on the 'Cut' (scissors) icon in the Default
Tools toolbar, or
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Press Ctrl+X
The selected element is copied to the clipboard.
However, the element remains visible on the current
diagram until the clipboard content is pasted onto a
different diagram.
The model element itself is not affected in any way.
·

4

In the Project Browser, double-click on the name of
the diagram into which the element is to be moved.
The diagram opens in the Diagram View.

5

Either:
· Click on the Paste button in the Default Tools
toolbar, or
· Press Ctrl+V or Shift+Insert
The element is pasted from the clipboard onto the
current diagram and removed from the original
(source) diagram.
Again, the model element itself is not affected in any
way.

Copy elements from one diagram to another
Ste Action
p
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1

In the Project Browser, double-click on the name of
the diagram that contains the element to be moved.
The diagram opens in the Diagram View.

2

Click on the element in the diagram to select it.

3

Either:
· Click on the Copy icon in the Default Tools
toolbar, or
· Press Ctrl+C, or
· Right-click on the element and select the 'Copy /
Paste | Copy' menu option
The selected element is copied to the clipboard.
Neither the current diagram, nor the model element
itself are affected in any way.

4

In the Project Browser, double-click on the name of
the diagram into which the element is to be copied.
The diagram opens in the Diagram View.

5

Either:
· Click on the Paste button in the Default Tools
toolbar, or
· Press Ctrl+V or Shift+Insert
The element is pasted from the clipboard onto the
current diagram.
Again, neither the source diagram nor the model
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element itself are affected in any way.

Notes
·

·

·

By selecting more than one element at a time, you can
move or copy multiple elements in the same operation
You can remove an element from a diagram by selecting
it, then pressing the Delete key
You can also place an element onto an open diagram by
locating the element in the Project Browser, then dragging
it onto the diagram
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Connect a Different Element on a
Diagram
When creating connectors in your diagrams, at some point
you might connect the wrong pair of elements. Enterprise
Architect provides a simple method to help you to move the
end of a connector from one element to another; that is:
· Change the source element of a connector from the
current element to another, or
· Change the target element of a connector from the current
element to another

Change a connected element
Ste Action
p
1

In the diagram, click on the connector to select it.
The connector is highlighted with 'handles' at each
connector end.

2

Move the cursor over the 'handle' at the end of the
connector to reconnect.
The cursor changes to a small arrow pointing
upwards to the right.
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Click on and drag the connector end to the other
element to connect to.
When you release the mouse button, the connector
breaks from the original element and reconnects to
the new element.

Notes
·

You can also tidy up a connection by dragging the end of
the connector to a better position on the edge of the
element, or move both ends at once by dragging the
middle of the connector
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Delete a Connector
It is possible to hide a connector on a diagram, or to delete it
entirely from the model, removing the relationship between
the previously connected elements.
Displaying all of the connectors on a complex diagram can
make the diagram somewhat confused, so it can be useful to
hide some of the connectors, to clarify a specific aspect of a
more complex picture.

Hide or remove a connector between two
elements
Ste Action
p
1

Open the diagram containing the connector of
interest.
Either:
· Double-click on the diagram name in the Project
Browser, or
· Make an already open diagram the 'active'
diagram, by clicking on its tab in the Diagram
View

2

Click on the connector in the diagram to select it.
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The selected connector is highlighted in the diagram.
3

Either:
· Press Ctrl+Delete
· Right-click on the connector and select the 'Delete
Connector' option, or
· Press the Delete key
If you press Ctrl+Delete, a dialog displays prompting
you to confirm that you want to delete the connector
(and the relationship it describes) from the model.
You can click on the Yes button immediately to
remove the connector, but the dialog also provides a
Traceability button that displays the Traceability
window, so you can check what impact deleting the
connector might have on other representations of the
model.
The Delete key and 'Delete Connector' option
display the 'Remove Connector' dialog.

4

On the 'Remove Connector' dialog, choose one of the
options:
· Hide the connector or
· Delete the connector from the model
'Hide the connector' obscures the connector on the
current diagram; you cannot see it but the
relationship between the two elements still exists and
is shown on other diagrams containing the two
elements together, and on all reports of connectors
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between the elements.
'Delete the Connector from Model' removes the
relationship that exists between the two elements;
the connector is removed from the current diagram,
from all other diagrams on which it is shown, and
from all reports on connectors between the two
elements.
5

Optionally, tick the checkbox 'Don't ask again'.
Selecting this option prevents the 'Remove
Connector' dialog from being displayed next time
you select the 'Delete Connector' command; the
command uses the setting you last used on the
dialog.
Make sure that you have selected the right option to
use as your default.

6

Click on the OK button.
The connector disappears from the diagram.
If you selected the 'Delete the connector from the
model' option, the relationship represented by the
connector is also deleted from your model.

Notes
·

You cannot select multiple connectors - it is only possible
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to select one connector at a time
If you select the 'Don't ask again' checkbox on the
'Remove Connector' dialog, you can reset this option on
the 'Links' page of the 'Preferences' dialog ('Start > View
> Preferences > Links' ribbon option)
Selecting the 'Hide the connector' option in the 'Remove
Connector' dialog has the same effect as hiding the
connector on the 'Links' tab of the source element
'Properties' dialog, or using the 'Visibility | Hide
Connector' context menu option on the connector
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Delete an Element
You can delete the elements of a model from a diagram or
from the Project Browser.

Delete an element
Options
Remove elements from a diagram: this is essentially
'hiding' the element in that particular view of the model.
Delete elements from a model - the element, its properties
and any child elements or diagrams it has are all deleted;
the element is removed from all diagrams on which it
appears.
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Remove Elements From a Diagram
Removing an element from a diagram does not delete the
element from the model and therefore does not alter the
structure of the underlying model. When you remove an
element from a diagram, you are essentially 'hiding' the
element in that particular view of the model.

Remove elements from a diagram
Ste Action
p
1

Open the diagram that is to be modified.
Either:
· Double-click on the diagram name in the Project
Browser, or
· Make an already open diagram the 'active'
diagram, by clicking on its tab in the Diagram
View

2

Either:
· Press Ctrl+A to select all of the elements in the
diagram, or
· Click on an element in the diagram to select it (and
use Ctrl+click to add further elements to your
selection, or to remove elements from the
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selection)
The selected elements are highlighted in the
diagram.
3

Either:
· Press the Delete key, or
· Press Ctrl+D, or
· Right-click a selected element and select the
'Delete <element name>' or 'Delete Selected
Elements' option
The selected elements are removed from the
diagram.

Notes
You can 'undo' the removal of a diagram element, by
pressing Ctrl+Z, or by clicking the Undo button in the
Default Tools toolbar

(c) Sparx Systems 2018

Page 690 of 694

User Guide - User Interface

21 December, 2018

Delete Elements From Your Model
You can delete elements from your model, working either
from the Project Browser or from a diagram.
· When you delete an element from your model, the
element, its properties and any child elements or diagrams
it contains are all deleted
· The deleted element is removed from all diagrams on
which it appears
· All relationships that it was involved in are also deleted
from the model

Delete one or more items from your model
using the Project Browser
Ste Action
p
1

In the Project Browser, click on an item to select it.
To select additional items, or to remove items from
the selection, use Ctrl+click or Shift+click.
The selected items are highlighted in the Project
Browser.

2

Either:
· Press Ctrl+Delete or
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Right-click on one of the selected elements, then
select the 'Delete selected item(s)' option
A confirmation dialog displays.
·

3

Click on the Yes button.
The selected items are deleted from your model.

Delete one or more items from your model
using a diagram
Ste Action
p
1

To open the diagram containing the items to be
deleted from your model, either:
· Double-click on the diagram name in the Project
Browser, or
· Make an already open diagram the 'active'
diagram, by clicking on its tab in the Diagram
View

2

Either:
· Press Ctrl+A to select all of the elements in the
diagram, or
· Click on an element in the diagram to select it,
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then use Ctrl+click to add or remove specific
elements to and from the selection
The selected elements are highlighted in the
diagram.
3

Press Ctrl+Delete.
A confirmation dialog displays.

4

Click on the Yes button.
The selected elements are removed from the model.

Notes
·

·

·

Deleting a Package completely removes the Package and
all its contents - diagrams, child Packages and elements from the model
Deleting an element completely removes the element and
its properties, connectors, child elements and child
diagrams from the model, and from every diagram that
contains it
Deleting a diagram completely removes the diagram from
the model, but not the diagram's component elements;
they remain in the parent Package
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